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Welcome to TeleVantage___________________________________
TeleVantage is a feature-rich, software-based phone system that combines rock-solid stability 
with the most advanced communications technology available today. TeleVantage delivers 
greater functionality, flexibility, and value than proprietary PBXs to a variety of customers, 
from small offices to large enterprise organizations with sophisticated call centers. 

What’s new in this version of TeleVantage
See the online Help for a complete list of new features in this version.

Major TeleVantage features
Major TeleVantage features include:

Q Fault tolerant architecture. Designed to keep your phone system up and running. If the 
network or your desktop computer goes down, your phone lines are unaffected. Even in 
the case of a TeleVantage Server malfunction or power outage, your critical phone lines 
will stay open.

Q Graphical call control. Gives you an easy visual way to place calls, transfer, put on 
hold, send to voice mail, set up conference calls and more.

Q Verbal menus. Guide you through all call handling and user management tasks so that 
you can use TeleVantage even without a computer.

Q Full-featured voice mail. Lets you create caller-specific greetings, log in remotely, and 
manage your voice messages graphically from the TeleVantage Client or your e-mail 
Inbox. You can also easily call back the person who left you a message.

Q Powerful call center options. Two types of call centers are available in 
TeleVantage—call center queues and ACD workgroups. Call center queues provide a 
full-featured call distribution system, enabling you to customize your callers’ hold 
experience, play single or repeating prompts, prompt callers to enter data, configure call 
priority, and set up multi-level supervisor permissions. ACD workgroups provide fewer 
features and are available to you if you have not purchased the Call Center Agent 
licenses that are required for call center queues. You can use the TeleVantage Call 
Center Reporter to run a variety of reports on call center activity for both call center 
queues and ACD workgroups.

Q E-mail, pager, and call notification. Receive notification of incoming voice mail, 
using e-mail, pager, or by having TeleVantage call you.

Q Advanced caller identification. Using PIN numbers or Caller ID, TeleVantage lets you 
easily screen every call and message, either visually or by announcing the caller's name 
when you answer the phone. 

Q Call recording. Lets you record conversations of calls or conferences, on demand or 
automatically across the entire company or specified individuals.

Q Personal statuses. Lets you create “Vacation,” “Out of the Office,” and other personal 
statuses to let your coworkers know what you are doing. Personal status can set whether 
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your phone rings, the greeting that plays, and routing list behavior when you are not able 
to answer calls.

Q The TeleVantage Web Client. Enables users with a Web browser to access voice mail 
or manage personal settings from anywhere in the world over the Internet or from 
non-Windows platforms in the office.

Q “Follow-me” call forwarding. Features routing lists that try several locations to find 
you. You can create several routing lists and apply them to specific callers.

Q Call logging. Lets users see a record of their own calls and gives TeleVantage system 
administrators access to your company’s complete log.

Q Scheduled auto attendants. Allows you to schedule an auto attendant’s use of specific 
greetings and the way it routes calls according to the time of the day and days of the 
week.

Q Flexible Internet-ready architecture. Supports pure IP telephony and hybrid solutions 
such as IP-connected phones. Lets you adapt to Internet telephony at your own pace.

Q TAPI Service Provider and Contact Manager Assistant. Lets you use Act!, Outlook, 
GoldMine, GoldMine FrontOffice, or other TAPI-compliant applications with 
TeleVantage. You can place calls and receive screen-pop identifications when you 
receive calls from contacts in these applications.

Q The TeleVantage Software Development Kit and open architecture. Use one of the 
many off-the-shelf applications available from third-party vendors to customize 
TeleVantage behavior and call processing.  Programmers can use the comprehensive 
TeleVantage Software Development Kit (SDK) for the ultimate in flexibility.  The SDK 
includes the Client API to access all Client functions, calls and data; the IVR Plug-in API 
to perform any custom call and voice processing; and the Device Status API to get 
real-time information on any trunk or station.

Q Multi-lingual system prompts. Lets both users and callers select the language in which 
they hear TeleVantage prompts.

Q CLASS, ADSI, IP, and Toshiba digital phone support. QFor analog CLASS phones, 
Caller ID, call waiting, and message waiting lights are supported.

Q Tenanting support. Tenanting allows one Server to be shared between multiple 
companies or groups, with each user's outbound calls to be tracked in the Call Log by 
organization.
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Changes from previous versions of TeleVantage _______________
The following features are changes from previous versions of TeleVantage:

Q TeleVantage now uses the Intel Dialogic SR 5.1.1 drivers instead of the DNA 3.3 
drivers.

Q Most user phone settings (for example, voice mail, call screening, and queue calling) 
now follow the user when he or she logs in at another station.

Q Music-on-hold stations or Enhanced 911 (E911) stations no longer consume station 
licenses.

Wherever possible, TeleVantage settings from previous versions are upgraded seamlessly to 
work with new TeleVantage features.

Before configuring a new TeleVantage system_________________
Before you configure a new installation of TeleVantage, be sure that you have successfully 
completed the following tasks as described in Installing TeleVantage:

Q Install the Dialogic hardware and drivers in the TeleVantage Server computer. 

Q Physically connect your trunks and stations.

Q Install the TeleVantage Server and the TeleVantage Administrator.

Q Add any required licenses.

Note: You can start the Administrator in a mode that allows you to configure a system without 
having installed telephony boards or licenses. See the next section.

This chapter outlines the tasks you must perform after installation. Detailed instructions for each 
step are in subsequent chapters.

Configuring a new TeleVantage system_______________________
After you have successfully installed TeleVantage and entered licenses as described in 
Installing TeleVantage, you are ready to configure your system. Configuring a new system 
involves the following minimum steps, each of which is described in detail in this manual. The 
other chapters describe additional features and capabilities.

1. Configure system settings. See Chapter 3.

2. Configure your trunks. See Chapter 5.

3. Create users. See Chapter 6.

4. Set up outbound call handling. See Chapter 8.

5. Set up call routing for inbound calls. See Chapter 9.
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Configuring TeleVantage without telephony boards or licenses
You can use TeleVantage in a mode that enables you to configure a system, and run reports, 
even if you do not have telephony boards and licenses installed. Note that licenses are still 
required to assign stations IDs to users. Licenses and telephony hardware are also required to 
configure trunks and place or receive calls.

In this mode you can do the following:

Q Use the Administrator and Client applications to configure nearly all TeleVantage 
settings, even if you have not entered appropriate licenses.  

Q Use the Call Center Reporter to run reports. This can be a useful way to report on 
database backups you have made to save space. To run reports, you must have a Server 
and Reporter licenses, even if those licenses are not activated. 

To configure TeleVantage without telephony boards or licenses

1. Start the Administrator as described in “Logging on to the Administrator” on page 2-2.

2. With the Administrator running, choose Tools > System Settings. On the General 
tab, check Server should not detect devices during startup, and click OK.

3. Start the TeleVantage Server.

To turn off this configuration mode

1. Enter all required hardware and licenses as described in Installing TeleVantage.

2. Stop the Server.

3. In the Administrator, choose Tools > System Settings, uncheck Server should not 
detect devices during startup, and click OK.

4. Start the Server again.

Where to get help ________________________________________
Contact your TeleVantage system administrator for technical support. For information about 
how to report problems, see “Reporting problems to your TeleVantage provider” on page 11-27.

You can get help through TeleVantage documentation as described in the next section.

TeleVantage documentation
TeleVantage includes the following documentation:

Q Installing TeleVantage—This manual guides you through the installation process for 
upgrades and fresh installations, and describes how to change hardware, configure your 
Server, and add licenses.

Q Using TeleVantage—This manual describes how to use the TeleVantage Client Web 
Client, Contact Manager Assistant, TAPI Service Provider, and telephone commands.
CHAPTER 1. INTRODUCTION TO TELEVANTAGE 1-5



Q TeleVantage Call Center Administrator’s Guide—This manual contains complete 
instructions for setting up and maintaining both types of TeleVantage call center—ACD 
workgroups and call center queues—as well as instructions for agents and supervisors.

Q TeleVantage Pocket Reference Card—This wallet-sized card is a convenient reference 
for the TeleVantage telephone commands.

Q TeleVantage QuickStart Guide—This quick-start guide for new users describes basic 
TeleVantage commands for the telephone and the Client.

Q Online Help—Context-sensitive help is available in all TeleVantage applications. In any 
view or dialog box, click the Help button, press F1, or choose Help > Contents and 
Index for an explanation of the available fields.

Q TeleVantage Developer’s Guide—This online reference describes how to extend 
TeleVantage's built-in features using the Client API, the IVR Plug-in API, and the 
Device Status API.

The following table shows the TeleVantage documentation set and the formats in which it is 
available.

Notes:

Q The online books are available in HTML-based format. To access an online book, click 
Help > Online Books in any TeleVantage application.

Q The PDF-formatted books are available on the TeleVantage master CD, in the \Manuals 
directory. Use Adobe Acrobat Reader—also available on the TeleVantage master CD in 
the \Adobe directory—to view and print these files.

Document Printed
Online 
Book

Acrobat (PDF)

Installing TeleVantage Yes Yes Yes

Administering TeleVantage Yes Yes Yes

Using TeleVantage Yes Yes Yes

TeleVantage Call Center 
Administrator’s Guide 

Yes Yes Yes

TeleVantage Developer’s 
Guide 

No No Yes

TeleVantage Pocket 
Reference Card 

Yes No No

TeleVantage QuickStart 
Guide 

Yes No Yes
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About the TeleVantage Administrator ________________________
The TeleVantage Administrator is a Microsoft Windows application that lets you configure, 
monitor, and manage your TeleVantage system. For a list of Administrator functions, see “The 
Administrator interface” on page 2-3.

This chapter describes logging on to the Administrator, using the interface of the Administrator, 
and performing basic actions in the Administrator. 

Important: Changes to user and system settings made using the Administrator do not take 
effect immediately. The system will recognize changes within 5 minutes of their being made.

Logging on to the Administrator
For information about logging on to the Administrator using command line options, see 
Appendix B. 

1. Choose Start > Programs > Artisoft TeleVantage > TeleVantage Administrator. The 
Log on dialog box opens. 

2. If you want to change your default TeleVantage Server or associated phone (station 
ID), click Options to view the expanded dialog box. 

3. Type your User name.

A user name called “Admin” exists by default. To create other administrators, you 
must add users to whom you give Administrator permissions (see “The Security tab” 
on page 6-38).

4. Type your Password. The Admin user password is set to 100 at installation. Change 
the password for the Admin user after you log on for the first time (see the important 
note below). 

5. If you want to log on to a different Server than the one already selected under Server, 
click  and select a Server name.

6. If you want to change your station ID, enter a valid station ID in the Station ID field. 

The station ID identifies the phone associated with this computer—the one you use to 
make recordings in the Administrator and perform other audio tasks. To find the 
station ID of a TeleVantage phone, pick it up and dial *0.

7. Click OK.
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Important: Leaving the Admin user password as 100 is a security risk that can cost your 
company money due to toll fraud. Until you change it, and the password of the Operator user, you 
will see a reminder message prompting you to do so each time you start the Administrator. For 
instructions on changing passwords, see “Creating a password” on page 6-14. For more 
information about system security, see Appendix C, “Protecting Your Phone System Against Toll 
Fraud.” 

Reconfiguring the computer to use a different phone
Each computer running the Administrator (or other TeleVantage workstation applications) has 
an assigned phone, which it uses when you perform commands such as making recordings or 
listening to voice mail. The phone is specified by the station ID you enter when logging on (see 
the previous section). 

To change the phone associated with the computer, click Options when logging on and enter 
the new station ID. You must do this, for example, if you move the computer to an office with 
a different phone.

The Administrator interface ________________________________
The TeleVantage Administrator interface is composed of views (see “Working in views” on 
page 2-7). Each view enables you to configure, manage, or monitor an aspect of the 
TeleVantage system. 

View Description See 

Users
Manage TeleVantage users. Includes 
changing passwords and allocating 
disk space to users for voice mail 
messages and greetings.

Chapter 6,
“Managing Users and Roles” 

Workgroups
Manage workgroups (groups of 
related extensions or contacts). 

Chapter 7
“Managing Workgroups” 

Trunks
Manage the phone lines or Internet 
trunks that connect your TeleVantage 
system to the public phone network.

Chapter 5, 
“Managing Trunks, Spans, and 
Stations” 

Dialing 
Services

Customize how outbound calls are 
allocated to different trunk groups, 
and dialing behavior. Includes routing 
services (which route calls based on 
customizable rules). 

Chapter 8, 
“Managing Outbound Calls” 
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Device 
Monitor

View and manage TeleVantage 
activity on stations and trunks.

Chapter 11, 
“Monitoring and Backing Up” 

Auto 
Attendants

Manage auto attendants that handle 
and route inbound calls with voice 
menus.

Chapter 9,
“Handling Inbound Calls” 

Queues
Manage groups of agents in 
TeleVantage call center queues.

TeleVantage Call Center 
Administrator’s Guide

Maintenance 
Log

View a log recording Administrator 
actions.

Chapter 11
“Monitoring and Backing Up” 

System 
Prompts

Listen to and change recordings used 
for standard system prompts and 
auto attendants.

Chapter 12,
“System Prompts” 

Call Log
View a record of all the calls made on 
the system. 

Chapter 11, 
“Monitoring and Backing Up” 

IVR Plug-Ins
Manage TeleVantage IVR Plug-ins, 
which are custom interactive voice 
response applications that you or 
third parties can create.

Chapter 14,
“Extending TeleVantage” 

IP Gateways
Manage IP Gateways, by which you 
can exchange calls with remote 
TeleVantage Servers over the Internet 
or an IP network.

Chapter 13
“Configuring Internet 
Telephony Support” 

View Description See 
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Using the Tools menu
The Tools menu of the Administrator offers additional TeleVantage features not available from 
the views:

Command Description See

Audio Output Lets you choose whether audio 
files play over your computer 
speakers or the phone 
associated with this workstation.

“Working with voice files” 
(page 2-10)

Backup/Restore 
Database

Backs up your TeleVantage files, 
so that your system can be 
restored in the event of 
disruption.

“Backing up TeleVantage” 
(page 11-17)

Shut down Server Stops the TeleVantage Server. “Shutting down the 
TeleVantage Server” (page 
11-16)

Update Access 
Codes

Lets you change the access 
code used for a particular dialing 
service.

“Changing an access code 
in users’ saved numbers” 
(page 8-7)

Adjust Station IDs Prompts you to shut down the 
Server and then increments or 
decrements all station IDs on the 
system by a number you specify, 
so that if you add or remove a 
low-number station board you do 
not have to edit each station ID 
individually.

Recalculate Disk 
Usage

Updates the display in the Users 
dialog box, Mailbox tab that 
shows how full users’ mailboxes 
are. The display is updated once 
a day automatically.

“Viewing the user’s 
mailbox usage” (page 
6-16)

Analyze Security Runs an online report on how 
secure your system is.

“Identifying users with 
security-risk passwords” 
(page C-3)

Columns Lets you customize the columns 
that appear in each view.

“Customizing columns” 
(page 2-9)
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Options Lets you customize the 
appearance of names, Call Log 
size, and defaults for station and 
extension numbers.

“Assigning an extension” 
(page 6-10)

“Changing the station ID 
default” (page 6-12)

“Displaying a specific 
number of Call Log 
entries” (page 11-13)

Agent Skills Lets you define skills for call 
center agents or any users. You 
must define a skill to use 
overflow agents in a call center 
queue.

TeleVantage Call Center 
Administrator’s Guide

Account Codes Lets you define user-entered 
account codes for billing, 
tracking, or other purposes.

“Using account codes to 
track phone usage” (page 
10-6)

Custom Data Lets you attach custom 
information to calls, to aid 
customer service, enable 
automatic call handling, or other 
purposes.

“Using custom data to add 
information to calls” (page 
9-18)

Routing Variables Lets you create special variables 
that help routing rules identify 
outbound calls for intelligent 
routing.

“Adding custom routing 
variables” (page 8-30)

Organizations Lets you define multiple tenants, 
businesses, or other entities that 
share your TeleVantage system, 
for tracking and billing purposes.

“Using Organizations” 
(page 10-2)

System Call 
Recording

Lets you set up automatic 
recording of all system calls, or 
those of specific individuals.

Chapter 4, “Recording All 
TeleVantage Calls” 

Advanced Settings 
Editor

Launches the Advanced Settings 
Editor, where you can modify 
advanced TeleVantage settings 
not available from the 
Administrator.

“Using the TeleVantage 
Advanced Settings Editor” 
(page A-31)

System Settings Lets you configure and 
customize several aspects of 
your TeleVantage system.

Chapter 3, “Defining 
System Settings” 

Command Description See
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Working in views
To open a view, click its button in the vertical view bar on the left side of the Administrator 
window. To change the location of a button on the view bar, drag and drop it.

You can also open a view by clicking the View menu and choosing a view.

Note: If a view is not available to you, you might not have permission to view it. Check with your 
system administrator, or see “The Security tab” on page 6-38.

The main part of a view contains rows of the items that pertain to that view. For example, in the 
Users view, each TeleVantage user appears as an item on a row. Double-click an item to edit it. 
Some views, such as the Call Log and Device Monitor, display read-only information that 
cannot be edited.

Using commands in a view
A command always affects the item or items that are selected. To select multiple items, hold 
down the CRTL key as you click the items. You can perform a command using any of the 
following methods:

Q Choose a command from the view’s menu. For example, in the Trunks view, click the 
Trunks menu and choose a command. 

Q Click a toolbar button (see the next table).

Q Right-click an item and choose a command from the shortcut menu that appears. This is 
often the fastest way to perform an command.

Using the Administrator toolbar
The Administrator toolbar is located on the main menu bar in each view. It gives you quick 
access to several Administrator commands that are also available through the Administrator 
menus. 
CHAPTER 2. THE TELEVANTAGE ADMINISTRATOR 2-7



To create a new item when you are working in any TeleVantage view, click the arrow next to 
the first button on the toolbar and select an item.

See the next section for information about creating new items that are based on existing items.

Performing basic actions in the Administrator _________________
This section shows you how to perform the following basic actions in most views:

Q Creating items

Q Deleting items

Q Renaming items

Q Copying items

Q Customizing columns

Creating items
You can create a new item in any of the following ways:

Q Choose File > New, and select the type of item to create.

Q Click the arrow to the right of the first toolbar button.

Q In any view, click the first toolbar button to create a new item for that view. For example, 
in the Users view, click the first toolbar button to create a new user.

To create a new item that is based on an existing item

1. Select the item on which you want to base a new item, such as a user in the Users view.

2. Choose Edit > Copy. A copy of the item is placed on your clipboard.

3. Choose Edit > Paste. A New <Item> dialog box opens. Copy of <item that you 
copied> appears in the title bar of the dialog box. It contains a duplicate of the selected 
item’s information. You can use this information as a basis for creating a new item.

4. Enter or change any information required for the new item in the dialog box.

5. Click OK to save the changes as a new item.
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Deleting items
To delete one or more items, select them and choose Edit > Delete. In some views, like the 
Maintenance Log or Device Monitor, you cannot delete items.

Renaming items
Items in some views cannot be renamed, for example, Call Log items cannot be renamed.

To rename an item

1. Double-click the item to open its dialog box.

2. In the Name field, type a new name for the item.

3. Click OK.

Copying items
Copying a row in any view places the information about the item in that row on the clipboard as 
text that you can paste into other applications. Use this method to paste Call Log entries and 
voice message information into the Problem Report Wizard (See “Using the Problem Report 
Wizard” on page 11-27.).

Some items, such as users, workgroups, and auto attendants, can also be pasted back into the 
Administrator view to create a copy.

Customizing columns
Click a column header to sort by that column. Click again to sort in the reverse order. The arrow 
in the column header shows by which column and in what direction the display is currently 
sorted.

You can resize column widths by dragging the sides of the column headers.

For each view in the Administrator, you can choose the columns that you want to see and the 
columns that you want to hide. Some views do not show all the available columns by default.

To show or hide columns in a view

1. Choose Tools > Columns, or right-click a column header.The Columns dialog box 
opens.

2. From the View drop-down list, choose the view you want to change.

3. Check a column to show it. Uncheck a column to hide it. For an explanation of the 
various columns, click Help.

4. Click OK.
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Working with voice files
A voice file is an audio recording that is stored as a file. TeleVantage stores system prompts, 
greetings, voice messages, and recorded conversations in voice files that you can play over your 
computer speakers or on the telephone. You can record voice files using the telephone. 

TeleVantage supports the following file formats for voice files:

Q .WAV (standard Microsoft Windows audio format)

Q .VOX MuLaw (used in North America and Japan)

Q .VOX ALaw (used in most locations outside North America and Japan)

The TeleVantage Server natively uses 8-bit PCM .VOX format.

Changing the voice file format
You can change the format of your TeleVantage .VOX voice files from ALaw to MuLaw, or 
from MuLaw to ALaw, by using the TVConvert utility as follows:

1. Run the file TVConvert.exe in the TeleVantage Server directory on the TeleVantage 
Server computer. The default path is:

C:\Program Files\TeleVantage Server\TVConvert.exe

2. Click OK to convert all your TeleVantage voice files to the other format. If the voice 
files are ALaw, they become MuLaw. If they are MuLaw, they become ALaw.

In most cases you will not need to use this procedure, because your voice file format will have 
been correctly set when your TeleVantage system was installed 

Using the audio controls
TeleVantage’s audio controls make it easy to create and modify recordings of all types. The 
following controls appear in TeleVantage wherever you can create and listen to recordings.

To create recordings, use the buttons on the audio controls as shown in the following table and 
speak into your phone. 

Record When you are ready to record, pick up your phone, and 
then click this button. A beep signals that recording has 
begun. 

Stop When you are done recording, you can either hang up or 
click this button.

Play To hear the recording, click this button.
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To move forward and backward within the recording, drag the slider bar.

Importing and exporting voice files
To import or export a voice file, use the import or export buttons on the recording control, as 
shown in the next table.

Changing audio output
TeleVantage can play audio files over your telephone. You can also play them on your computer 
if it has a sound card and speakers. 

Import You can import a voice file in .WAV or .VOX format to 
use for any Client recording (greetings, voice titles, and so 
on). 

TeleVantage can import .WAV files with a frequency of 
8Khz, 11.025 Khz, 22.05 Khz, or 44.1 Khz. You can also 
import an 8 kHz PCM .VOX file (MuLaw format for 
North America and Japan, ALaw format for other 
countries).

Export You can export any of your Client recordings, including 
voice messages and recorded conversations, to a .WAV 
file.

To hear audio output over the phone, click the telephone button on the 
status bar, or choose Tools > Audio Output > Phone. 

To hear audio output over your computer speakers, click the speaker 
button on the status bar, or choose Tools > Audio Output > Speakers.
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About system settings ____________________________________
System settings control overall TeleVantage behavior. Before adding TeleVantage trunks or 
users, you should define your system settings by choosing Tools > System Settings.

Creating system settings __________________________________
This chapter assumes that you have already entered the required licenses (see Installing 
TeleVantage). It describes how to create system settings by using the following tabs in the 
System Settings dialog box:

Q General. Use this tab to set system hold audio, tones generation, default language for 
system prompts, confirmation menu before sending to voice mail, voice-first answering, 
and outbound Caller ID (see page 3-5).

Q Licenses. See Installing TeleVantage. You must enter licenses here before you can 
proceed to create other system settings.

Q Call Log. Use this tab to set logging of internal calls and to set archiving options for the 
Call Log (see page 3-7).

Q Storage. Use this tab to view current disk usage and set locations for backups of voice 
files and the database (see page 3-8).

Q Dialing. Use this tab to set up special access codes for the dial-by-name directory, for 
trunk selection, and for the default dialing services. Also use this tab to set dialing 
time-outs (see page 3-11).

Q Emergency. Use this tab to configure emergency dialing options (see page 3-13).

Security. Use this tab to increase the security of your TeleVantage system against toll 
fraud by setting password requirements and lockout behavior (see page 3-15).

Q Other. Use this tab to create the dial-by-name directory settings, set up Microsoft 
Exchange synchronization and e-mail notifications, and set up event e-mail notification 
(see page 3-17).

Advanced TeleVantage settings
Some TeleVantage settings are low-level settings that are rarely, if ever, changed, and cannot be 
changed from the Administrator. For a complete description of these settings, see Appendix A, 
“TeleVantage Configuration Settings.” 

Re-recording voice prompts
For information about how to re-record the TeleVantage system prompts or translate them into 
another language, see Chapter 12, “System Prompts.” 
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Setting Business Hours ___________________________________
TeleVantage uses your business hours settings in schedules that you create for the following:

Q After hours greetings. See “Scheduling transfers and greetings” on page 9-13.

Q Automatic transfers. See “Scheduling transfers and greetings” on page 9-13.

Q Notification of new voice messages. See “Scheduling notifications” on page 6-21. 

Q Call rules. See Using TeleVantage.

You can create as many sets of business hours as you need. For example, you can create a set of 
business hours for the company as a whole (the default), and then create additional sets of 
business hours for individual departments, shifts, and so forth.

Defining business hours
To define your business hours, you must define your daily work hours, work days and holidays.

To define business hours

1. Click Business Hours on any tab in the System Settings dialog box. The Business 
Hours dialog box opens. To edit an existing set of business hours, select its Name on 
the drop-down list. To create a new set of business hours, go to step 2.

2. On the Work Hours tab, under Work days, check each day that is a work day, and 
under Work hours, enter the starting and ending times for each work day. 

Note: When you define business hours and holidays, you can type dates and times in 
most formats. Your entries are converted to a standard format that is based on your 
Windows regional settings.
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3. To define holidays, click the Holidays tab.

4. Click Add to add a new holiday. Click Edit to edit an existing one.

5. Enter the Holiday date.

6. Choose if this is an All day holiday or Partial day holiday. For a partial day holiday, 
enter:

Q Work hours begin at. Starting time for work on the holiday.

Q Work hours end at. Ending time for work on the holiday.

7. When you finish creating holidays, click OK.

8. Click OK in the Business Hours dialog box.

9. Click OK in the System Settings dialog box to save the settings you have created so far 
or go to the next section.
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The General tab__________________________________________
Choose Tools > System Settings and then click the General tab to set general Server options. 

Setting Server configuration
Use the Server configuration section to set the following general options for your TeleVantage 
system:

Q Use hold audio from station number. Check this box to play music for callers on hold. 
The music can be played on a CD player or other music device, or from the CD drive of 
the Server computer using the Windows’ CD Player application, as long as the device or 
sound card is connected to the specified station port. 

It is highly recommended that you use music on hold for systems with call centers or 
systems that use “follow-me” call forwarding, so callers don’t hear ringing or silence for 
too long.

TeleVantage plays whatever is on the specified channel and does not monitor the 
channel. If the music device stops, callers on hold hear nothing.

Note: If you are using the Windows CD Player application or other software application 
for music-on-hold, you can have the application automatically start whenever the Server 
computer is started, so that you never need to remember to manually launch it. From the 
Windows Control Panel, choose Scheduled Tasks, then select the application and When 
my computer starts. In the application options, set it to automatically start playing at 
startup and to repeat.

Q Generate tones using software. Check this box to generate dial, reorder, callback, and 
stutter dial tones using TeleVantage software. You will need to use this feature only if 
you are using Dialogic boards that do not generate these tones in hardware.
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Customers who use the D/41ESC board must check this box. U.S. customers can usually 
leave this box unchecked, because most U.S. Dialogic hardware generates the tones. 

Q Allow voice-first answering. If checked, users with Toshiba, Cybiolink or Aastra 
Powertouch phones can use the voice-first answering feature. With voice-first 
answering, internal calls are connected to the user’s speakerphone automatically without 
the phone ringing or needing to be picked up. (External callers ring the phone as normal.)

To use voice-first answering, a user must turn it on using the Client or the telephone 
commands. See Using TeleVantage for details.

Q Present a confirmation menu before voice mail. If checked, callers hear the prompt 
“To leave a message press 1, or press * to return to the menu” after they hear a user's 
voice mail greeting. If unchecked (the default), callers go directly to recording their 
message after hearing the greeting.

Q Server should not detect devices during startup. If checked, you can use TeleVantage 
in a mode that enables you to configure a system, and run reports, even if you do not 
have telephony boards and licenses installed. See “Configuring TeleVantage without 
telephony boards or licenses” on page 1-5.

Q Default system prompts. Use this drop-down list to select the language version of 
system prompts that are played to callers and users on the TeleVantage system.

U.S. English is installed by default. You must reinstall TeleVantage to access additional 
languages, such as U.K. English or Latin American Spanish. For more information, see 
Installing TeleVantage.

Q Queue statistics refresh interval. This field enables you to slow the Queue Monitor 
refresh rate for call centers. See the TeleVantage Call Center Administrator’s Guide.

Setting ISDN outbound Caller ID for the system
Use the ISDN outbound Caller ID section to specify the Caller ID information that accompanies 
outbound calls from the TeleVantage system on ISDN trunks (including ISDN BRI). 

The outbound Caller ID settings you make here can be overridden by individual user settings, 
and also by the settings for the span on which the call is to placed. See “Outbound ISDN Caller 
ID hierarchy” on page 5-23.

Note: On trunk types other than ISDN, outbound Caller ID is always set by the telephone 
company.

You can customize ISDN outbound Caller ID in several places in the system. For an overview, 
see “Specifying ISDN outbound Caller ID” on page 5-20.
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To set outbound ISDN Caller ID for the system

From the Calling party presentation drop-down list, select one of the following:

Q Span default. The system’s outbound Caller ID number and name will be what you 
specify in the properties of the ISDN span used to place the call. See “Specifying ISDN 
outbound Caller ID” on page 5-20.

Q Custom. The system’s outbound Caller ID number and name will be what you specify 
in the following fields: 

Q Calling party number. Enter the number to use as your outbound Caller ID number, 
for example your business’ main number.

Q Calling party name. Enter the text to use as your outbound Caller ID name, for 
example the name of your business.

Q Blocked. The system’s Caller ID is blocked on outbound calls.

The Call Log tab _________________________________________
The Call Log tab contains settings for logging internal calls and for archiving the Call Log. For 
more information about the Call Log, see “Using the Call Log view” on page 11-10.
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Logging internal calls
By default, TeleVantage logs only external calls. If internal Call Log information is important 
to you, and you can afford the additional disk space, you can log internal calls as well.

To log internal calls as well as external calls

1. Choose Tools > System Settings and then click the Call Log tab.

2. Check Log internal calls.

Call Log archiving
For instructions on using this tab to archive Call Log information, see “Archiving the Call Log” 
on page 11-14.

The Storage tab __________________________________________
The settings on the Storage tab control how TeleVantage’s database stores your system 
configuration settings and voice files.

Disk usage
Q Database. Percentage of disk space allocated for the TeleVantage database that is 

currently used, also shown in kilobytes used out of the total number of kilobytes 
allocated. The size of the TeleVantage database is set and the required disk space 
allocated when the TeleVantage Server is installed. The default database size is 100 MB. 
It will grow automatically up to a maximum of 2 GB if you are using the MSDE 
database, or to the size of your hard drive if you are using SQL Server Standard or 
Enterprise editions. See Installing TeleVantage for supported databases and 
requirements.
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When you start the Administrator, TeleVantage displays a warning message if the 
TeleVantage database is 80% or more full. You should check the database usage 
periodically to make sure that you are not running out of space. You will also 
automatically receive e-mail notifications of low space if you have set up Windows 
Event Log notifications (see “Setting up Windows Event Log notifications” on 
page 3-20).

Q Messages. Percentage of disk space allocated for all users’ voice mail messages, as well 
as any call recordings users have made, that is currently used.

Q Greetings. Percentage of disk space allocated for all users’ greetings and voice titles 
that is currently used.

Q Call Log. Amount of space currently used in the TeleVantage database for Call Log 
records, in kilobytes. Some or all of this space can be recovered by archiving Call Log 
information if total database usage is high (see “Archiving the Call Log” on page 11-14).

Allocating disk space
When you set up new users in TeleVantage, you specify the maximum size of each user’s voice 
mailbox and the maximum space permitted for each user's greetings and voice titles. 

When disk space for mailboxes and greetings becomes critically low, the Administrator displays 
a warning. You will also automatically receive e-mail notifications of low space if you have set 
up Windows Event Log notifications (see “Setting up Windows Event Log notifications” on 
page 3-20). When you see such a warning message, you should take steps to reduce disk space 
usage. Actions you can take include reducing the space allocated to users and having users 
export or delete unneeded messages. 

For more information about allocating disk space for users, see “The Recordings tab” on 
page 6-15.

Note: When users log on to the Client or use the telephone commands, they may get a warning 
if their voice mailboxes are more than 80% full. You can check available message and greeting 
space for users in the Users view.

If the available disk space on the Server drops below 50 MB, a verbal message alerts you when 
you pick up a TeleVantage phone. You will also automatically receive e-mail notification if you 
have set up Windows Event Log notifications (see “Setting up Windows Event Log 
notifications” on page 3-20).
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Moving voice files
If disk space is low on the drive on which you installed TeleVantage, you can move your voice 
message and prompt files to another local drive that has sufficient space. To move voice files, 
you must log on to the Administrator as a user who has write access to both the source and 
destination directories.

To move voice message files

1. Shut down the TeleVantage Server. You cannot move voice files while the Server is 
running.

2. Start the TeleVantage Administrator. 

3. Choose Tools > Systems Settings and then click the Storage tab.

4. Click Move.

5. Choose a new location for your voice files. The drive you select must be a local drive 
on the TeleVantage Server, not a network drive.

6. Click OK.

Moving the database backup
The Database backup field shows the location of the last database backup made. Click Move 
to move it to a different location.

Backing up your database is something you should do periodically to ensure the integrity of your 
TeleVantage system. See “Backing up TeleVantage” on page 11-17.
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The Dialing tab___________________________________________
System-wide settings for phone system dialing prefixes, special access codes and dialing 
time-outs are made on the Dialing tab.

Choose Tools > System Settings and then click the Dialing tab.

Defining special access codes
Enter the access codes that users must dial for the following:

Q Dial-by-name directory.  Number to access the TeleVantage dial-by-name directory. 
The default is 411.

Q Select a trunk.  Number to dial to place a call on a particular trunk. The default is 88.

To place a call on a specific trunk, dial the access code and the trunk number. Users must 
have the permission Select a specific trunk for outbound call to use this command. If 
users need to select trunks, create dialing services for the appropriate trunks. See “About 
dialing services” on page 8-2 for more information.

You also enter default phone number and Internet address access codes on this tab that the 
system uses when returning calls from voice messages. For more information, see “Setting 
default access codes for callbacks” on page 8-8.
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Setting dialing time-outs
TeleVantage uses dialing time-outs that you define to determine the end of a number that was 
entered by a user. If users press # after entering the final digit of a number, TeleVantage dials 
the number immediately and does not wait for the time-out period to elapse.

Q Internal dialing incomplete time-out. Number of milliseconds before TeleVantage 
times out on an internal call if not enough digits were entered. The default is 8000 
milliseconds (8 seconds).

Q Internal dialing ambiguous time-out. Number of milliseconds before TeleVantage 
times out on an internal call if the digits entered cannot be resolved into a recognized 
number. The default is 3000 milliseconds (3 seconds).

Q Dialing service incomplete time-out. Number of milliseconds before TeleVantage 
times out on an external call if not enough digits were entered. The default is 8000 
milliseconds.

Q Dialing service ambiguous time-out. Number of milliseconds before TeleVantage 
times out on an external call if the digits entered cannot be resolved into a recognized 
number. The default is 3000 milliseconds.

Note: The default dialing time-outs work in most installations, and they should be modified 
carefully. 

You may want to consider increasing the Dialing service ambiguous time-out by half-second 
intervals if users intermittently hear “Number not available” when they dial out on analog or 
Robbed Bit T1 spans (this is not a problem for ISDN or IP lines). 

If you increase this time-out by too much, however, users can miss the beginning of the audio 
signal at the target if the called party answers immediately, for example, a company auto 
attendant. If this problem occurs, you can do any of the following:

Q Reduce the dialing service ambiguous time-out.

Q Instruct users to enter # after dialing a number.

Q Collect all digits before dialing (see page 8-10).
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The Emergency tab_______________________________________
Settings for two kinds of emergency dialing services—standard 911 and Enhanced 911 
(E-911)—are made on the Emergency tab.

Note that users can make an emergency call from any TeleVantage station, even one not 
assigned to a user, and even if they are blocked from making external calls.

Using standard 911 service with TeleVantage
Standard 911 service does not require additional hardware. All standard 911 calls use a 
TeleVantage trunk and go through the phone company to the emergency dispatching center. 

You can change the emergency number from 911 to something else by entering the new number 
in the Emergency Number field.

Check Emergency number can be dialed at internal dial tone if you want users to be able to 
dial the emergency number without first dialing an access code (such as 9 to get an outside line). 
If unchecked, users must dial the access code and then the emergency number (for example, 9 
911). This setting affects emergency calls only. Be careful when changing this setting may cause 
accidental emergency calls.

Using enhanced 911 service with TeleVantage
Enhanced 911 (E-911) calls send the calling station’s ANI information (the TeleVantage station 
ID) to the phone company’s E-911 center so they can identify the location of the person who 
made the emergency call, for example, the specific floor and office in a large building. 

Before enabling E-911 service
Before you can use E-911 service with TeleVantage, you must have installed and configured an 
E-911 device, and connected one or more E-911 stations. See Installing TeleVantage for 
instructions.

Note: E-911 stations must be physically connected to the E-911 device and dedicated to the 
E-911 service. They cannot be shared with a user.
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Enabling E-911 service
After you install and configure an E-911 device and stations, you must use the Emergency tab 
to enable E-911 service and assign your E-911 stations, as follows:

1. Check Enable support for E-911 service.

2. Click Add to add each E-911 station. that is connected to the E-911 device.The Add 

E-911 Station dialog box opens.

3. Select a station from the drop-down list, and then click OK. 

The list shows all unassigned station IDs. Note that an E-911 station will not appear in 
this list if a user is also assigned to that station ID. If an E-911 station does not appear 
in this list, you must unassign it from the user who shares it. To change a user’s station 
ID, see “Assigning a station ID” on page 6-11.

4. Repeat the steps in this procedure until you have added all E-911 stations.

How E-911 calls work
If E-911 is enabled and the E-911 device has been installed and configured correctly, an 
emergency call from any station is automatically routed to one of the E-911 stations. As soon as 
the E-911 station takes the call, the station ID of the caller’s station is passed to the E-911 device. 
The E-911 device then calls the emergency center directly over a dedicated trunk. 

If for any reason the emergency call cannot be placed using E-911 service, TeleVantage 
automatically places a standard 911 call to the emergency center using the local carrier. 

Troubleshooting E-911
Causes for failure of an E-911 call include the following:

Q All the E-911 stations are busy.

Q The E-911 device fails.

Q The dedicated trunk from the E-911 device to the emergency center is down.

Q The trunk does not respond within a certain time period.

Q E-911 is not enabled in TeleVantage.
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The Security tab _________________________________________
Choose Tools > System Settings and then click the Security tab to set password options that 
increase your system security.

Important: Password security is crucial in preventing your company from being victimized by 
toll fraud. Unauthorized users who gain privileged access to your telephone system can place 
outbound long distance or international calls that get charged to you. In 99% of cases, access is 
gained through insecure (easy-to-guess) passwords. By making your passwords more secure, 
you can dramatically increase the security of your TeleVantage system against toll fraud. For 
more information about making your system secure, see Appendix C, “Protecting Your Phone 
System Against Toll Fraud.” 

Restricting password options
Use the Permitted passwords section to restrict the passwords that users can choose. By 
forbidding easy-to-guess passwords, you can make your system much more secure from 
unauthorized access. Artisoft highly recommends checking all these options to prevent toll 
fraud.

When you change any of the password options, users whose passwords are now prohibited will 
be prompted to change them the next time they log on, and will show up in the Security Analysis 
report (see “Identifying users with security-risk passwords” on page C-3).

Q Minimum password length. Enter the minimum number of digits for a password. For 
secure passwords, the minimum should be at least five, and preferably seven or more 
digits.

Q Prevent passwords that contain an account’s extension. Passwords that contain the 
extension number are especially easy to guess. Check this option to prevent the 
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extension from being any part of the password. For example, a user at extension 337 
could not have a password of 337, 33755, or 13378080.

Q Prevent passwords that contain entries from the following list. Check to prevent 
passwords from containing any of the digit strings in the list. TeleVantage provides by 
default a list of easy-to-guess digit strings.

To add a new digit string to the list, click Add. To edit a digit string in the list, select it 
and click Edit. To remove a digit string from the list, select it and click Delete. 

Increasing password security
Use the following options in the Password security section to safeguard your TeleVantage 
system against unauthorized access:

Q Passwords automatically expire after __ days. Checking this option forces users to 
regularly change their passwords. Enter the number of days that each user may keep a 
password before the system requires them to change it to something new.

You can override this setting for individual users, to permit passwords that never expire. 
You can also manually force a user to change his or her password whenever you want. 
See “Securing the user’s account” on page 6-40. 

Note: You should exempt users with Polycom IP phones from having to change their 
passwords. See “Issues for users of Polycom IP phones” on page E-15.

Q Automatically lock out accounts after __ failed logon attempts. If checked, the 
system locks out an account after the number of consecutive failed logon attempts that 
you enter. A locked-out account cannot log on to the system, even with the correct 
username and password, until the administrator unlocks it.

Note: For lockout to occur, the multiple failed logon attempts must all happen within a 
30-minute time period. You can change this time period by changing the 
LockoutResetInterval registry setting. See “TeleVantage Server registry settings” on 
page A-2.

To unlock a locked-out account, do the following: 

Q User. In the Users view, double-click the user to open the Users dialog box, click 
the Other tab, uncheck User is locked out, and click OK.

Q Queue. In the Queues view, double-click the queue to open the Queue dialog box, 
click the Account tab, uncheck Queue is locked out, and click OK.

Q Hang up trunks after __ failed logon attempts. If checked, the system hangs up on any 
incoming caller who tries to log on to a TeleVantage account with an invalid password 
after the number of consecutive attempts that you enter.

Identifying security risks
You can analyze your system for potential security risks by choosing Tools > Analyze Security. 
For more information, see “Identifying users with security-risk passwords” on page C-3.
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The Other tab____________________________________________
Choose Tools > System Settings and then click the Other tab to set options for the 
dial-by-name directory, Microsoft Exchange synchronization, e-mail and pager notifications of 
new voice messages, and Windows Event Log notifications.

Creating dial-by-name directory settings
In Search directory by, select one of the following methods by which callers can search for 
users:

Q Last name. Callers enter the first few letters of the last name. This is the default.

Q First name. Callers enter the first few letters of the first name.

Q Last name or First name. Callers enter the first few letters of either the first or last 
name.

In Present names using, select one of the following methods for presenting the names of users 
to callers:

Q Extension number.  Callers hear an extension number after each name, for example, 
“For John Sargent, press 175.” This is the default.

Q Numbered list. Callers hear a sequence number after each name, as in “For John Smith, 
press 1”.

By default TeleVantage connects a caller immediately to the user that was chosen in a menu of 
multiple names. Similarly, when the system finds one match only, the call is immediately 
transferred to the user. However, you can select Present a confirmation menu before 
transferring if you want callers to confirm their choices before they are transferred to the one 
extension that matched the name they entered. For example, a caller would hear, “For John 
Sargent, press 1. To try again, press *.” 
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Configuring TeleVantage to send e-mail notifications
Check Server is configured to send e-mail notifications to enable TeleVantage e-mail 
functionality on your system. This functionality includes e-mail notification and Exchange 
synchronization. Before checking this checkbox, you must prepare your TeleVantage Server for 
e-mail notifications (see Installing TeleVantage). 

Using Microsoft Exchange synchronization
If your organization is using Microsoft Exchange Server for e-mail, you can choose this option 
to synchronize TeleVantage voice mail messages with the corresponding e-mail notifications in 
Exchange. You then must set up e-mail notification and Exchange synchronization for 
individual users (see “The Notifications tab” on page 6-18).

Synchronization enables users to manage their TeleVantage voicemail efficiently from 
Microsoft Outlook.

Synchronization behavior depends on whether e-mail notifications have voice messages 
attached, as follows:

Q If a voice message is attached to an e-mail notification, the following occurs:

Q Moving a voice message from the Inbox folder to the Deleted folder in either 
system also moves the voice message on the other system. For example, if you 
delete voice messages from the TeleVantage Inbox (using either the telephone 
commands or Client), the corresponding e-mail notifications and any attachments 
are deleted from the Exchange Inbox also.

Q A voice message in TeleVantage is deleted permanently when the associated e-mail 
notification in Exchange is deleted or is moved to any folder other than the Inbox 
or Deleted folder in Exchange.

Q An e-mail notification in Exchange is deleted permanently when the associated 
voice message is deleted permanently in TeleVantage.

Q If a voice message is not attached to an e-mail notification, the following occurs:

Q An e-mail notification in Exchange is deleted permanently when the associated 
TeleVantage voice message is deleted, either via the Client or the telephone 
commands. 

Q Deleting an e-mail notification in Exchange has no effect on the voice message in 
TeleVantage. Voice messages therefore cannot be deleted accidentally in 
TeleVantage before a user has the opportunity to listen to them.
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Exchange Server Mailbox Permissions
In order to synchronize with Microsoft Exchange, the TeleVantage account must be a domain 
account that has User role permissions to all Exchange mailboxes that are to be synchronized.

One way you can do this is by assigning the User role permissions to each individual Exchange 
mailbox. This method is secure but time-consuming. Alternately, you can assign the User role 
to all Exchange mailboxes at the site level. This method is less secure, but it requires less 
intervention by system administrators. For more information about assigning User role 
permissions, see your Exchange Server documentation.

With Exchange Server version 5.5 or later, note that depending on how Exchange Server is 
configured, it may take up to two hours for mailbox permission changes to take effect, because 
changes are cached before they are applied. For more information and details on how to change 
the cache interval for Exchange Server 5.5, see:

http://support.microsoft.com/support/kb/articles/q179/0/65.asp

To set up Microsoft Exchange synchronization for a user

1. On the Other tab of the System Settings dialog box, check Synchronize messages 
with Microsoft Exchange. Then enter:

Q Exchange Server name. Name of the Exchange Server on your LAN.

Q Synchronization interval. Frequency of synchronization, in minutes. The default 
is one minute.

2. Set up e-mail notification for the user (see “Setting e-mail notification” on page 6-19).

3. Enable Exchange synchronization for the user (see “Enabling Microsoft Exchange 
Server synchronization” on page 6-16).

Note: The user’s Microsoft Outlook client must be configured to deliver messages to a mailbox 
on the Exchange Server. Exchange Server synchronization does not work if the user’s Outlook 
client is configured to deliver messages to a PST file on the local computer.
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Setting up Windows Event Log notifications
You can configure TeleVantage to send e-mail notification of each TeleVantage-related event 
logged in the Server’s Windows Event Log. By setting up notifications, you can stay informed 
of critical problems, like low disk space, no matter where you are.

Windows Event Log notifications are sent based on the following settings on the Other tab:

Q E-mail phone system events for

Select one of the following from the drop-down list:

Q No events. This is the default. No notifications are sent.

Q Errors and warnings. 

Q Errors only. 

Q All events.

Errors indicate that a failure has occurred. Warnings indicate that a critical resource 
is getting low, though no failures have occurred yet. For a complete list of events, 
see “TeleVantage-related Windows Event Log messages” on page 11-19.

Q E-mail to. Identify to whom the notifications are sent. 

Q All phone system administrators.  Notifications go to all TeleVantage users with 
Administrator permissions who have e-mail notification turned on. The users you 
identify here must also have e-mail notification set to receive Windows Event Log 
notifications (see “Setting e-mail notification” on page 6-19).This is the default 
setting.

Q E-mail address(es). Enter the e-mail addresses of users whom you want to receive 
notifications, separated by semicolons.

Note: All calls to 911 are logged in the Windows Event Log as an entry.
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About recording calls _____________________________________
You can have TeleVantage automatically record all calls handled by the system, while 
exempting the individuals, roles, or queues of your choice. For example, you could record all 
calls except for those belonging to users in the Administrators role. You can also exempt internal 
(station-to-station) calls.

Note: Users can also record their own calls manually (see Using TeleVantage), and you can 
configure call center queues to automatically record calls (see the TeleVantage Call Center 
Administrator’s Guide). 

System call recordings are stored in a voice mailbox of your choice. You can manage them 
exactly as you would manage voice messages, including automatically moving them to your 
e-mail server to free up valuable TeleVantage disk space. For instructions on playing and 
managing voice messages using the phone or Client, see Using TeleVantage.

What parts of the call are recorded
Call recordings include only calls with two or more parties, and only the portion of the call from 
time the parties are connected to the end of the call. The following parts of a call are not 
recorded:

Q Hold music

Q Auto attendant messages

Q Voicemail greetings

Q Voicemail messages

Q Telephone commands or prompts

Q IVR Plug-in prompts

Q Consultation calls during supervised transfers

When a call is transferred, the various conversations are included in a single call recording.

Exempting queue calls
Call centers usually comprise a large portion of a system’s total phone traffic. If your site uses 
TeleVantage call center queues, it is recommended that you exempt your queues from system 
call recording, and use the queue’s own recording features to record queue calls (see the 
TeleVantage Call Center Administrator’s Guide). Otherwise, a needless duplication of 
recordings can result.
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Preparing to record all calls ________________________________
Recording all TeleVantage calls can significantly reduce your available disk space and Intel 
Dialogic voice resources (see Installing TeleVantage for information on managing voice 
resources). Before beginning to record calls, you should plan for how to store the resulting voice 
files and manage the demand for voice resources to record the calls.

Sending call recording voice files to your e-mail server
Each minute of call recording consumes .46 MB of disk space. If you store all call recordings 
on the TeleVantage Server computer, it can rapidly consume your available hard disk space and 
interfere with phone system performance and users’ ability to receive voice messages. 
Therefore, it is highly recommended that you automatically offload call recordings from the 
TeleVantage Server computer to your e-mail server, using the e-mail notification feature. To do 
so:

1. Create a placeholder user (named, for example, “Recorded Calls”) to whom you send 
all call recordings. For instructions on creating a user, see “Adding users” on page 6-7.

2. Set up e-mail notification for the user with the following selections:

Q Send e-mail for all messages

Q Attach voice message and delete from Inbox

For instructions on setting up e-mail notification, see “Setting e-mail notification” on 
page 6-19. 

With these settings, the call recording files are moved to your e-mail server in the form of e-mail 
attachments, with detailed Call Log information, and are deleted from the TeleVantage Server 
computer as soon as they arrive, so that no extra disk space is consumed. 

Managing call recording e-mails
When you offload call recording files via e-mail notification, you will have a large number of 
e-mails in the e-mail account to which they are sent—one e-mail for each recorded call. 
TeleVantage automatically puts information about the call into the e-mail’s subject and body, 
so that you can use your e-mail program’s Search capability to find a particular call recording.

The e-mail’s subject holds information in the following format:

SysRec: TrunkX/SMITH,KARYN->Station Y/User Y

where -> indicates the direction of the call, Trunk X indicates the trunk number involved and 
the Caller ID name (where available), Station Y indicates the station ID of the station involved, 
and User Y indicates the extension of the user involved.

The e-mail body also includes the following Call Log information that further describes what 
was recorded (example data used):

Direction: Inbound
From: Unknown
To: Corey Smythe
Answered By: Corey Smythe
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From Number: 6171234567
To Number: 104
From Code: <None>
To Code: <None>
From Device: Trunk 5
To Device: Station 4
Duration: 00:06
Start Time: 9/20/2002 10:38:20
Stop Time: 9/20/2002 10:38:26
Wait Time: 00:08
Parties: 2
CallerID Name: VIN WILLIAMS
Organization: <None>
Call Log Id: 04010000001238
TeleVantage Code:1175:1102:1

Storing call recordings on the TeleVantage Server
If you decide to store call recordings on the TeleVantage Server instead of offloading them via 
e-mail, you should choose the amount of disk space that you want to devote to storing call 
recording files. When this space is filled, you can have TeleVantage automatically make room 
for the newest call recordings by deleting the oldest. To set this up:

1. Limit the size of the placeholder user’s voice mailbox to the amount of disk space you 
want to devote to call recordings. Use the formula 1 minute = .46MB. For example, to 
devote 1 GB to call recordings, set the user’s voice mailbox to 2185 minutes. See 
“Configuring the user’s voice mailbox” on page 6-15.

2. Configure system call recording to automatically delete the oldest call recording when 
the mailbox is full. See “Recording all calls” on page 4-5.

Call recordings and voice resources
Call recording involves one additional voice resource for each call being recorded. This includes 
internal calls as well as those involving a trunk. For example, if your system has 5 trunk calls 
and 8 internal calls occurring at the moment, 13 extra voice resources are required to allow for 
call recording.

Note: Trunk voice resources cannot be shared for system call recording, because they must be 
reserved for manual (“on demand”) recording of calls by users. Likewise, call center queues 
require an additional voice resource per call to handle automatic call recording by the queue.

Before beginning to record all calls, you should make sure that your hardware configuration 
includes enough voice resources to meet the increased demand. For instructions on calculating 
voice resource needs and installing extra voice resources, see Installing TeleVantage.
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Recording all calls________________________________________
Use the following procedure to set up the automatic recording of all TeleVantage calls, and 
specify exemptions for calls that you do not want to record:

1. Choose Tools > System Call Recording. The System Call Recording dialog box 
opens.

2. Check Record all calls to have TeleVantage automatically record system calls 
according to the settings you make here. If unchecked, TeleVantage does not record 
system calls.

3. From the Send call recordings to drop-down list, select the voice mailbox to which 
system call recordings are sent.

4. From the When mailbox is full drop-down list, choose one of the following options:

Q Discard new call recording. TeleVantage deletes the new call recording instead of 
storing it. Selecting this will cause call recordings to stop when the mailbox is full.

Q Delete oldest call recording. TeleVantage deletes the oldest call recording in the 
mailbox to make room for the new recording. Only call recordings can be deleted 
by this method. TeleVantage never deletes voice messages in this way.

5. To exempt internal calls, so that only calls involving a trunk are recorded, check Do 
not record internal station to station calls. If unchecked, both internal calls are calls 
involving a trunk are recorded.
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6. Use the Do not record calls while these are in the call list to exempt users or roles 
from system call recording. You can exempt any of the following entities:

Q Users. The system does not record any call while an exempted user is a participant.

If an exempted user joins a conference call that is being recorded, the recording 
pauses as long as the exempted user is in the call. If the exempted user leaves the 
conference, the recording resumes.

Q Roles. The system does not record any call while a member of the role is a 
participant.

Q Queues. The system does not record any queue call. 

When a queue call is transferred to a user who is not an agent in the queue, it ceases 
being a queue call and recording of it begins.

To exempt a user, role, or queue from system call recording, click Add. Make your 
selection in the System Call Exclusion dialog box and click OK.

7. When you are finished adding exemptions, click OK.
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About trunks and spans ___________________________________
Trunks are the outside phone lines that connect your business to the telephone company and 
other providers. 

A TeleVantage trunk is a single channel of communication that can support one call at a time. 
A span is a collection of many trunks bundled together on a single digital line. For example, a 
T1 span on ISDN PRI contains 23 trunks.

Adding trunks to your TeleVantage system is a three-step process:

1. Connecting the physical trunk line to the Dialogic telephony board in the TeleVantage 
Server computer. See Installing TeleVantage.

2. Defining the trunk in the TeleVantage Administrator’s Trunks view. This involves 
defining the individual trunks and (for digital trunks) the span behavior and settings. 
See “Adding trunks” on page 5-3.

3. Including the trunks in one or more dialing services so that users can place outbound 
calls on it. See “About dialing services” on page 8-2.

For information about required hardware and how to order services from your phone company, 
see Installing TeleVantage.

Trunk types
TeleVantage supports analog and digital trunks. The analog trunks supported are the following:

Q Standard analog trunks. The standard type of analog trunk.

Q Analog Direct Inward Dial (DID) trunks. For TeleVantage to support analog DID 
trunks, they must be properly configured (see Installing TeleVantage).

Q Centrex trunks or analog extensions from another PBX. In TeleVantage, these are 
referred to collectively as Centrex/PBX extensions.

Note: TeleVantage does not support ground start analog circuits.

The digital trunk types supported are the following:

Q Robbed Bit T1 trunks. 24 trunks per span.

Q ISDN PRI over T1 trunks. 23 trunks per span.

Q ISDN PRI over E1 trunks. 30 trunks per span.

Q ISDN BRI over BRI trunks. Two trunks per span.

Q E1 CAS trunks. 30 trunks on one span.

Q Internet trunks. Each IP board supports a different number of trunks.

Note: TeleVantage supports both Wink start and Immediate start on Robbed Bit T1 trunks.

You do not need additional telephone company trunks for IP telephony with TeleVantage. A 
Dialogic board connects to your network and accesses the Internet through your gateway. 
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Adding trunks
This chapter contains instructions for adding new trunks of each type, as follows:

Q “Adding an analog trunk” (page 5-9)

Q “Adding a digital Robbed Bit T1 span” (page 5-14)

Q “Adding a digital ISDN or CAS span” (page 5-16)

Q “Adding a digital ISDN BRI span” (page 5-17)

Q “Adding an Internet span” (page 5-25)

Before you perform the steps in each section of this chapter, you must have installed and 
configured the Dialogic boards and drivers that are required for your trunks. See Installing 
TeleVantage for instructions.

If you add a trunk in the Administrator before it is physically installed or configured, the trunk 
has a status of “Not Installed” in the Device Monitor, until the physical trunk is installed.

Naming trunks 
When you name your trunks later in this chapter, give them names that convey important 
information about them, so that you can identify trunks quickly and easily. Information 
recommended for use in a trunk name includes:

Q The telephone number of an analog trunk

Q The IP address of an Internet trunk

Q The name of the digital or Internet span to which the trunk belongs

Monitoring trunks
For instructions on how to monitor the activity on a trunk, how to enable or disable a digital 
trunk, or how to restart a trunk that is experiencing problems, see “Using the Device Monitor 
view” on page 11-2.

Deleting trunks
Deleting a trunk removes it from your TeleVantage system configuration but does not affect the 
telephone line, the hardware, or the Trunk license.

Although you can delete a single analog trunk, you cannot delete a single T1, E1, or Internet 
trunk from the span to which it belongs. If you must permanently remove a digital trunk, you 
must delete the entire span. To disable an individual trunk in a span temporarily, right-click the 
trunk in the Device Monitor choose Disable Trunk. Uncheck the options for receiving inbound 
calls and placing outbound calls. 

A deleted trunk appears in the Device Monitor as “NA” if the physical line is still connected to 
the Intel Dialogic board.
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Configuring trunks for inbound and outbound calls ____________
You can configure trunks as inbound-only, outbound-only, or both inbound and outbound. In 
most TeleVantage installations, trunks are configured for both inbound and outbound use. 

If it is critical that a phone line is always available for inbound calls (for example, if you have 
an emergency hotline), you can set up an inbound-only trunk. Similarly, if it is critical that there 
is always a trunk available for outbound calls, you can set up an outbound-only trunk.

For instructions on configuring each trunk type for inbound and outbound calls, see the 
instructions for that trunk type in this chapter.

Matching trunk settings with your phone company
TeleVantage inbound and outbound settings control only how TeleVantage treats trunks. They 
do not affect how the telephone company treats trunks. 

For example, if you configure a trunk for inbound calls only, TeleVantage does not use it for 
outbound calls. You do not receive any calls on the trunk, however, unless you have instructed 
your telephone company to include the trunk in your inbound hunt group.

Similarly, specifying a trunk as outbound-only does not prevent inbound calls if your telephone 
company included the trunk in your inbound hunt group and given the trunk’s telephone number 
to outside parties. If calls arrive on a trunk designated for exclusive outbound use, TeleVantage 
plays a message indicating that the caller dialed a wrong number and then hangs up.

Note: The message played under these circumstances is the system prompt “Wrong Number.” 
You can rerecord it to have the message give the caller the correct number to reach your 
company. See Chapter 12 for more information about recording system prompts.

Inbound and outbound calls and hunt groups
It is recommended that you ask your telephone company for a terminated hunt group. In this 
arrangement, inbound calls try the lowest phone number first and then the next higher until a 
free line is found. When you are adding trunks to your configuration in the Administrator, assign 
the lowest phone numbers to the lowest TeleVantage trunk numbers.

On outgoing calls, by default TeleVantage starts searching for a free line with the highest 
TeleVantage trunk number. This behavior results in the fewest conflicts for lines (if you have a 
terminated hunt group), because inbound calls are arriving on the lower-numbered trunks, and 
outbound calls are going out on the higher-numbered trunks. This behavior is defined by the 
dialing service used to place the call, and can be changed to accommodate other configurations 
and needs. See “About dialing services” on page 8-2 for more information.

Placing outbound calls on a specific trunk
Users with the permission Select a specific trunk for outbound call can place a call on a 
specific trunk for testing purposes by dialing 88, the trunk number, and then the phone number. 
For example, to place a call on trunk #1, dial 8801 (you must use 4 digits). To place a call on 
trunk #12, dial 8812. When you are using specific-trunk dialing, you do not need to dial the 
access code to make an external call.
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You can change the 88 code to other digits. See “Defining special access codes” on page 3-11.

Note: If you want to allow users to access a specific trunk, create a dialing service that allocates 
that trunk. See “About dialing services” on page 8-2. To restrict the use of outbound trunks to 
certain users, see “Restricting outbound trunk use by Organization” on page 10-4.

Telephone company services that help TeleVantage____________
The following services from your phone company enable TeleVantage to work with maximum 
efficiency:

Q Caller ID/ ANI (Automatic Number Identification). Enables TeleVantage to 
identify incoming calls by number and sometimes name too, perform one-click callback 
of voice messages, and use other features. ANI provides Caller ID information about 
analog DID and digital trunks.

Q DID (Direct Inward Dial). Enables direct routing of incoming calls to individual 
stations, so callers do not need to dial an extension at an auto attendant. To give a user a 
DID number, see “Assigning a DID number” on page 6-14.

Q DNIS (Dialed Number Identification Service). Provides DID data on toll-free lines 
such as 800, 877, and 888 numbers. Throughout TeleVantage, “DID” means both DID 
and DNIS.

Collecting ANI/DID digits
Some caller or number identification services that you can order with your analog or Robbed Bit 
T1 phone lines require that TeleVantage collect information that arrives with an inbound call. 

Note: TeleVantage automatically collects Caller ID digits on analog trunks and ANI/DNIS digits 
on ISDN or CAS trunks, if available. If your system has only these trunk types and services, you 
can skip this section.

For TeleVantage to collect DID/DNIS information when a call arrives on an analog or Robbed 
Bit T1 trunk, or to collect ANI digits on a Robbed Bit T1 trunk, the TeleVantage Server needs 
to know exactly how the data is signaled. Use the information supplied by your telephone 
company or T1 carrier to define these signals to TeleVantage. For detailed instructions, see:

Q “Setting up digit collection on an analog trunk” (page 5-11).

Q Instructions for using the Robbed Bit T1 Experimenter in Installing TeleVantage.

See Installing TeleVantage for information about ordering and installing DID/DNIS for analog 
or digital lines.
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Using DID with Robbed Bit T1 trunks
1. Make sure that your Robbed Bit T1 trunks have been installed correctly.

2. Configure digit collection signaling for the trunks (see Installing TeleVantage for 
instructions on using the Robbed Bit T1 Experimenter).

3. Verify that each trunk in the digital span is configured to accept inbound calls and that 
calls are sent to a user or auto attendant (see “Entering trunk defaults for a span” on 
page 5-29). 

4. Assign DID numbers to users or auto attendants (see “The General tab” on page 6-10).

Using DID with analog trunks
1. Make sure your analog DID trunks and digital interface units have been correctly 

installed and configured. See Installing TeleVantage.

2. Configure analog digit collection signaling for the trunks (see “Setting up digit 
collection on an analog trunk” on page 5-11). 

3. Enable DID for each inbound analog DID trunk (see “Adding an analog trunk” on 
page 5-9).

4. Assign DID numbers to users or auto attendants (see “Assigning a DID number” on 
page 6-14).

Setting up fax routing _____________________________________
TeleVantage supports the use of fax machine and modem communication. The quality of the 
communication (for example, the bandwidth supported) is determined by the telephony board 
used. 

TeleVantage also supports fax detection on incoming calls, and can route calls to the appropriate 
extension (for example, a fax machine or fax server). Fax detection and routing is supported on 
the following trunk types:

Q Analog

Q Robbed Bit T1

Q ISDN/CAS T1/E1

To route faxes to a fax machine

1. Create a placeholder user whose station ID is connected to the fax machine (for 
example, a user named “First floor fax machine.”) See “Adding users” on page 6-7. 

2. Select that user when defining a trunk, in the Faxes are sent to drop-down list. For 
instructions on defining trunks of different types, see the sections in the rest of this 
chapter.
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Note: By default, if a DID match occurs on an inbound fax call, the call is routed to the user 
whose DID number is dialed, not diverted to the Faxes are sent to extension. You can change 
this behavior and enable fax diverting by changing the registry setting DirectCallsUseFaxTarget. 
See “Server\DirectCallsUseFaxTarget” on page A-35.

Whenever TeleVantage detects a fax signal on a trunk, the call is automatically routed to the 
trunk’s fax target station. You can select a different station as the fax target for each trunk. 

For instructions on how to configure specific trunk types to support fax routing, see the sections 
on adding those trunk types later in this chapter.

Customizing fax routing
If you have a bank of fax machines, you can route faxes to the entire bank at once. Whichever 
fax machine answers first receives the call. To set this up, add all the fax machine users to a 
workgroup (see “Creating a Workgroup” on page 7-4), then select the workgroup as the fax 
target when defining the trunk (see the rest of this chapter).

To handle faxes differently based on time or date, you can route fax calls to an auto attendant 
and then schedule transfers to the appropriate fax devices.

The Trunks view _________________________________________
Click Trunks in the view bar to open the Trunks view.
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Each trunk that you add appears as a row in the view. The following table show the information 
that appears for each trunk.

Because you can add trunks to the configuration before the physical trunks are added to your 
system, the number of trunks shown in the trunks view may not reflect the actual number of 
trunks available for TeleVantage’s use.

Column Description

Number Port number on the Dialogic board associated 
with this trunk.

Type Type of trunk: Analog, Robbed Bit T1, Internet, or 
ISDN/CAS E1/T1.

Inbound If checked, this trunk is used for inbound calls.

Outbound If checked, this trunk is used for outbound calls.

Rings Number of rings before TeleVantage picks up an 
incoming call.

Retrieve DID If checked, TeleVantage retrieves Direct Inward 
Dial digits from calls coming in on this trunk.

Centrex If checked, indicates a Centrex trunk.

Span For digital spans, the number of the span to which 
the trunk belongs.

Name Descriptive name assigned to the trunk.

Send calls to Auto attendant, operator, user, or IVR Plug-in that 
receives inbound calls on this trunk.

Send faxes to User to whom inbound faxes on this trunk are 
routed. 

IP Address IP address of the Internet trunk, if applicable.

Span Description Optional information provided when the span was 
added.
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Digital and Internet spans
TeleVantage represents digital and Internet trunks as a span of a number of individual trunks. 
The number corresponds to the number of available channels. For example, a Robbed Bit T1 
span offers 24 channels. When you add a Robbed Bit T1 span, 24 individual trunks appear in 
the Trunks view. You can set some properties for the span as a whole and some properties for 
individual trunks in the span only as follows:

Q To set properties for a span as a whole, right-click a trunk in the span and choose Open 
Span.

Q To set properties for an individual trunk, right-click the trunk and choose Open Trunk.

When you add a digital span, make sure that the span type matches the protocol type that was 
specified with the Dialogic Configuration Manager (DCM), as described in Installing 
TeleVantage. You cannot change a span’s type after you add it. If you create a span of the wrong 
type, delete the span and add a new one of the correct type.

Adding an analog trunk ___________________________________
Use the following procedure to add a new analog, analog DID, or analog Centrex/PBX trunk.

1. Choose Trunks > New Trunk > Analog Trunk. A new Trunk dialog box opens. 

2. Enter the number and name of the trunk, as follows:

Q Number. Identifies the hardware resource on the TeleVantage Server used for this 
trunk. If you are using a Dialogic BCP Connection Panel, the number must 
correspond to the port on the panel to which the trunk is connected.

If you have a mix of analog and digital trunks, and have not yet installed the trunks, 
be sure that you assign trunk numbers that reflect how trunks will be installed in 
your system. Analog trunks always use the lower-numbered trunks, so either add 
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the analog trunks first, or bump up the starting trunk number for the digital span to 
reflect the actual trunk number. See “Digital and Internet spans” on page 5-9 for 
information about adding a digital span.

Q Name. Descriptive name for the trunk. See “Naming trunks” on page 5-3.

3. Choose whether the trunk is used for inbound calls, outbound calls, or both, using the 
following fields:

Q Accept inbound calls. Check this box if the trunk is used for inbound calls. 

Q Number of rings before answering. Enter the number of rings that 
TeleVantage detects on the incoming call before accepting it. Billing for a call 
begins at the moment TeleVantage accepts it, at which point TeleVantage sends 
the call to the destination you specify in Calls are sent to.

The default of 2 rings allows for the capture of Caller ID on analog trunks, 
which in the U.S. appears between the first and second ring. In areas such as the 
U.K., where Caller ID appears before the first ring, this setting can be changed 
to 1 so that calls on an inbound trunk are answered after the first ring. 
TeleVantage uses Caller ID for identifying contacts, performing callbacks, and 
other features.

Q Calls are sent to. Select the auto attendant, user, ACD workgroup, call center 
queue, or IVR Plug-in that answers all inbound voice calls on this trunk. To 
change the target according to time of day, send the calls to an auto attendant 
and define the appropriate scheduled transfer action.

Q Faxes are sent to. Select the extension that answers all inbound fax calls on 
this trunk. See “Setting up fax routing” on page 5-6 for more information.

Q Retrieve DID digits from this analog line. Check this box to detect DID digits 
and route inbound calls directly to the user, auto attendant, or IVR Plug-in 
associated with the DID number. See “Setting up digit collection on an analog 
trunk” on page 5-11 for more information.

Q Allow outbound calls. Check this box if the trunk is used for outbound calls.

Q Centrex/PBX transfers supported. If this is a Centrex trunk or a trunk connected 
to an external PBX, check the box to enable users to transfer or forward calls using 
only Centrex or PBX extensions. When this option is selected (and if supported by 
your Centrex service or PBX), TeleVantage can transfer or forward a call without 
using any TeleVantage trunks.

Q Pre-transfer sequence. Type the keys required before transferring a call to a 
Centrex or PBX extension. The valid keys are 0-9, *, #, and & (Flash). The 
default is &.

Q Post-transfer sequence. Type the keys required after TeleVantage dials the 
pre-transfer sequence and the extension, to transfer a call to a Centrex or PBX 
extension. The valid keys are 0-9, *, #, and & (Flash). After the post-transfer 
sequence is dialed, TeleVantage hangs up.

4. Click OK to add the trunk to your configuration.
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Setting up digit collection on an analog trunk
The format used to transmit ANI and DID/DNIS information on analog trunks varies with the 
carrier, as follows:

Q Fixed format. Each piece of information is always the same length. For example, DID 
information is typically the last four digits that the caller dialed.

Q Variable format. Each piece of information can vary in length, with filler digits used as 
separators, for example, 4 DID digits and 5 ANI digits in the format 
#DDDD#AAAAA#. 

To collect the variable-format digits shown in the previous example, you must specify the 
following three (3) separate actions that TeleVantage must perform (see the next procedure): 

Q Collect the filler digit # that indicates the start of the DID information. The digit type is 
Filler, and the number of digits to collect is 1. 

Q Collect the DID digits sent by the carrier. The digit type is DID. You collect a variable 
number of digits up to the filler digit, #.

Q Collect the ANI digits sent by the carrier. The digit type is ANI. You collect a variable 
number of digits up to the filler digit, #.

To collect digits on an analog trunk 

1. In the Trunks view, select the trunk. 

2. Choose Trunks > Analog Digit Collection. The Analog Digit Collection dialog box 
opens. Any digit collection actions that already have been defined for this trunk appear 
in the list under Current actions.

3. In the Wait field, enter the number of milliseconds that you want TeleVantage to wait 
for the analog DID interface device to send digits.

4. Click Add to add an action to the list under Current actions, or click Edit to modify 
the selected action. In either case, the Modify Action dialog box opens.
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5. In the Modify Action dialog box, select the Digit type to retrieve. You can retrieve 
DID, ANI, or Filler digits.

6. Under Digit length, do one of the following:

Q To retrieve fixed-format data, click Exactly __ digits, and then type the number of 
digits to collect.

Q To retrieve variable-format data in which each piece of information may vary in 
length, and filler digits are used as separators, click Variable up to the first ___ 
digit, and then type the filler digit.

7. Click OK.

8. Repeat steps 4-7 to add all the actions required to collect digits coming in on the trunk, 
and then click OK.

After you have configured analog digit collection correctly, make sure that the trunk is 
configured to accept inbound calls and retrieve DID digits. Double-click the trunk to open the 
Trunk dialog box to verify both of these settings.
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Handling international Caller ID on analog trunks
If your carrier ever sends incoming Caller ID numbers that begin with something other than area 
code—for example, international numbers that begin with 0, or with the country code—you 
should make sure that TeleVantage is set up to handle them. If you do not, then users will not 
be able to use the callback feature on international calls, or any calls where the Caller ID number 
begins with something other than the area code.

To enable TeleVantage to handle international Caller ID

1. In the Trunks view, choose Trunks > Analog Caller ID Settings. The Analog Caller 
ID Settings dialog box appears.

2. Check Caller ID does not always begin with area code.

3. Enter the following data to specify your Server’s regional location (the illustration 
above shows the settings for the United States):

Q Country/Region. Select your country.

Q Long distance prefix. Enter the number you must dial to make a long distance calls 
from your location.

Q International prefix. Enter the number you must dial to make an international call 
from your location.

Q Area code. If applicable, enter your area code. Otherwise, leave blank.

Q Local number length. Enter the length of a local number in your location, without 
area code or prefixes of any kind. 

4. Click OK.

Once these settings are made, users can use the callback feature on international calls and other 
calls with non-standard Caller ID numbers.
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Adding a digital Robbed Bit T1 span _________________________
This section explains how to add a digital Robbed Bit T1 span by configuring signaling and 
adding the span to TeleVantage in the Trunks view.

Note: Before you add a Robbed Bit T1 span in the Administrator, you may want to run the 
TeleVantage Robbed Bit T1 Experimenter on the TeleVantage Server computer to configure 
signaling on the T1 span. For information about installing and using the Experimenter, see 
Installing TeleVantage. 

To add a Robbed Bit T1 span

1. Choose Trunks > New Trunk > Robbed Bit T1 Span. A new Robbed Bit T1 Span 
dialog box opens.

2. On the General tab, specify the following information for the span:

Q Span number. The sequence number of this Dialogic T1 board as installed in your 
TeleVantage Server computer (the sequence number of the first T1 board is 1, not 
0).

Q Starting trunk number. The starting trunk number of the span. The dialog box 
shows you the range of numbers of the 24 trunks belonging to this span. If your 
system also has analog trunks, the analog trunks must have the lower trunk 
numbers, so if you have not added them yet, leave room for them in your numbering 
of the span.

Q Wink duration. The length in milliseconds of the signal TeleVantage sends to your 
T1 carrier to indicate that it is ready to receive digits. You can also set the wink 
duration using the Robbed Bit T1 Experimenter.

Q Send and receive. For T1 trunks with ANI or DID/DNIS service only, the 
signaling type—DTMF or MF—used for inbound digit collection. You can also set 
this in the Robbed Bit T1 Experimenter.

Q Description. A description of the span, typically including the main phone number 
of the span.

3. Click the Signaling tab and review the event definitions that appear for your T1 trunk. 
These are the event definitions that you specified using the Robbed Bit T1 
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Experimenter. The trunk will not work unless these definitions match your carrier’s 
definitions. 

Note: You can import and export signaling templates to make the signaling setup 
easier. See the next section.

To change a definition, do one of the following:

Q Use the Robbed Bit T1 Experimenter (see Installing TeleVantage). This method is 
useful since it allows you to test the settings, but it requires that the TeleVantage 
Server be stopped.

Q Select the definition you want to change, and click Edit. Use this method only if you 
know exactly what change you need to make.

4. Click the Trunks tab and set the default values for the 24 trunks that will be created in 
this span. You can then change these values for each trunk individually. See “Entering 
trunk defaults for a span” on page 5-29.

5. Use the Caller ID Settings tab to set the values for your location and Caller ID formats. 
See “Setting location and Caller ID settings” on page 5-19.

6. Click OK to add the span to your configuration.

Using a signaling template
The Robbed Bit T1 Experimenter includes templates that contain Robbed Bit T1 signaling 
definitions that will be valid in many cases, as follows:

Q Local1. Use this template for a local Robbed Bit T1 trunk.

Q Longdistance. Use this template for a long-distance Robbed Bit T1 trunk.

To apply a template to a span, click Load Template on the signaling tab. Select the template to 
apply, click Open, and then click OK.
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Note: If you have installed the Robbed Bit T1 Experimenter to a directory other than the 
TeleVantage Administrator’s directory, you must look for the template in that directory.

You can also export the current signaling definitions shown in the tab, for example, to use in 
another span. Click Save as Template, and specify the path and filename.

To edit signaling definitions applied from a template, see the previous section.

Adding a digital ISDN or CAS span __________________________
Use the following procedure to add an ISDN T1, ISDN E1, or CAS E1 trunk. To add ISDN 
Basic Rate Interface (BRI) trunks, see “Adding a digital ISDN BRI span” on page 5-17.

1. Choose Trunks > New Trunk > ISDN/CAS T1/E1 Span. A new ISDN/CAS T1/E1 

Span dialog box opens.

2. Click the General tab and specify the following information for the span:

Q Board number. The sequence number of the span. 

Q Description. A description of the span, typically including the main phone number 
of the span.

Q Protocol type. Select whether the trunk is an ISDN T1 or an E1 type. The actual 
protocol used is determined when the Dialogic drivers are installed, as described in 
Installing TeleVantage.

Note: If you are using an E1 board with the CAS protocol, and your country’s E1 
CAS protocols are different than the standard format, contact your TeleVantage 
provider.

Q Starting trunk number. The starting trunk number of the span. The dialog box 
shows you the range of numbers of the trunks belonging to this span. If your system 
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also has analog trunks, the analog trunks must have the lower trunk numbers, so if 
you have not added them yet, leave room for them in your numbering of the span.

3. Click the Tuning tab and optimize your ISDN settings as needed. See “Optimizing 
your ISDN settings” on page 5-19.

4. Click the Trunks tab and set the default values for the 24 trunks that will be created in 
this span. You can then change these values for each trunk individually. See “Entering 
trunk defaults for a span” on page 5-29. 

5. Use the Caller ID Settings tab and Outbound Caller ID tab to set the values for your 
location and Caller ID formats. See “Setting location and Caller ID settings” on 
page 5-19.

6. Click OK to add the span to your configuration.

Note: ANI/DNIS is automatically retrieved by TeleVantage for ISDN T1 trunks and E1 trunks.

Adding a digital ISDN BRI span _____________________________
Use the following procedure to add a new ISDN Basic Rate Interface (BRI) span. To add 
Primary Rate Interface (PRI) spans, see “Adding a digital ISDN or CAS span” on page 5-16.

1. Choose Trunks > New Trunk > ISDN BRI Span. A new ISDN BRI Span dialog box 
opens
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2. Click the General tab and specify the following information for the span:

Q BRI board number. The sequence number of the span. 

Q Description. A description of the span, typically including the main phone number 
of the span.

Q Number of ports. The number of trunks supplied by your Dialogic BRI board. If 
you are using a BRI/80-SC board, select 8. If you are using a BRI/160-SC board, 
select 16.

Q Protocol. The protocol of your BRI span, as given to you by your BRI supplier.

Q Starting trunk number. The starting trunk number of the span. The dialog box 
shows you the range of numbers of the trunks belonging to this span. If your system 
also has analog trunks, the analog trunks must have the lower trunk numbers, so if 
you have not added them yet, leave room for them in your numbering of the span.

Q Service Protocol Identifier Number (SPID). A unique number assigned to each 
trunk in the BRI span. Enter the SPID numbers supplied to you by your BRI 
supplier. SPID numbers are required for North American BRI installations only. If 
your BRI board is the Dialogic BRI/2VFD, you do not need to enter SPID numbers.

3. Click the Trunks tab and set the default values for the trunks that will be created in this 
span. You can then change these values for each trunk individually. See “Entering 
trunk defaults for a span” on page 5-29. 

4. Use the Caller ID Settings tab and Outbound Caller ID tab to set the values for your 
location and Caller ID formats. See “Setting location and Caller ID settings” on 
page 5-19.

5. Click OK to add the span to your configuration.

Editing an ISDN BRI span
If you make changes to an ISDN BRI span, you must restart all trunks in the span for your 
changes to take effect. When you make changes and click OK, TeleVantage prompts you to 
restart the span. Choose one of the following options:

Q Click Yes. The span is restarted, and all calls using the span are disconnected without 
warning. 

Q Click No. Your changes are saved, but they will not take effect until you manually restart 
the span. To do so, select any trunk in the span in the Trunks view and choose Trunks > 
Restart Span.
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Optimizing your ISDN settings______________________________
When you are adding an ISDN trunk, you can use the Tuning tab to change ISDN board 
parameters. Any changes you make take effect after the current call ends.

To optimize your ISDN settings

1. Run the Dialogic Makecall Utility (DMU), which is supplied on the TeleVantage 
master CD. For instructions, see Installing TeleVantage. The DMU wizard leads you 
through the process of testing your ISDN board and generates the file 
Outbound_MCB.txt in the Output subdirectory.

2. Click the Tuning tab, click Import, select the Outbound_MCB.txt file, and then click 
OK.

This procedure updates all ISDN parameters based on their optimum value as determined by the 
DMU. To undo the update, click Restore Defaults. The parameters on the Tuning tab return to 
their initial values.

You can also change each parameter individually. Click OK on the Tuning tab when you are 
done.

Setting location and Caller ID settings _______________________
When adding a Robbed Bit T1 or ISDN span, use the Caller ID Settings tab to specify the 
Server’s location and how it handles incoming Caller ID in different formats.

Note: The location settings can affect your outbound Caller ID. For example, if your carrier 
expects a ten-digit Caller ID number and you are sending a seven-digit local number, 
TeleVantage appends the area code specified on this tab. For more about outbound Caller ID, 
see the next section.
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To specify location and Caller ID formats

1. Click the Caller ID Settings tab.

2. Enter the following general information:

Q Country/Region. Select the country where this TeleVantage Server resides.

Q Long distance prefix. Enter the number to dial to begin a long-distance call. In the 
United States, this number is 1.

Q International prefix. Enter the number to dial to begin an international call. In the 
United States, this number is 011.

Q Area code. If applicable, enter the area or city code of the region where this 
TeleVantage Server resides. Otherwise, leave blank.

3. If your carrier ever sends incoming Caller ID numbers that begin with something other 
than area code, for example numbers prefixed with 0, check Inbound Caller ID does 
not always begin with area code, and then enter the length of a local phone number 
in the Local number length field. When checked, TeleVantage automatically adjusts 
to incoming Caller ID numbers with different formats, enabling callback to work 
correctly.

If unchecked, callback will not work on Caller ID numbers that do not begin with the 
area code.

If your carrier always sends Caller ID numbers beginning with the area code, you do 
not need to check this field, but there is no harm in doing so.

4. Click OK.

Specifying ISDN outbound Caller ID _________________________
When adding an ISDN span, you can optionally click the Outbound Caller ID tab to configure 
this span to send Caller ID on outbound calls.

Important: Not all providers support this feature. If you configure the span to use this feature 
and your carrier does not support it, outbound calls can fail. Be sure to test the line after enabling 
outbound Caller ID.
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By default, each span is set to accept your system setting for outbound Caller ID (see “Setting 
ISDN outbound Caller ID for the system” on page 3-6). By editing the span setting, you can 
override the system setting for outbound calls placed on this span. Editing the span setting is the 
only way to override outbound ISDN Caller ID settings for individual users and queues.

Preparing to enter outbound Caller ID settings
Before beginning this procedure, ask your ISDN carrier the following questions:

Q Does my ISDN line support custom calling party numbers (sometimes referred to as 
custom Caller ID or customer-defined Caller ID)?

Q What is my Preferred Party Plan—“ISDN” or “National?”

If the Preferred Party Plan is “ISDN,” ask: 

Q What is my Preferred Party Type—“International” or “National?”

Entering outbound Caller ID settings
Use the following optional procedure to specify how an ISDN span handles outbound Caller ID:

1. Click the Outbound Caller ID tab in the ISDN dialog box.

2. Specify the following outbound Caller ID format information to match your ISDN 
provider’s requirements:

Q Preferred party plan. Select “ISDN” or “National.”

Q Preferred party type. If your Preferred party plan is “ISDN,” select “International” 
or “National.”
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3. Under By default send, enter any of the following information as the span’s basic 
outbound Caller ID settings. These settings determine caller ID for all outbound calls 
on the span unless you specifically permit other settings (see step 4):

Q Span Caller ID name. This span’s outbound Caller ID name; for example, your 
business name. If unchecked, Caller ID name is set by your telephone company.

Q Span Caller ID number. This span’s outbound Caller ID number; for example, your 
business’ main number. If unchecked, Caller ID number is set by your telephone 
company.

Q Blocked. Check to block outbound Caller ID information on this span, so that it 
does not appear to the destination party. Note that the system still sends Caller ID 
information even though it is blocked: this is a requirement, because some 
institutions have the right to read blocked Caller ID, for example emergency 
services and 800-numbers.

4. Under If it exists, send, specify whether to send Individual or system default Caller 
ID name and number. If checked, the custom Caller ID information specified for a 
user, queue, or the system as a whole is attached to outbound calls where specified. 
(User and queue settings override the system-wide setting if both are specified.) If no 
custom information is specified, the span settings are used.

If unchecked, customized numbers are ignored and the Span Caller ID number setting 
in step 3 is always used.

5. If your ISDN provider limits the outbound Caller ID numbers on this span to the span’s 
registered numbers, you must do the following: 

Q Check Only send registered numbers. 

Q Enter all the registered phone numbers for the span, as provided by your ISDN 
provider. To enter a number, click Add. Enter the number in the Registered Number 
dialog box and click OK. 

If your ISDN provider supports any custom outbound Caller ID numbers, leave Only 
send registered numbers unchecked.

6. Click OK.
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Outbound ISDN Caller ID hierarchy
With TeleVantage, you can customize outbound Caller ID for the system as a whole as well as 
for individual users and queues. You can customize ISDN outbound Caller ID in the following 
places:

The Caller ID on an outbound call using an ISDN trunk is determined as follows:

Q Individual user and queue settings override the system setting.

Q Span settings override all other settings.

For example, to block individual user or queue settings, you must edit the span setting.

Getting the outbound Caller ID setting that you want
Use the following guide to get the outbound ISDN Caller ID that you want:

To customize ISDN 
outbound Caller ID... See...

For the system as a whole “Setting ISDN outbound Caller ID for the system” 
(page 3-6)

For an individual user “Setting the user’s ISDN outbound Caller ID” (page 
6-42)

Using TeleVantage

For a call center queue TeleVantage Call Center Administrator’s Guide

For an ISDN span This section

Desired result Configuration

All outbound Caller ID is set by 
your telephone company

This is the default behavior. To restore it after 
changes, double-click the ISDN span in the 
Trunks view, click the Outbound Caller ID tab, 
and make sure that all fields under By default 
send and If it exists, send are unchecked.

The number (617) 111-2345 is 
always your outbound Caller ID 
number for all spans

Choose Tools > System Settings. On the 
General tab, under ISDN outbound Caller ID, 
select Custom and enter 6171112345 in 
Number. Make sure that the ISDN spans are set 
to use the system default. 
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Recognizing inbound Caller ID name on ISDN lines
If you are using ISDN PRI, you may need to customize certain registry settings in order to 
correctly receive Caller ID name. See “Configuring Calling Name Identification on PRI boards” 
on page A-27.

Enabling ISDN Megacom support ___________________________
If you are using ISDN Megacom service, you must change the TeleVantage Server computer’s 
registry in order to make outbound international calls. Without this change, international calls 
will fail, because TeleVantage does not provide the parameter indicating national or 
international calls that ISDN Megacom service requires.

For instructions on changing the registry for ISDN Megacom calls, see “ISDN Megacom service 
settings” on page A-29.

Using a partial T1 span ____________________________________
In some cases you might want to use only part of a TeleVantage T1 span, and disable the unused 
trunks. For example, you may have purchased a partial T1 line from your telephone company, 
or you may want to use some of the trunks for data rather than phone traffic.

To disable unused T1 trunks in a span

1. In the Trunks view, double-click each trunk that you want to disable in turn. The Trunk 
dialog box opens.

2. Uncheck both Accept Inbound calls and Allow outbound calls.

3. Click OK.

When you disable a trunk in this manner, TeleVantage responds to incoming calls on it by 
playing a message that says, “The number you have dialed does not accept inbound calls.”

Note: Do not try to disable trunks for this purpose using the Device Monitor > Disable Trunk 
command in the Device Monitor view. Trunks disabled that way are enabled again whenever the 
Server is restarted, and TeleVantage does not respond at all to incoming calls on those trunks.

Specify a custom Caller ID 
number for each user that 
matches their DID number, so 
people can return their calls easily

Double-click the ISDN span in the Trunks view, 
click the Outbound Caller ID tab, and check 
Individual or system default Caller ID number.

For each user in the Users view, double-click 
the user, click the Other tab, set Calling party 
presentation to “Custom,” and enter the user’s 
DID number in Calling party Number. Users can 
select that number or other settings in the Client 
(Tools > Options).

Desired result Configuration
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Adding an Internet span___________________________________
Internet trunks require no physical trunks from your telephone company. However, they require 
that TeleVantage Server computer has an active, preferably high-speed connection to the 
Internet, and that you have installed one or more Dialogic Internet telephony boards as described 
in Installing TeleVantage. The Internet “trunks” represent the individual channels that the 
Dialogic telephony board supports.

Note: After adding Internet trunks to a span, you must restart the computer. If the trunks fail to 
appear, delete the span and add the span again.Then restart the computer.

To add an Internet span

1. Choose Trunks > New Trunk > Internet Span. A new Internet Span dialog box opens. 

2. Click the General tab and specify the following information for the span:

Q IP Board number. The sequence number of the Dialogic DM3 IPLink board 
installed in your TeleVantage Server computer (the sequence number of the first 
DM3 board is 1, not 0).

Q IP Address. The IP address of the IPLink board if it has its own built-in Network 
Interface Card (NIC). Otherwise, use the IP address of the TeleVantage Server 
computer’s NIC.

Q Description. A description of the span. Include the address of the span in the 
description for easy reference.

Q Number of trunks. The number of trunks contained in the span. Enter the number 
of channels available on the Internet telephony board. To find the number of 
channels available on your board, refer to the model number of the board and 
Installing TeleVantage.
CHAPTER 5. MANAGING TRUNKS, SPANS, AND STATIONS 5-25



Q Starting trunk number. The starting trunk number of the span. The dialog box 
shows you the range of numbers of the trunks belonging to this span. If your system 
also has analog trunks, the analog trunks must have the lower trunk numbers, so if 
you have not added them yet, leave room for them in your numbering of the span.

Q Send inbound calls to. Select the auto attendant, user, or IVR Plug-in that answers 
all inbound voice calls on the trunks in this span.

3. Click the Trunks tab and specify how trunks in this span are used:

Q Accept inbound calls. If checked, the trunks are used for inbound calls.

Q Allow outbound calls. If checked, the trunks are used for outbound calls. 

4. Click the Codecs tab and review the default codecs used by this span for all inbound 
calls and as dialing service defaults for outbound calls. If you must change 
TeleVantage’s default codec list, see the next section, “Modifying TeleVantage IP 
codecs.”  

Note: You can override the default span codecs when you set up a dialing service that 
allocates trunks in this span (see “The Codecs tab” on page 8-13).

5. Click OK to add the span to your configuration.

Modifying TeleVantage IP codecs
A codec is a protocol used to compress and decompress voice signals for transmission over an 
IP network. When an IP call is established between two devices, the devices automatically 
choose which codec to use. This choice is based on whether the codec is available to both 
devices and how highly the codec is preferred by both. This tab lets you make codecs available 
to your device and arrange them in order of preference. The first codec listed is the most 
preferred codec. For example, you may prefer one codec over another for bandwidth reasons.

Important: Two TeleVantage Servers connecting over an IP Gateway must use the same 
codec lists in the same order. If they do not use the same codec lists, audio failure can occur 
during calls. See “Connecting two Servers using IP Gateways” on page 13-8 for more information 
about IP Gateway connections.
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You can make the following codecs available. See the Known Issues in the Administrator online 
Help for up-to-date information about the availability of codecs.

Q G.729a. Best for TeleVantage-to-TeleVantage connections. Offers a good balance 
between sound quality and bandwidth. (8.8 kbs.)

Q G.711 ALaw, G.711 MuLaw. Supported by all H.323 gateways and terminals, but high 
bandwidth. (64 kbs.)

Q G.723.1. Best for NetMeeting and other H.323 terminals. (5.3 kbs. or 6.3 kbs.)

Q MSGSM. (13.0 kbs.)

Q GSM. (13.0 kbs.)

To modify TeleVantage IP codecs

1. In the Trunks view, double-click the Internet span, then click the Codecs tab.

2. If necessary, click Add to add another codec, or select a codec and click Edit to change 
any of the parameters used with the codec.

3. In the Add Codec dialog box, select a Codec name from the list of codecs supported 
by the board in the drop-down list. 

4. If you want to modify any of the parameters used with the codec, enter the new values. 
The fields you can change vary depending on the codec you select. If a field is enabled 
for a particular parameter, select Any to accept whatever parameter value the other 
device sends. Parameters include:

Q Frame size. Frame buffer size, in milliseconds. A larger frame size means more 
latency (time delay).

Q Frames per packet. Number of frames in a packet.

Q Bit rate. Rate at which data is transmitted over the network.

Q Transmit audio only when voice is detected. If checked, only actual voice audio 
signal is digitized for transmission, not silence.

5. Click OK to add the codec and return to the Codecs tab.

6. Continue to add codecs to the service, as needed. Click the arrows to arrange the listed 
codecs in the order you want. The first codec in the list is the most preferred. 

7. Click OK on the Codecs tab save your changes.
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Fine-tuning your IP connection 
TeleVantage’s Internet Span dialog box includes a Tuning tab on which you can change the 
board parameters. Any changes you make take effect after the current call ends.

Parameters that may be useful to change include Echo canceler and the volume parameter that 
is located under Level controls.

To change a board parameter

1. In the Trunks view, double-click the Internet span to open its dialog box, and then click 
the Tunings tab.

2. Click the plus sign next to the Parameter to expand it.

3. Click in the Value column of the parameter that you want to change and select a new 
value by using the drop-down lists or the slider bar at the bottom of the dialog box.

4. Click OK to save your changes or click Restore defaults to restore the board defaults 
and cancel any changes.

Note: If you dial out on an IP-to-Phone Number dialing service and you cannot send digits to an 
external phone system, increase the values for DTMF Gain and DTMF On-time, under DTMF 
Parameters on this tab.
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Entering trunk defaults for a span___________________________
When you create a new digital span, you can set the defaults for all the trunks in the span on the 
Trunks tab.

To enter trunk defaults for a span

1. Check Accept inbound calls if the trunk is used for inbound calls.

2. In Calls are sent to, select the auto attendant, user, or IVR Plug-in that answers all 
inbound voice calls on this trunk.

In Faxes are sent to. Select the auto attendant, user, or IVR Plug-in that answers all 
inbound fax calls on this trunk. See “Setting up fax routing” on page 5-6 for more 
information.

3. Check Allow outbound calls if the trunk is used for outbound calls. 

After you add the span, the Trunks tab is disabled. To modify the settings for an individual trunk 
after the span has been added, edit the trunk in the Trunks view.
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Managing stations ________________________________________
This section presents information about adding a station and about phones that are supported in 
TeleVantage.

To add a station to your TeleVantage system

1. Using phone cable, connect the phone, fax machine, or other device to the 
TeleVantage Server’s Dialogic board, BCP Control Panel, or breakout box, as 
described in Installing TeleVantage.

2. In the User’s view of the TeleVantage Administrator, assign the appropriate station 
number to a user (see “Assigning a station ID” on page 6-11). 

Supported phones
See Chapter 5 of Installing TeleVantage for a list of supported phones and phone types.

Supporting different types of analog CLASS phones
Two TeleVantage registry settings specify the format used to send Caller ID or visual message 
waiting indicator information to analog CLASS phones. See “MSI station board settings” on 
page A-30 for more information.

Important: These two registry settings change the message format sent to all phones 
connected to the specified MSI, DISI, or HDSI board. 

Caller ID information
Caller ID information is sent to a CLASS phone in one of the following formats:

Q Single Data Message Format (SDMF), which sends the date, time, and 10-digit Caller 
ID number.

Q Multiple Data Message Format (MDMF), which sends the date, time, 10-digit Caller ID 
number, and 15-digit caller name. 

Q United Kingdom message format (UK), which sends the date, time, 18-digit Caller ID 
number, and 20-digit caller name. This information is only delivered as Caller ID on call 
waiting, that is, when the user is on another call.

The default format, MDMF, works for most CLASS phones, as does SDMF.

Note: These formats specify only how TeleVantage sends Caller ID information to CLASS 
phones. They do not affect how Caller ID information is passed along with a call by the phone 
company.

Visual message waiting indicator information
Visual message waiting indicator information is sent to a CLASS phone in either SDMF or 
MDMF.

The TeleVantage default is the SDMF format. If the message waiting light on your CLASS 
phone does not work, try changing the VMWI_FSK_FORMAT setting to MDMF.
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Having a station automatically dial when picked up
You can configure a station to automatically dial a number whenever it comes offhook. You 
might want this feature in the following situations:

Q A lobby or waiting-room phone that automatically calls the Operator.

Q A hotline phone that calls a key person, like the company president.

Q Phones that call an IVR Plug-in. You can use this feature to set up information kiosk 
phones that play messages in response to caller questions.

You can configure the station to dial any TeleVantage extension or external number. 

To configure a station to automatically dial when picked up

1. In the TeleVantage Administrator, go to the Users view and double-click the user 
whose station you want to configure.

If the station you want to configure is shared by more than one user, double-click any 
of those users. 

2. In the User dialog box, click the Phone tab.

3. Check On off-hook, automatically speed dial. 

If unchecked, the station does no automatic dialing when taken offhook.

4. Click  to open the Speed Dial dialog box.

5. Select or enter the number to automatically dial whenever the phone is taken offhook, 
as follows:

Q To choose an extension, click Extension and select the extension from the 
drop-down list.

Q To choose an external number, select the dialing service to use from the Call Using 
drop-down list, then enter the number in the Number field.

6. Click OK to close the Speed Dial dialog box.

7. Click OK to close the User dialog box.
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Setting up stations to require logon before placing calls
You might want the area phones in your office—for example, phones in lobbies or conference 
rooms—to be unable to place calls unless a TeleVantage user logs in. Unauthorized people 
would then be unable to place external, perhaps long-distance calls from your office, and you 
would also ensure that all calls from those phones appeared in the Call Log with the name of the 
users who dialed them.

To require logon before placing calls

1. Create a Role called, for example, “Area Phones.” Set the permission Place external 
calls from a station to “Disallow.” See “Managing roles” on page 6-46.

2. For each area phone in your office, create a placeholder user named after the phone, 
for example, “Conference Room 1,” “Waiting Room,” and so forth. Give each 
placeholder user the station ID of the corresponding area phone. Assign the 
placeholder users the “Area Phones” role only. See “Adding users” on page 6-7.”

The area phones now cannot place external calls unless a TeleVantage user logs on. The 
following optional steps prevent the area phones from placing internal calls as well without user 
logon:

3. Create an auto attendant whose only menu choice is the User login action. Uncheck 
Process all other digits as user extensions. See “Setting up an auto attendant” on 
page 9-6.

4. Double-click each placeholder user to edit it. On the Phone tab, enter the auto 
attendant’s extension in On offhook, automatically speed dial.

After completing steps 3 and 4, the area phones are configured so that when someone picks one 
up, he or she is automatically connected to an auto attendant at which logging on is the only 
option. To place calls, users would pick up the phone, dial the auto attendant’s key for logon (by 
default #), followed by their extension and password, followed by #, then the number they want 
to dial.

Viewing station activity 
For information about how to view station activity and restart a station that is experiencing 
problems, see “Monitoring station activity” on page 11-3. 

Setting up a remote phone to work with the Call Monitor
Normally, users must be at a TeleVantage station to use the Call Monitor commands in the 
Client. For a workaround that enables users to use Call Monitor commands at other phones—for 
example, a remote phone or an IP phone—see Appendix F.
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About users _____________________________________________
Unlike a traditional PBX, TeleVantage manages phone traffic by user rather than by device, 
giving the system the flexibility to handle users who move from phone to phone. This chapter 
explains how to create and manage users and roles. Roles are collections of specific permissions 
that are used to grant permissions to users. 

Your TeleVantage system can contain the following types of users (choose File > New > User):

Q User. A person using a telephone in your office. Such a user can also use TeleVantage 
remotely (see Using TeleVantage).

Q ACD workgroup user. A special type of user that routes calls to one or more 
Automatic Call Distribution (ACD) workgroups. For information about setting up ACD 
workgroups, see TeleVantage Call Center Administrator’s Guide.

Q IP Gateway user. A special type of user that represents a user on a remote 
TeleVantage Server that is linked to your Server by an IP Gateway connection over the 
Internet or other IP network. With IP Gateway users, the users on both TeleVantage 
Servers appear to be local, effectively creating a single large TeleVantage site. For more 
information, see “Connecting two Servers using IP Gateways” on page 13-8.

The instructions in this chapter refer to the standard User type.

The Admin and Operator users
Two default users are already defined in TeleVantage, as follows:

Q Admin. The Admin user belongs to the Administrators role. The Admin user and all 
users who belong to the Administrators role are permitted to run the Administrator 
application and the Device Monitor application. They also can perform all 
administrative functions. You cannot delete or rename the Admin user, and you can only 
change select logon permissions for the Admin user (see “Managing roles” on 
page 6-46).

You can give individual administrative permissions to any user—for example, 
permission to shut down the phone system—without making the user a member of the 
Administrators role. See “TeleVantage permissions” on page 6-49.

Q Operator. The Operator user is the user to whom all calls are sent by default if they 
cannot be handled in any other way. For example, if a user’s mailbox cannot be found, 
the call is sent to the extension assigned to the Operator. You cannot delete or rename 
the Operator, but you can change the Operator user’s roles and permissions. Operators 
are covered in detail in the next section.

Changing the Admin and Operator users’ passwords
Immediately after installing TeleVantage, you should change the passwords of the Admin user 
and Operator user, in order to make your system more secure from unauthorized access. For 
more information, see Appendix C, “Protecting Your Phone System Against Toll Fraud.” 
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Operators
Your system can have a main Operator user and also personal operators for other users. This 
section discusses operators from the Administrator’s viewpoint. For more information, see 
“Customizing the Client for Operators” in Using TeleVantage.

Understanding personal operators
The TeleVantage system has one Operator user, but each user can specify a personal operator. 
A user’s personal operator is the extension to which callers are transferred if the caller presses 
0 from within the user’s voice mailbox or routing list. By default, a user’s personal operator is 
the Operator user, but a user can specify any extension as their personal operators (even that of 
an auto attendant, IVR Plug-in, or queue). See “Setting up a personal operator” on page 6-14.

How callers are transferred to Operators
The following table shows to which operator callers are transferred when they press 0 in 
different locations.

Note: If a user does not set up a personal operator, callers are transferred to the Operator user 
in all cases. 

Changing the Operator’s extension from 0
You can change the Operator’s extension to a number other than the default of 0 (for example, 
in order to use 0 as a dialing service access code). However, even when the Operator’s extension 
is something other than 0, callers must press 0 to transfer to the Operator. For example, if a caller 
reaches a user’s voice mail, and wants to transfer to the Operator instead of leaving a voice 
message, the caller dials 0, even if the Operator’s extension is 111.

Caller presses 0 within Caller is transferred to

Auto attendant Operator user

If the auto attendant is restricted by workgroup, the 
caller is transferred to the extension specified in the 
workgroup’s If no answer, transfer field.

Dial-by-name directory Operator user

User’s voice mailbox Personal operator

User’s routing list Personal operator

As soon as TeleVantage knows what user is being 
called, the call enters that user’s routing list.

On hold Personal operator
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Extending ring duration for live Operator systems
If you have a system in which all calls are answered by a live Operator, you may want to increase 
the Operator user’s ring duration, which determines how long a call rings the Operator’s phone 
before proceeding to the next action on the routing list. An increased ring duration helps ensure 
that multiple calls continue to ring until they are answered, without being diverted.

By default the maximum ring duration is 120 seconds, but you can increase the maximum to 999 
seconds by editing the MaxRingDuration setting as described in “Server\MaxRingDuration” on 
page A-37.

Setting up workgroups for the Operator
To make it easier for the Operator to transfer calls to different departments, you can set up a 
separate workgroup for each department in your system. The Operator’s Call Monitor will then 
display a tab for each department, and the Operator will be able to see a list of people in a 
specific department by clicking on the appropriate tab. See Chapter 7, “Managing 
Workgroups,”  for details about setting up workgroups. 

Configuring a system without an Operator
If you choose not to have a person act as an Operator in your system, the Operator extension still 
receives calls whenever callers press 0 from within the system. Even if the Operator user’s 
extension has no station associated with it, voice messages left by callers are saved in the 
Operator user’s mailbox.

If you do not want this to happen, create a new routing list for the Operator user that has a single 
action—transferring calls to another extension, such as an auto attendant. For instructions, see 
Using TeleVantage.

Setting up multiple Operators
To define multiple Operators—for example, for multiple businesses that share the TeleVantage 
Server—see “Configuring Operators for multiple Organizations” on page 10-5.
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The Users view __________________________________________
The Users view presents information about individual users and roles in your organization. 
Roles appear in bold in the Users view. For more information about roles, see “Managing roles” 
on page 6-46.

To add, edit, or delete TeleVantage users, click Users in the view bar. The Users view opens. 
Double-click a user in the view to edit that user.

Each user that you add appears as a row in the Users view. The following table shows the 
information that is displayed for each user.

Column Description

Name User’s name.

Extension Extension number dialed to reach the user.

DID Direct inward dial number used to dial the 
user directly.

Station Default station ID (phone device) assigned to 
the user.

Type The type of user:
User. An individual with an extension on this 
Server. Can also be a conference room.
ACD workgroup user. An automatic call 
distribution workgroup user.
IP Gateway user. A user created to enable IP 
calls to a user on a remote Server.
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Agent If checked, the user is an agent in one or 
more call center queues. See the 
TeleVantage Call Center Administrator’s 
Guide.

Locked Out If checked, the user is unable to log in to his 
or her account, due to multiple failed 
attempts to access that account as defined in 
System Settings (see “Increasing password 
security” on page 3-16). To unlock the user’s 
account, uncheck User is locked out on the 
Security tab of the User dialog box.

Personal Status The name of the user’s current personal 
status.

ACD DND If checked, the user is not currently accepting 
ACD workgroup calls.

Mail Usage Percentage of allocated voice mail space 
currently used. For details on how the 
information in this and the following two 
columns is calculated, see “Viewing the 
user’s mailbox usage” on page 6-16.

Greeting Usage Percentage of allocated greeting and voice 
title space currently used.

Disk Usage Amount of disk space in megabytes used by 
the user's voice message, greeting, and 
voice title files.

Mailbox Size Total space allocated to the user for voice 
messages, in minutes.

Greeting Size Total space allocated to the user for greetings 
and voice titles, in minutes.

Forwarding To Number to which the user is currently 
forwarding calls.

Listed If checked, the user is listed in the 
dial-by-name directory.

Voice Title If checked, the user has a recorded voice 
title. You can record titles for users on the 
Recordings tab of the User dialog box, or 
they can record their own.

Column Description
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Adding users____________________________________________
Adding a user to the system allows that person to make and receive calls using TeleVantage. 
Unlike other telephone systems, TeleVantage assigns access permissions to specific people 
rather than to devices. Users access the system with their own identities, not the identities of the 
telephone devices they use.

You must have a Station license available for each user that has an assigned station. It is 
possible, however, to add a user who does not have an assigned station number, in which case a 
station license is not used by that user. Such a user is commonly created for ACD workgroups, 
users with IP phones, users who have only voice mail, and remote users who always have their 
calls forwarded outside the office. Users without stations do not require Station licenses. For 
more information about license requirements, see Installing TeleVantage.

You can add a new user in the following ways:

Q At the telephone. This is a convenient way to quickly activate phones when you are 
setting up a new TeleVantage system (see the next section). However, you must 
physically go to each user’s telephone to activate it, and must still use the Administrator 
to finish configuring the details (such as the name) of each user. 

Q In the User dialog box. This method allows you to set up all user options at one time 
from one location. 

Announce Callers Displays the types of calls to which the user 
is applying call announcing.

Exchange Sync If checked, TeleVantage and Microsoft 
Exchange Inboxes are synchronized.

Comments Comments added about the user.

Must Change 
Password

If checked, the user must change his or her 
password at the next logon. 

Note: This column is checked only if the field 
User must change password on next logon is 
checked for the user (see “The Security tab” 
on page 6-38). The column is not checked if 
the user’s password has expired.

Password Never 
Expires

If checked, the user’s password never 
expires.

Title The job title entered for this user. You can 
enter titles for users when you create them.

Organization Name of the Organization with which the user 
is associated, if any.

Column Description
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Q Using a template. You can save time and reduce typing when adding new users in the 
Administrator by creating a template user with characteristics common to all users. You 
can then copy this template user and customize each new user that you create based on 
it. You can create different template users for various types of users who share specific 
properties, for example, ACD agents, remote users, and so on.

Adding a user at the telephone
At the new user’s telephone, press *0 and follow the prompts to create the user and assign an 
extension. After you successfully add a new user at the telephone, the system also prompts you 
to record a voice title or change user preferences. 

Note: If a user has already been assigned to that phone, you will hear the station ID and 
extension numbers instead of the prompts. 

A new user is created with default information in the User dialog box. For example, if you assign 
extension 123 to a new user, the User dialog box for that user shows “New” as the first name, 
“User123” as the last name, and a default password of “123” until you modify the information 
and set any additional user properties. 

If TeleVantage cannot create the user at the telephone extension (for example, a user with that 
name already exists or there are no more Client licenses available), you must run the 
Administrator, resolve the issue, and add the user there.

Adding a user in the User dialog box
To create a user, choose Users > New User. The following tabs in the User dialog box allow 
you to add and modify user properties. These properties are described later in this chapter.

Q “The General tab” (page 6-10). Enter basic information that defines the user to 
TeleVantage. Assign an extension, station ID, and DID number. Create a password, 
specify a personal operator, and select a language for telephone prompts.

You also use this tab to create a user for handling ACD agents (see TeleVantage Call 
Center Administrator’s Guide) or an IP Gateway user that allows users to directly dial 
the extension of a user on a remote TeleVantage Server (see “Creating Gateway users to 
unify two TeleVantage Servers” on page 13-14).

Q “The Recordings tab” (page 6-15). Allocate space for the user’s voice messages, 
greetings, and voice title. Indicate where call recordings made by this user are sent. 
Record a voice title. Set up Microsoft Exchange synchronization.

Q “The Notifications tab” (page 6-18). Set up and schedule e-mail, pager and call 
notifications of new voice messages.

Q “The Call Handling tab” (page 6-26). Set up call screening. Specify how the user is 
listed in the dial-by-name directory. Personalize the user’s hold music. Set up call 
forwarding for the user.

Q “The Phone tab” (page 6-31). Enable features on the user’s telephone, such as Caller 
ID and message waiting indicator. Specify how long the phone rings before a call is sent 
to voice-mail. 
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Q “The Dialing tab” (page 6-36). Allow the user to make external calls, and specify phone 
numbers the user can or cannot call.

Q “The Security tab” (page 6-38). Set permission values and assign roles that determine 
the options or features that the user can access. Adjust the user’s password-change 
settings.

Q “The Other tab” (page 6-41). Enable hands-free mode, set outbound Caller ID and call 
logging options for the user.

Adding a user by using a template
Create a user, named, for example, “User Template” that has the settings you want all users to 
share, such as mailbox size and dialing permissions. You can also set up notification options in 
the template, and you can enable phone features that are applied to all users that are created using 
the template.

To add a new user based on the template, select the template user in the Users view, and then 
choose Edit > Copy. Choose Edit > Paste to open the User dialog box, in which you can 
customize the new user’s properties, such as first and last name, extension and station ID, e-mail 
address for notifications, and so on.

Where to set user options
User options are set in both the TeleVantage Administrator and Client. 

Q Some options can only be set in the Administrator. These options are described in 
detail in this chapter.

Q Some options can only be set in the Client.  These include the user’s routing list, 
contacts, voicemail greetings, call rules, and personal workgroups. To edit these options 
from the Administrator, select the user in the Users view and choose Users > Edit All 
Client Settings. See “Modifying a user’s Client settings” on page 6-44. Client options 
are described in detail in Using TeleVantage.

Q Some options can be set in both places. You can set up users with standard defaults 
for your organization and then individual users can customize the settings further. You 
also can restrict the options that users can customize. These options are described in this 
chapter and in Using TeleVantage.
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The General tab __________________________________________
Choose File > New > User in the Administrator, and then click the General tab.

Identifying the user
In Type, choose User. Then enter the user’s First name and Last name. You must enter a name 
in one of the name fields. You can enter the user’s Title and any Comments (such as the user's 
department) that you want to be displayed along with the user name in the User view.

It can be helpful to use the Title field for the user’s department, for example, “Sales.” When a 
caller requests to be transferred to someone in Sales, the Operator can see all the users in the 
Sales department grouped together in the Client’s Transfer Call dialog box. You can also use 
workgroups to group users by department (see Chapter 7, “Managing Workgroups” ).

Assigning an extension
A user’s extension is the number callers dial to reach the user. Extensions must comply with the 
following restrictions:

Q No longer than 10 digits

Q Numeric characters only

Q Must be unique
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In addition, follow these recommendations when assigning extensions:

Q Avoid extensions that begin with another extension or access code. For example, if one 
user is given extension 17 and another extension 177, users who dial extension 17 will 
experience a brief delay while TeleVantage waits to see if another “7” is dialed. See 
“Avoiding dialing ambiguities” on page 8-6 for more information.

Q Avoid extensions that begin with the same number used for an auto attendant menu 
choice. Callers will be unable to dial the extension at the auto attendant, because they 
will activate the menu choice instead. See “Setting up an auto attendant” on page 9-6.

Q Avoid extensions that begin with frequently dialed area codes—if users forget to dial an 
access code, they may unexpectedly dial the extension instead. For example, if 1-617 is 
a commonly dialed prefix for your location, do not assign extension 161.

When you create a new user, you can accept the extension suggested automatically by 
TeleVantage or you can assign a different one. TeleVantage suggests the next-highest extension 
number that has not yet been assigned, and it reuses extensions that have been unassigned. 

By default, new extensions are assigned starting with extension 100. If you want all your 
extensions to start with a different number, choose Tools > Options, and then enter the Starting 
extension number under User auto suggestion.

Note: You can give the Operator user an extension other than the default of 0. See “Changing 
the Operator’s extension from 0” on page 6-3.

Assigning a station ID
A user’s Station ID is the numeric identifier of the telephone at the user's default location. To 
find the station ID of the user’s phone, pick up the phone and dial *0. For users without a 
telephone, remote users, or users with an IP phone, enter a station ID of 0. Note that station ID 
is not used for users of the type ACD workgroup or IP Gateway. 

Station ID corresponds to the interface on the station board to which the station is connected. 
On systems using BCP Connection Panel, this number is often the same number as that 
displayed on the BCP connection jack to which the phone is attached.
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TeleVantage handles a user’s assigned station as follows:

Q Inbound calls. Calls to the user’s extension ring that station, unless the user routes calls 
elsewhere by using call forwarding or a routing list.

Q Outbound calls. By default, TeleVantage treats all calls from the station as if the user 
is making them. They appear in the Call Log as being from the user and are subject to 
the user’s dialing restrictions and permissions. 

Other users can temporarily associate themselves with the station by logging in, using 
either the telephone commands at that station or the TeleVantage Client at that 
workstation. While logged in, TeleVantage treats outbound calls as being from them. 

Changing the station ID default
When you create a new user, TeleVantage suggests the lowest unassigned station ID. By default, 
your first station IDs are assigned starting with station ID 1. To start with a different station ID, 
choose Tools > Options and enter a different Starting station number. The station ID you enter 
for a user, however, must always be the actual station ID of the user’s phone for TeleVantage to 
work correctly.

Assigning analog stations 1-4 for Watchdog mode
On analog systems using the BCP connection panel, TeleVantage’s Watchdog mode provides 
limited phone service in the event of a power failure or Windows server failure, by automatically 
routing the first four incoming analog trunks to stations 1-4. If your site uses this analog setup, 
you should assign station 1 to your Operator and stations 2-4 to people who are assigned to 
answer phones in the event of a system failure.

About users, stations, and workstations
A TeleVantage workstation is the combination of a TeleVantage station and a computer running 
the TeleVantage Client (or other TeleVantage workstation application). Just like a user, a 
workstation computer has an assigned station, which is usually the phone closest to it. The 
computer rings its assigned station whenever you perform a TeleVantage Client command 
requiring a phone, for example speed-dialing a call or making a recording. The computer’s 
station is assigned when you install the TeleVantage workstation applications, and you can 
change it at any time by clicking Options when you log on to the Client or Administrator (see 
“Logging on to the Administrator” on page 2-2).

Note: A workstation computer has one assigned station that holds true for all TeleVantage 
applications on it. For example, when you change the assigned station for the Client, it changes 
for the Administrator too.
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It is important to understand the distinction between a user’s extension and station ID:

Q Extension. The number that callers dial to reach the user, not the number they dial to 
reach the telephone on the user’s desk. Because users can set up call forwarding or 
routing lists to route their calls elsewhere, a call to a user’s extension might actually ring 
another phone in the office, their home phone, a cell phone, and so on.

Q Station ID. The station ID represents the physical telephone assigned to the user, and the 
user’s default location. In the absence of call forwarding or other custom changes, calls 
to the user’s extension ring his or her station. There is no way to dial a phone according 
to its station ID.

Setting up conference room, fax, or area phones
All stations must be assigned to a user, even phones that are not associated with an individual in 
the workplace, such as a conference room phone. To represent such phones, create dummy users 
called “Conference Room 1,” “Mail Room,” ““Sales Fax Machine,” and so forth, and assign the 
stations to them. 
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Assigning multiple users the same station
You can give multiple users the same station ID, which means they share the same phone. 
Outgoing calls from the phone are attributed in the Call Log to the user who logged on most 
recently.

For example, Steve and Dorothy work different shifts, but they share the same workstation. At 
the beginning of his shift, Steve logs on to the Client. In the Call Log, the From column for calls 
he makes contains “Steve”. At the end of his shift he logs off and exits the Client. Dorothy then 
starts work, and makes a call using the telephone. Because she forgot to log in, this call is also 
identified in the Call Log as having been placed by Steve. After Dorothy logs in, either via the 
Client or the telephone commands, the station is in her name and the calls she makes are 
attributed to her in the Call Log.

Assigning a DID number
You can assign a DID number to a user from the block of numbers provided by your telephone 
service provider. When TeleVantage recognizes this number as the final digits on an inbound 
call, the caller is automatically connected to this user, bypassing the main auto attendant. 

To assign multiple DID numbers to a user, separate each number with a comma (,). For more 
information about DID, see “Telephone company services that help TeleVantage” on page 5-5.

Creating a password
Enter a numeric Password that controls access to the user's voice mail and account options. This 
password also allows the user to log on to the TeleVantage Client. The user’s password can be 
changed either on this tab or in the Client. 

Retype the new password in the Confirmation field. 

Important: Assigning secure passwords is one of the key means by which you can protect your 
business from unauthorized access, and lost money due to toll fraud. See Appendix C, 
“Protecting Your Phone System Against Toll Fraud.” 

User passwords must conform to your system’s password requirements. See “The Security tab” 
on page 3-15.

Setting up a personal operator
By default, TeleVantage dials the Operator user’s extension whenever a caller presses 0 while 
listening to a user's greeting or leaving a message. To transfer calls to another user instead (for 
example, a departmental operator, personal assistant, or other auto attendant), select the user to 
whom you want to transfer calls from the Operator drop-down list on the General tab. For more 
information about operators, see “The Admin and Operator users” on page 6-2. A personal 
operator can be also be set in the TeleVantage Client. 
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Choosing a language for telephone prompts
On the General tab, in the Telephone prompts drop-down list, select the language that you want 
to be used for this user. When the user logs on or is identified on the telephone, TeleVantage 
automatically switches to this language for all subsequent system prompts during the call. The 
language can be also be set in the TeleVantage Client. This setting does not affect any prompts 
that other callers or users hear. 

If you see only one language listed, you must reinstall the TeleVantage Server to add other 
languages. See Installing TeleVantage.

The Recordings tab_______________________________________
Use the Recordings tab to configure the user’s voice mailbox, record the user’s voice title, and 
allocate space for greetings and voice titles. 

Configuring the user’s voice mailbox
In Mailbox with __ minute max size, enter the maximum size of the mailbox, in minutes. 
Mailboxes can be as large as 9999 minutes.

Choose the default setting of 20 minutes (9.2 MB of storage) for typical users. You may need to 
increase the default for users who record calls, because call recordings (including those that 
were e-mailed to the user) are stored in the user’s mailbox.

To create an extension without a voice mailbox, for example, a conference room, fax machine, 
or an IP Gateway user, click No mailbox.
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Enabling Microsoft Exchange Server synchronization
You can enable synchronization of a user’s TeleVantage voice messages with the corresponding 
e-mail notifications in Exchange.

To enable synchronization

1. Check Synchronize with Exchange Server mailbox. If this control is disabled, first 
set up Exchange Server notification on the Other tab of the System Settings dialog box. 
For more information, see “Using Microsoft Exchange synchronization” on page 3-18.

2. Enter the user’s Exchange Server mailbox. This can be obtained from Microsoft 
Exchange.

Note: Exchange Server mailboxes must not be confused with the e-mail address 
supplied when setting up e-mail notification for the user (see “Setting e-mail notification” 
on page 6-19). One of the e-mail addresses specified for the user for e-mail notification 
must route e-mail to the Exchange Server mailbox that you specify here.

Choosing the mailbox for call recordings
By default, call recordings that the user makes manually from the TeleVantage Client’s Call 
Monitor are sent to the mailbox of the user who made them. Select a name from the Send 
personal call recordings to drop-down list on the Recordings tab to send personal recordings 
to another user’s mailbox.

Note: This field applies only to call recordings manually made by the user. The destination for 
automatic call recordings made by the system and by queues are set separately. See Chapter 4 
and the TeleVantage Call Center Administrator’s Guide.

Viewing the user’s mailbox usage
The Mailbox frame displays how full the user’s voice mailbox currently is, in minutes, MB and 
percentage of total space.

To avoid slowing the opening and scrolling of the Users view, TeleVantage does not 
dynamically recalculate these totals. Totals are recalculated once a day at 1:00 a.m. However, 
you can recalculate the totals at any time by choosing Tools > Recalculate Disk Usage.

Allocating space for recorded greetings and voice titles
In Maximum storage, enter the number of minutes of recorded greetings and voice titles the 
user can save. These voice file types include the following:

Q Greetings. All greetings displayed in the Client’s Greetings view, plus the user’s 
grab-and-hold greeting.

Q Voice titles. The user’s own voice title plus all voice titles for the user’s contacts.

The default setting of 10 minutes requires 4.6 MB of storage. The Administrator opens a 
warning message if the total allotment of voice message and greeting space for all users exceeds 
the available disk space on the TeleVantage Server.
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Enabling voicemail greeting logon
By default, users can log on to their TeleVantage accounts from a TeleVantage station or auto 
attendant only. You can also choose to let this user log on by pressing 9 during his voicemail 
greeting. If you have a DID-based system that uses no auto attendants, you should enable this 
feature for all users, because it is the only way for them to access their accounts remotely. To 
enable the feature, check Allow voice mail log on during greeting by pressing 9.

With this form of logon, the system prompts the user for password only, not extension.

Note: Voicemail greeting logon can be slightly less secure than auto attendant logon. If you 
enable voicemail greeting logon, you should enforce secure passwords. See “Restricting 
password options” on page 3-15.

Recording the user’s voice title
A user’s voice title is a short recording consisting only of the user’s name. TeleVantage uses the 
voice title in several prompts, for example, the call screening prompt when the user calls another 
user (the user receiving the call hears “Call from <voice title>”). Users can record their voice 
titles themselves in their own voices, using either the telephone commands or the Client. 
However, since the voice title is a critical part of the TeleVantage system (for example, users 
without a voice title are not listed in the dial-by-name directory), it is recommended that you 
record them, after which those users who want to re-record them can do so.

To record the voice title, use the audio controls under Voice title. See “Using the audio controls” 
on page 2-10.
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The Notifications tab ______________________________________
You can set TeleVantage to send notification by e-mail, page, or phone call whenever a user 
receives a new voice message. This powerful feature enables users to keep abreast of their 
TeleVantage voicemail no matter where they are. Notification messages include important 
details about the call, and give users quick access to hearing the message and responding to it. 
TeleVantage can send notifications for all voice messages or for Urgent messages only. You can 
also send notifications only at certain days or times.

Users can also configure notifications in the TeleVantage Client.

Note: Notifications are sent only for new voice messages, not new call recordings that arrive in 
a user’s Inbox.

Notification information
The following information is attached to notifications of each type, making them a powerful tool 
for voicemail management, even at a remote location.

E-mail notifications can contain:

Q Caller’s name

Q Phone number at which the call originated

Q TeleVantage extension at which the message was left

Q Voice message length

Q Notes associated with the message

Q Voice message as a .WAV file attachment
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Pager notifications can optionally contain:

Q Caller ID for message

Q TeleVantage extension that was dialed

Q Voice message length

Call notifications contain:

Q Voice title of the user who received the message

Q Voice title or recorded name of the person who left the message, if available

Q Identification of urgent messages

Q Length of the voice message

Q Ability to press # right from the call and hear the message, then press 43 to call them 
back.

Determining which voice messages send notification
For each notification type—e-mail, pager, and call—you can define how often notifications are 
sent, using the following drop-down list options:

Q Do not send notifications. The user does not receive notification of new voice 
messages.

Q Send notification for all messages. The user receives a notification whenever new 
voice messages arrive.

Q Send for Urgent messages only. The user receives a notification whenever voice 
messages marked Urgent arrive.

Setting e-mail notification
Make sure e-mail notification is configured properly as described in Installing TeleVantage. See 
“Configuring e-mail notification support” in Chapter 10 of that manual for more information.

1. From the Settings for drop-down list, select E-mail notifications. 

2. Select whether e-mail notifications occur, and if so, how often. See the previous 
section.

3. In the E-mail address(es) field, enter the e-mail address to which notifications are 
sent. Separate multiple addresses by semicolons (;). 

Note: Valid e-mail addresses must be in the format user@company.com or be 
resolvable via the address book of the e-mail client configured on the TeleVantage 
Server. For example, the e-mail address “Bob Smith” will work if the address book is 
configured to look up or resolve on that name.
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4. In the next drop-down list, choose whether the voice message is attached to the e-mail 
as a .WAV file, by selecting one of the following:

Q Do not attach voice message. The voice message is not attached to the e-mail.

Q Attach voice message. Messages are attached to the e-mail and also appear in the 
user’s TeleVantage Inbox marked as unheard.

Q Attach voice message and mark as already heard. Messages are attached to the 
e-mail and appear in the user’s Inbox marked as already heard.

Q Attach voice message and delete from Inbox. Messages are attached to the e-mail 
only, and do not appear in the user’s TeleVantage Inbox. You cannot select this 
option if Exchange synchronization is enabled for a user (see “Enabling Microsoft 
Exchange Server synchronization” on page 6-16).

Setting pager notification
1. From the Settings for drop-down list, select Pager notifications. 

2. Select whether pager notifications occur, and if so, how often. See “Determining 
which voice messages send notification” on page 6-19.

3. In the Page using field, select the dialing service that you want TeleVantage to use to 
dial the user’s pager.

4. In the Dial Sequence field, enter the dial string for the pager, including the phone 
number of the paging service and the pager's PIN if required. The dial string can 
contain any touch tone digit (0-9, *, #). You can enter commas to indicate 1-second 
pauses in the dial sequence.

You can also use the following special characters to add information to the page:

Q I or i sends the Caller ID number (for an external call) or TeleVantage extension 
(for an internal call).

Q E or e sends the TeleVantage extension that the caller dialed.

Q L or l sends the length of the voice message in seconds.

For example, the dial sequence 18007771000,,,1245983#E causes TeleVantage to 
dial the paging service, pause for 3 seconds, enter the pager’s PIN (1245983) followed 
by # to indicate end-of-PIN, enter your extension (where the voice message was left), 
and then hang up. In this example, your pager displays only the extension number.

If users receive only the last portion of the pager data specified, there are not enough 
pauses between the pager number and the information. If this problem occurs, add 
more commas.

Note: Do not enter multiple stars (*) in a row in the pager string. Use only one star to 
send a dash. Multiple consecutive stars can terminate the page message.
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Setting call notification
1. From the Settings for drop-down list, choose Call notification.

2. Select whether call notifications occur, and if so, how often. See “Determining which 
voice messages send notification” on page 6-19.

3. Click  in the Number field to open the Call Notification Number dialog box.

4. Choose one of the following options:

Q Click Extension and select an extension from the drop-down list.

Q For an external number, use the Call Using drop-down list to select the access code 
and dialing service to use when placing notification calls. Then enter the number to 
dial in Number, exactly as it should be dialed.

5. Click OK.

Scheduling notifications
If you do not want to receive notifications 24 hours a day, 7 days a week, you can schedule 
notifications to occur at specific times only. For example, you can have TeleVantage send 
notifications only during business hours or after business hours on work days. You can also set 
up custom hours. You can create different schedules for e-mail, pager, and call notification. 
Notifications can also be scheduled in the TeleVantage Client. 

Note: When you turn notification on for a user, by default TeleVantage sends notifications 24 
hours a day, 7 days a week. If this is what you want to do, you do not need to schedule 
notifications.

A schedule contains individual schedule entries. For example, if you want a user to be notified 
of new voice messages during business hours and all day on holidays, you would add a schedule 
entry for “during business hours” and another schedule entry for “on holidays.” You (or users) 
can define custom schedule entries for even greater precision.

You can enable or disable each schedule entry as needed. For example, if you do not want a user 
to be paged during a specific upcoming holiday, disable the schedule entry for “on holidays.” 
You can enable it after the holiday has passed.
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Defining a schedule for notifications
After setting the options in the e-mail, pager, or call section on the Notifications tab, click 
Schedule in the appropriate section to define a schedule for notification. The Schedule 
(E-mail/Pager/Call) Notifications dialog box opens. The Schedule button is unavailable until 
you have created notification settings on the Notifications tab. 

The Schedule Notifications dialog box lists the schedules that have been defined so far, if any. 
Click one of the following:

Q Always send a notification. The schedule entries in the list (if any have been created) 
are ignored, and the user receives notification of new voice messages at all times.

Q Only send a notification during the following times. The user receives notification 
only during the times specified in the schedule entries that appear in the list with a check 
mark in the Enabled column.
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To add a schedule entry

1. To add a schedule entry, click Add. The Schedule Notification dialog box opens. 

2. To view or change the business and holiday hours used for scheduling, or to create 
other sets of business hours, click Business Hours. See “To define business hours” 
on page 3-3.

3. Under This schedule entry occurs, choose one or more of the following time periods 
during which you want to notify the user of new voice messages. For purposes of 
illustration, each of the time periods in the following list show in parentheses what 
would be the result of selecting that time period in a company whose business hours 
are Monday through Friday, from 9:00 a.m. to 5:00 p.m.

Q During business hours. (Notifications are sent during business hours, Monday 
through Friday, from 9:00 a.m. to 5:00 p.m.)

Q During nonbusiness hours. (Notifications are sent at all times other than business 
hours, including early mornings, evenings, weekends, and holidays. Notifications 
are sent Monday through Friday, 5:01 p.m. to 8:59 a.m., and on Saturdays, Sundays, 
and holidays.)

Q After business hours on workdays. (Notifications are sent Monday through 
Friday, 5:01 p.m. to 8:59 a.m.)

Q On nonworkdays. (Notifications are sent on Saturdays and Sundays.)

Q On holidays. (Notifications are sent on holidays.) See “To define business hours” 
on page 3-3.

Q During custom hours. (Notifications are sent during specific days and hours 
independent of the business and holiday hours already defined.) See “Setting up 
custom hours” on page 6-24.

4. Be sure to check Enable this schedule action, and then click OK. Now the schedule 
in the Schedule Notifications dialog box includes the schedule entry you just created. 
Add more schedule entries as needed, and then click OK when you are finished.
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Setting up custom hours
You can define custom hours that are not related to your office’s business hours and holidays 
and use them to schedule notifications, auto attendant actions (described in Chapter 9), and 
routing list actions (described in Chapter 8). Custom hours are specific to the user, auto 
attendant, or routing list for which you create them. That is, the custom hours you set up for a 
user do not apply automatically to other users. Custom hours for a user can also be set up in the 
TeleVantage Client. 

When setting custom hours, you can enter dates and times in most formats—they are converted 
to a standard format based on your Windows regional settings.

To set custom hours

1. Click Custom Hours in either the Schedule Notification dialog box (for users) or the 
Schedule Action dialog box (for auto attendants). The Custom Hours dialog box 
opens.

2. On the Days tab, check each day of the week for which you want the custom schedule 
to be active. If you leave the Hours field blank for a selected day, the entire day is 
included in the custom schedule. To include only part of a day, enter starting and 
ending hours. 
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3. On the Dates tab, click Add if you want to apply the custom schedule to a specific date. 

4. In the Custom Date dialog box that opens, enter the Custom date, and then click All 
day or Partial day. For a partial day, enter starting and ending times. 

5. Click OK to add the custom date to the list on the Dates tab of the Custom Hours dialog 
box. 
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The Call Handling tab _____________________________________
You set up call screening, dial-by-name options, and hold music for a user on the Call Handling 
tab. 

Setting up call screening and announcing
TeleVantage provides two call-screening features—call announcing and call screening—that 
verbally give the user information about incoming calls. The user can then decide whether to 
accept or decline a call. When turned on, a user picking up his or her ringing phone is not 
connected to the caller. Rather, the user hears a message identifying the call, then a prompt to 
accept or decline the call. These features are especially useful when the user is not running the 
TeleVantage Client. For more information about answering the phone with call screening and 
call announcing, see Using TeleVantage.

To turn off call screening and announcing, so that the user is connected directly to the caller 
when picking up the phone, uncheck Announce who the call is for, Internal, External, and 
External Direct.

Call announcing
Check Announce who the call is for to have TeleVantage announce whom the call is for when 
the user answers the phone. The user hears “Call for” followed by the name of the user whose 
extension was dialed. This feature is useful if the user shares a phone. It is also convenient if the 
user receives both personal and call center calls. 
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Call screening
When call screening is turned on, the user picking up the phone hears “Call from,” followed by 
the name of the caller. 

To turn on call screening

1. Under Screen and announce the caller’s name for these types of calls, turn call 
screening on for any of the following types of calls by checking them:

Q Internal. Calls from TeleVantage users.

Q External. External calls routed to the user by an auto attendant or operator.

Q External direct. Calls dialed directly using the user’s DID number, or calls that 
come in on a trunk configured to send calls to this user.

2. Check Ask callers without a voice title for their name if you want TeleVantage to 
prompt callers to say their names if no voice titles have been recorded for them. The 
caller’s answer is then played to the user after the “Call from” message.

With this field unchecked, when the user receives a call from a caller without a voice 
title he or she hears either “Call from internal user,” “Call from external caller,” or 
“Call from contact.”

If the user has a phone with a Caller ID display, you can check If Caller ID is present, 
do not ask for their name, since the user can see who is calling. This avoids 
prompting callers to identify themselves unnecessarily. When Caller ID is not present, 
name prompting is used.

3. Check Announce who is transferring if you want TeleVantage to play the voice title 
of the user who is transferring a call.

Setting up call forwarding
Call forwarding directs the user’s incoming calls to ring at another phone, either another 
extension or an external number. 

A change to call forwarding automatically updates the Where I Am location in all of the user’s 
routing lists. The Where I Am location is normally the first step in a routing list. Therefore, when 
call forwarding is turned on, a routing list rings the forwarding phone number as the first step, 
and does not ring the user’s default station. Call forwarding options can also be set in the 
TeleVantage Client. For more information about routing lists, see Using TeleVantage.
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To turn on call forwarding

1. On the Call Handling tab of the User dialog box, click Call Forwarding. The Call 
Forwarding dialog box opens. 

Note: The call forwarding settings in this dialog box may be overridden if a user 
changes the active settings directly or applies a personal status with different call 
forwarding preferences. For more information, see Using TeleVantage. 

2. Check Forward Calls (change “where I am”) and select one of the following from the 
list of locations:

Q To forward calls to another extension, select to another extension in the list of 
locations and then select the extension from the drop-down list.

Q To forward calls to an external phone number, Internet address, or other destination, 
select the appropriate category in the left pane, and then enter the dialing service in 
the Call using field and the number in the Number field. 

Q See “Forwarding calls over Centrex/PBX trunks” on page 6-30 for an explanation 
of the Attempt Centrex/PBX Transfer field.

3. Under When forwarding calls to an external number, choose any of the following:

Q Call number for __ seconds. Determines for how long a call rings at the forwarded 
phone before proceeding to the next step on the user’s routing list (usually voice 
mail). If the option Prompt recipient for password or Prompt recipient to accept 
or decline call is checked (described below), you must allow at least 30 seconds. 
Otherwise the call might be sent to voice mail before the user finishes listening and 
responding to the prompts.

Q Prompt recipient for password. If checked, the person who picks up the phone 
hears, “Call for <the user’s voice title>. Please connect me.” To be connected to the 
caller, the user must enter a valid TeleVantage password. Choosing this option 
ensures that only users can receive their forwarded calls.
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This option is used only when calls are forwarded to an external number and the 
user has a voice title recorded. 

Q Prompt recipient to accept or decline call. If checked, when the user picks up the 
phone, TeleVantage announces the caller (“Call from”) and intended recipient 
(“Call for”) and offers the option to accept or decline the call. Declined calls 
proceed to the next step in the user’s routing list, usually voice mail.

Note: When you forward calls to a mobile phone, make sure that you check Prompt 
recipient to accept or decline call. See “Mobile phone issues with forwarded calls” on 
page 6-29. 

4. Select Ignore call rules and use Standard routing list if you want to sends all of the 
user’s incoming calls to the forwarded phone. This setting disables the user’s call rules 
and uses the Standard routing list for all calls. See Using TeleVantage for an 
explanation of routing lists and call rules.

Leaving this field unchecked keeps the user’s active routing list and call rules in effect, 
which means that some calls might ring elsewhere than the forwarded phone.

5. Click OK.

To turn the user’s call forwarding off, uncheck Forward Calls in the Call Forwarding dialog 
box.

Mobile phone issues with forwarded calls
Calls to a mobile phone are picked up by the mobile phone company first and then passed to the 
individual phone. When TeleVantage detects the first pickup, it stops proceeding down the 
routing list, whether or not anyone has actually answered the mobile phone. For this reason, 
when forwarding calls to a mobile phone, always check Prompt recipient to accept or decline 
call. TeleVantage then relies on user input to signal a connection. TeleVantage proceeds down 
the routing list unless someone explicitly accepts the forwarded call.

Call forwarding and voice mail
If a forwarded call is not answered, it is sent to the user’s voice mail.

To completely transfer a user’s calls to another user's phone, so that the other user receives voice 
mail as well as the calls themselves, do not use call forwarding. Instead, use the Client to create 
a routing list whose final (and only) action is Transfer to Extension, and make it the user’s active 
routing list. See Using TeleVantage.
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Forwarding calls over Centrex/PBX trunks
If your Server uses Centrex trunks, is connected to an external PBX, or is connected to another 
TeleVantage server with an IP Gateway, you can forward calls using the option Attempt 
Centrex/PBX transfer, which economizes TeleVantage’s trunk usage. 

If this option is checked, TeleVantage does the following:

Q If the incoming call is on an analog Centrex/PBX line, TeleVantage attempts to route the 
user’s incoming calls out to the forwarding number on the same trunk line using a 
Centrex or external PBX transfer, thus saving two TeleVantage trunks. Incoming calls 
on other analog trunk types are routed to the forwarding number in the usual way, using 
a second trunk.

Q In cases where a call is forwarded between three TeleVantage Servers using IP 
Gateways, TeleVantage performs call path replacement to conserve trunks. For 
example, if a call starts on Server A, goes to Server B, and is forwarded to Server C, 
TeleVantage automatically simplifies the path to a direct connection between Server A 
and Server C, thus saving trunk usage on Server B. For more information on IP 
Gateways, see “Connecting two Servers using IP Gateways” on page 13-8.

Note: Forwarding calls with this method avoids tying up extra trunks. However, when a call is 
routed out using a Centrex/PBX transfer, TeleVantage loses control of it and cannot send it to 
subsequent steps on the user’s routing list. For example, after a call is transferred using 
Centrex/PBX, it does not go to voice mail.

This option is also available when specifying external phone numbers in a user’s routing list. 
See Using TeleVantage.

Listing a user in the dial-by-name directory
To include a user's name in the dial-by-name directory that callers can search, check List in 
dial-by-name directory on the Call Handling tab, and make sure that the user has a voice title 
recorded. 

To play a user's extension along with the user's name when callers choose the user from the 
dial-by-name directory, check Play extension to the caller. 

Note: This checkbox is enabled only if Present names using numbered list is selected in 
System Settings. See “Creating dial-by-name directory settings” on page 3-17.

Setting the user’s hold music
Users can have individualized hold music, that is different from the default system hold music. 
A user’s hold music is heard by callers whenever the user puts them on hold. A user’s hold music 
can come from any station that you have set up as a music-on-hold device.

To customize hold music for a user, check Change hold music to station number, and enter 
the station ID of the music-on-hold device that you want. If unchecked, the system-wide hold 
music is used for the user.

To set up default system hold music, see “Setting Server configuration” on page 3-5.
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The Phone tab ___________________________________________
Use the Phone tab to make settings relating to the user’s phone. The Phone tab appears 
differently for the following types of phone:

Q Any analog phone, including CLASS and ADSI feature phones

Q IP phone

Q Toshiba digital phone

Phone tab (analog phones)

Setting the number of seconds to ring the phone
In the Ring phone __ seconds field, enter the number of seconds TeleVantage rings the user’s 
extension before proceeding to the next action in the user’s routing list. This option can also be 
set in the TeleVantage Client. 

Having the station automatically dial when taken off hook
To have the user’s station automatically dial a number whenever it is taken off hook—for 
example, to create a hotline phone—enter the number in On offhook, automatically speed dial. 
For more information, see “Having a station automatically dial when picked up” on page 5-31.

Sending DTMF digits to stations
Use this feature if you are integrating a third-party device with TeleVantage, such as a fax server 
or voice mail system. For more information, see “Extending TeleVantage with third-party 
devices” on page 14-4. 
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Activating features for analog CLASS phones
Certain analog telephones support special features, known as CLASS features. Not all phones 
support all features. For a list of phones that have these features, see Installing TeleVantage. If 
a user has a phone that supports one or more of these features, you activate them on the Phone 
tab.

Under Use the following features on this user’s phone, select the user’s phone type and check 
any of the features that are supported on the user’s phone. These options can also be set in the 
TeleVantage Client. 

Q Analog phone type. For most analog phone types, select Standard. If the user is using 
an Aastra Powertouch or Cybiolink phone, select that phone type instead.

Note: You must be using an Aastra Powertouch or Cybiolink phone, and have selected 
it here, to use voice-first answering, paging, or intercom with an analog phone. If your 
regular analog phone is in hands-free mode, you can use these features.

Q Caller ID. TeleVantage sends Caller ID name and phone number to the user's phone on 
an incoming call, along with the date and time of the call. Caller ID is sent for 
TeleVantage users and external callers, as well as for contacts who can be identified by 
TeleVantage. TeleVantage may also send “P”, indicating a private call, or “O”, 
indicating an out of area call.

Q Caller ID on call waiting. TeleVantage delivers Caller ID information while the user is 
on another call, so that the user can decide whether or not to accept the incoming call.

When this option is used, the first call waiting beep is a different tone than the second 
beep, because the first beep is a special ADSI Alert Tone. You can change the volume 
of the first beep by modifying the registry key DXCH_ADSIALERT_AMPL. See 
“VoiceBoard channel settings” on page A-23 for details.

Q Message waiting indicator. TeleVantage notifies the user when a new voice message 
is received by activating the message waiting indicator on the user’s phone.

Q Stutter tone. TeleVantage alerts the user to the existence of unheard messages via a 
stutter dial tone when the user picks up the phone.

Q Voice-first answering. Enables voice-first answering.  With voice-first answering, 
internal calls are connected to the user’s speakerphone automatically without the phone 
ringing or needing to be picked up.  All external callers ring the phone as normal.

To use this field, voice-first answering must be enabled at the system level (see “The 
General tab” on page 3-5), and the user must have selected Aastra Powertouch or 
Cybiolink under Phone Type above. Voice-first answering is also available if your 
analog phone is in hands-free mode.
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Padding extensions sent as Caller ID on internal calls
For internal calls, TeleVantage sends the user’s extension as Caller ID. Some Caller ID displays 
cannot handle Caller ID strings of less than 10 digits. On the Phone tab, check Pad extensions 
when sent as Caller ID to add digits to a short string so the phones display extensions correctly. 
Choose a Padding position:

Q Before extension. Add digits before the extension with the padding character you 
select, for example, *******186.

Q After extension. Pads after the extension, for example, 186*******.

Phone tab (IP phone)
If the user uses an IP phone, such as a Polycom phone or an Intel PBX-IP Media Gateway, then 
do the following:

1. Assign the user a station ID of 0.

2. Click the Phone tab. The Phone tab has a different appearance for users with station 
ID 0.

3. Check Using a VoIP phone.

4. Make the following selections relating to the IP Phone:

Q Ring phone for __ seconds. Enter how long the phone should ring on incoming 
calls before the calls proceed to the next step on your routing list.

Q Phone type. Select the user’s make of IP phone. 

Q Call Using. Select the Internet dialing service used to place outbound calls from the 
IP phone.

Q Address. Enter the IP address of the IP phone.

5. Click OK.

For more information on setting up and using an IP phone with TeleVantage, see Appendix E.
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Phone tab (Toshiba digital phone)
The Phone tab displays a set of options customized for the Strata’s special features.

Make the user’s phone settings as follows:

1. Under Settings, set the following options:

Q Ring phone for __ seconds. Enter the number of seconds that you want 
TeleVantage to ring the user’s extension before continuing with the user’s routing 
list or transferring to voice mail. 

Q On off-hook, automatically speed-dial. Check to have the user’s station 
automatically dial a number whenever it is taken off hook—for example, to create 
a hotline phone. Enter the number to dial. For more information, see “Having a 
station automatically dial when picked up” on page 5-31.

Q LCD idle message. Enter the message that you want to appear on the LCD display 
when the phone is not in use. This message usually shows the user name and 
extension for the phone. 

Q Ring volume. The slider bar adjusts the default ring volume for the phone. 

Q Use voice-first answering. Enables voice-first answering.  With voice-first 
answering, internal calls are connected to the user’s speakerphone automatically 
without the phone ringing or needing to be picked up.  All external callers ring the 
phone as normal.
6-34 ADMINISTERING TELEVANTAGE



To use this field, voice-first answering must be enabled at the system level (see 
“The General tab” on page 3-5)

2. In the Button settings section, you can set each of the Toshiba phone’s programmable 
buttons. To set a button, click the button number in the Button column, then select a 
feature from the drop-down list in the Feature column. 

If you select Speed Dial or Secondary Directory Number in the Features list, see the 
following sections for instructions.

3. Click OK.

Setting Speed Dial parameters
If you select the Speed Dial feature and click the button in the Parameter column, the Speed 
Dial window opens. 

To speed-dial an extension, click Extension and select an extension from the drop-down list. To 
speed-dial an outside number, click Phone number, select the number used to get an outside 
line in the Call using field, and then enter the phone number that you want to dial in the Number 
field. 
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Setting Secondary Directory Number parameters 
If you select the Secondary Directory Number (SDN) feature and click the button in the 
Parameter column, the Secondary Directory Number dialog box opens.

In the Extension field, you can select a secondary number from the drop-down list. If you check 
Ring this phone when the extension is called, you can set your phone to either ring 
immediately, or specify the number of seconds to wait before ringing. 

The Dialing tab ___________________________________________
Use the Dialing tab to control which numbers the user is permitted to dial.

Note: It is recommended that you set dialing permissions at the Role or dialing service level, and 
set permission at the user level only for special exceptions. In cases of conflict, the more 
individual setting applies. See “Dialing permissions hierarchy” on page 6-53 for more information.
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To set dialing permissions

1. Use the Default permission list to specify how to set the user’s dialing permissions. 
Choose one of the following options:

Q Use Role permissions. Applies the dialing permissions set up for the role to which 
the user belongs. This is the easiest way to set up dialing permissions for users. See 
“Managing roles” on page 6-46 for more information.

Q Use Role permissions except the following. Applies the dialing permissions set 
up for the role, except for the numbers allowed or disallowed in the Exception 
permissions list. The listed settings override the role’s settings. 

Q Allow all numbers except the following (ignore Role permissions). Allows the 
user to dial all numbers except those disallowed in the list.

Q Disallow all numbers except the following (ignore Role permissions). Prevents 
the user from dialing any numbers except those allowed in the list.

2. Under Exception permissions, click Add to add a new exception permission to the 
list. Click Edit to modify an existing exception permission. The Dialing Permission 
dialog box opens.

3. In the Dialing Permission dialog box, choose to Allow or Disallow calls, and then enter 
the digits. Enter a phone number or the initial digits of a phone number. Be sure to 
include 1 before the number if it is normally be dialed as part of the number, for 
example, 1800. 

4. Click OK. The exception permission appears in the Exception permissions list and is 
applied whenever the user dials a number beginning with the digits.

5. Click OK on the Dialing tab to save your changes.

Setting account code modes
Account code modes determine whether and under what circumstances TeleVantage prompts 
the user to enter an account code. For instructions, see “Setting a user’s account code modes” 
on page 10-10. For an overview of account codes, see “Using account codes to track phone 
usage” on page 10-6.
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The Security tab__________________________________________
The Security tab controls the user’s access to TeleVantage features by means of roles and 
permissions, and lets you manually control the user’s password security.

For a description of permissions, see “TeleVantage permissions” on page 6-49. 

Before assigning permissions
Before assigning permissions and roles to users, set up the roles the way you want (see 
“Managing roles” on page 6-46). A role is a template enabling you to apply the same group or 
collection of permissions to multiple users, so by setting up roles in advance, you can save time 
in giving each user the permissions he or she needs.

Assigning the user’s permissions
A user’s permissions determine which TeleVantage views and features he or she can use. To 
assign permissions, do the following:

1. Assign the user to a role if necessary. A role is a collection of permissions. By default, 
new users belong to the Users role. To assign the user to a new or different role, click 
Change. See the next section for instructions.

Note: A quicker way to assign batches of users to a role is to edit the role. See 
“Assigning users to a role” on page 6-46.

You can assign a user to more than one role. If the roles’ permissions conflict, the most 
permissive setting is used. For example, users who belong to both the Users role and 
the Administrators role have their permission for Place external calls when logged 
on via a trunk set to Allow, which is the permission level for the Administrators role. 
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2. If you want to give the user unique permissions, different from those of the roles to 
which he or she belongs, edit the user’s permissions using the Permissions pane. The 
user’s Permissions pane settings override all role settings.

To adjust an individual permission for a user, click the Value column for that 
permission in the Permissions pane. Select one of the following from the drop-down 
list:

Q Use roles (value). Permission for this item is determined by the user’s role 
memberships (described in the following section). The actual value of the 
permission is displayed in parentheses.

Q Allow. The listed feature (for example, exporting Contacts) is available to the user. 

Q Disallow. The function is not available to the user. 

Q View and Edit. The specified tab or folder (such as the Phone settings tab or the Call 
Log folder) can be viewed and edited by the user.

Q View only. The user can view the folder or tab, but cannot change it. 

Q No access. The folder or tab cannot be used or viewed by the user. 

Changing the user’s roles
To change the roles to which the user is assigned, do the following: 

1. Click Change on the Security tab. The Roles dialog box opens.

2. Use Add and Remove to place the roles to which the user should belong in the 
Selected roles list.

To create a new role, click New Role. See “Creating a new role” on page 6-47 for 
instructions.

3. Click OK.

Note: If the user belongs to no roles, by default the user’s permissions are all set to deny access. 
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Securing the user’s account
Use the options in the Security section of the Security tab to protect the user’s account and your 
TeleVantage system from unauthorized access and toll fraud. For more information about toll 
fraud, see Appendix C, “Protecting Your Phone System Against Toll Fraud.” For system-wide 
security options, see “The Security tab” on page 3-15.

The following security options are available:

Q Password never expires. If checked, the user’s password does not expire, although you 
can always manually change it or force the user to change it. If unchecked, the user’s 
password may expire as determined by your system settings (see “Increasing password 
security” on page 3-16). 

Checking this field is a security risk, as long-standing passwords are easier to guess.

Note: You should check this field for users of Polycom IP phones, because a changed 
password prevents the phone from working. See “Issues for users of Polycom IP phones” 
on page E-15.

Q User must change password on next logon. If checked, the system requires the user 
to change his or her password the next time he or she logs on to any workstation 
application or by using the telephone commands.

Q User is locked out. If checked, the account cannot log on to the system, even with the 
correct username and password. Depending on your system settings (see “Increasing 
password security” on page 3-16), lockout can occur automatically if someone 
repeatedly tried and failed to log on to the account. Uncheck the field to unlock the 
account and permit normal logging on.
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The Other tab____________________________________________
The Other tab contains options for hands-free answering, outbound Caller ID, and call logging.

Enabling hands-free answering
Hands-free answering is especially helpful for headset and speakerphone users. Using 
hands-free answering, a user can leave his or her phone off-hook and still receive, place, and end 
calls. The dial tone does not play, and the phone does not ring. When an incoming call arrives, 
a beep plays to notify the user, then the call is connected. (For complete instructions on working 
in hands-free mode, see Using TeleVantage).

Note: If you are using a BCP Connection Panel with stations 1 through 4 in hands-free mode, 
and the Server goes down, the stations remain offhook and the Watchdog mode of Dialogic BCP 
panels will not work. For more information about Watchdog mode, see Installing TeleVantage.

To enable hands-free answering for the user

1. Check Enable hands-free answering. If unchecked, hands-free answering is turned 
off and the user’s phone behaves normally.

2. To allow dialing while using hands-free answering, check Allow dialing in hands-free 
mode. If checked, the user can place calls by dialing them. If unchecked, the user must 
press Flash first to get a dial tone, then dial the call. 

Note: This option requires the system to dedicate a voice resource for each user for 
whom it is checked. To see your system voice resource availability and current use, see 
“The TeleVantage performance counters” on page 11-6. For more information 
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regarding voice resource use, see Installing TeleVantage.

3. In Dial tone duration before going silent, enter the length of time in seconds that you 
want the dial tone to play after a call ends. To end a hands-free call, the user presses 
the Flash button or hangs up, and then waits for the phone to go off-hook again. 
During this time the user hears a dial tone. This setting allows you to control whether 
or not the user hears a dial tone for a specific amount of time before returning to 
off-hook status after disconnecting from a call. The default setting is 0, meaning that 
dial tone is not played at all after a call ends.

Changing the hands-free answering beep
You can change the beep that signals an incoming call during hands-free mode, by replacing or 
re-recording the sound file HandsFreeBeep.vox, located by default in C:\Program 
Files\TeleVantage Server\Vfiles.

Setting the user’s ISDN outbound Caller ID
If supported by your ISDN provider, use the Calling party presentation drop-down list to select 
the type of Caller ID number that accompanies outbound calls placed by the user on ISDN 
trunks. Note that the user can make his or her own selection using the Client, but cannot specify 
a different custom number. If the user selects Custom, the Caller ID is what is entered under 
Custom here.

Note: On trunk types other than ISDN, outbound Caller ID is always set by the telephone 
company.

Choose one of the following options:

Q System default. Outbound Caller ID will be whatever you have set for the TeleVantage 
system as a whole (see “Setting ISDN outbound Caller ID for the system” on page 3-6). 
The current setting is displayed in parentheses.

Q Custom. You can specify a custom Caller ID number to make available to the user, for 
example the user’s DID number. If the user selects it, it accompanies his or her outbound 
calls. Enter the Caller ID number in Calling party number. 

When Custom is selected, outbound Caller ID name is set to the user’s TeleVantage 
username.

Q Blocked. Caller ID is blocked on outbound calls from the user.

For more information about ISDN outbound caller ID, see “Setting ISDN outbound Caller ID 
for the system” on page 3-6, and “Specifying ISDN outbound Caller ID” on page 5-20.

Logging the user’s calls
The following sections cover how the user’s calls appear in the Call Log, in terms of which calls 
are logged, whether they are associated with an Organization, and what happens if the user logs 
onto another user’s station. For more information on the Call Log, see “Using the Call Log 
view” on page 11-10.
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Determining which calls are logged
By default, all inbound and outbound calls made by the user appear in the Call Log. However, 
there are times when you might not want to log a user’s calls due to space or readability reasons, 
for example if the user’s station is connected to a fax server used for sending thousands of faxes 
daily.

To turn off call logging for the user, uncheck Log this user’s calls. If checked, you can choose 
whether to log the user’s inbound calls, outbound calls, or both.

Notes

Q If you turn off call logging for a call center agent, you will not be able to run reports on the 
agent’s personal calls. Reports on queue calls and all statistics in the Queue Monitor are 
unaffected.

Q Users with call logging turned off cannot use the Client’s callback feature (File > Return 
Last Call) or the list of recently dialed calls on the Client’s File menu. 

Q If you have turned off internal call logging at the system level (see “Logging internal calls” 
on page 3-8), the user’s internal calls will not be logged, regardless of this setting.

Associating the user with an Organization
If you have created one or more Organizations, you can associate the user with the Organization 
to which he or she belongs. All calls placed by the user will be logged with that Organization 
showing in the Call Log’s Organization column. Organizations are a means of setting up 
multiple companies that share an office and a TeleVantage Server. See “Using Organizations” 
on page 10-2. 

To associate the user with an Organization, check Organization, and select an Organization 
from the drop-down list.

If unchecked, outbound calls from the user will appear in the Call Log with the Organization 
column blank.

Resetting station logging after the user’s visits
If the user has logged in at another user’s workstation—using either the Client or the telephone 
commands—this setting determines how much time elapses before the station automatically 
resets to its default user. Enter the number of minutes in Automatically log out of other user’s 
stations after __ minutes of inactivity. 

This feature provides a way to automatically reset call logging in cases where the user walked 
away from someone else’s desk without logging out. All calls are written to the Call Log 
according to the user logged in at the station, so a user can log in anywhere in the office and 
make calls that are logged correctly under his or her name. Calls from the station continue to be 
logged under the visiting user’s name until one of the following happens:

Q The visiting user logs out, either by pressing *00 at the dial tone or by choosing File > 
Exit and Log Off in the Client. This resets the station to its default user.

Q Another user logs in to the station using the Client or telephone commands. This resets 
the station to the new user.
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Q The amount of time specified in Automatically log out of other user’s stations after 
__ minutes of inactivity is exceeded. This resets the station to the default user. Inactivity 
is defined as any time except during active calls (inbound or outbound) and when 
telephone commands are used that require entering a password (for example, logging 
into the phone to listen to voice mail). All other station activity, such as picking up the 
phone and dialing *14, or using the Client to play a voice message over the station, count 
as inactivity.

Note: Incoming calls for other users, such as calls forwarded to the station, do not count 
as activity even if they are answered.

Uncheck Automatically log out of other user’s stations after __ minutes of inactivity to 
prevent resetting the station after any amount of inactivity.

Modifying a user’s Client settings ___________________________
There are times when you may need to troubleshoot aspects of a user’s account that can only be 
accessed using the TeleVantage Client. For example, with the Client you can modify the 
following user settings that cannot be modified in the Administrator:

Q Routing lists

Q Call rules

Q Voicemail greetings

Q Personal status settings

Q Call waiting and ringback settings

TeleVantage lets you modify a user’s Client-based settings directly from the Administrator, 
saving you the trouble of going to users’ workstations and interrupting their work.

You must have the Client installed to use this feature.

To modify a user’s Client-based settings from the Administrator

1. In the User’s view, select the user whose Client settings you want to edit.

2. Choose Users > Edit All Client Settings.

A limited version of the TeleVantage Client opens with the selected user logged in. You can 
access all Client-based features except for the following:

Q The user’s Voice Messages view

Q The user’s Call Monitor

To modify many Client-based settings, choose Tools > Options. For complete instructions on 
using the Client, see Using TeleVantage.
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Helping new users get started ______________________________
To get new users up and running quickly on the system, give them copies of the TeleVantage 
QuickStart Guide and the TeleVantage Pocket Reference Card.

When you add a new user, a “Welcome to TeleVantage” voice message is copied automatically 
to the user’s voice mailbox. This message helps the new user get started by explaining how to 
record a voice title and create a custom voice mail greeting using the telephone commands.

The information that new users must know includes:

Q Their extensions and passwords.

Q Their Direct Inward Dial numbers, if any.

Q A list of your office's dialing services and access codes, along with instructions about 
when to use each one.

Q A list of special access codes, such as the codes for the TeleVantage dial-by-name 
directory and emergency services.

Q The path they must use to install TeleVantage workstation applications, such as the 
TeleVantage Client, TAPI Service Provider, and Contact Manager Assistant. The 
default path is <Servername>\NetSetup\Setup.exe.

Q The URL address for the Web Client, if your system supports it.

Q The telephone key they must use at an auto attendant to log in from a remote phone, if 
you have changed it from #.

Q Whether they have permission to make external calls:

Q From stations

Q When logged in from an outside phone

Q In call forwarding or routing list situations

Q A list of any Client views or tabs in the Client’s Option dialog box that they cannot 
access.

Q Whether they can record calls in the Call Monitor.

Note: The TeleVantage QuickStart Guide contains a form where the user can write down some 
of this information.

Deleting a user __________________________________________
Deleting a user prevents that user from using TeleVantage and removes all of the user’s voice 
mail files from the system (unless the voice mailbox is being shared with another user). A 
deleted user’s Call Log entries are left in place to maintain an accurate and complete call history 
on the system. Note that you cannot delete the Administrator or Operator user. 

For information about deleting items in TeleVantage, see “Deleting items” on page 2-9. 
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Managing roles___________________________________________
Roles are templates that enable you to apply the same slate of permissions to multiple users. You 
can create as many different roles as you want, to represent different groups of users who have 
similar permissions. Roles appear in the Users view in bold. 

When a user belongs to a role, he or she inherits the role’s permissions. A user can belong to 
more than one role, in which case the most permissive settings apply in cases of conflict.

You can grant a user individual permission settings that override those of the role, by adjusting 
his or her permissions individually on the Permissions tab of the User dialog box. See 
“Assigning the user’s permissions” on page 6-38.

TeleVantage comes with the following two roles:

Q Administrators. You cannot delete this role, but you can edit some of its settings. By 
default the role has full permissions. You can disallow only the following permissions: 

Q Place external calls when logged on via a trunk

Q Place external calls from a station

Q Forward or route calls to external numbers

Q Return calls when logged on via a trunk

The Admin user belongs to the Administrators role by default and cannot be removed. 

Q Users. By default new users belong to this role. 

Assigning users to a role
The quickest way to assign a batch of users to a role is to edit the role and add the users. See 
“Creating a new role” on page 6-47. 

You can also assign a user to a role by editing the user. See “The Security tab” on page 6-38.

Editing a role
To edit an existing role, double-click it in the Users view. For further instructions, see the next 
section.

When editing a role, be aware of the following:

Q When you change a role’s permissions, those permissions change for all users belonging 
to the role, except where a user’s individual permission setting overrides the role, or 
where a user’s other role provides a more permissive setting.

Q When you remove a user from a role, the user loses all permissions granted by that role.

Q The Administrators role can only be edited in limited ways.
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Creating a new role
You can create a new role, for example Admin Assistant, for a group of users that require the 
same or similar permissions. All users that you assign to this role are automatically granted its 
permissions, except where their individual permission settings override roles.

To create a new role

1. Choose File > New > Role. The Role dialog box opens.

2. Enter the name of the role and any comments about its function.

3. Click the Users tab to assign users to the role.

To add users to the role, select them in the All users list and click Add. To select 
several users at once, hold down SHIFT or CTRL as you click.

To remove a user from the role, select the user and click Remove.
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4. Click the Permissions tab to choose the role’s permission settings.

To set a permission, click its Value column and select the setting you want. 

5. Click the Dialing Permissions tab to specify which numbers can be dialed by users 
belonging to this role. A disallowed number prevents the dialing of any number 
beginning with those digits.

Note: You can set dialing permissions globally for each Phone Number dialing 
service, and also individually for each user. In cases of conflict, the more individual 
setting applies. See “Dialing permissions hierarchy” on page 6-53.
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6. Use the Default permission list to specify how to set the role’s dialing permissions. 
Choose one of the following options:

Q Use dialing service permissions. The role applies no dialing permissions or 
restrictions to users belonging to it. Users’ dialing is controlled by the permissions 
of the dialing service they use, and any individual exceptions they have.

Q Use dialing service permissions except the following. The exceptions you enter 
here override dialing services’ permissions for users belonging to this role.

Q Allow all numbers except the following (ignore dialing service permissions). 
Users belonging to this role can dial all numbers except what you disallow here, 
regardless of dialing service permissions. Users are also prohibited from dialing any 
numbers disallowed at the individual level.

Q Disallow all numbers except the following (ignore Role permissions). Users 
belonging to this role cannot dial any numbers except what you allow here, 
regardless of dialing service permissions. Users are also permitted to dial any 
numbers allowed at the individual level.

7. Under Exception permissions, click Add to add exception permissions to the list. For 
instructions, see page 6-37.

8. When you are finished defining dialing permissions, click OK to close the Role dialog 
box.

TeleVantage permissions __________________________________
A user’s access to TeleVantage features is controlled by permissions. There are three types of 
TeleVantage permissions:

Q General user permissions. These control what Client views and TeleVantage 
commands the user can use. See the next section.

Q Dialing permissions. These control what phone numbers the user can dial. See “Dialing 
permissions” on page 6-52.

Q Call center agent permissions. These apply to agents in a call center queue only, and 
control what queue features the agent can use. See the TeleVantage Call Center 
Administrator’s Guide.

Users inherit general permissions and dialing permissions from the roles to which they belong. 
Roles are collections of permissions that you set up to define jobs or roles in your office. See 
“Managing roles” on page 6-46. Users can also have individual permissions that override the 
permissions of the roles to which they belong.
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General user permissions
To assign permissions to a role, see “Creating a new role” on page 6-47. To assign individual 
permissions to a user, see “The Security tab” on page 6-38. You can assign the permissions in 
the following table:

TeleVantage General User Permissions

Permission Controls the ability to...

Standard

Access call center reporter Use the call center reporter to run reports.

Place external calls when logged 
on via a trunk

Dial in to TeleVantage from a remote location and place 
external calls through the Server that get billed to the 
Server. See also Forward or route calls to external 
numbers.

Place external calls from a station Place outbound calls on TeleVantage trunks.

Change Personal Status Change the user’s own personal status. You might disallow 
this for agents in a call center queue, to ensure that they 
take calls during their shifts. See the TeleVantage Call 
Center Administrator’s Guide.

Delete Call Log entries Use the Edit > Delete command in the Client’s or 
Administrator’s Call Log.

Export data Export contacts, extensions, or the Call Log, using the 
Client. Does not affect exporting audio files or using export 
commands in the Administrator.

Forward or route calls to external 
numbers

Specify an external number when forwarding calls or 
setting up routing lists.

Log on to the Web Client Use the Web Client.

Log on to the Windows Client Use the TeleVantage Client.

Log on via IP trunk Log on when making an Internet call to TeleVantage .

Log on via station Log on by pressing # at a station.

Log on via trunk Log on when calling from a remote location, either via the 
auto attendant or by pressing 9 at a voicemail greeting.

Change password Change the user’s own TeleVantage password.

Off-hook page Use the *15 telephone command to place pages or 
intercom calls.

Pick up other ringing call Use the *91 or *99 commands to answer one ringing 
station from another.
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Record calls Record calls using the Call Monitor.

Report on all call logs Run the Call Log report on the Call Log of any user or 
queue. When set to Disallow (the default), the report can 
be run only on the Call Log of the user logged in to the 
Reporter. For instructions on running reports, see the 
TeleVantage Call Center Administrator’s Guide.

Return external calls when logged 
in on a trunk

Use the 43 or 44 commands to call back a voice message 
from an external number, when calling in from a remote 
location.

Show ‘All’ tab in Client 
Extensions view

See a tab in the Client’s Extensions view that shows all 
extensions in the system. With this tab turned off, the user 
can still see the filtered tabs, such as tabs for workgroup or 
call center queue extensions. 

Access... View and be able to use the specified features in the 
Client’s Options dialog box (Tools > Options).

Access call forwarding Forward calls, using the Client, Administrator, or telephone 
commands.

Access voice title Record the user’s own voice title, using the Client, 
Administrator, or telephone commands. Does not affect the 
ability to record or capture voice titles for contacts.

Folder Visibility

View... These permissions control whether or not the specified 
view or folder appears when the user logs into the 
TeleVantage Client or Web Client. To make a folder visible 
but not editable, use the Folder Access section.

Administration

Access... View and be able to use the specified features in the 
Administrator.

Note that the permission Access Queues folder enables 
users to sign agents in and out of any queue, including 
themselves if they are non-observer agents. It overrides 
the per-queue permission Queue sign in/out (see the 
TeleVantage Call Center Administrator’s Guide).

Edit all Client settings Use the Edit all Client Settings button to edit a user’s 
Client settings from the Administrator.

TeleVantage General User Permissions

Permission Controls the ability to...
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Dialing permissions
Dialing permissions determine what phone numbers can be dialed by TeleVantage users. By 
default, all numbers are allowed. You can use dialing permissions to disallow certain numbers, 
either globally, by role, or on a per-user basis. You can decide whether to permit all numbers 
except for a few, or disallow all numbers except for a few.

A user who dials a disallowed number hears the message, “I’m sorry, you do not have 
permission to dial that number.” A user cannot include a disallowed number in a routing list or 
forward calls to a disallowed number.

Export Call Log Export the Call Log using the Administrator. Does not 
affect exporting the Call Log using the Client.

Export system prompt text Export system prompts to a text file using the 
Administrator.

Select a specific trunk for 
outbound call

Dial 88 followed by a trunk number and a phone number to 
place a call on a specific trunk.

Backup and restore the database Perform database backups and restores.

Edit system settings in 
TeleVantage settings editor

Use the TVSettings.exe application to modify registry 
settings.

Start and stop the Server Use the Administrator or Device Monitor commands to 
start and stop the TeleVantage server.

Access...folder These permissions control whether or not the specified 
view or folder appears when the user logs into the 
Administrator.

Folder Access

Access... These permissions control the degree of access the user 
has to the specified Client view or folder. Some folders 
permit the View only setting, which means the user can 
view but not edit or delete the folder’s items.

If set to No access, the view or folder does not appear in 
the Client.

Note that a No access setting prevents the user from 
accessing the folder even using the TeleVantage API. 
Disallowing a folder using the Folder Visibility permission 
removes it from the Client, but still permits access via the 
API.

TeleVantage General User Permissions

Permission Controls the ability to...
6-52 ADMINISTERING TELEVANTAGE



A disallowed number means that the user cannot dial any number beginning with those digits. 
Commonly disallowed numbers include the following:

Dialing permissions hierarchy
You can set dialing permissions separately for the following:

Q Phone Number dialing services. Use this setting to create global dialing restrictions 
that affect everyone using the dialing service. See “The Permissions tab” on page 8-17.

Q Roles. Use this setting to apply the same dialing restrictions to a group of users. See 
“Managing roles” on page 6-46.

Q Users. Use this setting to give individual users exceptions to the more general dialing 
permissions. See “The Dialing tab” on page 6-36.

In cases where dialing permissions conflict, the more individual setting applies. User settings 
override role settings, and role settings in turn override dialing service settings. For example, if 
a dialing service disallows 011 numbers, and a role allows them, users belonging to the role can 
dial them. However, if a user has 011 numbers disallowed at the individual level, that user 
cannot dial them.

Prefix Disallows

1 Long-distance calls. Be aware that in some areas this may 
block local calls as well.

011 International calls.

1550 Group conversation lines.

1554 Adult information services.

1900 Long-distance programs.

1976 General information programs.
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About Workgroups _______________________________________
A workgroup is a group of related extensions or contacts. With TeleVantage workgroups you 
can do the following:

Q Place or pick up calls to a group of users. You can direct calls to a workgroup so that all 
phones in the workgroup ring simultaneously, and the first to answer receives the call. 
Users in a workgroup can also use the *99 telephone command to answer any ringing 
phone in their workgroup.

Q Organize groups of extensions for display in the Client’s Extensions view, making it 
easier for users to locate an extension for calling or transferring calls.

See Using TeleVantage for instructions on placing calls, routing calls to workgroups, and using 
the Extensions view.

Public and personal workgroups
TeleVantage provides two types of workgroups: public and personal. 

Public workgroups are visible to all TeleVantage users. Only public workgroups can have 
extensions. Likewise, the *99 telephone command only works with public workgroups. 
Administrators and users with the appropriate permissions can create public workgroups. Public 
workgroups are managed in the Administrator.

Personal workgroups created by users for ease of locating an extension in the Client’s 
Extensions view. A personal workgroup is visible only to the user who created it. Personal 
workgroups do not have extensions. Personal workgroups are managed in the Client (see Using 
TeleVantage).

Benefits of using workgroups
TeleVantage workgroups offer the following benefits:

Q The process of finding an individual to take calls or to join a conference call is easier, 
because the Extensions view in the Client can be filtered by workgroup. 

Q Auto attendants, queues, contacts, or IVR Plug-ins can be added to a workgroup (for 
informational purposes) and viewed in the Extensions view.

Q Contacts can be added to workgroups for caller identification via call rules (see Using 
TeleVantage).

Q Any public workgroup member can pick up a ringing call within the workgroup by 
dialing *99 <workgroup’s extension>. 

Q Calls to a workgroup simultaneously ring the phones of all the users who are members 
of that workgroup. IVR Plug-ins, auto attendants, queues, and contacts who are 
members of that workgroup are not called. Public workgroups can be called by their 
extension numbers or via the Client. Private workgroups can only be called via the 
Client.
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Q When workgroup members set their personal statuses to Do Not Disturb (see Using 
TeleVantage) their phones do not ring when the workgroup is called.

Q When workgroup members forward their calls internally (see Using TeleVantage), calls 
to the workgroup ring at the number to which calls are being forwarded. When a 
workgroup member’s calls are forwarded to an external number, workgroup calls do not 
ring the external number. 

Workgroups view
To add, edit, and delete public workgroups, click Workgroups in the view bar to open the 
Workgroups view:
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Creating a Workgroup _____________________________________
To create a public workgroup, choose File > New > Workgroup and enter information on the 
tabs in the Workgroup dialog box, as follows:

1. On the General tab, enter the Name of the workgroup and at least one member. You 
can optionally add a note about the workgroup in the Description field.

2. To add members to the workgroup, select names from the list of Available extensions 
and click Add. To select multiple names, hold down CTRL while clicking.

3. Use the arrows next to the Members list to arrange the order of the members. The order 
in which the names appear can be used in conjunction with a user who has a routing 
list that calls the members of this workgroup in a “top down” or “round robin” 
sequence (for more information about routing lists, see Using TeleVantage). You can 
also use the Remove button to delete members from the list
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4. To give the workgroup a number so that it can be dialed using the telephone, click the 
Dialing tab. All of the information on the Dialing tab is optional. Use the following 
sections to configure dialing for this workgroup.

Note: The Organization field is not used in this version of TeleVantage. Outbound 
calls are always marked with the Organization of the user. See “Using Organizations” 
on page 10-2.

Calling, paging, or picking up calls from workgroups
Assign an Extension number that callers can dial to reach the workgroup. For more information 
about extension requirements and restrictions, see “Assigning an extension” on page 6-10.

When no extension number is entered, the workgroup can be called using the Client, but not 
from the auto attendant or telephone, and users cannot use the Workgroup pickup option (*99) 
to retrieve ringing calls within their workgroup, or the paging option (*15).

Assigning a DID number to a workgroup
You can assign a DID number to a workgroup from the block of numbers provided by your 
telephone company. When TeleVantage recognizes this number as the final digits on an inbound 
call, the caller is automatically connected to this workgroup, bypassing the main auto attendant. 

To assign multiple DID numbers to a workgroup, separate each number by a comma (,). For 
more information about DID, see “Telephone company services that help TeleVantage” on 
page 5-5.
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Recording a voice title for a workgroup
You can give the workgroup a voice title, which is played to callers whenever they select the 
workgroup from the dial-by-name directory. The voice title should be recording of just the 
workgroup’s name, for example, “Sales Department.” See “Using the audio controls” on 
page 2-10.

Listing the workgroup in the dial-by-name directory
If you have recorded a voice title, check List in dial-by-name directory to list the workgroup in 
your company’s dial-by-name directory and play the workgroup’s extension when the extension 
number is dialed after the time limit has expired for the phone to ring.

When no one answers a call to a workgroup
Calls to the workgroup’s extension ring the phones of all users in the workgroup. As an option, 
you can set a time limit for how long such calls can ring unanswered. If the time limit is 
exceeded, TeleVantage transfers the call to an extension of your choice. If you do not choose 
this option, calls to the workgroup continue to ring all users’ phones until the call is answered 
or the caller gives up.

To set a time limit for ringing on calls to the workgroup

1. Check Limit the time that calling this workgroup will ring all users’ phones.

2. In Ring time in seconds, enter how long calls can ring unanswered before being 
transferred.

3. In If no answer, transfer, select the extension to which TeleVantage transfers 
unanswered calls.

Note: The extension you specify is also the workgroup’s personal Operator. If the workgroup is 
used for dial restrictions in an auto attendant, callers who dial 0 at the auto attendant are 
transferred to the If no answer, transfer extension.
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About dialing services_____________________________________
Dialing services route outbound TeleVantage calls over your trunks. Users must select a dialing 
service to make an external call, though this can be as simple as dialing 9 before the number. By 
creating multiple dialing services, you can intelligently manage your outbound trunk use and 
place the full variety of TeleVantage trunk types at your users’ fingertips, including the ability 
to dial Internet addresses, extensions on remote TeleVantage Servers, and more.

Each dialing service has a name and an access code. The access code is a number (such as 9) 
that users dial to begin an external call. The access code tells TeleVantage which dialing service 
to use. When placing external calls from the Client, users select a dialing service by name with 
the Call Using drop-down list. 

Each dialing service routes calls over a group of trunks. For example, a Phone Number dialing 
service (for example, access code 9) can route calls over your telephone company trunks, while 
an Internet Address dialing service (for example, access code 71) can route calls over your 
Internet trunks. Users would dial 9 plus a phone number to place a normal phone call, or 71 plus 
an IP address to place an Internet call.

By default, TeleVantage comes with one dialing service, called “Phone number,” with an access 
code of 9. It routes calls over any of your available telephone company trunks (analog or digital). 
For some installations this will be the only dialing service needed. If so, you can skip this 
chapter.

Dialing service types
You can add the following types of dialing service:

Q Phone Number service. Used to dial standard phone numbers over the public telephone 
network. You can specify prefixes and suffixes to automatically take advantage of phone 
company services, restrict the dialing of unwanted numbers, and configure the service 
for accurate processing of dialing rules, such as when calling back voice messages.

Q Centrex/PBX Extension service. Used to dial Centrex extensions, PBX extensions, or 
other custom numbers over trunks that are connected to external switches such as the 
phone company’s Centrex service or an external PBX. You can specify the minimum 
and maximum digits your Centrex/PBX service uses.

Q Internet Address service. Used to dial Internet addresses over Internet trunks. With this 
service, users can pick up a phone and dial an Internet address (for example, a number 
such as 123*456*78*90) to connect to H.323 devices such as a PC running Microsoft’s 
NetMeeting software. Users can also place such calls from the Client using either IP 
addresses or domain names (for example, a name such as voip.mycompany.com).

Q Internet-to-Phone Number service. Gateway service used to dial a phone number 
through another TeleVantage Server at a remote location. The call connects to the 
remote Server using the Internet or a private TCP/IP network, and then the phone 
number is dialed from that Server. 
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Q Internet-to-Centrex/PBX Extension service. Gateway service used to dial Centrex or 
PBX extensions or other custom numbers through another TeleVantage Server at a 
remote location. The call connects to the remote Server using the Internet or a private 
TCP/IP network, and the number is dialed from that Server. This type of service accesses 
an internal dial tone on the remote Server, so you can you can dial any valid number that 
can be dialed at that Server’s dial tone, such as an extension, 411, or # to log in to a 
remote account. 

Q Routing service. A special dialing service that routes calls through other dialing 
services. You can use routing services to route calls differently based on different 
routing rules, such as time of day, number dialed, or the user placing the call. With 
routing rules you can offer your users one access code for all outbound 
calling—including phone service and Internet calling—while still taking advantage of 
advanced dialing service features.

For more information, see “Using routing services” on page 8-20.

Examples of using dialing services
By creating new dialing services, you can do any of the following: 

Q Segregate trunks for different uses. For example, you might want to use your 
long-distance T1 and Internet trunks for all long-distance calls and route all your local 
calls over your analog trunks. You can create one dialing service that manages your 
long-distance T1 and Internet trunks and another that manages your analog trunks. Users 
can select the appropriate dialing service manually by access code or name, or you can 
set up a routing service that distinguishes between local and long-distance numbers and 
automatically routes calls over the appropriate trunks.

Q Enable Internet calls. Any use of Internet telephony requires that you create one of the 
Internet dialing services. This includes using IP Gateways to connect two TeleVantage 
Servers over the Internet (see “Connecting two Servers using IP Gateways” on 
page 13-8).

Q Set up global dialing restrictions. You can use dialing services to control what 
numbers users can dial over your telephone company trunks. For example, you could 
prevent the dialing of international calls by disallowing calls beginning with 011. (Roles 
and individual users can have dialing exceptions that override a dialing service’s 
permissions. See “Dialing permissions hierarchy” on page 6-53).

Q Use the same trunks in different ways. For example, you can send both Centrex 
numbers and regular phone numbers over your Centrex trunks. You can create a 
Centrex/PBX dialing service (access code 6) and a Phone Number dialing service 
(access code 9) that route calls to the same group of trunks. You can define the Phone 
Number dialing service to automatically prefix another 9 to the number dialed by the 
user, so that the user gets an outside line from the Centrex system.

Q Take advantage of use telephone company services. For example, you can create a 
Cost Saving dialing service that automatically prefixes all numbers with the 
“10-10-xxx” code belonging to the carrier of your choice. The user dials only the access 
code and the phone number. 
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Testing trunks with dialing services
You can also use dialing services to install and test new trunk lines without interfering with live 
call handling on the TeleVantage Server. You add the new trunks to a service that you use for 
testing. After the trunks work properly, you can move them to the default Phone Number service 
or another dialing service that users access to place calls. 

You can also use dialing services to isolate problem trunks from your system without 
interrupting service. Remove them from the dialing service and the Server will no longer use 
them to place calls.

The Dialing Services view__________________________________
To add, edit, and delete dialing services, click Dialing Services in the view bar. The Dialing 
Services view opens.

Each dialing service appears as a row in the Dialing Services view. Double-click a dialing 
service to edit it. 

The following table describes the information displayed for each dialing service.

Column Description

Type Dialing service type. For the different types, see the 
previous section.

Name Name that you assign to a dialing service when you 
create it. 

Access Code Number that users dial to select this service. For 
example, 9 to access a dialing service that routes all 
phone number calls. See “Managing access codes” 
on page 8-6 for more information. 
Note: You can see the access code for a call in the 
From code and To code columns of the Call Log view.
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Deleting or disabling a dialing service
Deleting a dialing service means that users can no longer use that dialing service when placing 
calls. If you delete the last remaining dialing service assigned to a trunk, you have in effect 
disabled that trunk for outbound calls. Client contacts and routing lists that refer to the access 
code for the deleted service will not work until you specify an alternate access code (see 
“Changing an access code in users’ saved numbers” on page 8-7). For information about 
deleting items in TeleVantage, see “Deleting items” on page 2-9. 

To disable a dialing service temporarily, edit the dialing service and uncheck Enabled on the 
General tab.

Hiding dialing services
You can hide a dialing service if you do not want users to see it in the Client or dial it. Hiding 
dialing services can be useful when you want to use them for testing purposes, or make them 
available to users only through a routing service. 

For example, you can set up dialing services for each of several long-distance carriers and then 
set up a single routing service that chooses the least expensive dialing service for each call. You 
can then hide the dialing services for the individual carriers so that users can only make 
long-distance calls through the routing service.

Enabled If checked, TeleVantage allows users to dial phone 
numbers using this service. See “Disabling dialing 
services while creating them” on page 8-6.

In Client If not checked, TeleVantage does not display this 
service in the Client (see “Hiding dialing services” on 
page 8-5). 

In Dial Plan If not checked, the dialing service cannot be accessed 
by dialing its access code.

Default If checked, this is a default service. See “Setting 
default access codes for callbacks” on page 8-8 for 
more information.

Trunk Order Order in which the dialing service’s list of trunks is 
prioritized (see “The Trunks tab” on page 8-12 for 
more information). This column is blank for routing 
services, because they always get their lists of trunks 
from other dialing services. 

Column Description
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To hide a dialing service, edit it and uncheck the following on the General tab:

Q Show in Client. This hides the dialing service from all Call Using lists in the 
TeleVantage Client.

Q Include in dial plan. This hides the access code so that dialing it does not select the 
dialing service. 

To hide a dialing service for purposes of testing, clear Show in Client, leave Include in dial plan 
checked, and give the service a multi-digit access code for testers to use, that would be hard for 
users to select accidentally.

Disabling dialing services while creating them
While you are creating a dialing service, it can be helpful to uncheck Enabled on the General 
tab. Doing this disables the dialing service, and makes it unavailable to users. With the dialing 
service disabled, you can click OK to save the dialing service at any time during the creation 
process without giving users access to an incomplete service. When you have finished creating 
the dialing service, check Enabled again. 

Managing access codes ___________________________________
This section covers choosing access codes for new dialing services that avoid dialing 
ambiguities and help your system run smoothly.

Tips on access codes and names for services 
If your system has multiple dialing services that users will access directly, it is important to 
choose their names and access codes carefully, because these are the points of contact for the 
users who place outbound calls. Typically, you set up dialing services with names like “Phone 
Number,” “Centrex Extension,” or “Cambridge IP Gateway” and access codes of 9 or 7, which 
makes it easy for users to remember the dialing service to use when they place a call.

For dialing services that you do not want users to access directly and that you may have hidden 
(see “Hiding dialing services” on page 8-5), consider using 4-digit access codes of the form 
80xx. Doing this places the access codes in the same numbering space as is used for auto 
attendants, which helps prevent dialing ambiguities. It is important not to select access codes 
that begin with the same digit as extensions.

Avoiding dialing ambiguities
When setting up access codes and extensions, it is possible to introduce ambiguities that will 
delay dialing. For example, if you have a dialing service with an access code of 9 and a user with 
the extension 901, a user who dials either one will experience a delay while TeleVantage waits 
to see if the number is complete.

Note: Users can bypass the delay by pressing # after dialing. You can change the length of the 
delay by modifying the internal dialing ambiguous time-out system setting (see “Setting dialing 
time-outs” on page 3-12).
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TeleVantage warns you when you try to save an extension or access code that starts with the 
same digits as one that already exists.

Creating a dialing service with access code 0
By default, 0 is the Operator user’s extension. To use 0 as a dialing service access code (for 
example, to have users dial 0 to get an outside line), you must first change the Operator user’s 
extension to a number other than 0. See “Changing the Operator’s extension from 0” on 
page 6-3.

Changing an access code in users’ saved numbers
When users save phone numbers in the Client that can be speed-dialed or auto-dialed, the dialing 
service used to make the call is saved with them. Such numbers include contact phone numbers 
and the phone numbers specified in call forwarding and routing lists. You can do a global 
replace of one dialing service for another across all users’ saved numbers. For example, you can 
specify that all numbers saved with the “9 - Phone number” service now use your “8 - Centrex” 
service. 

To replace all occurrences of one saved dialing service with another

1. Choose Tools > Update Access Codes. The Update Access Codes dialing box opens.

2. Choose the dialing service you want to replace under Current access code and the 
dialing service you want to replace it with under New access code.

3. Click OK. 

All phone numbers that users have entered in the TeleVantage database with the Current 
access code are changed to use the New access code.
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Setting default access codes for callbacks
When users return calls or voice messages using the telephone commands or the Client, the 
system automatically uses a default access code. You can set one default access code for phone 
numbers and one default access code for Internet addresses. The defaults are used system-wide. 

You set the default access codes on the Dialing tab of the System Settings dialog box as follows: 

Q Default phone number access code. Select the access code for the dialing service that 
will be used to return a call from a phone number from the Call Log and Voice Messages 
views. The default is 9. You can select a routing service (see “Using routing services” 
on page 8-20) or any dialing service that takes phone numbers as inputs. You typically 
would use a routing service or a Phone Number dialing service.

Q Default Internet address access code. Select the access code for the Internet Address 
dialing service that will be used to return an IP call—typically a NetMeeting call—that 
did not come from a remote TeleVantage Server. When returning a call that came from 
a remote TeleVantage Server, the system automatically uses the correct access code 
required to reach the remote Server. 

Where the default access codes appear
In the Administrator, the Default column of the Dialing Services view shows the current defaults 
for phone number and Internet callbacks. 

In the Client, the Place Call To dialog box always opens with the current default dialing service 
for phone numbers selected (the user can also choose a different dialing service to place a call). 
When you import contacts, new phone numbers and IP addresses automatically receive the 
default access codes.

Adding a dialing service ___________________________________
This section describes adding a new dialing service of any type other than Routing service. For 
instructions on adding a routing service, see “Using routing services” on page 8-20. For a 
description of the dialing service types, see “Dialing service types” on page 8-2.

To add a new dialing service

1. Choose File > New > Dialing Service, and the type of dialing service to create. The 
Dialing Service dialog box for that type opens. 

2. Define the dialing service using some or all of the following tabs. Which tabs are 
available depends on the type of service being added. The tabs are described in detail 
in the following sections.

Q General tab. Use to enter the service’s name and access code, hide or show the 
service, and enter other general information. See the next section.

Q Trunks tab. Use to specify on which trunks the service routes outbound calls, and 
how the trunks are prioritized. See page 8-12.
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Q Codecs tab. Internet services only. Use to optimize the codecs for the Internet 
connections that the service makes. See page 8-13.

Q Location Settings tab. Phone number services only. Use to specify the location of 
the TeleVantage Server to enable accurate dialing. See page 8-14.

Q Dialing Exceptions tab. Phone number type only. Use to add dialing rules for 
exchanges in your area code that require different dialing. See page 8-15

Q Permissions tab. Phone number type only. Use to control which numbers can be 
dialed using the service. See page 8-17.

3. When you have finished defining the dialing service, click OK on any tab to close the 
Dialing Service dialog box.

The General tab
Use this tab to enter the service’s name and access code, enable or disable the service, hide or 
show the service, and enter other information specific to the service type. The following sections 
describe the General tab for each service type.

General information for all dialing service types

The following fields of the General tab are the same for all dialing service types:

Q Name and Access code. Choose a name and access code that will make it easy for users 
to select this dialing service when placing a call. See “Tips on access codes and names 
for services” on page 8-6. 

Note: If you change the access code of a dialing service here, you must use Tools > 
Update Access Codes before the change can take effect. See “Changing an access 
code in users’ saved numbers” on page 8-7.

Q Enabled. To make this dialing service available to users, leave Enabled checked. 
Clearing the check box disables the dialing service so that users cannot select it. 
Disabling can be useful while you are in the process of creating or troubleshooting the 
dialing service.

Q Show in Client. To hide this dialing service in the Client, uncheck this field. Hiding a 
service from the Client is typically done for testing purposes or to make the service 
available only via a routing service. See “Hiding dialing services” on page 8-5.

Q Can be dialed. To prevent users from using the dialing service’s access code, uncheck 
this field. Making the access code non-dialable is typically done to make the service 
available only via a routing service. For testing purposes, you would leave this field 
checked.
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Completing the General tab
To complete the General tab, enter the following information if it applies to the service type you 
are adding. Each field is described in the following sections.

Q Collect all digits before dialing on trunk. See the next section.

Q Dial prefix and suffix. See page 8-10.

Q Minimum and maximum number of digits. See page 8-11

Q IP Gateway and remote Server information. See page 8-11.

Collect all digits before dialing on trunk
Check this field to have TeleVantage wait until the user finishes dialing before sending the 
complete dial string to the phone company. Uncheck it to have TeleVantage send digits to the 
phone company as the user dials them, and let the phone company determine when the dial string 
is complete.

Normally, digits are sent as the user dials them. In certain cases, however, you can collect all 
digits:

Q To simulate a dial tone for carriers that do not generate a dial tone after a Primary 
Interexchange Carrier (PIC) code (in the U.S., you can create a dialing service that uses 
a PIC code prefix to access a particular carrier).

Q To improve tone detection when users attempt to place an outbound call while logged 
into TeleVantage remotely from a digital cell phone or other low-quality connection.

If you check this option, TeleVantage assumes that all digits have been dialed when the dialing 
service ambiguous time-out elapses, and places the call (for more information, see “Setting 
dialing time-outs” on page 3-12). Users can dial # when they are done dialing to skip the 
time-out and place the call immediately.

Dial prefix and suffix
When you create a Phone Number or Centrex/PBX Extension dialing service, you can enter a 
dialing prefix and suffix. A dialing prefix consists of digits dialed automatically by the dialing 
service before the number that the user dialed. Similarly, a dialing suffix consists of digits dialed 
automatically after the number the user dialed.

The following are examples of how you can use a dialing prefix or suffix:

Q To create a Phone Number service (“Outside Line”) used to dial phone numbers over a 
Centrex trunk. Enter a dialing prefix, typically 9, to get an outside line from Centrex. 
You can also support the dialing of Centrex/PBX extensions over the same trunks by 
creating a Centrex/PBX Extension dialing service without entering a dialing prefix.

Q To create a Centrex/PBX Extension service (“Voice mail”) that accesses a PBX that 
provides voice mail. Enter a prefix that takes users into voice mail. Enter a suffix that 
takes them directly to their new messages. 

Q To create a Phone Number service (“Calling Card”) that makes it easy for users to charge 
calls to a calling card company. Enter a dial prefix that is the entire number used to 
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access the calling card company (including the calling card number), and then enter a 
dialing suffix that is the number of the credit card used to pay for these calls.

All users need to do to charge a call is dial the access code for the dialing service, then 
the number they want to call. The dialing service automatically dials the number of the 
calling card (the prefix), then dials the number the user dialed, and finally supplies the 
credit card number (the suffix).

Minimum and maximum number of digits
When a user dials a Centrex/PBX extension, TeleVantage waits to collect all of the digits up to 
the minimum number of digits you specify here, and does not dial them until one of the 
following occurs:

Q A time-out occurs (see “Setting dialing time-outs” on page 3-12).

Q The user presses # to signify that all digits have been entered.

Q The maximum number of digits (that you specify below) have been entered.

If every Centrex/PBX extension that users can dial is the same length, you can expedite dialing 
by entering that information here. For example, if the extensions are 3 digits long, set both 
values to 3. 

IP Gateway and remote Server information
Enter the following information when defining an Internet-to-Phone Number or 
Internet-to-Centrex/PBX Extension dialing service:

Q IP Gateway. Select the IP Gateway that will direct calls from this dialing service to a 
remote TeleVantage Server. To create a new IP Gateway, click the IP Gateway button. 
See “Creating an IP Gateway” on page 13-10.

Q Remote Server’s Phone Number service access code. (Internet-to-Phone-number 
services only.) Use this field to specify the dialing service that the remote Server will use 
to place outbound calls. Enter the access code of a Phone Number dialing service on the 
remote Server (typically 9). 

Q Place Centrex/PBX calls on remote Server using. (Internet-to-Centrex/PBX 
Extension services only). Select one of the following options, depending on the type of 
IP Gateway calling you want to perform using this dialing service:

Q To call TeleVantage extensions on the remote Server. 
Select Remote Server’s internal dial tone. With this selection , callers are 
connected directly to the internal dial tone on the remote Server, from which they 
can dial extensions, log into accounts, or use the TeleVantage telephone commands.

Q To place Centrex/PBX calls through the remote Server. 
Select Remote Server’s Centrex/PBX service access code, and enter the access 
code of a Centrex/PBX Extension dialing service on the remote Server. This option 
lets users dial Centrex/PBX extensions that are external to the remote Server, for 
example, to connect to a legacy PBX on the remote Server or dial a Centrex 
extension.
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The Trunks tab

The Trunks tab is used by all dialing service types except routing services (see page 8-20). This 
tab specifies the trunks to which calls will be routed and the order in which those trunks will be 
allocated. In this procedure, the Trunks tab from the Phone Number Service dialog box is used 
for illustration. All dialing service types except routing services have the same tab, but the 
options on the tab refer to the trunks appropriate to the dialing service you are creating, and the 
Available trunks list will show the appropriate trunks.

To complete the Trunks tab

1. In Use trunks in this order, choose one of the following:

Q Bottom to Top. Trunks are allocated starting at the bottom of the list each time. 
If a trunk is busy, the next trunk up is allocated.

Q Top to Bottom. Trunks are allocated starting at the top of the list each time. If 
a trunk is busy, the next trunk down is allocated.

Q Round Robin. Trunks are allocated in the same sequence as Bottom to Top, but 
starting with a different trunk for each call.

2. Select one of the following:

Q Use all <trunk type>. If selected, this dialing service will allocate all trunks listed 
under Available trunks and will use the algorithm selected in the previous step. 

Q Use only selected trunks. If selected, this dialing service will allocate only the 
trunks in the Selected trunks list on the right and will use the algorithm selected in 
the previous step. Click Add to add a trunk to the Selected trunks list. Click 
Remove to remove it.
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Q Available trunks. Lists all the trunks in the TeleVantage system that can be 
used by this type of dialing service:

Q Phone Number service: analog and digital trunks

Q Centrex/PBX Extension service: analog and digital trunks

Q Internet Address service: Internet trunks

Q Internet-to-Phone Number service: Internet trunks

Q Internet-to-Centrex/PBX Extension service: Internet trunks

Q Selected trunks. Lists the trunks that this dialing service will allocate. Use the 
arrows to move a trunk higher or lower in the list.

The Codecs tab

When you add a dialing service of the type Internet Address, Internet-to-Phone Number, or 
Internet-to-Centrex/PBX Extension, you can use the default codecs specified for the Internet 
span or override the defaults and specify one or more codecs. For a complete description of 
codecs, including which ones to choose, see “Modifying TeleVantage IP codecs” on page 5-26.

You can create different Internet dialing services optimized for specific uses, for example, one 
Internet dialing service with codecs optimized for NetMeeting, and another with codecs 
optimized for TeleVantage Server-to-TeleVantage Server communication over the Internet.

Note: To view your default codecs, display the Internet span properties in the Trunks view. If you 
want to use the default codecs, you do not need to make any changes on the dialing service’s 
Codecs tab. 

If you decide to override the default codecs for the span, arrange the codecs in the order in which 
you prefer to use them. For example, you may prefer one codec over another to get greater 
bandwidth or better voice quality. 
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To change the codecs used by a dialing service

1. To override the codecs set up at the Internet span level, click Use the following 
codecs. 

2. Click Add to add another codec, or select a codec and click Edit to change any of the 
parameters used with the codec. For more information about how to use the Add 
Codec dialog box, see “Adding an Internet span” on page 5-25.

3. Click the up or down arrows to promote or demote a specific codec within the list. 

The Location Settings tab

The Location Settings tab is used by Phone Number and Internet-to-Phone Number dialing 
services. TeleVantage uses location information to format and dial telephone numbers entered 
in the Client or collected from Caller ID information. 

Identify the local and long-distance phone number formats used to dial using this service, as 
follows:

Q Country/Region. Choose the location of the TeleVantage Server.

Q Long-distance prefix. Enter the prefix required to dial a long-distance number from the 
Server location.

In the U.S., enter 1. Outside of the U.S. and Canada, the long-distance prefix is typically 
0.

Q International prefix. Enter the prefix required to dial an international number from the 
Server location. In the U.S., enter 011. Outside of the U.S., the international prefix is 
typically 00.

Q Area code. Enter the city or area code for local phone numbers, if applicable. If not, 
leave blank.
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Q Dial local numbers without area code. Check to have TeleVantage strip the area code 
from local numbers before dialing. In most areas, this field should be checked, unless 
the service allocates trunks that only support long-distance numbers or if it always 
expect numbers to include area codes.

Q Include long-distance prefix in area code. Check to have TeleVantage assume that the 
long-distance prefix is always included with the area code, as in the U.K., for example, 
0181. This field is only available for a Phone Number service, and it is disabled in the 
U.S.

Note: When using this tab to create an Internet-to-Phone Number dialing service, these values 
must match those on the remote TeleVantage Server.

The Dialing Exceptions tab
The Dialing Exceptions tab is used only for Phone Number dialing services. If Dial local 
numbers without area code on the Location Settings tab is checked (see “The Location 
Settings tab” on page 8-14), TeleVantage dials all calls within your area code as local calls. All 
other calls are dialed as long-distance calls. You can change this default behavior or add other 
dialing rules to cover exceptions for certain exchanges. 

Dialing exceptions apply only to calls placed from the Client. When placing a call using the 
telephone, you must dial it with the correct area code usage.

Note: If you did not check Dial local numbers without area code, you usually do not need to 
specify dialing exceptions. Dialing exceptions are used to only to convert numbers entered into 
the Client, and callback numbers from Caller ID. Dialing exceptions do not affect manually dialed 
numbers. 

The Dialing Exceptions tab displays dialing exceptions created so far. If these settings are 
incorrect, calls dialed automatically to local exchanges will be dialed as long-distance calls.

To enter dialing exceptions

1. Click Add to create a new dialing exception, or Edit to modify an existing one. The 
Dialing Exception dialog box opens.

For information about importing and exporting dialing exceptions, see “Exporting and 
importing dialing exceptions” on page 8-17.
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2. In the Dialing Exception dialog box, add a default dialing rule for each city or area 
code for which you want to define exceptions. 

Q City/Area code. Enter the city or area code. 

Q Dial as. Select a dial string from the drop-down list. This string will be used to dial 
all calls to this city or area code that do not match any of the exceptions that you 
define. In this example, the default dialing rule for the 617 area code has been 
defined. Click Apply to save the default dialing rule. 

3. In Number, enter the exchange within the selected City/Area code that requires a 
dialing exception. Select the Dial string to be used for calls to this exchange from the 
drop-down list. In the following figure, the dialing exception for the 235 exchange has 
been defined. 

4. Click Apply to save the dialing exception. 

You can define several dialing exceptions for a city or area code to cover different 
exchanges. Continue to enter exchanges for which dialing exceptions are needed. 
When you are done, click OK.

The Dialing Exceptions tab displays the default dialing rule and the dialing exceptions 
you defined.

You can continue to add default dialing rules for other city or area codes, or add 
additional dialing exceptions. Enter only those city or area codes for which local 
calling applies. If a city or area code is not in the list, all calls to it are dialed as 
long-distance calls.
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Exporting and importing dialing exceptions
Exporting and importing dialing exceptions allows you to copy dialing exceptions from one 
TeleVantage Server to another, or from one Phone Number service to another on the same 
TeleVantage Server, so that you do not have to retype them on each system. Dialing exceptions 
are exported into a comma-separated value (.CSV) file.

To export dialing exceptions

1. In the Phone Number Service dialog box, click the Dialing Exceptions tab.

2. Click Export. The Export Dialing Exceptions dialog box opens. 

3. Enter a file name for the exported file. Click Browse to specify a destination.

4. Click Finish to export the file.

To import dialing exceptions

1. In the Phone Number Service dialog box, click the Dialing Exceptions tab.

2. Click Import. The Import Dialing Exceptions dialog box opens.

3. Click Browse to locate the file to import.

4. Click Finish to import the file.

The Permissions tab

The Permissions tab is used only for Phone Number dialing services. It enables you to control 
which numbers can be dialed when using the dialing service. Dialing service permissions can be 
inclusive (“allow all numbers except for...”) or exclusive (“disallow all numbers except for...”). 

Note: Dialing service permission settings can be overridden by dialing permissions set at the 
role or user level. See “Dialing permissions hierarchy” on page 6-53.
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To set dialing permissions

1. Specify the default behavior when users dial a number using this service by selecting 
one of the following:

Q Allow all. Users can dial all numbers using this dialing service except those 
numbers that appear in the list under Numbers beginning with.

Q Disallow all. Users cannot dial any numbers using this dialing service except those 
numbers that appear in the list under Numbers beginning with.

2. Click Add to add a new permission, or Edit to modify an existing one.

3. Choose to Allow or Disallow calls, and then enter the digits. The permission is applied 
whenever a user selects this dialing service and then dials a number beginning with the 
digits you entered.

4. Click OK to close the Dialing Permission dialog box.

An example of how to set dialing service permissions
The following example illustrates how to set dialing service permissions: 

Q You want to allow users to dial all local numbers in the 216 area code. These calls are 
dialed without the area code because they are local calls as set up on the Location 
Settings tab (see “The Location Settings tab” on page 8-14).

Q You want to allow calls to some exchanges in the 330 and 440 area codes, which are 
dialed with a 1 in front of them because they are long-distance calls, for example, 
1-330-531-1234 and 1-440-674-4321.

Q In addition, you want to prevent calls to all other long-distance and international 
numbers, but allow calls to 1800 and other toll-free numbers.

To do this with the fewest steps, set up the following dialing service permissions:

Q By default, allow all numbers except those starting with:

Q Disallow 1. This prevents calls to long-distance numbers.

Q Disallow 011. This prevents calls to international numbers.

Q Allow 1330531. This allows calls to numbers in the 531 exchange of the 330 
area code.You must enter a separate permission for each valid exchange in the 
330 area code. 

Q Allow 1440674. This allows calls to numbers in the 674 exchange in the 440 
area code. You must enter a separate permission for each valid exchange in the 
440 area code.
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Q Allow 1800. This allows calls to toll-free numbers. You must create a separate 
permission for each valid toll-free area code that you want to allow users to dial. 

In this example, the rules are applied in this order, longest to shortest:

1330531—allow
1440674—allow
1800—allow
011—disallow
1—disallow

The following numbers are allowed:

1 330 531 1234 
1 800 123 4567
731 4521 (in the local area code)

The following numbers are disallowed:

1 347 555 1212
1 330 532 1212
011 44 181 555 1212
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Using routing services ____________________________________
If you have created several different dialing services, you may be able to simplify dialing for 
your users by creating a routing service. A routing service is a special type of dialing service 
that routes the number dialed to other dialing services. The routing service can choose how to 
route a call based on the phone number dialed, the time of day or day of the week, or the user 
placing the call. By using routing services you can do the following:

Q Allow users to dial a single access code (for example, 9) for all their phone calls. Routing 
rules can automatically determine the best dialing service for a given call, and are not 
limited to a single type of trunk. 

Q Automatically route a call to trunks on an alternate dialing service when all the trunks of 
the preferred dialing service are in use.

Q Prevent certain users from dialing certain numbers, at all times or only at certain times 
of the day.

For specific examples of using routing services, see “How you can use routing services” on 
page 8-21.

You can add as many routing services as you want, but typical installations need no more than 
one routing service. 

How routing services work
A routing service uses routing rules to identify which dialing service will be used for the number 
dialed. For example, the following table shows a simple routing rule that identifies local calls. 
If the dialed number matches the pattern in the Digits dialed column, then the Local calls 
dialing service will be used to place the call. Local calls is referred to as the target dialing 
service for this rule. 

This example shows the routing rule as it would appear on the Routing Rules tab of the Routing 
Service dialog box (see “The Routing Rules tab” on page 8-27).

All routing rules contain the following information:

Q Digits dialed. A pattern that matches the dialed numbers that you want the routing rule 
to process. The pattern Nxxxxxx matches any seven-digit number starting with the digits 
2 through 9. See “Defining patterns to match the dialed digits” on page 8-30 for details. 

Q Schedule. One or more scheduled times at which the rule will be applied. This field is 
set to Always if no schedule is defined, and the rule is always applied. 

Q Membership. A rule can be used to restrict the dialing of certain numbers or the use of 
certain trunks to a specific group of users. If this is the case, the Membership column is 
checked. If no membership is defined, the rule applies regardless of the user who placed 
the call.

Schedule Digits dialed New digits Action Service/Reason Notes

Always Nxxxxxx Nxxxxxx Route 76 - Local calls
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Q New digits. The pattern of the number to be passed to the target dialing service. In the 
example shown in the previous table, the number is unchanged.

Q Action. A rule’s action can be Route, which attempts to route the call through the target 
dialing service, or Stop, which stops processing of any further routing rules that use this 
pattern. 

Q Service/Reason. The example shown in the previous table gives the access code and 
name of the target dialing service for this rule. If the rule’s action was Stop, this field 
would list the reason for stopping, which can be played over the phone as an error 
prompt. 

Q Notes. Comments that you can enter when you create the rule. 

A routing service can have an unlimited number of routing rules. The routing service attempts 
to match the number dialed to each routing rule from the topmost rule down to the end of the list 
of routing rules. If one or more valid rules are found, the routing service attempts to route the 
call through the target dialing service. If all trunks on the target dialing service are busy, the 
routing service tries the next matching routing rule and corresponding target dialing service until 
the call is placed or all valid routing rules have been tried. If the routing service finds a rule that 
tells it to stop processing the number, no further attempts to match a number dialed to a routing 
rule are made. If the number dialed does not match any rules, then the user will hear “The dialing 
service you selected is not properly configured. Please contact your administrator.“

If a routing rule matches the dialed digits, the target dialing service checks the rule’s New digits 
against the dialing permissions defined for the user, the user’s roles, and the target dialing 
service. If the dialed digits are blocked by these permissions, the target dialing service is not 
used. For information about dialing permissions, see Chapter 6, “Managing Users and Roles.” 

Before the routing service passes the number to a dialing service, it modifies the number 
according to the pattern specified in New digits (the number is unchanged if New digits matches 
Digits dialed). The dialing service then applies any prefixes, suffixes, and dialing exceptions 
(see pages 8-10 and 8-15) to the modified number before the call is placed. 

How you can use routing services
By setting up multiple dialing services and using a routing service, you can do any of the 
following:

Q Route local calls and long-distance calls to different trunks. Write one or more 
routing rules that identify local calls and route them to dialing services that offer the 
lowest cost for local calls. Write other routing rules that identifies long-distance numbers 
and routes them to the trunks that offer the lowest price for long distance. 

Q Restrict the outbound use of certain trunks to specific users. A rule can be limited 
to specific users or Roles only, enabling you restrict the use of a certain phone number, 
dialing service or collection of trunks to those users. You might use this feature if one 
organization sharing the Server has special dialing privileges or has ownership of several 
trunks.  To restrict a rule to a group of users, either specify the individual users in the 
membership or create a Role containing the appropriate users and then specify the Role 
in the rule.
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Q Schedule the use of different dialing services for the same number to implement 
least-cost routing. For example, you have three different carriers for long-distance 
calls. One is the least expensive during business hours, one during the evening hours of 
business days, and one during nights and weekends. You can set up three dialing 
services for the three carriers. In your routing service, create three routing rules. Each 
routing rule matches long-distance numbers but is in effect only during the specified 
time period. Each rule routes calls to the appropriate dialing service for the lowest price.

Q Route long-distance calls over an Internet gateway so that they are made as local 
calls from a remote TeleVantage Server. For example, you are in the New York office. 
Your company also has an office in Boston. Your New York users make many calls to 
a Boston area code (617). You can set up an Internet-to-Phone Number dialing service 
named Call Through Boston that routes calls over the TeleVantage Server in Boston. 
You can then create a routing rule that matches numbers with the 617 area code 
(1617Nxxxxxx) and routes the calls to the Call Through Boston dialing service. 

Q Perform least-cost routing by selecting the least expensive dialing service for a 
given phone number and time. For example, you might have two different carriers for 
long-distance calls. One carrier is the least expensive during business hours, and the 
other is the least expensive during evenings and weekends. You can set up a dialing 
service for each of the two carriers. You can then set up a routing service that can route 
the call through either dialing service. The routing service automatically assigns the 
highest priority to the dialing service of the least expensive carrier, based on the call’s 
time of day. Users do not have to remember separate access codes for the two carriers 
because they always dial the access code for the routing service. 

An example of routing rules
Arrange your routing rules in the order that you want them to be evaluated and applied, from top 
to bottom (see the next figure). You can create multiple rules to match the same phone number. 
The first routing rule can be the least expensive long-distance option, for example, while 
subsequent rules route to progressively more expensive options. 

The routing service in the following example has four routing rules (rules 6 through 9) that 
match the same set of numbers. Rule numbers are provided in the figure for purposes of 
illustration only.

Rule Schedule Membership Digits dialed New digits Action Service/Reason

1 Always XYZ users Route 79 - T1 line

2 Always All 011 Stop Invalid number

3 Always All 1900 Stop Invalid number

4 Always All 411 411 Route 79 - T1 line

5 Always All 411 Stop All lines busy

6 Weekdays All 1NxxNxxxxxx 1010321NxxNxxxxxx Route 79 - T1 line

7 Always All 1NxxNxxxxxx +1NxxNxxxxxx Route 79 - T1 line

8 Always All 1NxxNxxxxxx +1NxxNxxxxxx Route 78 - All trunks

9 Always All 1NxxNxxxxxx Stop All lines busy

10 Always All ~ ~ Route 79 - T1 line
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Rules 1-10 in the preceding figure work as follows:

1. This rule is defined so that calls from specific users (for example, all users in the XYZ 
Organization) are routed to the T1 line dialing service. You might do this if your other 
trunks are paid for by a different business that is sharing the system. (See “Using 
Organizations” on page 10-2 for more information about handling multiple businesses 
on a system.)

2. This rule is defined so that users are not permitted to place international calls with this 
routing service. This could be useful if you only want international calls to be placed 
by users who have been given a special access code that corresponds to a different 
dialing service. 

3. This rule is defined so that calls to 900 pay-per-minute numbers are prevented. You 
could replace 900 with a routing variable that matches all pay-per-minute numbers. 
See “Adding custom routing variables” on page 8-30. 

4. This rule is defined so that 411 calls are routed to the T1 line dialing service, which 
was created to place calls over a T1 line.

5. This rule is defined so that call processing stops and a message plays if all trunks are 
busy on T1 line. The message says that all lines are currently busy. Without this stop 
rule, rule 9 would match 411 calls also, so this stop rule causes a much quicker 
time-out when no lines are available. 

6. This rule is defined so that long-distance calls placed during hours defined by the 
Weekdays schedule use the least expensive carrier. The PIC code 10-10-321 (a code 
used to save money by using a particular carrier) is added to the dialed digits before 
the number is passed to the T1 line dialing service.

7. This rule is defined so that long-distance calls that are not placed during Weekday 
hours use the same target dialing service as rule 5. The PIC code is not used. 

8. This rule is defined so that if all of the T1 line dialing service trunks are busy, calls are 
routed to the All trunks dialing service. 

9. This rule is defined so that call processing stops if the dialed digits match this rule and 
the call has not yet been processed. With the stop rule in place, if no trunks are 
available from the previous rules, the routing service stops the processing of the call 
and plays a system prompt to the user saying that no lines are available. Without such 
a stop rule, the routing service would search for another matching rule and therefore 
rule 9, which was not created to handle long-distance calls, would then handle the call. 

10. This rule is defined so that all other numbers, for example, local numbers, are passed 
to the T1 line dialing service unchanged. 
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How the Client reformats phone numbers
Phone numbers dialed from a telephone reach the routing service exactly as dialed. On the other 
hand, the Client can automatically reformat phone numbers before they are received by a routing 
service. 

For example, the Client may strip the area code from a local number, even if the user has entered 
the area code in the Client’s Check Phone Number dialog. Putting local numbers from the Client 
and the telephone into the same seven-digit form allows you to use the same routing rules for 
local phone numbers from both the Client and the phone. 

Your routing rules must be able to handle numbers received from the Client, so it is important 
that you understand when and how the Client reformats them. Here are the main points to 
remember:

Q The Client stores information about whether or not a number can be reformatted.  
In the Client’s Check Phone Number dialog, the use country code and area code 
dialing rules checkbox specifies whether or not the number may be reformatted. 

If this checkbox is not checked, the Client will never reformat this number. (For more 
information, see “Using dialing services” in Using TeleVantage). 

Q If the number can be reformatted, the Client uses the dialing rules specified in the 
Location Settings tab of the routing service’s default dialing service. A routing 
service does not have location settings of its own, but every routing service is configured 
with a default dialing service (see “Adding a routing service” on page 8-26). The 
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location settings of the default dialing service supply the rules that the Client will use to 
reformat the number. 

The number can be reformatted in the following ways:

Q If a user enters a number without an area code, the Client can use the dialing 
service’s area code and country code settings to add that information. For example, 
if the user types 3540600 in the Client’s Place Call To dialog box, the Client can add 
the area code, and the number received by the routing service will be 6173540600. 

Q If the routing service’s default dialing service has Dial local numbers without area 
code checked, the Client will strip the area code from the number before sending it 
to the routing service. For example, even if the user enters 6173540600, the Client 
will strip the area code from the number, and the number received by the routing 
service will be 3540600. 

It is important to remember that all reformatting takes place before the routing service receives 
the number and begins to apply routing rules to it. Dialing services specified in routing rules will 
never receive a number until after the Client has had a chance to reformat the number based 
using the routing service’s default dialing service. 
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Adding a routing service
1. Choose File > New > Dialing Service > Routing Service. The Routing Service dialog 

box opens.

2. On the General tab, enter the basic information about the routing service. For 
instructions on Name, Access code, Enabled, Show in Client, and Can be dialed, 
see “General information for all dialing service types” on page 8-9.

3. From the Default service drop down-list, select the dialing service whose location 
settings are applied to numbers dialed from the Client. Select a dialing service from 
the drop-down menu, click to create a new dialing service, or press ALT and click 
to edit the selected default service. 

4. Click the Routing Rules tab and add routing rules (see “Adding a new routing rule” on 
page 8-27) until you have provided coverage for all phone numbers that you expect 
users to dial. 

5. Click OK to add the routing service.
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The Routing Rules tab
The top pane on the Routing Rules tab displays routing rules for this routing service. 

The bottom pane displays the routing variables that are currently available. Click Routing 
Variables if you need to create or edit routing variables for use in your routing rules. 

See “Adding custom routing variables” on page 8-30 for more information. 

To create a new routing rule, click Add (see the next section). 

Adding a new routing rule
When you click Add On the Routing Rules tab, the Add Routing Rules dialog box opens.
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Use this rule under the following conditions
In this section of the dialog box, you can define what calls the rule handles. You can have the 
rule handle calls on the basis of the digits dialed, the time or date when the calls are placed, and 
the users placing the calls, in any combination.

Q Digits dialed. Type the pattern that will match the dialed numbers you want the routing 
rule to process. For example, Nxxxxxx would match any seven-digit local number. See 
“Defining patterns to match the dialed digits” on page 8-30 for details. The pattern 
entered here appears in the Dialed digits column of the Routing Rules tab. This field 
cannot be left blank.

To have the routing rule process calls without regard to the number dialed, enter ~ here. 
For example, you might have a routing rule that processes calls solely on the basis of 
schedule or membership. Stop rules cannot use the ~ character.

Q Schedule. If you want to apply the rule only at scheduled times, check this field and 
click . In the Custom Hours dialog box that opens, define the hours and days of the 
week or the specific dates that this rule will be in effect. See “Setting up custom hours” 
on page 6-24 for more information. If you enter a schedule, it appears in the Schedule 
column of the Routing Rules tab. 

Q Membership. If you want to apply the rule only to outbound calls from certain users, 
check this field and click . In the Routing Rule Members dialog box that opens, add 
the users or roles you want to the Selected Members list by selecting them and clicking 
Add. If a role is selected, all users in the role are members.

Click OK to return to the Add Routing Rule dialog box. The rule will be used only on 
calls from the users in the Selected Members list.

Note: If your TeleVantage Server is shared between different organizations, you can 
use the Membership feature to restrict the use of some trunks to members of a role that 
has the same members as the organization. You might do this, for example, if one 
company had paid for certain proprietary trunks. See Chapter 10, “Managing Multiple 
Organizations.” 
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Execute the following action
In this section of the dialog box, you can specify the action to be performed with the dialed 
digits. You can choose one of two actions: you can either Route, which passes the number to the 
target dialing service, or Stop, which stops processing any further routing rules that use this 
pattern. The action you choose appears in the Action column of the Routing Rules tab. 

Q Route the call to another dialing service. Select this option if you want the number 
passed to the target dialing service. 

Q Dialing Service. From the drop-down list, select the target dialing service for this 
rule. The dialing service you select appears in the Service/Reason column of the 
Routing Rules tab. 

Q New Number. Type the pattern that defines the number that you want to pass to the 
target dialing service. If you do not want to change the number, use the same pattern 
that you entered in Digits dialed. See “Defining a new number for a routing rule” 
on page 8-32 for more information. If you enter a pattern, it appears in the New 
digits column of the Routing Rules tab. 

Q Stop processing rules. Select this option if you want to prevent the routing service 
from looking further for rules that match the dialed number. 

If no rules have matched when the stop rule is reached, or if no trunks are available from 
the target dialing services of the rules that matched, TeleVantage plays an appropriate 
system prompt to the user. The available prompts include “I’m sorry, all lines are 
currently busy,” “I’m sorry, the phone system has not been configured to dial this 
number. Please contact your administrator,” and “I’m sorry, the number you entered was 
invalid. Please try again.” The name of the prompt you select appears in the 
Service/Reason column of the Routing Rules tab.

Most routing services will include stop rules. You can use them for the following 
purposes:

Q Prevent numbers from being dialed over inappropriate trunks. For example, 
create routing rules that route 411 calls to dialing services that support 411. Add a 
stop rule so that TeleVantage does not attempt to dial 411 on dialing services with 
trunks that do not support 411 calls. Restrict 1800 numbers to specific trunks in the 
same way. 

Q Eliminate time-outs when a user is dialing from the telephone. For example, 
with 911 calls, you can create one or more routing rules for the dialing services that 
can handle 911 calls. Add a stop rule for 911 that will cause TeleVantage to pass 
the call to a 911 dialing service immediately instead of evaluating all of the 
remaining rules for matches before routing the call. 

Q Block calls to numbers. You can set up stop rules for 1900 numbers, for example, 
to prevent users from calling them (this could also be done with dialing 
permissions, but stop rules can provide a more versatile solution in some cases).
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Defining patterns to match the dialed digits
You can include any of the characters identified in this section in the Digits dialed that the 
routing rule uses to match digits received (see “Use this rule under the following conditions” on 
page 8-28). The Digits dialed field cannot be left blank.

Routing rules can match the exact digits in phone numbers, such as 16173540600, or use number 
patterns that include variables to match all dialed digits that fall into a more general category. 
For example, using the pattern 1617Nxxxxxx to match the dialed digits would match all phone 
numbers in the 617 area code. The pattern 1NxxNxxxxxx can be used to match any long-distance 
number in the North American Numbering Plan. 

Note: Variables are case-sensitive. For example, upper-case N and lower-case n would be 
interpreted as two different variables. 

By default, the system defines the following routing variables: 

Q N matches any digit from 2-9. These are the initial digits used in exchanges and area 
codes.

Q x matches any digits (0-9).

Q ~ matches any sequence of digits and asterisks to the end of dialed digits. This creates 
an ambiguous time-out (see “Avoiding dialing ambiguities” on page 8-6). 

Note: You cannot use this character when defining a stop rule.

You also can define your own routing variables to match combinations of digits, as described in 
“Adding custom routing variables.” .

The following list presents examples of match patterns and the phone numbers that match them:

Q 1617Nxxxxxx matches 16173540600 and any other seven-digit phone number in the 617 
area code. 

Q 1617~ matches 1617, 16173540600, 16173540600123456789, or any other set of digits 
that follows the digits 1617.

Q Nxxxxxx matches 3540600, 2000000 and any other seven digits in which the first digit 
is from 2-9.

Q ~ matches any number dialed.

Adding custom routing variables
Routing rules use a set of variables to define the phone numbers to be matched. As explained 
previously, by default the system defines the routing variables N, x, and ~. You can define 
additional routing variables that match individual digits or combinations of digits, such as area 
codes or exchanges.

For example, if you are in the 617 area code and calls to the 617, 781, and 508 area codes have 
the same low cost over certain trunks, you can create a new routing variable AAA that matches 
the digit sequences 617, 781, and 508. By using the AAA routing variable, for example, in a 
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1AAANxxxxxx match pattern, you can match calls to any seven-digit phone number in these three 
area codes. Doing this would enable you to consolidate your handling of 617, 781, and 508 calls 
in a single routing rule. 

To add a routing variable

1. Click Variables on the Routing Rules tab (see page 8-27). The Routing Variables 
dialog box opens.

Note: You also can open this dialog box by choosing Tools > Routing Variables.

2. Click Add. The Routing Variable dialog box opens. 

3. Enter a name for the new variable in the Name field, and then enter the set of values 
that the variable will match in the Data field. The name must be a string that consists 
of a repeating upper case letter (for example, W, RRR or HHHHH).

Note: The number of characters in the Name of the routing variable must be the same 
as the number of digits being matched. For example, you can use a variable named 
BBB to match the area codes 617 and 781, but you cannot use a variable named 
BBBBB to match those area codes, and a variable BBB cannot contain anything but 
3-digit numbers.

4. Click OK to return to the Routing Variables dialog box. Click Add to add another 
routing variable or click OK. 
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Defining a new number for a routing rule
You can include any of the characters shown in the following table in the New number that you 
define for a routing rule (see “Adding a new routing rule” on page 8-27).

See “Examples of number patterns and dialed digits” on page 8-33 for examples of dialed digits 
and new numbers that use these characters.

Characters Digits placed in the new number

N, x Places the digit that the variable matched into the new 
number. The position of the variable within the match 
pattern is preserved in the new number. For example, If 
the match pattern Nxxxxxx matches the dialed digits 
5551212, including xxxx in the new number would yield 
the digits matched by the first four x variables: 5512.

+ If + is the first character in the New Number field, the 
routing rule’s target dialing service will apply its area 
code and country code rules to the basic number. If a + 
is not present, the target dialing service’s area code and 
country code rules are not used.

0,-,9,*,# Valid telephone digits.

,& A comma in the dialing sequence causes a 2-second 
pause. An ampersand causes a Flash on analog trunks, 
and is ignored on other trunk types.

[n] The nth digit in the dialed digits. 

[n-m] The nth through mth digits in the dialed digits.

[n-] The nth through the last dialed digit. 

~ All digits matched by the ~ in the dialed digits. (Can only 
be used when the match pattern uses ~.)

"<string>" Use quoted strings without modification. For example, 
the following new number begins with the MyNetPhone 
gateway as a quoted string, incorporates all the dialed 
digits, and then adds an account name and password as 
a suffix: “gateway.mynetphone.net/”[1-]*1234*1234.
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Examples of number patterns and dialed digits
The following table illustrates some of the possibilities for defining the new number used by a 
routing rule. The first column shows number patterns and dialed digits that match those patterns. 
The second column shows New Number patterns that incorporate some or all of the dialed digits 
and the number that results from applying the new number pattern to the dialed digits. 

Note: The last example in the following table assumes that the U.S. is the country and 617 is 
the area code that was selected on the Location Settings tab of the routing rule’s dialing service.

Match pattern/
Dialed digits

New Number pattern/
Number produced by pattern

1NxxNxxxxxx
16173540600

NxxNxxxxxx
6173540600

1NxxNxxxxxx
16173540600

Nxx[5-11]
6173540600

1NxxNxxxxxx
16173540600

[5-11]
3540600

1NxxNxxxxxx
16173540600

[5][6][7][8][9][10][11]
3540600

1NxxNxxxxxx
18005551111,,1211#E

[1-]
18005551111,,1211#E

1Nxx~
16173540600

18002255288,1Nxx~,4321
18002255288,16173540600,4321

Nxxxxxx
3540600

1010321Nxxxxxx
101032116173540600

Nxxxxxx
3540600

+1617Nxxxxxx
+16173540600
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About inbound call routing_________________________________
This chapter provides an overview of inbound call routing methods in TeleVantage and directs 
you to the chapters in this manual that explain in detail how to use them. 

With TeleVantage, you can route incoming calls in the following ways. You can use one of these 
methods or several of them in combination:

Q Route calls to an auto attendant. Incoming calls go to an auto attendant, at which 
callers enter an extension number. Auto attendants can also provide a dial-by-name 
directory for callers who do not know a user’s extension.

Q Route calls on a trunk directly to a user. All incoming calls on a specific trunk go to 
a specified user’s phone. With this method, you can send calls to a live operator who then 
transfers them to users. You can also give a user a dedicated private line.

Q Ring multiple users simultaneously. Incoming calls simultaneously ring the phones of 
all users in a specific workgroup. The first user in the workgroup who answers is 
connected to the caller. Workgroups can contain an unlimited number of users. For more 
information about workgroups, see Chapter 7, “Managing Workgroups.” 

Q Route calls to a call center queue or an ACD workgroup. Incoming calls are 
automatically put on hold in a call center queue or an ACD workgroup until an agent 
becomes available. See TeleVantage Call Center Administrator’s Guide for details about 
setting up and using call center queues and ACD workgroups. 

Q Route calls directly to an IVR Plug-in. Incoming calls are transferred to an IVR 
Plug-in for further processing. For more information about IVR Plug-ins, see 
Chapter 14, “Extending TeleVantage.” 

Q Assign DID (Direct Inward Dial) numbers. Incoming calls on any trunk are routed to 
the appropriate user, auto attendant, workgroup, IVR Plug-in, or queue using the DID 
numbers that callers dial. Departments in your company can have their own phone 
numbers and auto attendants without requiring your system to use dedicated trunks. For 
more information, see “Telephone company services that help TeleVantage” on 
page 5-5.

Q Route calls to a fax machine or a pool of fax machines. For more information, see 
“Setting up fax routing” on page 5-6.
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In addition, users can route calls by setting up call forwarding or using routing lists. For more 
information, see Using TeleVantage.
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About auto attendants_____________________________________
By default TeleVantage uses auto attendants to route calls to users. Auto attendants 
automatically answer incoming calls and offer callers options for directing their calls. For 
example, your main auto attendant might say: “Welcome to Barchetta Industries. You may dial 
an extension at any time. For Sales, press 1. For Customer Support, press 2. To hear a recorded 
message about our special offers, press 3. To speak to the Operator, please hold.”

What callers can do at an auto attendant
You can set up an auto attendant to let callers do any of the following:

Q Dial an extension

Q Dial a user by name in the dial-by-name directory

Q Log in using a TeleVantage extension and password

Q Hear a recorded message

Q Transfer to a user, queue, workgroup, or IVR Plug-in

Q Transfer directly to a voice mailbox to leave a message

Q Transfer to another menu (another auto attendant)

You can also specify an automatic action to take if callers do nothing.

How you can use auto attendants
You can use auto attendants in powerful ways, as follows:

Q You can create additional auto attendants and assign them to different trunks or DID 
numbers. For example, if you distribute different phone numbers for your sales 
department and your accounting department, you can create a custom auto attendant for 
each department.

Q TeleVantage lets you nest auto attendants, so that one option on an auto attendant menu 
can take callers to a menu of other options on another auto attendant. By creating 
multilevel auto attendants you can offer callers a nearly unlimited number of choices.

Q You can customize an auto attendant to automatically change its behavior by time of day 
by scheduling greetings and call transfer behavior. For example, after 6:00 pm (and on 
weekends) your auto attendant could automatically play a “We’re closed” greeting that 
reads your business hours, then transfer calls to a voice mailbox.

Q You can create auto attendants that are recorded in different languages but contain the 
same menu choices. A master auto attendant tells callers, “To continue in English, press 
1. To continue in Spanish, press 2.” Pressing the appropriate choice transfers the caller 
to the auto attendant recorded in that language. The language choice also changes the 
system prompts that TeleVantage presents to the caller to the specified language.

Q Different auto attendants can have different hold music (for example, sales pitches for 
sales reps or soothing music for support lines).
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Q Auto attendants can set a Custom Data variable depending on the menu choice that the 
caller selects. For example, you could have callers to your Customer Support line press 
1 for Product A, or 2 for Product B. Each option would transfer the caller to your 
customer support queue, but would set the “Product” variable differently. Agents using 
the Client’s Call Monitor would see a “Product” column showing the product that each 
caller had selected.

Q Auto attendants can be dedicated to a specific workgroup, so that callers can dial only 
the extensions of users who belong to that workgroup. The dial-by-name directory is 
similarly restricted. In this way you can have multiple companies share your office, and 
ensure that callers to one company do not reach users in another company by accident.

What callers hear
The auto attendant recording that callers hear is composed of a series of short individual 
recordings. The individual recordings are the following:

Q A greeting. The greeting is the first thing the auto attendant plays when it answers a call, 
for example, “Thank you for calling Barchetta Industries.”

Q Menu prompts. Each menu prompt recording tells callers about a single option. For 
example, “For Sales, press 1.” You must record each such prompt individually and 
specify the sequence in which you want the auto attendant to play them.

Note: Callers do not have to wait for a menu prompt to press the key for it. They can press the 
key as soon as they reach the auto attendant. This can be useful for pressing multiple keys quickly 
in cases where one menu choice leads to another menu.

The Default Auto Attendant
When TeleVantage is installed, all incoming trunk lines are assigned to the Default Auto 
Attendant at extension 8000. The Default Auto Attendant is also assigned to any new trunk that 
you add. You can change these assignments at any time.

The Default Auto Attendant plays a greeting and offers the caller the following options:

Q Dial any TeleVantage extension.

Q Press 9 to access a dial-by-name directory.

Q Press 0 to transfer to the Operator.

Q Press # to log in to TeleVantage.

If three seconds pass after the greeting has played without the caller pressing a key, the call is 
transferred to the Operator. 

Note: Although you can edit the Default Auto Attendant, it is recommended that you leave it 
unmodified and create another auto attendant to customize for your use. The Default Auto 
Attendant is used if a trunk is assigned to an auto attendant that was later deleted (see “Deleting 
auto attendants” on page 9-16). 
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The Auto Attendants view
To create and manage auto attendants, click the Auto Attendants icon in the view bar to open 
the Auto Attendants view.

Each auto attendant that you create appears as a row in the Auto Attendants view. A nested auto 
attendant is considered a separate auto attendant and appears on its own row. 

Double-click an auto attendant in the view to edit it in the Auto Attendant dialog box.

Auto attendants that you create are not used until you assign them to a trunk in the Calls are 
sent to field in the Trunk dialog box, as described for the various trunk types in Chapter 5. In 
this way you can create multiple auto attendants for various situations and then activate the one 
you want at the appropriate time. 

Setting up an auto attendant________________________________
The following aspects of setting up an auto attendant are described in the sections that follow:

Q “Creating a new auto attendant”  (see the next section)

Q “Defining menu choices” (page 9-8) 

Q “Restricting an auto attendant to members of a workgroup” (page 9-13)

Q “Scheduling transfers and greetings” (page 9-13) 

Q “Setting up hold music” (page 9-16) 

Q “Assigning an auto attendant to a trunk” (page 9-16) 
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Creating a new auto attendant
1. Select File > New > Auto Attendant. The Auto Attendant dialog box opens.

2. Enter the following information:

Q Name (required). Descriptive name for the new auto attendant, for example, “Sales 
auto attendant.”

Q Extension (required). Extension used to reach the auto attendant. TeleVantage 
users can transfer callers to the auto attendant at this extension. See “Assigning an 
extension” on page 6-10 for recommendations and restrictions. 

To test the auto attendant, dial the auto attendant’s extension. The default auto 
attendant is assigned an extension of 8000.

Q DID number. To give this auto attendant a DID number, assign one from the block 
of numbers provided by your telephone company or T1 provider. When 
TeleVantage recognizes this number as the final digits of an inbound call, the caller 
is automatically connected to this auto attendant, instead of the main auto attendant. 
To assign multiple DID numbers to an auto attendant, separate each number by a 
comma.

Q Description. Information that describes the auto attendant.

Q Organization. This field is reserved for future use. To restrict auto attendant dialing 
by membership, see “Restricting an auto attendant to members of a workgroup” on 
page 9-13.

3. Record a greeting that plays when callers first reach the auto attendant. A typical 
greeting is, “Thank you for calling Barchetta Industries. If you know your party’s 
extension, you can enter it at any time.” For more information, see “Using the audio 
controls” on page 2-10.
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4. Click each of the remaining tabs to finish creating the new auto attendant:

Q Menu Choices (described in the next section)

Q Scheduled Actions (described in “Scheduling transfers and greetings” on page 
9-13)

Q Hold (described in “Setting up hold music” on page 9-16)

5. Click OK on any tab to save the new auto attendant. 

6. To activate the auto attendant to handle incoming calls, assign it to a trunk (see 
“Assigning an auto attendant to a trunk” on page 9-16).

You can save time and reduce typing when you want to create a new auto attendant by 
right-clicking an existing auto attendant in the Auto Attendants view and clicking Copy on the 
shortcut menu. Then right-click anywhere in the view and click Paste on the shortcut menu. The 
Auto Attendant dialog box opens with a copy of the existing auto attendant and you can now 
customize it.

Defining menu choices
An auto attendant can present a series of menu choices to callers. For example, callers might 
press 1 to transfer to the Sales department, 2 to transfer to the Customer Service department, etc. 
When a caller reaches an auto attendant, its greeting plays, followed by its menu choice prompts 
in the order you specify.

Important: If your auto attendant supports extension dialing, make sure that its menu choices 
do not conflict with extension numbers. For example, if you assign the 2 key to a menu choice, 
make sure there are no extensions beginning with 2. Otherwise callers trying to dial the extension 
will select the menu choice instead. See “Assigning an extension” on page 6-10.

Each menu choice can contain the following:

Q Prompt. A recorded message that explains the option to the caller. For example, “For 
Sales, press 1.”

Q Key. The telephone key callers must press to select the option.

Q Action. The action the system takes when the key is pressed. 

Q Language. The language for subsequent system prompts. When callers enter the key 
associated with this menu choice, all subsequent prompts are in the specified language. 
Your system supports the languages that were installed with the TeleVantage Server. For 
more information, see Installing TeleVantage.

Q Custom data. Extra information attached to the call. Whenever a caller selects the menu 
choice, a custom data variable receives the value you define (text or numeric). That value 
is attached to the call and can be seen by users or used to automate call handling. For 
more information, see “Using custom data to add information to calls” on page 9-18.
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Menu choice actions
The following table lists the actions that you can choose. 

Note: TeleVantage automatically disconnects calls if callers do not press a key during three 
consecutive jumps between auto attendants (for example, if you set up an auto attendant to jump 
to itself for the “nothing” menu choice action). Callers are presumed to have hung up. To change 
the number of auto attendants that can execute without caller input, see 
Server\MaxAutoAttendantLoops on page A-37.

Setting general menu options
1. In the Auto Attendant dialog box, click the Menu Choices tab.

Action Description

Transfer to user Transfers the call to a TeleVantage user

Send to voice mail Transfers the call to a user’s voice mailbox

Play message Plays a message that you record

User login Offers callers the TeleVantage login prompt

Dial by name Offers callers the dial-by-name directory

Jump to auto 
attendant

Transfers the call to another auto attendant 
(see the Note following this table)

Transfer to IVR 
Plug-in

Transfers the call to an IVR Plug-in for 
processing

Transfer to Queue Transfers the call to a call center queue
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2. In Number of seconds before performing ‘nothing’ menu choice, enter the number 
of seconds that the auto attendant will wait without a menu choice being selected, 
before performing the action associated with the Nothing menu choice. The wait 
begins after the final menu choice prompt finishes playing. You can choose the action 
for the Nothing menu choice using the following steps.

Note: If you have turned on fax detection for your trunks, the combined time for this 
setting plus the auto attendant prompt (greeting and menu choice prompts) should be 
at least 10 seconds. If the combined time is less than 10 seconds, the system might fail 
to detect fax tones and route them before the “nothing” menu choice takes over.

3. To permit callers to dial extensions from this auto attendant, leave Process all other 
digits as user extensions field checked. For information on unchecking it, see 
“Creating auto attendants without extension access” on page 9-13.

Note: Auto attendant extensions (for example, 8001) cannot be dialed at an auto 
attendant.

4. To dedicate this auto attendant to a workgroup, so that only users in the workgroup can 
be dialed from it, check Restrict dial-by-name and extension matching to members 
of, and select the workgroup. For more information, see “Restricting an auto attendant 
to members of a workgroup” on page 9-13.
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Adding or editing a menu choice
1. On the Menu Choices tab of the Auto Attendant dialog box, click Add to create a new 

menu choice. Click Edit to modify the selected menu choice.The Edit Menu Choice 
dialog box opens.

2. On the General tab, type the text of the Prompt to offer this menu choice, for 
example, “For Sales, press 1.” Use the audio controls to record the prompt. For more 
information, see “Using the audio controls” on page 2-10.

3. In When caller presses, select the key that callers must press to select the menu 
choice. Valid keys are 0-9, *, or #.

4. In the Perform action drop-down list, select the action to perform when callers press 
the key. For a list of actions, see “Menu choice actions” on page 9-9.

For transfers to a user, IVR Plug-in, or queue, select an optional Announce prompt, 
that determines what callers hear when they select this menu choice:

Q Nothing. The call is transferred with no announcement.

Q Name or extension. Announces the name of the user, IVR Plug-in, or queue, using 
the voice title if available. If no voice title is available, the auto attendant announces 
the extension to which the call is transferring. 

Q One moment please. Announces “One moment please” as the call is transferred.
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5. Click the Advanced tab.

6. To change the language of subsequent prompts, check Change the caller’s telephone 
prompts to. Then select another language that was installed with TeleVantage from 
the drop-down list. When callers press the key for this menu choice, all subsequent 
prompts are in the language you specify here. 

For example, to give callers the option of accessing a dial-by-name directory in 
Spanish, set up a dial-by-name menu choice on the General tab, and then select 
Spanish on the Advanced tab.

7. To set the value for a custom data variable whenever this menu choice is selected, 
check Set custom data when this menu choice is pressed. Select the Variable 
name from the drop-down list and enter a Variable value. For more information, see 
“Using custom data to add information to calls” on page 9-18. To create a new 
variable, click  to open the Custom Data dialog box. 

8. Click OK to save the menu choice and return to the Auto Attendant dialog box.

9. On the Menu Choices tab, use the arrows to change the order in which menu choices 
are presented to callers. 

10. Add more menu choices or click OK to save the auto attendant.
9-12 ADMINISTERING TELEVANTAGE



Creating auto attendants without extension access
By default, all auto attendants permit the caller to dial extensions. However, sometimes you 
might want an auto attendant to offer menu choices only, for example an auto attendant whose 
only purpose is to transfer callers to call center queues, or an informational auto attendant that 
provides recorded messages based on caller choices. In such cases you might want to disallow 
extension dialing, to ensure that callers entering digits do not get transferred to extensions by 
accident.

To disallow extension dialing, uncheck Process all other digits as user extensions on the 
Menu Choices tab. When unchecked, the auto attendant responds only to the digits you define 
as menu choice selections.

When checked, the auto attendant permits the dialing of extensions.

Restricting an auto attendant to members of a workgroup
You can restrict an auto attendant to be able to reach only the extensions within a workgroup. 
When you do so, callers to the auto attendant can dial the extensions of workgroup members 
only, and the dial-by-name directory is restricted to workgroup members only. If they dial other 
extensions in the system, they receive an invalid extension message. You can use this feature 
when separate businesses share a TeleVantage Server, to make sure that callers to one business 
don’t reach users in another business. For more information about handling multiple 
organizations in a TeleVantage system, see Chapter 10.

To restrict auto attendant dialing to the members of a workgroup, check Restrict dial-by-name 
and extension matching to members of on the General tab, and select the workgroup. Click 

 to define a new workgroup (see “Creating a Workgroup” on page 7-4).

Note: When you restrict auto attendant dialing to a workgroup, callers who press 0 at the auto 
attendant are transferred to the workgroup’s If no answer, transfer extension, not the system’s 
Operator extension.

Scheduling transfers and greetings
You can customize an auto attendant to automatically change its behavior based on time of day 
or on special dates. You can schedule the following actions:

Q Playing of a different main greeting, which replaces the auto attendant’s regular 
greeting. For example, you can schedule a “We’re closed” greeting to be played to all 
callers after business hours and on weekends.

Q A transfer to any other extension, including another auto attendant, user, queue, IVR 
Plug-in, or workgroup. For example, to provide extended customer support coverage, 
support calls that arrive after your California office closes in the evening can transfer 
automatically to the main auto attendant at your facility in New Zealand.

Note: If you have scheduled a greeting and a transfer to occur at the same time, the transfer 
always takes precedence and the greeting does not play. Also, if you have two greetings or two 
transfers scheduled for overlapping times, the top-most scheduled item always takes 
precedence.
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To schedule transfers or greetings

1. In the Auto Attendants view, create a new auto attendant or double-click an existing 
auto attendant to edit it. The Auto Attendant dialog box opens. 

2. Click the Scheduled Actions tab.

The following table shows the information that appears for each scheduled action 
already defined for this auto attendant.

Column Description

Enabled If checked, the action will be performed as 
scheduled. If unchecked, the action is 
temporarily disabled.

Description Time period during which the action will be 
performed. 

Action Action that will be performed.
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3. Click Add to schedule a new action. Click Edit to modify the selected action. The 
Schedule Action dialog box opens.

4. Under This schedule entry occurs, select one of the periods of time during which the 
action will occur.

Note: If your TeleVantage system uses several sets of business hours, click 
Business Hours before you click OK in the Schedule Action dialog box and verify that 
the action will take place according to the set of business hours that you want to use. 
For more information about business hours, see “Setting Business Hours” on page 3-3.

If you choose During custom hours, click Custom Hours and see “Setting up custom 
hours” on page 6-24.

5. Under This schedule entry, select the action that the auto attendant will perform 
immediately when a call arrives during the period covered by the schedule entry:

Q Transfers to. Immediately transfers callers to the extension that you select from the 
drop-down list during the scheduled time period. 

Q Plays greeting. Immediately plays the greeting that you record during the 
scheduled time period. For more information, see “Using the audio controls” on 
page 2-10.

6. Check Enable this schedule action to activate this action as soon as you save the auto 
attendant. If unchecked, the action is temporarily disabled.

7. Click OK. The Schedule Action dialog box closes.

8. On the Scheduled Actions tab in the Auto Attendant dialog box, use the arrows to 
move a scheduled transfer or greeting to a different position on the list. If you have two 
greetings or two transfers scheduled for overlapping times, the one that is at the top of 
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the list will be used. If a greeting and a transfer are scheduled for the same time, the 
greeting is not played.

9. Click OK in the Auto Attendant dialog box to save your changes.

Setting up hold music
An auto attendant can play music that is different than the system-wide hold music. Callers hear 
an auto attendant’s hold music while the auto attendant is transferring them to an extension, and 
they continue to hear it while on hold until they reach a part of TeleVantage that uses different 
hold music, such as a queue or another auto attendant that has different hold settings. Each auto 
attendant can have its own hold music setting.

If you do not specify hold music for an auto attendant, the auto attendant uses the system default 
hold music. To configure system default hold music, see “Setting Server configuration” on 
page 3-5.

To set up different hold music for an auto attendant

1. In the Auto Attendant dialog box, click the Hold tab.

2. Check Play hold music from station number and enter the station number of an 
attached CD player or other music-on-hold device. 

3. Click OK.

Assigning an auto attendant to a trunk
In the Trunk dialog box or on the Trunks tab of an Internet span, select the auto attendant under 
Calls are sent to.

Deleting auto attendants
If you delete an auto attendant, all trunks using that auto attendant will use the Default Auto 
Attendant. You cannot delete the Default Auto Attendant.

For more information about deleting items in TeleVantage, see “Deleting items” on page 2-9.
9-16 ADMINISTERING TELEVANTAGE



Routing calls to users_____________________________________
When you route calls directly to users, all incoming calls on the dedicated trunk are sent to that 
user. If the user is busy or does not answer, the calls follow the user’s routing list. 

By routing calls directly to a user, you can do the following:

Q Send incoming calls on the trunk to a live Operator who then transfers the calls to the 
appropriate destination. You can do this on all your trunks.

Q Send incoming calls on the trunk to a user. If your phone lines do not support direct 
inward dial (DID), this is the only way to let callers dial a user directly (without going 
through an auto attendant).

To route calls on a trunk to a user, select a user in the Calls are sent to drop-down list on the 
Trunk dialog box. See “Adding an analog trunk” on page 5-9.

Routing calls to extensions ________________________________
To route calls on a trunk to any extension (user, auto attendant, queue, IVR Plug-in, or 
workgroup), modify the trunk in the dialog box specified in the next table.

For more information about routing inbound calls on a trunk, see Chapter 5, “Managing Trunks, 
Spans, and Stations.” 

Routing calls to workgroups _______________________________
You can have incoming calls ring the phones of all users in a workgroup at the same time. The 
first user to answer the call is connected to the caller. This feature is handy for departments or 
small offices in which it does not matter who answers an incoming call.

To route calls on a trunk to a workgroup, select a workgroup in the Calls are sent to drop-down 
list on the Trunk dialog box. See “Adding an analog trunk” on page 5-9.

Note: You can also select a workgroup in the Faxes are sent to drop-down list on the Trunk 
dialog box, to direct incoming faxes to a bank of fax machines or a fax server with many ports. 
The first fax machine to answer receives the fax.

Trunk type To modify trunk, open this dialog box

Analog trunk Trunk dialog box

Robbed Bit T1 
span

Robbed Bit T1 Span dialog box, Trunks tab

Internet span Internet Span dialog box, General tab

ISDN/CAS T1/E1 
span

ISDN/CAS T1/E1 Span dialog box, Trunks tab
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If you want to route calls to a group of people using a distribution algorithm other than 
simultaneous ring, create a placeholder user whose routing list calls the workgroup, and route 
calls to the placeholder user. See Using TeleVantage for instructions on creating routing lists.

Using custom data to add information to calls _________________
TeleVantage lets you attach extra information to incoming calls, using custom data variables. 
The information is displayed to users in the Client’s Call Monitor, and can also be used to 
automate call handling. Examples of attaching extra information to calls using custom data 
variables include the following:

Q Based on the caller’s auto attendant choice, set a variable called Product to the name of 
the product that the caller is calling about. For example, callers who press 1 have 
Product=“Widget,” while callers who press 2 have Product=“Advanced Widget.” When 
users answer the calls they see the product name in the Call Monitor in a column labeled 
“Product.”

Q Based on contact recognition, set a variable called Priority to a higher number for VIP 
callers to a call center queue. For example, a normal caller has Priority=1, while a VIP 
caller has Priority=10. VIP callers are automatically bumped closer to the head of the 
queue.

Using custom data variables is a two-step process, as follows:

1. Defining a custom data variable.

2. Setting the value for a custom data variable.

These steps are described in the following sections.
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Defining a custom data variable
You can define as many custom data variables as you want.

1. In the Administrator, choose Tools > Custom Data. The Custom Data dialog box 
opens, listing all the custom data variables you have created so far.

Each custom data variable is attached to every incoming call, though a given variable 
might not be used for every call.

Note: If you have purchased the TeleVantage Call Center module, two system 
variables are present by default, Expected wait time and Number of people ahead. For 
instructions on using them, see the TeleVantage Call Center Administrator’s Guide.

2. To create a new custom data variable, click Add. The second Custom Data dialog 
opens.

3. Enter the following information for the custom data variable:

Q Name. Enter a name for the variable. Keep the name relatively short, as it will 
appear in a column header in the Client’s Call Monitor.

Q Description. Enter a description of the variable if needed.

Q Data Type. This determines the type of information that the variable holds. Select 
one of the following:

Q Long. An integer number.

Q Double. A number that have decimal places.
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Q Boolean. The value must be either 0 or 1.

Q String. Text. Numbers can be part of the text string, but they are treated as text 
characters.

Q Default value. Enter the value that the variable receives if no other action sets a 
value. For string variables you can leave the field blank, meaning the variable is 
empty by default. For numeric variables you must enter a number, usually 0.

4. Click OK to add the custom data variable to the list.

5. Click OK to close the Custom Data dialog box that shows the list.

The variable you created is now attached to every incoming call, and users have a corresponding 
column in the Call Monitor where they can view the variable’s value for each call.

Setting the value for a custom data variable
You can have TeleVantage set the value of a custom data variable in the following ways:

Q Auto attendant choice. When defining an auto attendant menu choice, you can have it 
set the value of a custom data variable. See “Defining menu choices” on page 9-8.

Q Call center queue. If you purchased the TeleVantage Call Center module, you can have 
a queue set the value of a custom data variable based on caller data entry. See the 
TeleVantage Call Center Administrator’s Guide.

Q IVR Plug-in. An IVR Plug-in can set the value of custom data variables based on a 
variety of methods, including when it was called and caller data entry. For more 
information see Chapter 14, “Extending TeleVantage.” 
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About multiple organizations _______________________________
With TeleVantage you can have multiple businesses or contractors in an office that share the 
same Server and trunks, yet are independent of each other in terms of caller experience and 
internal billing. TeleVantage refers to such groups as Organizations.

With the Organizations feature, callers to a user hear an auto attendant greeting specific to that 
user’s Organization, and from the auto attendant can dial only the extensions of users within that 
Organization. The Call Log also shows which outbound calls belong to each Organization, 
allowing easy accounting and billing to the appropriate Organizations for the calls their users 
make.

TeleVantage also provides full support for user-entered account codes. With account codes you 
can distinguish any group of calls for reporting and accounting purposes. The calls can include 
both outbound and inbound calls. For example, if your office contains employees or contractors 
whom you bill separately for their phone use, you can use account codes to mark calls by the 
user they belong to. Other uses of account codes include marketing campaigns, case and issue 
tracking, and more.

Using Organizations ______________________________________
Once you define one or more Organizations, and assign each user to the appropriate 
Organization, you can do the following:

Q Log outbound calls by Organization for purposes of tracking or billing.

Q Restrict callers at the auto attendant to dialing only the extensions of users in the 
Organization they’re calling.

Q Distribute outbound trunk use between Organizations.

This section covers the following aspects of using Organizations:

Q “Defining an Organization” (page 10-3). 

Q “Assigning users to Organizations” (page 10-3). 

Q “How calls are logged by Organization” (page 10-4). 

Q “Creating an auto attendant for each Organization” (page 10-4). 

Q “Restricting outbound trunk use by Organization” (page 10-4). 

Q “Configuring Operators for multiple Organizations” (page 10-5). 
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Defining an Organization
To use Organizations, you must first define them.

1. Choose Tools > Organizations. The Organizations dialog box opens, listing all the 
Organizations you have defined so far.

Use this dialog box to edit or delete an existing Organization. Click the Organization, 
then click Edit or Delete.

2. To add a new Organization, click Add. The Organization dialog box opens.

3. Enter the name of the Organization, for example, the name of the company that is 
sharing the TeleVantage Server.

4. Click OK to return to the Organizations dialog box.

5. Click OK.

Assigning users to Organizations
Once you have defined Organizations, you can mark outbound calls by which Organization they 
belong to. You can view a call’s Organization using the Organization column in the Call Log, 
and TeleVantage reports, and easily sort by Organization for tracking or accounting purposes. 
You can also display a call’s Organization in the Client’s Call Monitor.

To assign a user to an Organization, edit the user, and use the Organization field, on the Other 
tab of the User dialog box.

See “Adding users” on page 6-7 for complete information about setting up a user’s account.

All calls placed by the user are associated with the user’s Organization. 
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How calls are logged by Organization
Only outbound calls are logged by Organization. Incoming calls appear in the Call Log with the 
Organization column blank.

Outbound calls are logged with the Organization of the user who placed the call.

Note: If a call center queue agent uses the *14 telephone command to place calls as the queue, 
the call is still logged with the Organization of the agent, not the Organization of the queue.

Conference calls are logged with the Organization of the user who started the conference call.

Creating an auto attendant for each Organization
Assuming that each Organization has its own phone number, you can define a separate auto 
attendant for each Organization. Callers will then hear a greeting and menu choices specific to 
the Organization they’re calling, and they will be unable to accidentally dial users in other 
Organizations, either by extension or dial-by-name. 

To create an auto attendant for an Organization

1. Create a public workgroup containing the same users that are the members of the 
Organization. For instructions see “Creating a Workgroup” on page 7-4.

2. Define an auto attendant as described in “Setting up an auto attendant” on page 9-6. 
Check Restrict dial-by-name and extension matching to members of on the Menu 
Choices tab, and select the workgroup.

3. Route the trunk(s) corresponding to the Organization’s phone number to the auto 
attendant. See “Assigning an auto attendant to a trunk” on page 9-16. Alternately, edit 
the auto attendant to give it the appropriate DID number. See “Creating a new auto 
attendant” on page 9-7.

Restricting outbound trunk use by Organization
You can restrict the use of one or more outbound trunks to specific users, such as the members 
of an Organization. For example, if one company within an office has paid for extra trunks for 
its business, you can ensure that only members of that business use those trunks for outbound 
calls.

To restrict outbound trunk use by user, you set up dialing services and a routing service as 
follows:

1. Create one dialing service for each group of trunks. Set up each dialing service to route 
calls to the trunks appropriate for that group.

When creating these dialing services, make sure that Include in dial plan is 
unchecked, so users cannot access these dialing services directly.

For example, if the members of company ABC can use trunks 1-4, and the members 
of Company YYZ can use all trunks 1-8, create two dialing services, one that routes 
calls to trunks 1-4, and a second that routes calls to trunks 1-8.
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2. Create a routing service as described in “Adding a routing service” on page 8-26. Give 
it an easily-to-use access code, for example, 9.

3. In the routing service, make sure there are routing rules for each dialing service you 
created in step 1. For each routing rule, do the following:

Q Click Route the call to another dialing service and specify one of the dialing 
services from step 1.

Q Check Membership and click . Add as members all the users (or other entities) 
who can use the dialing service’s trunks. 

Optionally, click Schedule if you want to restrict an Organization’s calls over a set 
of trunks to a particular time.

For added convenience, you can define a role for each company that contains all the 
employees of that company, then add the role as a member here. See “Managing 
roles” on page 6-46.

For example, if you selected the dialing service for Company YYZ, add as members 
all the users from Company YYZ. 

For detailed instructions on setting up routing services, see “Adding a new routing 
rule” on page 8-27.

When you have completed these steps, all users can dial the same access code to place outbound 
calls (for example, 9), but each company’s users will have their calls routed on the trunks 
reserved for that company.

Configuring Operators for multiple Organizations
At several places in the TeleVantage system, callers can press 0 to transfer to an Operator (see 
“Operators” on page 6-3). With multiple Organizations, you might want to have a different 
Operator for each Organization. To set up multiple Operators and make sure that callers reach 
the right Operator for the Organization they are calling, do the following:

1. Decide which extensions will be the Operators for the different Organizations. For 
example, 101 for Company ABC, and 102 for company YYZ. These examples are 
used in the following steps.

2. Edit each user. On the General tab under Operator, select the Operator extension 
appropriate to the user’s Organization. For example, if a user belongs to Organization 
ABC, select extension 101. This ensures that callers pressing 0 while leaving a user 
voicemail are handled correctly.

For full instructions, see “The General tab” on page 6-10.

3. If you have restricted one or more auto attendants by workgroup (see “Creating an auto 
attendant for each Organization” on page 10-4), edit each workgroup specified by an 
auto attendant. On the Dialing tab under If no answer, transfer, select the Operator 
extension appropriate to the Organization. For example, if the workgroup holds the 
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members of Organization YYZ, select extension 102. This ensures that callers 
pressing 0 at an auto attendant are handled correctly.

For full instructions, see “When no one answers a call to a workgroup” on page 7-6.

4. If you are using TeleVantage call center queues, edit each queue. On the General tab 
under Operator, select the extension appropriate to the queue’s Organization. For 
example, if the queue belongs to Organization ABC, select extension 101. This 
ensures that callers pressing 0 while leaving the queue voicemail are handled correctly.

See the TeleVantage Call Center Administrator’s Guide for complete information on 
creating and using a call center.

5. You can set up the default Operator at extension 0 to automatically transfer calls to the 
correct custom Operator based on who is calling. To do so, you must have created a 
workgroup for each Organization, containing all the users in that Organization. Edit 
the default Operator in the Client. For each Organization, create a call rule that 
activates for that Organization’s workgroup, and sends calls to the appropriate custom 
routing list. For each Organization, define a custom routing list to have no steps, only 
a final action that transfers the call to that Organization’s custom Operator. For 
example, the call rule that activates for workgroup ABC would send calls to a routing 
list that transfers them to extension 101.

See Using TeleVantage for instructions on creating call rules and routing lists.

Using account codes to track phone usage ___________________
TeleVantage allows you to track your phone traffic by either forcing or optionally allowing 
users to enter an account code for each call. Account codes can represent any aspect of your 
phone traffic—customer number, product line, department, and so forth—that you want to track. 
You can define the available account codes and tell your users the codes that they should or must 
enter under specific circumstances. 

Some of the ways you can use account codes are as follows:

Q For billing clients. With account codes you can track calls to various customers whom 
you bill for the phone time you spend with them. You can associate account codes with 
contacts for automatic customer tracking.

Q For internal accounting. If phone bills are a significant part of your company’s 
expenses, you can use account codes to perform detailed expense analyses. For example, 
you can track phone use by department.

Q For marketing campaigns. By setting up an account code for the campaign and having 
agents use it whenever they place or receive campaign calls, you can track the time, 
resources, and results of the campaign.

Account code information appears in the Call Log (see “Using the Call Log view” on 
page 11-10), and you can generate reports using the TeleVantage Call Center Reporter that show 
calls by account code. For information about the Call Center Reporter, see TeleVantage Call 
Center Administrator’s Guide.
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Example: Your office is working on the Gould case and the Avellanos case. You give the Gould 
case an account code of 88 and the Avellanos case an account code of 55. Whenever users place 
or receive calls relating to the Gould case, they enter 88. Whenever they place or receive calls 
relating to the Avellanos case, they enter 55. You can then run a report that sorts calls by account 
code and see the phone traffic for the Gould and Avellanos cases separately. You can also run a 
report that sorts by user, so that you can see how much phone time a specific user spent on each 
case.

Account code modes
On a per-user basis, you can set account code entry to be voluntary or required. You can also 
choose to have the system verify account codes against a list of valid account codes.

The following account code modes are available:

Q Optional non-verified. The user is not prompted to enter account codes, but can enter 
one if desired. If the user does enter an account code, it is not checked against the list of 
valid account codes.

Q Optional verified. The user is not prompted to enter account codes. If the user does enter 
an account code, it is checked against the list of valid account codes. If the account code 
is invalid, the user is prompted to enter it again.

Q Forced non-verified. The user is required and prompted to enter an account code when 
placing an external call. The account code is not checked against the list of valid account 
codes. This option is not available for inbound or internal calls.

Q Forced verified. The user is required and prompted to enter an account code when 
placing an external call, and the account code is checked against the list of valid account 
codes. If the account code is invalid, the user is prompted to enter it again in order to 
make an external call. This option is not available for inbound or internal calls.

How users enter account codes
Users can enter account codes for calls in the following ways:

Q When prompted by the system while placing an outbound call. Only users forced to 
enter account codes encounter this prompt. Exactly where the prompt occurs in the 
dialing sequence depends on whether you checked Collect account code before 
dialing number (see “Setting general account code options” on page 10-9).

By default the account code prompt is a beep. To change it, see “Using a verbal account 
code prompt” on page 10-12.

Q During a call. On an inbound or outbound call, users can press Flash to put a caller on 
hold, then *11 to enter an account code for the current call. In the Client, they can 
right-click the call in the Call Monitor and choose Enter account code from the shortcut 
menu. Users can use this command as many times as they want during a call to change 
or correct the account code. The last account code entered is the one that is used for the 
call. 
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Q Before dialing a call. A user can press *11 before dialing a call to enter an account code 
for that call. The user picks up the phone and dials *11 <account code> <access code> 
<phone number>. In the following example, spaces are shown for clarity:

*11 8877 9 212 123 4567 

In this example, 8877 is the account code and 9 is the access code.

In the Client, users can enter an account code before placing a call by using the Place 
Call To dialog box (or the Dial field in any view). To do so, they type the phone number, 
then a vertical bar ( | ), then the account code. 

Q After a call has finished. In the Client, a user can enter an account code for a completed 
call by selecting the call in the Call Log and choosing Actions > Enter account code. 
The user must have the permission Access Call Log folder set to “View and Edit” (see 
“TeleVantage permissions” on page 6-49).

Indicating the end of an account code
When users use the phone to specify account codes, TeleVantage detects the end of an account 
code when any of the following occurs:

Q The account code reaches the maximum number of digits. To define the maximum 
number of digits, see “Setting general account code options” on page 10-9.

Q The user presses #.

Q Three seconds elapse after the user entered a digit. The system uses the digits already 
entered as the account code that the user intended to enter. 

If a user does not enter an account code before 5 seconds have elapsed after the beep, the 
system beeps again to prompt the user to enter the account code.

Note: If you have a high maximum number of digits and your account codes can be of variable 
lengths, you should encourage users to press # when they reach the end of an account code.

Users can cancel an account code entry while they are entering it by pressing *.
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Setting general account code options
Before setting up account code modes for individual users, you should configure the 
system-wide account code options as follows:

1. Choose Tools > Account codes. The Account Codes dialog box opens.

2. Under Default inbound mode and Default outbound mode, choose the account code 
modes that you want to be active at stations to which a user has not been assigned. For 
an explanation of the modes, see “Account code modes” on page 10-7.

3. Check Collect account code before dialing number to prompt users for an account 
code immediately after they dial a dialing service access code (for example, 9). 
Uncheck the box to prompt users for an account code after they have finished dialing 
the entire phone number.

4. Check Verify account code according to range to have the system verify account 
codes by length. If an account code contains too many digits or too few digits, users 
are prompted to enter it again. Under Minimum length and Maximum length, specify 
the acceptable range for account code length. For example, if account codes in your 
system can be two, three, or four digits, enter a Minimum length of 2 and a Maximum 
length of 4. 

Note: It is more efficient to set Minimum length and Maximum length to the same 
number and use account codes that are all the same length. When set up this way, the 
system immediately recognizes when users finish entering an account code, so they do 
not need to press # at the end of the account code. When account codes are of variable 
length, users must press # to end the account code or there will be a slight pause while 
the system waits for more digits.

If Minimum length and Maximum length are both set to 0, account codes will not be 
verified by length.

5. Click OK.
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Setting a user’s account code modes
For each user, you can define whether account code entry is voluntary or forced, and whether 
the system verifies entered account codes against a list of valid account codes.  

For complete instructions on defining a user, see “Adding users” on page 6-7.

To set a user’s account code modes

1. Double-click a user in the Users view. The User dialog box opens. You can also set 
account code modes when you create a new user.

2. Click the Dialing tab.

3. Under Account codes at the bottom of the dialog box, select the user’s account code 
modes for inbound and outbound calls. See “Account code modes” on page 10-7.

4. Check Allow automatic account code lookup to enable automatic association of 
account codes with contacts for this user. If enabled, the user can enter an account code 
for each contact, and the system automatically applies the account code to calls to and 
from the contact. See Using TeleVantage for more information about using contacts.

5. Click OK.

Creating a valid account code list
If you want to use verified account codes for some or all users, you must create a text file that 
lists your valid account codes. The text file must be called Accountcode.txt and must reside in 
the \Accountcode directory on the TeleVantage Server computer. By default, the complete path 
is:

C:\Program Files\TeleVantage Server\Accountcode\Accountcode.txt

When a user whose account code mode is set to “Verified” enters an account code, TeleVantage 
checks the account code against the contents of the text file. If the account code is not listed in 
the text file, TeleVantage prompts the user to enter it again.
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Formatting the text file
Type each account code as a separate line in the text file. Blank lines are permitted and are 
ignored by the system. If you want to add a comment line that is ignored by the system, begin 
the line with a semicolon (;).

Account codes can contain only the numbers 0 through 9 and the wild card characters ? and % 
(see the next section).

Note: Account codes in the text file must meet your account code length requirements or they 
will not be added to the list of valid account codes. For example, if your account codes must be 
between 2 and 4 digits, a 5-digit account code will be rejected even if it appears in the text file. 
See “Setting general account code options” on page 10-9 for instructions on setting account code 
length requirements.

Using wild card characters
You can use the wild card characters ? and % when you enter valid account codes in the text file:

Q Question mark (?). Indicates any single digit. For example, an account code entry of 12? 
would make 123, 124, and 129 all valid account codes. In this case, however, neither 12 
nor 1233 would be valid account codes. 

Q Percent sign (%). Indicates any number of digits, including none. For example, an 
account code entry of 12% would make 12, 123, 1233, and 12789213120 all valid 
account codes. 

If you use either of these wild card characters in an account code, it must be the final character 
in an account code, and if you use both of these wild card characters in the same account code, 
the % character must be the final character.

Valid Invalid

12? 1?2

12?? 1%2

12% ?12

12?% %12

12?????% 12%?
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Note: Account codes that are identical except for wild card characters conflict with each other. 
For example, 1234 conflicts with 1234? and 1234%. In the case of conflicting entries, only the first 
entry is used to verify account codes.

Using a verbal account code prompt
By default, the account code prompt is a single beep. You should explain to your users that they 
must enter an account code when they hear the beep. TeleVantage provides an alternate account 
code sound file, with a verbal prompt that says, “Please enter an account code.”

To use the verbal account code prompt instead of the beep

1. Find the file AccountCodePrompt.vox in the user directory. This file contains the beep. 
By default the path is C:\Program Files\TeleVantage 
Server\Vfiles\User\AccountCodePrompt.vox.

2. Rename the file, for example, to AccountCodePrompt.vox.beep.

Users now hear the verbal prompt instead of the beep when they are prompted to enter an 
account code. 

Note: By renaming the beep file, TeleVantage automatically uses another 
AccountCodePrompt.vox file, which is found in your language directory and which contains the 
verbal prompt. The default path for the English language verbal prompt file is the following. It (or 
any other language version of this file) can be rerecorded using the System Prompts view.

C:\Program Files\TeleVantage Server\Vfiles\EN00\AccountCodePrompt.vox

Viewing account codes in the Call Log or Call Monitor
The Call Log view contains an Account Code column that shows the account code associated 
with each call. If the Account Code column is blank, no account code was entered for the call. 
Click the Account Code column header to sort the Call Log by account code. For more 
information, see “Using the Call Log view” on page 11-10.

Note: In the Call Log you can you can change a call’s account code or enter a new one. Select 
the call and choose Call Log > Enter Account Code. You must have the permission Access 
Call Log folder set to “View and Edit” (see “TeleVantage permissions” on page 6-49).

The Client’s Call Monitor view also contains an Account Code column, but it is hidden by 
default. In the Call Monitor view, choose View > Current View > Show Columns to display it.

Generating account code reports
For information about generating reports that show account code usage, see the TeleVantage 
Call Center Administrator’s Guide.

You can also export the Call Log, with its account code information, to a .CSV file that you can 
view in spreadsheet applications. See “Exporting the Call Log” on page 11-13.
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About monitoring and backing up your TeleVantage system _____
This chapter describes several aspects of monitoring and backing up your TeleVantage system. 

You can also monitor your system using the TeleVantage Call Center Reporter, which lets you 
run reports on a variety of system elements, including trunk use, call traffic, queues, agents, 
identified callers, account code use, and more. For more information on running the Call Center 
Reporter, see TeleVantage Call Center Administrator’s Guide.

You can also automatically record system calls. See Chapter 4.

Using the Device Monitor view______________________________
The Device Monitor view shows current station and trunk activity on your TeleVantage system. 
This information is useful when you are monitoring current usage and identifying potential 
bottlenecks. 

Note: You can view the same information and perform the same tasks by using the Device 
Monitor utility, which runs independently of the Administrator. The Device Monitor utility 
(TVDevmon.exe) is located in the TeleVantage Server directory, by default C:\Program 
Files\TeleVantage Server.
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Monitoring station activity
The following table shows the information that is presented in the upper pane of the Device 
Monitor view for each TeleVantage station (internal telephone).

Column Description

Station Number that corresponds to the MSI board 
resource to which a phone is attached.

Idle station. (Also called on-hook.)

Active station. (Also called off-hook.)

Status Current station activity. Station status codes 
include:

Startup. TeleVantage system is starting.

Pre-idle. A brief period just before the station 
goes idle.

Hands-free. Station is in hands-free mode.

Idle. Station is free (on-hook). 

In Call. Station is in use (off-hook).

Playing hold music. Station is used for music 
on hold.

Reorder. Station has been left off-hook for too 
long or is in an error condition.

Navigating TUI. User is logged in on the trunk 
and listening to the auto attendant menu.

Not responding. Station is not responding to 
device status queries.

The Status column can also show custom status 
information set by an IVR Plug-in that has been 
called by a station.

Device Type The type of station. The types are:

MSI. Analog phone

DKT. Toshiba digital phone
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Monitoring trunk activity
The following table shows the information that appears in the lower pane of the Device Monitor 
view for each trunk configured in TeleVantage.

Assignment Name and extension of the user permanently 
assigned to this station. This column may also 
contain:

Not assigned. 
Station is not currently used.
Not installed. Station has been configured for a 
user, but the supporting hardware has not yet been 
installed.

Logged In Name of the user currently logged in at the station.

Column Description

Column Description

Trunk Trunk number that corresponds to the resource on 
the trunk board to which the line is connected.

Idle trunk. 

Active trunk. 
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Status Current trunk activity. Some of the trunk status 
codes are:

Idle

Trunk is free (on-hook).

In call

Trunk is in use (off-hook).

Dialog Node. Caller is listening to the auto 
attendant menu or going down a routing list.

Calling. TeleVantage is ringing the trunk.

No loop current. Trunk is not connected to the 
telephone company.

Reorder. Trunk is in an error condition.

Navigating TUI. User is logged in on the trunk 
and listening to the auto attendant menu.

Not configured. Trunk is not currently used.

Not installed. Trunk has been configured, but 
the supporting hardware has not yet been 
installed.

The Status column can also show custom status 
information set by an IVR Plug-in that is connected 
to a trunk.

Device Type The type of trunk. The trunk types are:

DXXX. Analog trunk.

DTI. Digital trunk (Robbed Bit T1, ISDN, or 
BRI).

DM3. Internet trunk

In If checked, the trunk is used for inbound calls.

Out If checked, the trunk is used for outbound calls.

Enabled If checked, the trunk is enabled for use by 
TeleVantage. 

Name Optional descriptive name for the trunk.

Column Description
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Enabling and disabling trunks
For testing purposes, you can enable or disable one or more trunks without shutting down 
TeleVantage. Select the trunk and choose Device Monitor > Disable/Enable Trunk. You can 
disable multiple trunks at once by CTRL-clicking them in the Device Monitor. The Enabled 
column in the Device Monitor view reflects the current state of a trunk. 

When a device is disabled, TeleVantage does not process any events for the device. No calls, 
either inbound or outbound, can be placed on the disabled device. While the device is disabled, 
you can run various Dialogic utilities on the trunk, such as ISDIAG or DMU, to determine the 
correct call parameters or troubleshoot the trunk. You can then apply these parameters to the 
TeleVantage registry, enable the device, and try placing a call again.

Disabling a trunk does not allow you to modify Dialogic settings. The following restrictions on 
modifying Dialogic settings still apply:

Q You cannot modify Dialogic .PRM file settings and have them take effect without 
restarting the Dialogic drivers. 

Q You cannot modify Dialogic DCM settings while the drivers are running.

Q You cannot disable a Dialogic board via the DCM without first stopping the 
TeleVantage Server and the Dialogic drivers.

The TeleVantage performance counters ______________________
When the TeleVantage Server is installed, the installer registers with Windows a set of 
TeleVantage-specific performance counters for tracking statistics of the Server as it runs. The 
counters are organized into two groups: Phone System Calls and Phone System Devices. The 
counters can be monitored by system administration tools such as the performance monitoring 
utilities provided with Windows. 

The Phone System Calls group has the following counters:

Q Existing calls. Total number of active calls currently being handled by TeleVantage.

Q Total calls. Total number of calls handled by the Server since it was last started.

The Phone System Devices group has the following counters:

Q Stations. Total number of configured stations (phones) in the system.

Q Station in use. Number of stations off-hook.

Q % stations in use. Percentage of stations off-hook.

Q Trunks. Total number of configured trunks in the system.

Q Trunks in use. Number of trunks allocated to calls.

Q % trunks in use. Percentage of trunks allocated to calls.

Q Voice Resources. The total number of shared voice devices, plus any disconnected 
voice devices. A disconnected voice device is an LSI port without a physical trunk 
plugged in, that displays as “No Loop Current” in the Device Monitor. For example, if 
a system had one D/160SC-8LS trunk board with physical trunks plugged into four of 
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the eight slots, the Performance Counters voice resource figure would be 12—eight 
shared plus four disconnected.

Q Voice Resource in use. Number of voice resources currently being used.

Q % voice resources in use. Percentage of voice resources currently being used.

Viewing performance counters in Windows
The performance monitoring utility that comes with Windows is the application most commonly 
used to view performance counter information. You can add TeleVantage counters to a 
performance monitor’s display just as you can with the pre-installed Windows counters.

Note: This appendix does not describe the performance monitoring utility in depth. See the 
utility’s Help if you need more detailed information. 

In Windows NT, the utility is a stand-alone application called the Performance Monitor. To start 
Performance Monitor, choose Start > Administrative Tools > Performance Monitor. 

In Windows 2000, the utility is part of the Microsoft Management Console and is called the 
System Monitor. To start the Management Console, choose Start > Administrative Tools > 
Performance. The following examples use the System Monitor from Windows 2000.

To add the TeleVantage counters to the System Monitor display, right-click on the display and 
choose Add Counters from the shortcut menu. In the Add Counters dialog box, choose one of 
the TeleVantage groups from the Performance object drop-down list. 
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As shown in the next figure, TeleVantage performance counters for the group you have chosen 
are listed under Select counters from list. To add a counter, select it from the list and click Add. 
Repeat this process for each counter that you want to display. When you have selected all of the 
counters that you want to view, click Close. 

The counters you have selected are listed below the performance graph in the main System 
Monitor window.
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Restarting stations or trunks _______________________________
The TeleVantage Server periodically tests stations and trunks to see if they are responding. If a 
device is not responding, TeleVantage writes the following warning message to the Windows 
Event Log: “Device n is not responding.”, where “n” is the device number (positive numbers are 
stations, negative numbers are trunks.) The default testing interval is 5 minutes. For information 
about modifying the interval or turning off the setting, see “MonitorInterval” on page A-4.

Some error conditions may make a trunk or station unusable, and you must restart the device 
manually. For example, if a single station shows the status “Reorder” and does not respond to 
picking it up and hanging it up again, then you must restart it to re-establish the connection to 
TeleVantage. Generally, if the status of a device does not seem to reflect its actual status and 
you have checked the phone or trunk line to see if it is working, you must restart the device. 

Similarly, you can manually restart a trunk that has become unstable because of an error 
condition. You also must restart a trunk using the Device Monitor view to detect loop current 
on a newly added trunk before TeleVantage can use it. With digital trunk types you can choose 
to restart the entire span.

Both automatic and manual restarts are logged in the Windows Event Log. For more information 
about how to use the Windows Event Log with TeleVantage, see “Viewing the Windows Event 
Log” on page 11-19.

Note: Be aware that restarting a device may take up to 30 seconds. During that time, you cannot 
perform any other operations in the Device Monitor view. 

To restart a station or trunk

1. Do one of the following:

Q To restart a single device, select the device and choose Device Monitor > Restart 
Station, Restart Trunk, or Restart Span. The Restart Span command is available 
for digital trunk types, and restarts all trunks in the span.

Q To restart multiple devices, press CTRL or SHIFT while you select trunks or 
stations, right-click, and then choose Restart Devices on the shortcut menu. You 
cannot restart both trunks and stations in the same operation.

2. Click Yes to confirm the restart.

Starting a new Server log
Choosing Device Monitor > Start new Server log creates a new TeleVantage Server log file. 
Perform this operation only under the direction of your TeleVantage provider. 
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Using the Call Log view____________________________________
The Call Log view displays a record of the calls placed and received on the TeleVantage system. 
Each call appears as a row in the view. You can use the Call Log view to analyze system usage 
patterns, and you can export Call Log records to generate traffic analysis reports.

To open the Call Log view, click its button in the view bar.

The following table shows the information that is displayed for each call.

Column Description

From Name of the person who placed the call. On incoming 
calls, “Unknown” appears unless the user identified 
the caller as a contact. On outgoing calls, this column 
contains the user’s name.

To Name of the party who received the call. On incoming 
calls, the user’s name appears. On outgoing calls, 
“Unknown” appears unless the user identified the 
person as a contact.

Answered By Name of the user who answered an incoming call. 
Useful for analyzing data for ACD workgroups.

Number On incoming calls, Caller ID name and number if 
available. On outgoing calls, the number the user 
dialed. On a call to or from another TeleVantage user, 
this field contains <NA>.
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From Number On incoming calls, the caller’s extension or external 
phone number. On outgoing calls, the user’s 
extension.

To Number On incoming calls, the user’s extension or, if the user 
called into TeleVantage externally, the external 
number. On outgoing calls, the external number or 
extension the user called.

Callback 
Number

If a caller enters a callback number, it appears with 
the prefix “Callback:” 

Called 
Number

On incoming calls, your Direct Inward Dial (DID) 
number if the caller used it to call you. The field is 
blank for incoming calls without DID. On outgoing 
calls, the number you dialed.

Start Time Date and time that the call started.

Wait Time On incoming calls, the length of time between dialing 
the user’s extension and the call being answered. On 
outgoing calls, Wait Time is always 00:00.

Duration Length of time that the parties are connected.

Result How the caller's wait ended. The assigned values for 
the possible outcomes are:

Abandoned. Caller hung up before call was 
answered.
Connected. Caller was connected to a party.
To voice mail. Caller went to voice mail, but did not 
necessarily leave a message.
Blind transfer. A blind transfer sent the caller to 
another party.
Supervised transfer. A supervised transfer sent the 
caller to another party.
Unknown. TeleVantage was unable to identify the 
outcome of the call.
Login. Caller logged in to a valid TeleVantage user 
account.

Account Code The account code entered for the call, if any.

Message If checked, the caller left a voice message.

Recorded by 
User

If checked, this call was recorded by a user who 
handled it.

Column Description
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Recorded by 
Queue

If checked, this call was automatically recorded by a 
call center queue.

From Device On incoming calls, the trunk or extension from which 
the call originated. On outgoing calls, the user’s 
station number.

To Device On incoming calls, the user’s station number. On 
outgoing calls, the trunk used for the call. If an 
incoming call was transferred, this column shows the 
last station that took the call.

Parties Number of people who took part in the call, including 
the caller, the called party, anyone to whom the call 
was transferred, and any conference call participants.

Dial String Digits that TeleVantage actually dialed over the trunk, 
which may be different than the digits TeleVantage 
displays in a contact's phone number. For example, a 
dial string may contain an international or 
long-distance access code, a dialing prefix, or a 
dialing suffix.

From Type Type of incoming call: Phone, IP Gateway, or Internet.

From Code Access code of the dialing service that will be used to 
return this call. Only applicable to calls coming in from 
remote TeleVantage Servers over an Internet trunk.

From Rules If checked, TeleVantage's routing rules will be applied 
when returning this call.

To Type Type of outgoing call: Phone, Centrex, or Internet.

To Code Access code used to dial an outbound call.

To Rules If checked, routing rules were used to make an 
outbound call.

Organization Organization associated with the call, if any. 
Organizations are associated with outbound calls 
only, and represent the Organization to which the 
calling party belongs. For more information see 
“Using Organizations” on page 10-2.

Custom Data Custom data, if any, associated with the call. 

Column Description
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Displaying a specific number of Call Log entries
The Call Log can become very large over time and its size can cause a delay in its display. To 
reduce this delay, you can view fewer Call Log items at one time and not load the full database. 

To set the number of calls displayed in the Call Log

1. Choose Tools > Options. The Options dialog box opens.

2. In Display __ calls at a time, enter the number of entries that you want to appear when 
you open the Call Log view, using the following as a guide:

Q A high setting will likely cause a delay while the specified number of entries are 
copied over the network, but you can navigate within the information easily using 
the scrolls bars after the entries have been retrieved.

Q A low setting minimizes the delay before information is displayed, but you must 
retrieve entries more often in order to view the entire Call Log.

3. Click OK.

Note: This option controls how many entries are transferred in one request, but does not limit 
the entries available for view. All Call Log entries are always available by choosing Call Log > 
Next __ Calls or Previous __ Calls, or using the buttons on the toolbar.

By default, only external calls are logged. For information about logging internal calls, see 
“Logging internal calls” on page 3-8. For information about archiving the Call Log, see 
“Archiving the Call Log” on page 11-14.

Entering an account code for a call
To enter an account code for a call or change the one already entered, select the call and choose 
Call Log > Enter Account Code.

Account codes are a means of marking calls for tracking or billing purposes. For more 
information, see “Using account codes to track phone usage” on page 10-6.

Exporting the Call Log
You can export the Call Log to a comma-separated value (.CSV) file that can be read by most 
spreadsheet and database applications. Exported Call Log entries are not deleted from the 
TeleVantage database, and the size of the TeleVantage database does not change after an export. 

1. Choose File > Import and Export. The Import and Export Wizard opens.

2. Under Select an import or export action, select Export Call Log and click Next.

3. In Save exported file as, enter the path and file name for the exported file or click 
Browse to specify a destination. 

4. Under Options, enter the Start date and End date. 

5. Click Finish to export the file. Depending on the size of your Call Log, an export may 
take several minutes to complete.
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Result codes when exporting the Call Log
When the Call Log is exported, the Result field appears as a code. Use the following table to 
interpret the result codes:

Archiving the Call Log
Over time, Call Log information will begin to fill up your TeleVantage database. To recover 
database space, you can archive old Call Log information that is no longer needed to a location 
outside the database. 

Important: Archived information is permanently removed from the TeleVantage database. You 
cannot run Call Center reports on the time period that has been archived.

Call Log information is written to a comma-separated value (.CSV) text file that can be read by 
most spreadsheet and database applications. The default path for this file is C:\Program 
Files\TeleVantage Server\Archive\Calllog.csv.

You can archive Call Log data in the following ways:

Q Set up automatic archiving, which takes place at 1:00 a.m. every day.

Q Automatically overwrite the Call Log after a number of days that you specify.

Q Perform a manual archive on an as-needed basis, in addition to daily automatic 
archiving. You can do a manual archive whether or not automatic archiving is turned on.

You do not need to stop the TeleVantage Server or any other TeleVantage components to 
perform an archive. However, because archiving is database-intensive, you may want to 
perform it during off-peak hours so that it does not affect normal system operation.

Code Result

0, 3 Abandoned

1, 2 Connected

4 Left message

5 Blind transfer

6 Supervised transfer

8 Login to telephone commands

12 Login failed max number of times
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To archive Call Log information

1. Choose Tools > System Settings. The System Settings dialog box opens.

2. Click the Call Log tab and specify in the following fields how you want to perform 
archiving:

Q Archive Call Log daily. If checked, the Call Log is archived automatically at 1:00 
a.m. every day. If unchecked, the Call Log will continue to grow unless you 
manually archive it.

Q Archive calls older than ___ days. Number of days a call remains in the Call Log 
until it is archived.

Q Archive file name. Location of the Call Log archive file on the TeleVantage 
Server. This file is in .CSV format and can be viewed with most spreadsheet or 
database applications. 

Q Overwrite archive every ___ days. Number of days that archived information will 
be appended to the Call Log archive file. After that number of days, archived 
information in the file will be deleted and the file will be reused.

Q Archive will be overwritten on. Date and time that the Call Log archive file will 
next be overwritten and the data in it deleted. To preserve the archived data, back 
up the file just before it will be overwritten.

3. Click Archive Now to manually archive the Call Log according to the settings 
specified above. The archive begins immediately and may take several minutes to 
complete. You cannot perform any other Administrator functions until the archive 
completes. You can perform a manual archive at any time whether or not automatic 
archiving is turned on.

4. Click OK to save your archiving settings.

Note: Use the Import and Export Wizard (see “Exporting the Call Log” on page 11-13) to create 
a file containing Call Log information without removing the information from the database. 

Changing the Call Log archive location
Click Move to specify a new location for the archive file. Changing the archive path starts a new 
archive file in the new location the next time the archive is made. Any existing archive files 
remain in the old location.
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Monitoring database and disk usage_________________________
TeleVantage’s database stores your system configuration settings (information about trunks, 
users, auto attendants, and so forth), the Call Log, and an index to voice prompts, greetings, 
voice titles, and voice message files in a database. The voice files themselves are stored 
separately on disk.

Tasks associated with monitoring database and disk space include:

Q Allocating database space

Q Allocating disk space

See “The Storage tab” on page 3-8 for information about how to perform these tasks. See also 
Installing TeleVantage for information on the limits of MSDE and SQL Server databases. 

Shutting down the TeleVantage Server
Choose Tools > Shut down Server. Select one of the following options, and then click OK:

Q Immediately shut down and terminate all calls. Shuts down the Server when you click 
OK, terminating any calls currently in progress.

Q Prevent new calls in __ minutes, then shutdown when existing calls are finished. 
Preserves calls in progress by waiting the number of minutes you specify before starting 
to shut the Server down. When you click OK, all Client users receive a message that 
states that the Server is shutting down. After the number of minutes you enter, 
TeleVantage prevents any new outbound or inbound calls from beginning and waits 
until all current calls have ended. During this time, station-to-station calls are still 
allowed and will prevent the Server from shutting down until they are completed. When 
any station-to-station calls are completed, the Server shuts down.

While the Server is in the process of shutting down and blocking new calls, incoming 
callers hear ringing. The same is true after the Server has shut down.

Q Cancel scheduled shutdown. Cancels a shutdown that was scheduled using the 
previous option. You can cancel only the shutdown before the time that you specified 
expires.

Identifying security risks___________________________________
You can analyze your system for potential security risks by choosing Tools > Analyze Security. 
For more information, see “Identifying users with security-risk passwords” on page C-3.
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Backing up TeleVantage___________________________________________
It is critically important to back up the TeleVantage database on a regular basis. The system 
configuration information stored in the TeleVantage database, the accountcode.txt file, and 
the voice files (stored separately) are vital to the proper operation of TeleVantage. 

You must also regularly back up the TeleVantage voice files by copying them to another 
location.

Important: After upgrading TeleVantage to a new version, you cannot restore a database 
backup that was created using the previous version. You can only restore a database backup that 
was created using the currently running version of TeleVantage.

Note: For the most accurate backup, schedule the backup for a time when the system is not 
being heavily used. Backing up during times of heavy activity can result in an occasional voice 
message being lost from the backed-up files.

Backing up TeleVantage data
Use the following procedure to back up the TeleVantage database and other critical files:

1. Optionally, stop the TeleVantage Server as described in “Shutting down the 
TeleVantage Server” on page 11-16. Stopping the Server is not necessary, but ensures 
that the database and voice files match (because voice messages cannot be left while 
the system is stopped).

2. Choose Tools > Backup Database.

3. Click OK to confirm the backup. The TeleVantage Administrator creates a backup 
copy of your TeleVantage database and also copies your current TeleVantage registry 
settings to a TVServer.reg file.

4. Copy the following files to tape or to another disk.

If your TeleVantage 5.0 system was a new installation:

Q C:\Televantage Server\Data\Backup\Tvdb.dmp

Q C:\Televantage Server\Data\Backup\TVServer.reg

If you have had your TeleVantage system since version 3.5 or earlier:

Q C:\MsSQL7\Artisoft\Backup\Tvdb.dmp

Q C:\MsSQL7\Artisoft\Backup\TVServer.reg

5. Copy the contents of the following directory and all its subdirectories to tape or to 
another disk. The default location is:

C:\Program Files\TeleVantage Server\Vfiles\

Note: Be sure to include Temprecs and its files.

You must also back up the file C:\Program Files\TeleVantage Server\account 
code\accountcode.txt by backing it up to a safe location on a regular basis.

Note: For instructions on moving a backup of the database or voice files, see “The Storage tab” 
on page 3-8.
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Restoring TeleVantage data
You can restore the database from the backup that you have created previously on the same 
version of the TeleVantage software.

For a successful restoration, the backup used to restore the TeleVantage database must match 
the backup voice files exactly. For example, you must not use a backup of the database made on 
Monday and a backup of the voice files made on Tuesday. The best way to insure a successful 
restoration is to use database and voice file backups made at the same time.

Important: After upgrading TeleVantage to a new version, you cannot restore a database 
backup that was created using the previous version. You can only restore a database backup that 
was created using the currently running version of TeleVantage.

To restore the TeleVantage database

1. Make sure that the TeleVantage Server has been shut down (see page 11-16) and that 
there are no copies of the TeleVantage Client or Administrator running (except the one 
you are using).

2. Choose Windows NT/2000 Services in the Control Panel to stop and restart the 
MSSQL service (doing this ensures that no one is connected to the database Server).

3. Copy the most recent version of the Tvdb.dmp and TVServer.reg files from your 
backup device to one of the following:

Q For an upgraded system.  Copy the file to:

C:\MsSQL\Artisoft\Backup\

Q For a fresh system. Copy the file to: 

C:\Program Files\Televantage Server\Data\Backup

If the file already exists, overwrite it.

4. From the TeleVantage Administrator, choose Tools > Restore Database.

5. Click Yes to confirm that you want to restore the database.

6. If a file (TVServer.reg) containing backed-up TeleVantage Server registry settings is 
present when you restore the database, click Yes when you are prompted to restore the 
registry settings as well.

7. Delete all the files in the \Vfiles directory. The default location for this directory is:

c:\Program Files\TeleVantage Server\Vfiles

8. Copy the latest version of the files from your backup device to the \Vfiles directory. 
Be sure to include the \Vfiles\Temprecs directory and its files.

9. If necessary, copy the file accountcode.txt to C:\Program Files\TeleVantage 
Server\account code\accountcode.txt. Overwrite the old version.
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Moving a TeleVantage Server to another PC
You can restore the TeleVantage database from an online backup to another PC. The backup and 
restore function copies all Server registry settings and automatically resolves different source 
and target path names to simplify the process of moving a TeleVantage Server. 

To restore TeleVantage data to another PC

1. It is critical to make sure that the new TeleVantage Server is running exactly the same 
version of TeleVantage, including service packs or patches. 

2. Perform a backup of the original Server as described in “Backing up TeleVantage 
data” on page 11-17.

3. Restore the backup to the new Server as described in “Restoring TeleVantage data” on 
page 11-18.

Viewing the Windows Event Log __________________________________

The Windows Event Log contains informational messages from Windows and from 
applications running on the Server. Both TeleVantage and the database Server post startup, 
shutdown, error and warning messages to the Windows Event Log. By viewing the Windows 
Event log and receiving automatic notification of warnings, you can stay informed of critical 
problems like low disk space no matter where you are.

You can examine the Windows Event Log on the TeleVantage Server locally or remotely from 
any machine running Windows NT/2000. 

You can set up TeleVantage to send e-mail notifications when TeleVantage-related events are 
logged to the Windows Event Log. For more information, see “The General tab” on page 3-5. 

To view the Windows Event Log

1. Choose Start > Programs > Windows NT Administrative Tools (Common) > Event 
Viewer. If you are not running the Event Viewer on the TeleVantage Server, choose 
Log > Select Computer.

2. Choose Log > Application.

3. Review the log for TeleVantage or the database Server messages.

TeleVantage-related Windows Event Log messages
Messages are identified in the Windows Event Log by application and message number. 
Double-click a message to see its text.

The following messages are posted to the Event Log by TeleVantage:

100 - Informational
Server Started -- Version ##

An informational message indicating when the TeleVantage Server started.
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101 - Informational
Server Stopped

An informational message indicating when the TeleVantage Server was shut down. This 
message indicates an orderly shutdown, not a shutdown caused by a problem.

105 - Error
No Voice Resource Available

This message indicates that the trunk boards in your Server were unable to provide a voice 
resource for a requested operation. This error should not be encountered in normal operation and 
may indicate that you need additional voice resources for your current load. Contact your 
TeleVantage provider.

106 - Informational
Device ## Restarted

This message indicates a trunk or station was restarted to recover from an error condition. The 
restart may have been initiated automatically by the TeleVantage Server or manually by the 
administrator. If this message appears only infrequently, it can be ignored. If it is seen often, 
contact your TeleVantage provider. 

107 - Informational
Inbound call detected on outbound trunk ##

This message indicates a call was received on a trunk allocated for outbound calling only. The 
TeleVantage Server played a wrong number message and disconnected the call. If this message 
is seen frequently, it may indicate that the number for the line in question has been distributed 
to potential callers or that the line is included in an inbound hunt group.

108 - Informational
Inbound IP Gateway authentication failed. Trunk ##, Gateway extension: ##, 
Source: nnn.nnn.nnn.nnn

This message indicates that an inbound gateway call failed to provide the correct password.

109 - Warning
Warning: Low Voice Resources Detected

This message indicates that the trunk boards in your system had to use a voice resource normally 
reserved for another purpose for a requested operation. This message is a less severe version of 
message 105. 

If this message occurs only occasionally, and when the system is under heavy load, it can be 
ignored. If the error occurs frequently, however, it may indicate you must purchase additional 
resources for your current load. Contact your TeleVantage provider.
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111 - Error
Unable to start Mail Server. Voice Mail notifications via Email will be disabled.

On startup, the TeleVantage Server was unable to start the e-mail notification process. For 
example, it could not establish a MAPI connection with your mail post office. Mail notification 
will be disabled until the problem is resolved. Contact your TeleVantage provider.

112 - Informational
Started Mail Server.

An informational message indicating that the TeleVantage Mail Server started successfully 
when the Server started. 

115 - Error
Server Restarted

The TeleVantage Server had to be restarted by the TeleVantage Watchdog process.

116 - Error
Server cannot record any more voice messages or calls. Disk space is low.

TeleVantage cannot perform call recording on voice messages or calls, because the disk space 
on the voice files disk is low.

117 - Informational
Server can now record voice messages and calls. Disk space is available.

Call recording can resume, after having been disabled due to low disk space. Sufficient disk 
space on the voice files computer is now available.

118 - Error
Stopped using trunk ##: the trunk may have been disconnected.

TeleVantage Server has stopped using a trunk.

119 - Error
Failed to Restart Server: Total Restarts Exceeded.

TeleVantage Server failed to restart after trying several times.

120 - Error
Failed to Stop Device Handle ##.

121 - Error
Unable to start Exchange Server synchronization. Exchange Server 
synchronization will be disabled. 

Unable to start TeleVantage Exchange Server synchronization.
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122 - Informational
Started Exchange Server synchronization.

TeleVantage Server started Microsoft Exchange Server synchronization.

123 - Error
Unable to open device: ##

TeleVantage Server was unable to open the Dialogic device.

124 - Error
Unable to delete temporary message file for device ##.

This is recorded when there is a problem deleting a temporary message file for a device. The 
temporary message file for station 2 is S2-m.vox. For example, if this file cannot be deleted, an 
invalid message will be left for the recipient.

125 - Error
T1 Alarm: <Alarm Information>

A T1 alarm occurred on the trunk.

T1 alarms
The following two T1 alarms are written to the Windows Event Log:

Q Red Alarm. Signals that the Robbed Bit T1 line has lost synchronization with the 
switch to which it is connected. TeleVantage disables all channels on the affected digital 
span so that spurious signals are not processed as incoming calls.

Q Red OK. Signals that synchronization has been restored. All channels on the affected 
digital span are re-enabled.

All T1 alarms are written to the TeleVantage Server logs.

126 - Error
Unable to start IVR Plugin ’<ProgID>’: License count exceeded.

Unable to start the IVR Plug-in because the number of your Station licenses is less than the total 
number of stations assigned to users plus the total number of IVR Plug-ins currently running 
(every running IVR Plug-in uses 1 Station license).

127 - Error
Insufficient licenses: <message>

TeleVantage Server detects an insufficient number of Trunk, IP Port, Client, or Server licenses, 
and the Server was unable to start. Make sure that you have TeleVantage licenses for every user, 
trunk, and IP trunk you have added in the Administrator.
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128 - Error
Notification via pager failed; Unable to allocate trunk; user ‘<username>’, 
number ‘##’, access code ##

An attempt to send a pager notification of a new voice message failed. The error message shows 
the user’s name and the full dial string of the pager number that was dialed unsuccessfully. Alert 
the user that the pager number might be incorrect or that pause characters should be added to the 
dial string.

129 - Error
Server attempted to load a T1/E1 ISDN/CAS span but could not find the Dialogic 
GlobalCall Package.  If you plan on using a T1/E1 ISDN/CAS span, please reinstall 
the Dialogic Drivers and make sure you have selected the GlobalCall package.

You tried to add or use a T1/E1 ISDN/CAS span without having installed the Dialogic 
GlobalCall package. 

130 - Error
Disabling Exchange Server synchronization. Unable to connect to database.

TeleVantage could no longer access the SQL Server database and disabled Exchange Server 
synchronization.

132 - Error
Ring failed on station ## with error 14. Please restart the station.

133 - Error
Device ## is not responding, restarting...

TeleVantage was unable to open the Dialogic device and is automatically restarting it.

134 - Error
Unable to offer call to IVR Plug in ‘<ProgID>’.  Reason: ‘<reason>’.

Started the IVR Plug-in but OfferCall failed.

135 - Error
CallPlaced Event failed IVR Plug in ‘<ProgID>’.  Reason: ‘<reason>’.

Failed to hand off and outbound call to an IVR Plug-in.

136 - Error
Unable to start IVR Plug in ‘<ProgID>’.  Reason: ‘<reason>’. 

137 - Error
Device ## is not responding.

The trunk or station has stopped responding to events. Try restarting it.
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138 - Informational
Device ## Disabled.

Disabled via the Admin.

138 - Error
Email notification thread is not responding.

E-mail notifications will be disabled until the problem is resolved.

139 - Error
Device ## Disabled.

This station or trunk was disabled by a user through the Administrator.

140 - Informational
Device ## Enabled.

This station or trunk was re-enabled by a user through the Administrator.

141 - Informational
Device ## DChannel State Changed. Reason: ‘<reason>’.

142 - Informational
Emergency: <Username> at extension x## dialed <emergency number> from 
<station ##>

The specified user dialed TeleVantage’s emergency number (usually 911) from the specified 
station.

143 - Informational
Timed Out Waiting For Response from IVR Plugin ‘<AppID>’. Reclaiming voice 
device.

The specified IVR Plug-in did not respond to the TeleVantage Server. The Server assumed that 
the Plug-in was hung, and has terminated it and reclaimed its associated voice resource.

146 - Warning
No Low Priority Voice Resource Available

There are no low-priority voice resources in the pool available for CLASS features such as 
message waiting light, Caller ID display, intercom, and paging, or ADSI features such as 
voice-first answering. Voice resources will continue to be allocated for other tasks such as 
placing calls. For more information on managing voice resources, see the Vox advanced settings 
beginning on page A-40.
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149 - Warning
Database size is nearing critical limit. Archive call log or upgrade to full version 
of SQL Server.

Your TeleVantage database is nearing the 2GB limit of MSDE. Archive the Call Log to make 
more room (see “Archiving the Call Log” on page 11-14), or upgrade to the full version of SQL 
Server if you have not done so already. See the database server requirements in Installing 
TeleVantage

150 - Error
Database size has passed the critical limit and call logging has been stopped.  
Archive call log or upgrade to full version of SQL Server.

New calls are not being written to the Call Log because the TeleVantage database has passed 
the critical MSDE size limit (about 2 GB). Archive the Call Log to make more room (see 
“Archiving the Call Log” on page 11-14), or upgrade to the full version of SQL Server if you 
have not done so already. See the database server requirements in Installing TeleVantage.

The following two errors occur when you start the Dialogic drivers, if you do not have any DM3 
telephony boards installed:

7000 - Error
The dlgcmpd service failed to start due to the following error: The system cannot 
find the device specified. 

7001 - Error
The dlgcmcd service depends on the dlgcmpd service which failed to start 
because of the following error: The system cannot find the device specified.

These errors are benign and should be ignored.
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Using the Maintenance Log view ____________________________
The Maintenance Log view displays tracked actions and presents details about each action. 
Information contained in the log is stored in the database. To open the Maintenance Log view, 
click its button in the view bar. 

The Maintenance Log tracks many administrative actions, including:

Q Restarting a device

Q Starting the Server

Q Stopping the Server

Q Scheduling a Server shutdown

Q Changing a user’s password

Q Changing a queue’s password

Q Logging on to the Administrator or Device Monitor 

Q Logging out of the Administrator or Device Monitor

Q Account lockout

Q Trunk hangup after maximum login attempt

Q Changing any editable item in any Administrator view

Q Enabling or disabling a device

The following columns appear in the Maintenance Log view:

Q Action taken

Q Item that was acted upon (if applicable)

Q Date and time of the action

Q Name of the user who was logged on when the change was made

Q Name of the computer from which the change was made

Q Details about the action

Clearing the Maintenance Log
To clear the Maintenance Log, click in the toolbar.
11-26 ADMINISTERING TELEVANTAGE



Reporting problems to your TeleVantage provider _____________
Use the Problem Report Wizard to report any problems you experience with your TeleVantage 
system to your provider. Your TeleVantage provider has the expertise to debug, correct, and 
expand your TeleVantage system, and has access to Artisoft Technical Support resources for 
further assistance.

The Problem Report Wizard asks you to describe the frequency, patterns, and circumstances of 
the problem you are reporting. Based on the information you supply, the Problem Report Wizard 
isolates exactly when and where the problem occurred and automatically collects the 
appropriate TeleVantage log files and other information from your computer. By assembling all 
the relevant information, the Wizard helps your provider quickly identify the problem and begin 
to solve it.

Note: For information about known issues and workarounds for currently reported problems, 
see the Known Issues topic in the online Help for the TeleVantage Administrator.

Using the Problem Report Wizard
Use the Problem Report Wizard according to the following guidelines:

Q For TeleVantage Server problems, run the Wizard on the TeleVantage Server. See 
“Reporting TeleVantage Server problems” on page 11-28.

Examples of Server problems include:

Q The TeleVantage Server stops unexpectedly.

Q Caller ID is not sent correctly.

Q There is no dial tone.

Q A call-handling problem occurred. For example, TeleVantage does not answer 
incoming calls, calls are being disconnected, or calls are handled improperly (calls 
cannot be transferred, put on hold, and so forth).

Q For problems with any of the workstation applications—Client, Administrator, or TAPI 
Service Provider—run the Wizard on the computer that is experiencing the problem. See 
“Reporting workstation application problems” on page 11-29.

Examples of workstation application problems include:

Q Workstation application behaves unexpectedly.

Q User cannot connect to the network.

Q User cannot connect to the TeleVantage database.

Q Workstation application does not start.

Q Workstation application closes unexpectedly.

Q Data or commands executed in a workstation application don’t look or behave 
properly.
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Q For distributed problems (problems that occur with both a workstation application 
running on a user’s computer and the TeleVantage Server) run the Wizard on the user’s 
computer. Then run the Wizard on the Server so that you create a single problem report 
package. See “Reporting distributed problems” on page 11-29.

Examples of distributed problems include:

Q Problems with specific calls in the Client or Administrator.

Q Problems with specific voice messages in a Client Voice Messages folder.

Q Call-handling problems that involve the Client or Administrator (calls cannot be 
conferenced, for example).

Q User cannot make outbound calls from the Client.

Reporting TeleVantage Server problems
If you experience a problem with the TeleVantage Server, run the Problem Report Wizard on 
the Server. The Wizard automatically collects the required information from the Server, 
including the appropriate Server logs.

Server log files are critical to successfully identifying and solving many problems. Because 
these files can be large, by default the Wizard collects TeleVantage Server log information only 
for the period of time during which the problem occurred. 

Important: You can choose to include all the available Server log information when you run the 
Problem Report Wizard. Be aware that doing this can result in a very large problem report 
package. A large package can make it more difficult for your provider to identify the problem. 
Therefore, use this option (described in the following procedure) on a case-by-case basis and 
only if you need to capture as much history information as possible before the log files are 
overwritten. Be sure to delete the problem report package from your system as soon as you send 
it to your provider to regain disk space.

To report a TeleVantage Server problem

1. On the TeleVantage Server, choose Start > Programs > Artisoft TeleVantage Server 
> TeleVantage Problem Report Wizard. The Problem Report Wizard opens. 

To report a problem with a specific call or voice message, select the problem call (or 
the call that left the problem message) in the Call Log view and choose Actions > 
Report a Problem. The Problem Report Wizard starts with information about the call 
already entered. 

2. Answer the questions presented in each Wizard window. 

To include all the available Server log information in the problem report package, 
uncheck the Limit logs to the following time frame.
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Reporting workstation application problems
For a problem with any of the TeleVantage workstation applications—Client, Administrator, 
Contact Manager Assistant, or TAPI Service Provider—run the Problem Report Wizard on the 
computer that is experiencing the problem. The Wizard automatically collects the required 
information.

To report a workstation application problem

1. On the computer that is experiencing the problem, choose Start > Run. Enter the 
following path and then click OK. The path on your system may be different.

C:\Program Files\Common Files\Artisoft\TeleVantage\TVPRwizard.exe 

Alternately, to report a problem with a specific call or voice message, select the 
problem call (or the call that left the problem message) in the Call Log view and 
choose Actions > Report a Problem. The Problem Report Wizard starts with 
information about the call already entered. 

2. Answer the questions presented in each Wizard window. 

Reporting distributed problems
For a problem that involves both a workstation application running on a user’s computer and the 
TeleVantage Server (a distributed problem usually involves the Client Call Monitor view), you 
should gather information from both computers before contacting your TeleVantage provider. 
The Problem Report Wizard assembles all the information so that your provider receives all the 
necessary information about the problem in one .CAB file.

To report a distributed problem

1. Run the Wizard on the user’s computer to collect information about that computer and 
create a problem report package (perform the steps for reporting a workstation 
application problem on page 11-29).

2. Run the Wizard on the TeleVantage Server to gather all the necessary Server 
information (perform the steps for reporting a Server problem on page 11-28).

3. Check This report includes a Problem Report Package from the TeleVantage 
Client. 

The Wizard automatically browses the Packages folder on the Server so that you can 
select the .CAB file that was produced on the user’s computer. The Wizard then 
includes that file in the problem report package it creates on the Server.

If the Packages folder is not found, or the file was saved to another location, click 
Browse to select the .CAB file that was produced on the user’s computer.
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The problem report package
The problem report package is a single .CAB file. It contains all the information gathered about 
the problem by the Problem Report Wizard. The Wizard saves the problem report package to 
the location you specify. If you save the problem report package to the default location—your 
Desktop—it is represented by the following icon:

The Wizard summarizes the information reported, including the date and time the report was 
created, in a ProblemInfo.txt file within the .CAB file. You can open a .CAB file with any zip 
utility (for example, WinZip).

To prevent problem report packages from being overwritten, the Wizard gives each one a unique 
name based on your company name and a sequence number.

The Wizard increments the sequence number in the file name each time it creates a new problem 
report package.

Send the problem report package to your TeleVantage provider by attaching it to an e-mail 
message or using another method of transfer recommended by your provider. Because a 
problem report package can be large, after you send it to your provider, delete it from your 
system to regain disk space.

To e-mail a problem report package

1. Right-click the problem report package icon on your desktop (or the .CAB file name 
if you saved the problem report package to a different location.) 

2. Choose Send To > Mail Recipient. Your e-mail application opens.

3. Address the message and send it.
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About system prompts ____________________________________
System prompts are audio prompts that TeleVantage plays to callers and users. System prompts 
offer callers menu choices and provide menus and instructions to users.

This chapter explains how to play and rerecord the system prompts used throughout 
TeleVantage.You can use the standard prompts included with the system or record over them to 
create customized prompts. 

The System Prompts view _________________________________
The System Prompts view in the Administrator allows you to listen to and change the recordings 
used for standard system prompts and auto attendants. For example, when you are setting up 
your TeleVantage system, you typically go to this view to change the default Greeting prompt 
so that it contains your company name. Click the System Prompts button in the view bar to open 
the System Prompts view.

Each system prompt appears as a row in the view. The information in the following table is 
displayed for each system prompt.
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Controlling the prompt display
By default the System Prompts view displays all system prompts on the TeleVantage Server. 
Use the control on the toolbar if you want to display only the custom prompts you have recorded 
or only the prompts for a single language. 

Note: To install additional language prompts, you must run the TeleVantage Server installation 
again and select the languages you want.

Managing system prompts ________________________________
This section explains the following aspects of managing system prompts:

Q “Playing system prompts” 

Q “Exporting system prompt text” (page 12-4)

Q “Exporting and importing system prompt audio files” (page 12-5)

Q “Changing the encoding format of system prompts” (page 12-5)

Column Description

File name File name of the prompt.

Text Contents of the file in text form.
The text displayed here is accurate only if it is 
updated each time the file is changed. If you are 
unsure of the accuracy of the text, play the file to 
confirm what it says.

Last modified Last time that the file was modified.

Comment How the prompt is used in TeleVantage. Applies 
to custom prompts and auto attendant prompts 
only. The column is blank for all other prompts.

Language The set of language prompts to which this system 
prompt belongs. User-recorded prompts such as 
auto attendant prompts have this column blank.
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Playing system prompts
You can play system prompts to confirm that they contain the correct information. System 
prompts play over the telephone or through your computer speakers. If you choose to play a 
prompt over the telephone, your phone rings and the prompt plays when you answer. See “Using 
the audio controls” on page 2-10 for more information.

To play a system prompt

1. Select the name of the prompt that you want to play.

2. Choose System Prompts > Play.

Exporting system prompt text
Use the following procedure to export system prompt text into a .CSV file for processing by a 
professional recording studio or for maintenance purposes. 

To export system prompt text

1. Choose File > Import and Export. The Import and Export Wizard opens.

2. Select Export System Prompt Text and click Next.
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3. Under Save exported file as, accept the suggested location and file name or click 
Browse and choose a different location and enter a file name.

4. Under Options, accept the suggested dates or enter new ones.

5. Click Finish. The file is exported.

Exporting and importing system prompt audio files
You can export a system prompt from your Server for use on another TeleVantage Server. You 
also can import an existing sound file and use it as a system prompt. For more information, see 
“Importing and exporting voice files” on page 2-11.

Changing the encoding format of system prompts
TeleVantage supports two .VOX file formats, MuLaw format for use in the United States and 
Japan, and ALaw format for use in other countries. When TeleVantage is installed, the correct 
format is used based on the location of the TeleVantage Server.

On rare occasions, it may be necessary to convert the voice files on a TeleVantage system from 
one encoding format to another, for example, if you are staging a TeleVantage system in one 
location that will be deployed in another. 

To change the encoding format of all .VOX files in the system

1. Choose Tools > Shutdown Server to temporarily stop the TeleVantage Server.

2. Run the utility TVConvert.exe, which is located in the directory in which the 
TeleVantage Server was installed.

3. Choose Tools > Start Server to restart the Server.

TVConvert.exe checks the Windows NT/2000 registry for the current .VOX file format, 
converts all files to the other format, and updates the Windows registry.

Recording system prompts ________________________________
You may want to record over system prompts for some of the following reasons:

Q You want your custom prompts and system prompts to be recorded with the same voice.

Q You want to change the message text of a prompt, for example, the Welcome message. 

Q You have access to voice talent that you prefer over the existing TeleVantage voices.

Q You have localized the telephone commands for a language not provided with 
TeleVantage (see “Localizing the telephone commands” on page 12-12) and want to 
record all of the prompts in that language as well. 
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Recording options
You can record system prompts in either of the following ways:

Q “Recording system prompts professionally” (page 12-7)

Q “Recording over system prompts yourself” (page 12-8)

The sentence file
The sentence file is a text file that contains all the voice prompts and the sentences they form. 
The American English sentence file is located in:

C:\Program Files\TeleVantage Server\TVLEN00.INI

Note: “EN00” identifies American English files. TeleVantage includes two other sets of system 
prompts. EN10 identifies British English files. ES00 identifies Latin American Spanish files.

The .VAP and .VOX files
TeleVantage prompts are contained in:

Q The .VAP file, an indexed file containing individual .VOX recordings of variable 
information. Variable information, for example, numbers and dates, is used to build 
more complex prompts.

Q .VOX files. There is a separate .VOX file for each sentence and phrase in TeleVantage.

The .VAP and .VOX files are used together to produce the complete prompts that callers and 
users hear. For example, in the sentence prompt, “You have three new messages, and twelve 
saved messages”, the words “three” and “twelve” come from the .VAP file.

The American English .VAP and .VOX files are located in:

C:\Program Files\TeleVantage Server\Vfiles\EN00

The American English .VAP file is called TVLEN00.VAP.

The recording process
To record a complete set of system prompts, you must do the following:

Q Record the .VAP file. 

Q Build the indexed .VAP file.

Q Record the .VOX files.

Q Test the new prompts.

Q Deploy the new prompts.
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Recording system prompts professionally
If you choose to obtain professional recordings, you should choose a voice vendor with 
experience in telephony recording, and then:

Q Select a voice

Q Provide the appropriate files to the vendor in formats they can use

Q Test the new prompts for voice quality, usability, file-naming accuracy, and indexing 
accuracy

Q Deploy the new prompts

Selecting a voice
The vendor will often provide you with 44kHz, full-bandwidth voice samples from which to 
choose. Ask your vendor to provide voice samples that have been re-sampled or recorded as 
MuLaw PCM Mono 8 kHz, which is the format used in TeleVantage. This will ensure that your 
selection is based on how the voice will actually sound when used in your TeleVantage system. 

Keep in mind that high-pitched voices and high-frequency sounds degrade more as a result of 
this type of re-sampling, which may result in considerable change in higher frequency sounds at 
telephony bandwidth.

Using the standard TeleVantage voices
To add or modify prompts using one of the standard TeleVantage voices, contact the companies 
shown in the following table that provided the original set of prompts. These companies can 
record new voice files using the standard voices.

Providing files to the vendor
After you have selected a voice, you must provide your vendor with the list of prompt files and 
the text of each prompt to be recorded. The list of prompt files is available in the System Prompts 
and Prompts section of the TVLEN00.INI file. 

Language Voice Contact

U.S. English “Ellen” Marketing Messages
51 Winchester Street
Newton, MA 
U.S. 02461
800-486-4237 (phone)
617-527-3728 (fax)
http://www.marketingmessages.com

Latin American 
Spanish

“Claudia” Marketing Messages

U. K. English “Helen” Marketing Messages
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You also need to provide your vendor with the TVLEN00.VAP file, so that your voice vendor 
can match the indexing of the new .VAP file to the existing file. 

Testing the new prompts
It is important that you thoroughly test all voice files that you receive from the vendor to ensure:

Q Accuracy of file names

Q Synchronization of written and spoken prompt content

Q Quality of voice recording

Q Accuracy of index order and format of the .VAP file

See “Testing system prompts” on page 12-10 for information about using the Sentence Tester 
to assist with some of these tasks.

Deploying the new prompts
After all files are tested, you can replace the existing prompt files with the new ones. Place all 
new .VOX files and the .VAP file in the following directory:

C:\Program Files\TeleVantage Server\Vfiles\User

The following auto attendant prompts must also be copied to the User directory.

Q AACLOSED.VOX

Q AAHI.VOX

Q AA4SBN.VOX

Q AAOPORWT.VOX

The default location is C:\Program Files\TeleVantage Server\Voice Files\EN00.

Recording over system prompts yourself
When you record over system prompts yourself, you can record all of the .VOX files as well as 
the.VAP file, as with professional recording, or record just the .VOX files and use the .VAP file 
included with TeleVantage.

If you do not record over all the files, be aware that since prompts are combined with other 
prompts when presented to callers or users, recording some but not all prompts may result in a 
mismatch of voices.
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Recording over .VOX files
You use the TeleVantage Administrator to record over these files (see the next procedure). 

To record over a prompt

1. In the System Prompts view, double-click the prompt. The Edit Prompt dialog box 
opens.

2. Under Contents, enter the text of the new prompt. Use this text as a script when you 
record the prompt.

3. Record the prompt. See “Using the audio controls” on page 2-10 for instructions.

4. Click OK to save the new version of the prompt.

Recording over the .VAP file
You can record over the .VAP file by using a variety of recording tools and VAP tools. If you 
do not already have such a tool, you should consider VFEdit, which is available on the Internet.

Testing and deploying the new prompts
Use the Sentence Tester to test the new prompts. See “Testing system prompts” on 
page 12-10.For information about deploying the new prompts, see “Deploying the new 
prompts” on page 12-8.
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Testing system prompts
You can test system prompts by listening to them in context over your telephone. By joining 
individual prompts into sentences and playing them as they are used in TeleVantage, you can 
evaluate intonation, emphasis, and consistency.

Note: Computers must run on Windows NT/2000 to test system prompts.

To test system prompts

1. Start the Administrator using the /sentence command line option (see page B-1 for 
more information).

2. Choose Tools > Test Sentences. The Test Sentences dialog box opens.

3. In Language to test, select the language of the prompts that you want to test.
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4. Under Sentences, select a sentence from the list.

The Current sentence box displays how that sentence is described in the sentences.ini 
file. Many sentences consist of a single .VOX file. Other sentences are made up of 
several joined .VOX files, and may contain variables as well.

5. You can double click a sentence to test it, or select it and press Test. When your phone 
rings, pick it up and listen to the sentence in the language you selected. You can 
continue to play messages, and even change languages, without hanging up your 
phone.

6. If the sentence contains variables, they are indicated in the Name column with an 
asterisk. You can enter a new Value for a variable, and optionally select a different 
variable Data Type. 

For example, by default the sentence ToPurgeMsg sentence plays as:

“To permanently delete the 1 message in your Client’s Deleted folder, press 3. 
Otherwise, press 4.”

By changing the Value of Variable 1 to 6, the sentence plays as:

“To permanently delete the 6 messages in your Client’s Deleted folder, press 3. 
Otherwise, press 4.”

Click Clear to return all Values to their original settings.
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Localizing the telephone commands_________________________
The TeleVantage Localization Kit is available if you want to localize and record the telephone 
commands in another language. The Localization Kit includes all the necessary documentation 
and tools for localization.

Although the process for recording system prompts is the same for localized system prompts, 
the localization process requires several more steps, which are described in the Localization Kit.

For more information about the TeleVantage Localization Kit, contact your TeleVantage 
provider.

Changing the TeleVantage ringback tone
By default, the ringback tone (the sound you hear when the phone you dialed is ringing) is the 
United States tone. To rerecord this tone, rerecord the file Ringback.vox, located in the 
following directory on the TeleVantage Server computer:

C:\TeleVantage Server\vfiles\User

For instructions on rerecording the file, see “Recording system prompts” on page 12-5.
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About IP telephony and TeleVantage _________________________
TeleVantage seamlessly supports Internet telephony through an integrated Internet gateway that 
eliminates the need for external IP Gateway devices. Combined with dialing services, 
TeleVantage’s Internet telephony support makes it as easy to place and receive Internet calls as 
it is to place and receive regular telephone calls—whether you are calling from a station phone, 
a remote phone, or using the TeleVantage Client.

TeleVantage’s integrated Internet gateway supports the following Internet telephony features:

Q Placing and receiving calls from H.323 terminals, for example, NetMeeting (see 
page 13-3) or Phone Dialer (see page 13-7).

Q Enhancing a Web page with a “Call Us!” button (see page 13-7).

Q Connecting TeleVantage Servers over the Internet or over private IP networks (which 
can guarantee quality of service). See page 13-8. Over a properly configured IP 
Gateway, users can:

Q Call extensions on a remote TeleVantage Server.

Q Place calls to phone numbers from a remote TeleVantage Server.

Q Place calls on a remote Centrex/PBX service through a remote TeleVantage Server.

Internet telephony requirements
Before using any of TeleVantage’s Internet telephony features, you must first:

Q Install the hardware and software required to support Internet telephony. See Installing 
TeleVantage for more information.

Q In the TeleVantage Administrator, add and configure one or more Internet spans (see 
“Adding an Internet span” on page 5-25).

Q Ensure that the IP address of the Internet span on each Server is completely accessible 
by the other TeleVantage Server. To do this, you may have to configure firewalls at each 
location appropriately. 

This chapter explains in detail how to configure and use TeleVantage to make various types of 
Internet telephony connections.
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Placing calls to H.323 terminals such as NetMeeting ___________
You can use TeleVantage to place and receive IP calls from H.323-based terminals like 
Microsoft NetMeeting, a real-time conferencing and collaboration tool. The figure under 
“Placing calls to NetMeeting from the TeleVantage Client” on page 13-3 shows how the process 
of making TeleVantage-to- NetMeeting calls works.

After you have installed the proper Internet telephony hardware (see Installing TeleVantage), 
configured an Internet Address dialing service, and assigned it an access code, users can place 
calls to H.323 terminals such as NetMeeting from the Client or using the phone.

Note: Users who call NetMeeting terminals might hear an echo on the line. To avoid the echo, 
the NetMeeting user must use an echo-cancelling microphone.

NetMeeting is included with Windows 2000. To download NetMeeting for other operating 
systems:

1. Go to www.microsoft.com/downloads.

2. Select NetMeeting from the top list, select your operating system from the bottom list, 
and then click Find It!

To allow TeleVantage users to place calls to Microsoft NetMeeting or other H.323 
terminals 

1. In the TeleVantage Administrator, create an Internet Address dialing service (see 
“Adding a dialing service” on page 8-8).

2. Assign the service a name and an access code, for example, “Internet” and “71”.

Placing calls to NetMeeting from the TeleVantage Client
Users can place Internet calls from anywhere in the TeleVantage Client that allows them to enter 
phone numbers. For example, users can place Internet calls from the Place Call To dialog box, 
when they are adding a contact or adding a routing list action or when forwarding their calls. 
Users select an Internet Address dialing service and then enter the IP address or DNS host name 
of the computer that is running NetMeeting. 

For example, if a user enters either namemycomputer.mycompany.com or 123.45.67.89 in the 
Name/Address field of the Forward To tab of the Call Forwarding dialog box, calls will be 
forwarded to NetMeeting at the specified location (see the next figure).

Note: If you use a name, such as namemycomputer.mycompany.com, instead of an IP address, 
DNS must be properly configured on this PC, or else the name cannot be resolved to an IP 
address and the call will fail.
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Placing calls to NetMeeting from a TeleVantage phone
Users can place calls to PCs running NetMeeting from any TeleVantage phone by dialing the 
access code followed by the IP address of the computer running NetMeeting. 

IP addresses are dialed with each part of the IP address separated by an asterisk (*). For example, 
dialing 71 123*45*67*89 calls the computer running NetMeeting at the IP address 
123.45.67.89, where 71 is the access code of the TeleVantage Internet dialing service.
13-4 ADMINISTERING TELEVANTAGE



Calling TeleVantage from H.323 terminals such as NetMeeting 

Depending on how your TeleVantage Internet span and company firewall is configured, 
TeleVantage can receive calls from any H.323 terminal such as NetMeeting. 

To receive calls from an H.323 terminal such as NetMeeting

1. Configure your firewall to allow access to the IP address of one or more TeleVantage 
Internet spans.

2. In the TeleVantage Administrator, edit the TeleVantage Internet span to allow 
incoming calls.

3. Optionally, do one of the following:

Q Send Internet calls to the desired user, auto attendant, or IVR Plug-in.

Q Assign DID numbers to any user, auto attendant, or IVR Plug-in that you want to 
allow H.323 terminals to call directly.

Note: For the purpose of receiving Internet calls, you can give users DID numbers in 
TeleVantage only. You do not need to order DID service from your telephone company.

Internet trunks behave almost identically to regular trunks, and provide inbound Caller ID and 
direct inward dialing (DID). Internet calls are routed and processed just like regular calls to 
ACD workgroups, routing lists, and so forth. 

Note that the name of the TeleVantage system is displayed when NetMeeting calls TeleVantage. 
To change the name, edit the following registry key:

HKLM\Software\Artisoft\TeleVantage\Company
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Calling a TeleVantage Server from NetMeeting
To call a TeleVantage Server from NetMeeting, enter the IP address or DNS name of the 
TeleVantage Internet span. This is the IP address assigned to the Ethernet interface on the 
Internet telephony board. Callers with NetMeeting 3.0 or later can navigate TeleVantage using 
NetMeeting’s built-in touch tone keypad. 

Calling a TeleVantage DID number from NetMeeting
If you configure NetMeeting to use a TeleVantage Server as a gateway, TeleVantage interprets 
numbers dialed by NetMeeting as DID. Therefore, NetMeeting users can call any TeleVantage 
user, auto attendant, ACD workgroup, or IVR Plug-in with a DID number. 

To configure NetMeeting to use a TeleVantage Server as a gateway

1. Start NetMeeting.

2. Select Tools > Options.

3. Click Advanced Calling Options to open the Advanced Calling Options dialog box.

4. Check Use an IP Gateway to call telephones and video conferencing systems.

5. Enter the IP address or DNS name of the TeleVantage span, for example, 
123.45.67.89 or myiplinkaddress.mycompany.com.

6. Click OK.

Any numbers entered in NetMeeting now are sent to TeleVantage as DID. For example, placing 
a call to 1234 in NetMeeting will call the TeleVantage auto attendant, user, or IVR Plug-in that 
has a DID of 1234.
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Using Windows 2000 Phone Dialer as an H.323 terminal
A standard installation of Windows 2000 includes Phone Dialer, which has H.323 capabilities 
similar to those of NetMeeting. Phone Dialer allows you to make voice calls from your 
computer. 

To make a voice call, all you need is the recipient’s IP address or DNS (Domain Name System) 
name. The active call window has buttons that let you access a keypad to manually dial numbers. 

To receive calls, you must have Phone Dialer running. When you make or receive a call, a dialog 
box opens. 

Enhancing a Web page with a “Call Us!” button _______________
By using a CallTo: URL on your Web page, any Internet user with NetMeeting installed can 
click on a “Call Us!” link on your Web page to place a call to any TeleVantage DID number. If 
you assign a DID number to a TeleVantage ACD workgroup user or queue, you can send 
Internet users directly into your ACD workgroup or queue for processing by an agent. 

Note: The CallTo: tag is supported in Internet Explorer but is not supported in Netscape version 
4.7.

For example, you can insert the following CallTo: tag on your Web page:

<A HREF="callto:600+gateway=123.45.67.89+type=phone”>Call Us!</A>

When a user with NetMeeting installed clicks the Call Us! link, NetMeeting starts and calls the 
TeleVantage user who has a DID of “600” using the TeleVantage Internet span with an IP 
address of 123.45.67.89.

Note: On your Web page, it is a good idea to include a link to the NetMeeting download page 
for those users who do not have NetMeeting installed (www.microsoft.com/downloads).
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Connecting two Servers using IP Gateways___________________
You can configure TeleVantage’s integrated Internet gateway to connect two TeleVantage 
Servers over the Internet or a private IP network (sometimes called an IP tie-line connection). 
Doing this allows users on one TeleVantage Server to make calls as if they were on the other 
TeleVantage Server.

When two TeleVantage Servers are properly configured, users can do the following: 

Q Place calls to extensions on the remote Server. In addition to calling 
extensions, users can dial # to log in and check remote voice mailboxes, or dial 411 for 
the remote Server’s dial-by-name directory. 

Q Place external phone calls through the remote Server. Users can call remote 
phone numbers as if they were local phone numbers, such as calling directory assistance 
in another city. 

Q Place outbound Centrex/PBX calls through the remote Server. Users can dial 
remote Centrex/PBX extensions as if they were local, such as extensions on a legacy 
PBX system connected to the remote Server. 

Q Unify two Servers into a single user environment. By creating users of the type 
IP Gateway user on each TeleVantage Server, you can make all users appear to be on 
the same TeleVantage Server. Users on each TeleVantage Server can dial each other 
directly or select extensions for call forwarding and routing lists regardless of whether 
they are local (of the user type User) or remote. Local and remote users appear together 
in the Client’s Extensions view, in the Place Call To dialog box, and other lists of 
extensions.

Placing calls involving a remote TeleVantage Server
To make an IP Gateway call, users must choose the appropriate dialing service when placing the 
call, either by dialing the access code over the phone or by selecting it in the Client. See 
“Creating IP Gateway dialing services” on page 13-13.

By creating users of the type IP Gateway, you can also enable users to dial remote extensions 
directly, without dialing an access code, or to place calls to remote extensions from the Client. 
See “Creating Gateway users to unify two TeleVantage Servers” on page 13-14.

Receiving Internet calls from a remote TeleVantage Server
Incoming calls from a remote TeleVantage Server appear in the Client as if they were local calls. 
For example, Caller ID name and number are delivered just as they are for regular internal or 
external calls, which allows users to identify and call back remote users easily.

Codec use with IP Gateway connections
When you connect two TeleVantage Servers over an IP Gateway connection, be sure that the 
Servers use the same codec lists. If they do not, audio failure can occur during calls. See 
“Modifying TeleVantage IP codecs” on page 5-26 for more information.
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Overview of creating an IP Gateway connection
Setting up an IP Gateway connection involves the following steps. It is important to do them in 
the correct order:

1. On each Server, create an IP Gateway that points to the other Server. See “Creating an 
IP Gateway” on page 13-10.

2. On each Server, create one or more IP Gateway dialing services to cover the types of 
Internet calling you want to perform. See “Creating IP Gateway dialing services” on 
page 13-13.

3. To unify two Servers so that all users appear to be local users, create an IP Gateway 
user for each remote extension. See “Creating Gateway users to unify two 
TeleVantage Servers” on page 13-14.

Using the IP Gateway Configuration Worksheet
Appendix D of this manual provides a worksheet to help you set up multiple TeleVantage 
Servers for an IP Gateway connection. Use the IP Gateway Configuration Worksheet to help 
plan consistent access codes for dialing services and avoid conflicts such as overlapping 
extensions or passwords.

Illustration of an IP Gateway
The following figure illustrates TeleVantage Servers in London and Boston that are connected 
using an IP Gateway.

In the top of the figure, the administrator at the Boston Server set up an Internet-to-Phone 
Number dialing service with an access code of 71. The London Server has a Phone Number 
dialing service. Users in Boston can now dial phone numbers in London by dialing 71 followed 
by the phone number. 

In the bottom of the figure, the administrator at the London Server set up an 
Internet-to-Centrex/PBX Extension dialing service—configured to connect to the Boston 
Server’s internal dial tone, and gateway users, one for each user on the Boston Server. Users in 
London can now dial the extensions of users in Boston directly. 
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To establish the connection, each administrator creates an IP Gateway that points to the other 
Server. The administrator can use the IP Gateway on the local Server to control dialing 
permissions for incoming calls. For example, the London administrator can prevent Boston 
users from making long-distance calls through the London Server by changing the dialing 
permissions of the Boston IP Gateway.

You can think about TeleVantage IP Gateways as an authentication mechanism similar to a 
Windows Domain trust relationship. These relationships allow users on one Server to place calls 
on a remote Server without having a user account on the remote Server.

Creating an IP Gateway
To connect two TeleVantage Servers over IP Gateways, administrators on each Server must 
create an IP Gateway that points to the other Server. For example, on an IP Gateway connection 
between Boston and London, the Boston Server has an IP Gateway called “London,” and the 
London Server has an IP Gateway called “Boston.” Each IP Gateway has an extension and 
password that the other IP Gateway uses to log in when connecting IP Gateway calls.

The IP Gateway’s extension is not meant to be dialed directly. It does not appear in the Client 
or the dial-by-name directory, and calls to that extension do not go through. The extension is 
used behind the scenes only to let remote Servers connect.

You can use the IP Gateway to control remote users’ dialing permissions when placing calls 
through your Server. For example, if you are the administrator of the London Server, and you 
want to prevent Boston users from placing long-distance calls through your Server, you can edit 
the dialing permissions of the IP Gateway “Boston.” 

Each remote TeleVantage Server to which you connect over the Internet requires a separate IP 
Gateway. For example, if your Server connects to Servers in London and Chicago, you must 
create two IP Gateways—“London” and “Chicago.”
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The IP Gateways view
To add, edit, and delete IP Gateways, click the IP Gateways button in the view bar to open the 
IP Gateways view:

Each of your IP Gateways is shown as a line in the view. The following table shows the 
information that is displayed for each IP Gateway.

Double-click an IP Gateway in the view to see its properties. 

Column Description

Name Name of the local IP Gateway, usually the name 
of the remote Server’s location or the name of the 
remote Server computer itself.

Extension Extension of the IP Gateway on the local Server, 
used by IP Gateways on remote Servers to log on 
when connecting IP calls.

Password Password of the IP Gateway on the local Server, 
used by IP Gateways on remote Servers to log on 
when connecting IP calls.

Remote Address IP address or hostname of the remote Server.

Remote 
Extension

Extension of the IP Gateway on the remote 
Server, used by the local Server to log on when 
connecting IP calls.

Remote 
Password

Password of the IP Gateway on the remote 
Server, used by the local Server to log on when 
connecting IP calls.

Comments Any comments pertaining to the remote Server.
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Creating an IP Gateway
The following procedure uses an IP Gateway created on a Boston Server that connects to a 
remote London Server as an example.

To create and set up an IP Gateway

1. Have the following information ready:

Q The Internet address of the remote Server

Q The extension and password of the IP Gateway on the remote Server

2. Choose File > New > IP Gateway.

3. Enter a Name for the IP Gateway. Typically the name describes the remote Server’s 
location, for example, “London.”

4. Assign the IP Gateway a unique extension. The extension is not meant to be dialed, 
and does not appear in the Client or the dial-by-name directory. Calls to the extension 
will not be connected. The IP Gateway’s extension is used behind the scenes to 
connect to the remote Server to complete IP Gateway calls.

5. Enter a Password for the IP Gateway.

6. Add Comments to further identify the IP Gateway.

7. Under Operator, select the extension to which callers using this IP Gateway are 
transferred when they press 0 from within the local system. For example, a user on the 
remote Server might call a user on this Server using this Gateway, and press 0 while 
in the local user’s voice mailbox.
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8. Under Telephone prompts, select the language of the telephone commands as heard 
by users on the remote Server who log on to the local system using this IP Gateway.

9. Under Remote, specify the following information about the remote Server:

Q Remote Server’s IP address. Enter the IP address in the format nnn.nnn.nnn.nnn. 
You can also enter the DNS name.

Q Remote IP Gateway’s extension. Enter the extension of the IP Gateway on the 
remote Server that points to this Server.

Q Remote IP Gateway’s password. Enter the password of the IP Gateway on the 
remote Server that points to this Server.

10. On the Permissions tab, assign dialing permissions that limit the types of calls that can 
be made by remote users who make calls through this IP Gateway. For example, you 
might edit the local IP Gateway’s permissions to prevent London users from making 
unrestricted long-distance calls from London. See “The Dialing tab” on page 6-36.

11. Click OK.

Important: The administrator on the remote Server needs to know the extension and password 
of your IP Gateway in order to correctly configure the IP Gateway on the remote Server.

Creating IP Gateway dialing services
To use an IP Gateway connection, you must create at least one dialing service of the 
Internet-to-Phone Number or Internet-to-Centrex/PBX Extension type. To create a dialing 
service for IP Gateway use, do the following:

1. Refer to the table in this section to determine the type of dialing service you must 
create.

2. See “Adding a dialing service” on page 8-8 for complete instructions on creating the 
dialing service.

Note: Before creating an IP Gateway dialing service, make sure you have created an IP 
Gateway that points to the remote Server. See “Creating an IP Gateway” on page 13-10.
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The type of dialing service you must create depends on the type of IP Gateway calling you want 
to do, as described in the following table.

For each remote Server, you must create a separate dialing service for each type of IP Gateway 
calling you want to perform.

Troubleshooting Internet-to-Phone Number dialing services
If, when dialing out over an Internet-to-Phone-Number dialing service, you have problems 
sending digits to external phone systems, try increasing the DTMF Gain and DTMF On-time 
parameters in your Internet span’s Tuning tab. See “Fine-tuning your IP connection” on 
page 5-28.

Creating Gateway users to unify two TeleVantage Servers
Gateway users are a way to unify the users on two TeleVantage Servers connected by an IP 
Gateway, so that all users display and function as if they were local. Once you create Gateway 
users, users on each Server can:

Q Dial any user’s extension directly, without an access code.

Q See local users and remote users listed together in the Client’s Extensions view, Place 
Call To dialog box, and all other places where a list of users appears.

Q Select any user when placing a call, transferring a call, or creating a conference call.

Q Search for any user in the dial-by-name directory.

Q Forward calls to any extension, or include any extension in a routing list.

By connecting two Servers over a private IP network and unifying them with IP Gateway users, 
you can effectively double the number of stations your TeleVantage system supports.

Type of calling Dialing service needed Special instructions

Calling TeleVantage 
extensions on the remote 
Server

Internet-to-Centrex On the General tab, select 
Remote Server’s internal 
dial tone

Placing phone calls through 
the remote Server

Internet-to-Phone Number

Placing Centrex/PBX calls 
through the remote Server

Internet-to-Centrex/PBX 
Extension

On the General tab, select 
Remote Server’s 
Centrex/PBX service 
access code.
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Overview of IP Gateway users
An IP Gateway user is a special type of user that you create to mirror a user on the remote Server. 
For each user on the remote Server, you create an IP Gateway user on the local Server. For 
example, if the remote Server has a user named Pete Storpin, you would create a user of the type 
IP Gateway named Pete Storpin on the local Server that points to the remote user.

The administrator on the remote Server performs the same action, creating an IP Gateway user 
on the remote Server to mirror each normal user on your Server.

When a user dials an IP Gateway user’s extension, behind the scenes the IP Gateway user 
automatically forwards the call over your Server’s Internet-to-Centrex/PBX Extension dialing 
service to the matching user on the remote Server.

Before creating IP Gateway users
To create an IP Gateway user, you must have already done the following on each Server:

Q Created an IP Gateway to point to the remote Server. See “Creating an IP Gateway” on 
page 13-10.

Q Created an Internet-to-Centrex/PBX Extension dialing service that connects to the 
remote Server’s internal dial tone. See “Adding a dialing service” on page 8-8.

Q Made sure that no extensions on one Server conflict with extensions on the other. To 
avoid conflicts, you can have all the extensions on one Server begin with 1, while all the 
extensions on the other Server begin with 2.

The IP Gateway Configuration Worksheet in Appendix D can help you plan your IP Gateway 
connection so that no conflicts occur.
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To create an IP Gateway user

1. In the Users view, choose Users > New User. The User dialog box opens.

2. Under Type, select IP Gateway user.

3. At the bottom of the dialog box, under IP Gateway, select the IP Gateway that points 
to the remote Server on which this user resides. To create a new IP Gateway, click the 
IP Gateway button.

4. Make sure that the Gateway user’s Extension matches the user’s extension on the 
remote Server. This field is the only field that must be identical to the remote user’s 
setup. However, to reduce confusion, it is recommended that you use the same First 
Name and Last Name on both Servers.

5. Click the Call Handling tab, then click Call Forwarding. Click To another number. 
Under Call using, select the Internet-to-Centrex dialing service with which you 
connect to the remote Server. Under Number, enter the extension of the user on the 
remote Server.

To economize trunk usage on calls sent between two or more Servers, check Attempt 
Centrex/PBX Transfer. For more information, see “Forwarding calls over 
Centrex/PBX trunks” on page 6-30.

6. Enter the rest of the user information, which governs how the IP Gateway user behaves 
on the local Server. For complete instructions on adding users, see “Adding users” on 
page 6-7.

7. Click OK.
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Using Contact PINs with IP Gateway users
When a contact employs a Contact PIN to dial an IP Gateway user, the Contact PIN is lost when 
the call is transferred to the actual user on the other Server. The contact might then appear in the 
Call Monitor as an unknown caller.

To make sure that Contact PINs are recognized in all cases, users must duplicate their contacts 
on the other Server. For example, if Pete Storpin has defined his wife as a contact with a PIN of 
55, he must log in to his Gateway user account on the remote Server and define his wife again, 
using the same PIN of 55.

Note: The first time a user receives a Contact PIN call over the IP Gateway connection, the user 
must associate the call with the contact. Then the contact will be recognized on subsequent calls.

An easy way to duplicate contacts is to export them from the local Server’s account and import 
them to the remote Server’s Gateway user account. For a full description of Contact PINs and 
instructions on exporting and importing contacts, see Using TeleVantage.

Enabling call path replacement to economize trunk use
TeleVantage can perform call path replacement on calls transferred or forwarded between 
Servers, so as to economize trunk use. For example, if a call starts on Server A, goes to Server 
B, and is forwarded to Server C, TeleVantage automatically simplifies the path to a direct 
connection between Server A and Server C, thus saving trunk usage on Server B. 

To enable call path replacement, make sure that each IP Gateway user has the Attempt 
Centrex/PBX transfer field checked in their call forwarding settings. The field is checked by 
default for IP Gateway users.

Fine-tuning your IP connection _____________________________
TeleVantage’s IP Span dialog box includes a Tuning tab that you use to change any of the 
IPLink board parameters between IP calls. Changes you make while a call is in progress on the 
board will not be reflected until the call completes and a new call is initiated. See “Fine-tuning 
your IP connection” on page 5-28.
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About extending TeleVantage_______________________________
Versatility is what makes TeleVantage so powerful, and that versatility is enhanced even further 
by the ability to integrate other applications into the TeleVantage Server. You can extend a 
TeleVantage system in the following ways:

Q In-band signaling applications. Software designed to interact with PBX or Centrex 
systems can be configured to work with TeleVantage, providing custom IVR or 
call-handling functions (fax back, touch tone data retrieval, and so on). 

Q TAPI applications. TAPI-compatible phone dialers and contact managers such as Act!, 
GoldMine, FrontOffice 2000, and Microsoft Outlook can be integrated into TeleVantage 
through the TeleVantage TAPI Service Provider. 

Q Third-party telephony devices. Devices such as fax servers and voice mail systems can 
be integrated into the TeleVantage Server.

Q Custom software. If you have a requirement that cannot be met by one of the many 
off-the-shelf applications available from third-party vendors, programmers can use the 
TeleVantage Software Development Kit (SDK) to integrate custom-built software with 
your TeleVantage system. 

The next section of this chapter describes extending TeleVantage with off-the-shelf 
applications. The rest of the chapter provides an overview of what programmers can accomplish 
using the TeleVantage SDK. This chapter includes the following topics:

Q “Extending TeleVantage with off-the-shelf applications” (page 14-3). Describes how 
in-band signaling and TAPI applications can be integrated into the TeleVantage Server. 

Q “Extending TeleVantage with third-party devices” (page 14-4). Describes how to 
integrate third-party telephony devices. 

Q “The TeleVantage SDK” (page 14-8). Gives an overview of the SDK, which contains 
the following tools: 

Q “The Client API” (page 14-9). A set of software components that gives custom 
applications the ability to access all functions found in the TeleVantage Client. 

Q “The IVR Plug-in API component and sample applications” (page 14-9). A 
powerful way to integrate virtually any interactive voice response or voice 
processing application with your TeleVantage system. 

Q “The Device Status API” (page 14-11). A software component that gives custom 
applications the ability to get detailed information about trunks and stations from 
the TeleVantage Server. 
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Extending TeleVantage with off-the-shelf applications __________
Many off-the-shelf applications produced by third-party vendors can be integrated into the 
TeleVantage Server without any custom programming. These applications are integrated in one 
of the following ways:

Q In-band signaling applications can be configured to work with most Centrex and PBX 
systems, including TeleVantage. 

Q TAPI applications can use the TeleVantage TAPI Service Provider to communicate with 
the Server. 

In-band signaling applications
A human caller can send commands to any PBX, including TeleVantage, by generating a flash 
hook command by quickly pressing and releasing the hang-up button (or hook) on a telephone 
handset cradle. The flash hook command signals the PBX that special instructions will follow, 
such as placing a call on hold or transferring a call to another extension. For example, a 
TeleVantage user can generate a flash and then press 1 to transfer a call. 

This method of sending instructions is called in-band signaling. Many telephony applications 
use this same method, communicating with PBX or Centrex systems through flash hook 
commands. 

Most PBXs use their own proprietary sets of flash hook commands. An application that uses 
in-band signaling will usually provide you with a way to configure it for a specific set of flash 
hook commands, such as those used by TeleVantage. For example, &3 (a flash followed by a 3) 
is the flash hook command that TeleVantage uses to disconnect from a call, so you can configure 
the in-band signaling application to use &3 as its disconnect command. For a complete list of 
the TeleVantage telephone commands, see the “Telephone Commands Quick Reference” in 
Using TeleVantage.

TAPI applications
TAPI applications can communicate with the Server through the TeleVantage TAPI Service 
Provider (TSP). The TSP can be installed on the TeleVantage Server and on any workstation 
networked to the Server. When it is installed, users can use TAPI-enabled phone dialers, contact 
managers, and similar applications. No modem is required, and the TeleVantage Client does not 
need to be installed on the user’s computer.

The TSP runs in the background, establishing a connection between the TAPI application and 
the TeleVantage Server. Whenever a call is transferred to the station being monitored by the 
TSP, any TAPI-compatible application running on the same computer is notified of the call. The 
application can then perform functions such as getting Caller ID or DID, transferring the call, 
putting the call on hold, parking the call, or hanging up. TAPI applications can also place new 
calls.
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While any TAPI-compatible application should work with TeleVantage, the following contact 
managers are actively supported:

Q Act! 3.0, 4.0, and 2000

Q GoldMine 4.0 and 5.0

Q GoldMine FrontOffice 2000 

Q Goldmine Business Contact Manger 5.7

Q Microsoft Outlook 98, 2000 and XP

For detailed instructions on how to install the TSP and use it with the supported contact 
managers, see Installing TeleVantage. If you are writing a TAPI-compatible application, see the 
online TeleVantage SDK Developer’s Guide (TVSDK.PDF) for a description of the TAPI 
features that the TSP supports. (The developer’s guide is installed with the SDK.) 

Automatic reconnect to Server
The TSP validates the connection to the Server every 10 minutes by default. If the connection 
is lost, the TSP tries to reconnect. You can specify the validation interval in minutes by editing 
the following registry key:

HKLM\Software\Artisoft\Client\TSP\ServerPingInterval 

See “ServerPingInterval” on page A-11.

Extending TeleVantage with third-party devices _______________
Many telephony devices produced by third-party vendors, such as fax servers or voice mail 
systems, can be integrated into the TeleVantage Server. This option is only available for devices 
connected to MSI boards.

To use a third-party device with TeleVantage, attach the device to a TeleVantage station and 
configure it using the tabs in the User dialog box. 

When you integrate a third-party device, you may need to indicate how to send DID, or 
extension numbers, to the station as touch tone digits (DTMF). Consult the documentation for 
your third-party device for more information about the kind of DTMF information that is 
required. 

Note: Some third-party devices require a delay before DTMF digits are sent to the device. To 
specify this delay, change the SendDigitsToStationDelay registry setting (see “Modifying other 
supported TeleVantage settings” on page A-33).

To send DID information to a device as DTMF, on the Phone tab select one of the following 
methods from the Send digits to station drop-down list:

Q Do not send digits. If you are not integrating a third-party device, accept the default 
method. No DTMF digits are sent.

Q Send DID from PSTN. Send the DID number as DTMF digits from the trunk on which 
the call arrived.
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Q Send user’s extension number. Send the extension number of the calling user as 
DTMF digits.

Q Send call type and extension number. Send the call type and extension number as 
DTMF digits. This method is described in detail in the next section. 

Note: If you choose any setting except the default Do not send digits, all call screening options 
are disabled for the station. 

Sending call type and extension number to a device 
The Send call type and extension number method sends DTMF digits that represent the call 
type and one or more extension numbers to help the third-party device determine where the call 
came from. Using this information, the third-party device can customize call handling for 
individual calls. 

For example, a third-party voice mail system can use the extension number to preselect a 
specific user’s voice mailbox. Using the call type, the system can then customize how the call 
is handled. When users dial in from their desks, they are connected directly to their voice 
mailboxes and offered a “retrieve voice mail” menu. For external callers, the voice mail system 
offers a “leave message” menu with the user’s voice mailbox already selected.
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The possible combinations of DTMF digits that are sent to the device are described in the 
following table. 

The following example illustrates one way that TeleVantage can be configured to send DID 
digits to stations: 

Q Frank Smith is assigned extension 101. Miri Anatolia is assigned extension 102.

Q A third-party voice mail system is attached to several TeleVantage stations. The system 
administrator creates a user for each device and assigns each one an extension, as in 
“Voice Mail Port 1” at extension 301, “Voice Mail Port 2” at extension 302, and so forth. 
When setting the Send digits to station option for each user, the system administrator 
selected Send call type and extension number. Finally, each voice mail port is added 
to a workgroup called Voice Mail, at extension 300 (for more on setting up workgroups, 
see “Creating a Workgroup” on page 7-4).

Q Both Frank and Miri have a routing list that rings them first at their own extensions, and 
then sends calls to the workgroup Voice Mail at extension 300. Any calls for Frank and 
Miri that they do not pick up go to the first available voice mail port in the workgroup.

Note: In the previous example it is highly recommended that you use more than one voice mail 
device. A single device at extension 300, for example, can only handle one call at a time—either 
a user checking for voice messages or an external caller leaving a message. If a second call 
comes in to the device while it is busy, the second call goes to the final action of extension 300’s 
routing list, which may be TeleVantage’s voice mail, or any other final action that you configured.

Type of call DTMF digits sent

Direct call to this extension from an external 
caller.

“1”

Direct call to this extension from an internal 
caller at another TeleVantage source 
extension.

“2{source extension}#”

Call from an external caller to a different 
target extension. 

The call was sent to this extension via a 
routing list action because the target 
extension was busy or the call was not 
answered.

"5{target extension}#"

Call from an internal caller at another source 
extension to a different target extension. 

The call was sent to this extension via a 
routing list action because the target 
extension was busy or the call was not 
answered. 

"6{target extension}#
{source extension}#"
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Using the previous example again for illustration, the possible DTMF combinations that may be 
sent to one of the voice mail systems are described in the next table. In all cases, the call is 
handled by the first available voice mail device in the workgroup Voice Mail. 

Type of call DTMF digits sent

An external caller calls Voice Mail directly at 
extension 300 in order to leave a message for a 
user.

For a direct external call, the DTMF digits do not 
contain any information about the extension that 
was dialed. The caller follows the prompts offered 
by the device to identify the user who will receive 
the message.

“1”

Frank Smith at extension 101 calls Voice Mail 
directly at extension 300 in order to retrieve his 
voice messages.

For a direct internal call, the DTMF digits identify 
Frank’s extension. The voice mail device can send 
Frank directly to his own voice mailbox.

“2101#”

An external caller calls Miri Anatolia at extension 
102. If there is no answer or a busy signal at 
extension 102, the call rings Voice Mail at 
extension 300.

For an external call re-routed by a routing list, the 
DTMF digits contain Miri’s extension. The voice 
mail device can send the caller directly to Miri’s 
voice mailbox to leave a message for her.

"5102#"

Frank Smith at extension 101 calls Miri Anatolia at 
extension 102. If there is no answer or a busy 
signal at extension 102, the call rings Voice Mail at 
extension 300.

For an internal call re-routed by a routing list, the 
DTMF digits contain Frank’s and Miri’s extensions. 
The voice mail device can send Frank directly to 
Miri’s voice mailbox where he can leave her a 
message, and he may be identified as the sender.

"6102#101#"
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The TeleVantage SDK _____________________________________
The TeleVantage SDK is a powerful set of software libraries that programmers can use to 
achieve the tightest possible integration between their applications and the TeleVantage Server. 
A programmer can use the SDK to integrate custom voice and call processing applications such 
as:

Q Order processing systems with interactive voice response (IVR) 

Q Customer identification and screen pop applications

Q Smart operators that transfer calls based on Caller ID or other information

Q Automatic customer support call handling

Q Custom applications that monitor the status of TeleVantage devices

Q Anything the Client can do

For complete information about the SDK, see TeleVantage SDK Developer’s Guide.

Applications that use the TeleVantage SDK can be created by programmers who have 
experience with a Windows programming platform such as Visual Basic, Visual C++, or Delphi. 
Artisoft maintains a list of consultants qualified to develop applications using the TeleVantage 
SDK. 

Most custom applications can use TAPI or in-band signaling (as described in “In-band signaling 
applications” on page 14-3) to perform Caller ID and call control. Applications that need to 
perform interactive voice-processing tasks (collecting and interpreting touch tone digits, playing 
and recording voice files, generating spoken messages, and so on) require that you use the IVR 
Plug-in API (see “Developing IVR Plug-ins” on page 14-10 for details). 

Installing the TeleVantage SDK
The TeleVantage SDK consists of sample programs and Help files as well as the software 
libraries that programmers will use to integrate their applications with TeleVantage. You can 
print TeleVantage SDK Developer’s Guide (TVSDK.PDF) and provide it to programmers. 

To install the TeleVantage SDK

1. Run the TVSDK.exe program located in \TeleVantage on the TeleVantage master CD.

2. Follow the instructions in the TeleVantage SDK Setup window.

The TeleVantage SDK Application Programming Interfaces
The TeleVantage SDK consists of three APIs (Application Programming Interfaces) that can be 
incorporated into custom applications. Each API is a software library that the application can 
use to access specific functions and data within TeleVantage. The following APIs are provided: 

Q The Client API. Using the Client API, applications can perform any operation that the 
Client can perform, including all call handling and interacting with the TeleVantage 
Server database.
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Q The IVR Plug-in API. Using the IVR Plug-in API, programmers can tightly integrate a 
custom application with the TeleVantage Server to perform complex call-handling or 
voice-processing tasks (order entry, customer service, e-mail readers, and so on). The 
application (called an IVR Plug-in) is a virtual extension on the TeleVantage Server. The 
IVR Plug-in can be dialed from a phone or auto attendant, called from an internet trunk, 
or have calls forwarded or transferred to it, just like a regular extension assigned to a 
user. 

Q The Device Status API. Using the Device Status API, an application can monitor the 
status of all devices on the TeleVantage Server. For example, it can monitor current 
users on the system, obtain the name of a user currently logged on at a station, or identify 
the trunk to which a station is connected. The application can generate custom reports 
concerning the calls handled by TeleVantage.

The remainder of this chapter provides an overview of each API. For more detailed information, 
see TeleVantage SDK Developer’s Guide, which is available in the \Manuals directory on the 
TeleVantage master CD. 

The Client API
The Client API is an extensive collection of the COM objects used to write the TeleVantage 
Client. It contains objects that are typically used to interact with the TeleVantage Server 
database and the call-processing engine. Using the objects available in the Client API, your 
applications can use any function found in the TeleVantage Client. 

The IVR Plug-in API component and sample applications
The IVR Plug-in API enables a custom application to function as a virtual extension on the 
TeleVantage Server. The application (called an IVR Plug-in) can act just as if it were using a 
regular extension assigned to a user. IVR Plug-ins run on the TeleVantage Server and are 
assigned an extension in the TeleVantage Administrator’s IVR Plug-in view. Programmers use 
the IVR Plug-in API to get notification of new calls from the TeleVantage Server, retrieve Caller 
ID, DID, or other call data, and then optionally perform any voice processing (get digits, play 
or record greetings, perform database lookups, and so forth) by using the Plug-in API’s built-in 
voice processing commands to play files, get digits, play tones, etc. After an IVR Plug-in 
finishes processing the call, it can hang up or transfer the call back to any TeleVantage 
extension, auto attendant, voice mail box, or even another IVR Plug-in. IVR Plug-ins can also 
make outbound calls, which can be useful for predictive dialing applications. 

The IVR Plug-in API is exposed to your applications through a TeleVanatge software 
component. Sample applications are provided to illustrate how the IVR Plug-in API is used.

Q TVIVRLib type library. This software component exposes the IVR Plug-in API so your 
applications can use it to process calls. The library is contained in tvivr.tlb, which is 
located in the \Program Files\Common Files\Artisoft\TeleVantage directory when 
you install the TeleVantage Server or install the TeleVanatge SDK. 
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Several sample IVR Plug-ins written in Visual Basic 6.0 are installed with the TeleVantage 
SDK. The samples are provided in two versions: PlugInMedia samples that use the Plug-in 
API’s built-in voice processing capabilities and CallSuite samples that require Intel’s Call Suite 
for voice processing. By default, all samples are located in either the \Program 
Files\TeleVantage SDK\PluInMedia or \Program Files\TeleVantage SDK\PluInMedia 
directories. You must have Visual Basic 6.0 installed to use the sample programs as is, or modify 
them to meet your needs. The following samples are provided:

Q First. . This small IVR Plug-in demonstrates the most basic layout and design of an IVR 
Plug-in for a telephony server. It answers a call, plays a file, and then returns the caller 
to the active routing list. 

Q CustID. This IVR Plug-in demonstrates how to transfer customers to different agents 
automatically, based on the customer’s area code obtained from their caller ID or their 
customer record. It also includes a CustomerID database manager to maintain the 
Customer and Agent database tables accessed by the CustomerID IVR Plug-in. The 
program can be used to customize the customer and agent data for your location. 

Q OutBound. This sample includes two IVR Plug-ins (PlaceCall and ReceiveCall) that 
demonstrate how an IVR Plug-in (PlaceCall) can place outbound calls that are handled 
by the ReceiveCall Plug-in. It then plays a voice prompt, and then transfer the calls to a 
TeleVantage user.

Q OrderStatus. This IVR Plug-in answers calls, prompts the caller for ther 5 digit order 
number, searches a Orders database for a matching record and then reads back the order 
status, e.g. "Your order number [12345] was shipped on [December 31, 2002] and 
totalled [$123.56]"

Developing IVR Plug-ins
The TeleVantage SDK allows a programmer to integrate an application with the TeleVantage 
Server, including the ability to perform tasks such as dialing a phone number, interpreting touch 
tone digits, playing or recording voice files, or generating spoken messages. It also allows you 
to use telephony toolkits such as CallSuite to perform actions such as text-to-speech synthesis, 
voice recognition, accurate call progress analysis and faxing (which the IVR Plug-in API does 
not perform).

Telephony toolkits can be used to build applications such as:

Q Order entry systems

Q Benefits enrollment hotlines

Q Real estate fax lines

Q Voice mail and paging systems

Q Product literature fax-on-demand systems

Q Movie rating and information lines

Q Talking classifieds

Q Predictive dialers
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Q Golf tee reservation systems

Q Ski condition hotlines

IVR Plug-in licensing
IVR Plug-ins are licensed at runtime and count against your Station licenses. Your system may 
be configured to support an unlimited number of IVR Plug-ins, but each simultaneous call to an 
IVR Plug-in will consume one Station license for the duration of the call. 

For example, if you have a system with 16 Station licenses, and 15 of those stations are assigned 
to users, you have one free Station license that can be applied to calling an IVR Plug-in. If one 
person makes a call to an IVR Plug-in, and during the call another user makes a call to the same 
or a different IVR Plug-in, at that point the caller hears a message that the extension is not 
available, and an error is logged to the TeleVantage Server’s Windows NT/2000 Event Log 
saying that the license count has been exceeded. 

Note: If you use Callsuite, additional Callsuite licenses will apply. See Callsuite’s documentation 
for more information.

The Device Status API
The Device Status API provides functions that allow an application to monitor the status of all 
devices (stations and trunks) on a TeleVantage Server. The application can obtain the device 
name, number, hook state, current activity, and extensions for each device on the system. Each 
extension can be examined for the extension number, the user’s name, and whether the 
extension is in a Do Not Disturb personal status. Using these functions, the application could:

Q Monitor current users on the system and maintain a call log in a format customized for 
your special needs.

Q Obtain a current list of users permanently assigned to a station.

Q Obtain the name of a user currently logged in at a station.

Q Identify the trunk to which a station is connected.

All Device Status information is read-only. The API can be used in combination with the IVR 
Plug-in API to provide IVR applications with device information. 

The Device Status sample program
The Device Status sample program is a Visual Basic project for a simple device monitor that 
displays a constantly updated list of status reports on each device in the system. Programmers 
can use this sample program as a starting point for their own applications, expanding and 
customizing it as desired. It requires no hardware or software beyond what is already required 
for the TeleVantage Server and Visual Basic. 
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About TeleVantage configuration settings_____________________
This appendix lists the TeleVantage configuration settings that store information that is rarely 
changed, or that cannot be changed using the Administrator. 

There are two ways to edit TeleVantage’s advanced configuration settings:

Q Editing the Windows registry. See the next section. Many configuration settings are 
stored in the Windows registry on the Server computer and on client computers where 
one or more TeleVantage workstation applications are installed. Some settings are 
stored at the machine level and apply to all users on that machine while others are stored 
for the current user. The Windows registry settings can be edited using Regedit.exe or 
Regedt32.exe. 

Note: In this chapter, HKLM is the abbreviation for HKEY_LOCAL_MACHINE and HKCU is 
the abbreviation for HKEY_CURRENT_USER.

Q Using the TeleVantage Advanced Settings Editor. This TeleVantage application allows 
Administrators to edit settings that are stored in the TeleVantage database. See “Using 
the TeleVantage Advanced Settings Editor” on page A-31.

Note: In this chapter, all registry entries are shown as decimal, rather than hex, values. In 
RegEdit the default entry format is hex.

TeleVantage Server registry settings _________________________
Many registry settings are set at installation time. In this appendix, the default values shown for 
registry settings refer to the values that will be used when there is no registry entry, not to 
defaults set by the TeleVantage installer.

One TeleVantage Server registry setting is found (or can be created) under the following registry 
key:

HKLM\Software\Artisoft\TeleVantage\

..\Artisoft\TeleVantage\ 
COMPANY

STRING value sent to incoming IP callers who are directed to an auto 
attendant or IVR Plug-in. Some terminals such as NetMeeting will be 
able to display this name in their user interface. Calls that go directly to 
users will use the user’s name instead. Note that this value is written by 
the installer. This setting takes effect when SendDisplayOnAnswerCall 
(see page A-6) is non-zero. See also Q931DefaultSourceName on 
page A-5.

Default is “TeleVantage”.
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One TeleVantage Server registry setting is found under the following registry key:

HKLM\Software\Artisoft\System\

The TeleVantage Server registry settings in the following list are found (or can be created) under 
the following registry key:

HKLM\Software\Artisoft\TeleVantage\Server\Settings

..\Artisoft\System\ 
LOCKOUTRESETINTERVAL

DWORD value that sets the time frame in which multiple failed logon 
attempts must occur to result in a lockout (see “Increasing password 
security” on page 3-16). The value is in minutes and by default is set to 
30. Increasing the value means that lockout will be more likely, while 
decreasing the value means that lockout will be less likely. A value of 0 
will result in lockout never occurring.

Default is 30 minutes.

..\Server\Settings\ 
AnalogMinTrunkOnhookTime

DWORD value specifying the minimum on-hook time in milliseconds 
before the trunk will be used for another outbound call. 

Default is 3000 milliseconds.

BCPComPort

DWORD value specifying the COM port used to connect to the BCP 
panel for Watchdog mode. The watchdog signal is transmitted by 
TeleVantage over a serial cable that connects the PC COM port to the 
“RS-232 Watchdog Signal” port on the connection panel. 

Default is 1, indicating that the serial cable is connected to the COM1 
port. If you are using the COM1 port for another device, such as a mouse, 
change this setting to 2 and use the COM2 port.

DbCacheInterval

DWORD value specifying the number of minutes between database 
cache refreshes. 

Default is 5 minutes. Setting to zero turns off cache refreshes.

DisableDevices

See “Disabling Dialogic devices” on page A-15 for details. 

Default is 0. 
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EnableIPLogin

DWORD value specifying whether or not to enable IP caller login. 

Default is 1 (login is enabled).

EmptySentItemsFolder

DWORD value specifying whether or not to purge the Sent box in a 
Lotus Notes-based e-mail system each time an e-mail notification 
includes an attached voice message. If you are not using an e-mail system 
based on Lotus Notes, you do not need to define this setting. For more 
information, see “Using Lotus Notes for e-mail notification” in Installing 
TeleVantage. 

Default value is 0 (Sent box should not be purged). A value of 1 indicates 
that the Sent box should be purged. 

LogHours

DWORD value specifying the number of hours to log.  The Server will 
adjust NumLogs based on available disk space.  Set to 0 and the Server 
will not adjust logging settings.  A different value may be specified 
during installation.

LogPath

STRING value specifying the subdirectory in which TeleVantage Server 
log files (Tvlogxxx.TXT) will be created. If this registry value does not 
exist, or points to an invalid directory, Server logging will be disabled. 

Default path is: “” (empty string). 

MaxNonSilence

DWORD value specifying the maximum length of uninterrupted sound 
(in 10 ms units) that will be recorded before the recording is terminated. 

Default is 0 (no time-out). 

MinDiskFreeSpace

DWORD value specifying the minimum amount of disk space (in 
megabytes) that must be available for logging and saving voice 
messages. If the minimum amount is not available, no logging will occur 
and no voice messages will be saved. 

Default value is 50MB. 

MonitorInterval

DWORD value specifying the interval in minutes between TeleVantage 
Device Monitor checks for devices that are not responding. 

Default is 1 minute. 

..\Server\Settings\ 
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Monitortimeout

DWORD value in milliseconds. If a device has not responded for this 
length of time, TeleVantage checks the MonitorRestart setting to see if 
the device should be restarted, and adds the message “Device %1 is not 
responding” to the Windows Event Log. 

Default is 300000 milliseconds (5 minutes). 

MonitorRestart

DWORD value. If this value is non-zero, the system will attempt to 
restart a nonresponding device after the interval specified by 
Monitortimeout is exceeded. A non-zero setting can cause problems 
when a device is not responding, because it can result in slow database 
access. 

Default is 0 (system will not attempt to restart the device). 

NumLogs

DWORD value specifying the number of TeleVantage Server log files 
(Tvlogxxx.TXT) kept before they are overwritten. 

Default is 1. A different value may be specified during installation. To 
disable logging, set to 0.

PartyCustomDataMax

DWORD value specifying the maximum size allowed (in bytes) for 
custom data attached to each party. If a Client attempts to set custom data 
for a party that exceeds this size, the attempt will be disallowed. 

Default is 10000 bytes.

Q931DefaultSourceName

STRING value used when forwarding incoming PSTN calls without 
Caller ID to an Internet Address or IP Gateway service. The IPLink 
drivers will substitute the string “Name” unless another string is provided 
in the source address. This key should have the same value as the 
Company setting (see page A-2).

Default is “TeleVantage”. 

..\Server\Settings\ 
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SendDisplayOnAnswerCall

DWORD value specifying whether or not to display the company or user 
name to inbound Internet callers. You may need to disable this setting to 
use certain IP boards that do not support this feature. 

Default is 0 (automatic), specifying that all boards except the IP041 
boards provide a display string when answering a call. A setting of 1 
always provides a display string. A setting of 2 never provides a display 
string.

TruncateRecordings

DWORD value specifying whether or not TeleVantage should truncate 
extra silence at the end of voice message recordings. 

Default is 1 (silence is truncated). A value of 0 specifies that extra silence 
is not truncated.

UnknownCallerName

STRING value specifying the name to display in the call log when the 
actual caller name is unknown. 

Default is “Unknown”. 

UseConferencesForEchoCancellation

DWORD value specifying whether or not TeleVantage uses additional 
echo cancellation and gain control to improve the audio quality of 
forwarded calls on analog trunks. In particular, this feature can improve 
audio quality for the D/120-JCT board. However, the feature uses a 
conference resource when it connects an analog trunk to another trunk. It 
also may decrease call volume on some Dialogic ISA boards.

If you have PCI analog trunk boards, you must set the Receive Gain of 
those boards appropriately depending on whether the feature is on or off. 
If the feature is on, set the Receive Gain to P1. If the feature is off, set the 
Receive Gain to N1. For instructions on changing Receive Gain, see 
Installing TeleVantage. Note that if you have ISA analog trunk boards, 
you do not need to change Receive Gain.

When set to 0, the feature is off. 

When set to 1, the feature is on.

..\Server\Settings\ 
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TeleVantage Workstation applications registry settings _________
All supported TeleVantage workstation registry settings are found (or can be created) under the 
registry keys presented in this section. The workstation application settings are divided into 
those that apply to the current user (in the next section) and those set for the local machine 
(beginning on page A-9).

UseDedicatedVoiceDevices

DWORD value specifying whether or not TeleVantage will allocate 
dedicated voice devices when it allocates a voice device. When the 
Server requires a voice device (for playing/recording audio, or 
playing/detecting tones), it attempts to allocate one in the following 
order:

Q Allocate a shared voice device.

Q Allocate a dedicated, disconnected voice device (i.e. attached to LSI 
front end that is not plugged in).

Q If UseDedicatedVoiceDevices is enabled, allocate a dedicated, 
connected voice device.

Default is 1 (enabled. Server will attempt to allocate dedicated voice 
devices if necessary). A value of 0 disables this setting. 

UserVoxPath

STRING value specifying the path for local user voice prompts. Path 
string must end in a backslash. 

Default is set during installation. 

VoxHighEventInterval

DWORD value specifying the time interval (in milliseconds) for 
generating the Event log message "No Voice Resource Available."

Default is 800000 (15 minutes).

WaitLoopCurrenttimeout

DWORD value specifying the number of milliseconds to wait for loop 
current before dialing an outside number. Set this to zero to skip loop 
current checks when making outbound calls. 

Default is 1400 milliseconds. 

..\Server\Settings\ 
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Current User Settings
The workstation application settings in this section are located in HKEY_CURRENT_USER..

HKCU\Software\Artisoft\TeleVantage\Client

HKCU\Software\Artisoft\TeleVantage\Client\Admin\App

HKCU\Software\Artisoft\TeleVantage\Client\Layout

HKCU\Software\Artisoft\TeleVantage\Client\Logon

..\Client
ShowStatusBarServerInfo

DWORD value specifying whether the Client displays on the status bar 
the name of the Server to which it is connected. A setting of 0 does not 
display the Server name; a setting of 1 does display it.

Default is 0 on installation. 

..\Client\Admin\App 
LoggedInUserId

STRING value indicating the ID of the user who last logged in. 

Default is “” (empty string) on installation. 

..\Client\Layout
RedrawMode

DWORD value used to control the “flicker” effect in the Client display. 
The default setting of 1 (Normal) is less CPU-intensive but may result in 
a flicker. A setting of 2 (Buffered) eliminates the flicker, but 
performance may suffer.

Default is 1 on installation. 

..\Client\Logon
Address

STRING value specifying the user's station ID.

Default is “0”.

AutoLogon

DWORD value specifying whether or not autologon is on.

Default is 0 (false). 
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HKCU\Software\Artisoft\TeleVantage\Client\Call Monitor

Local Machine Settings
The workstation application settings in this section are located in HKEY_LOCAL_MACHINE.

Database

STRING value specifying the name of the database.

Default is “TVDB”.

History

STRING value specifying the list of recently logged in users. Specify an 
empty string to clear the list. 

Default is “” (empty string).

Server

STRING value specifying the name of the TeleVantage Server 
computer. May be either a NetBios name (for example, “TeleVantage”) 
or an IP Address (for example, “123.12.76.102”). 

Default is “” (empty string). 

Username

STRING value specifying the user’s TeleVantage login name. 

Default is “” (empty string). 

..\Client\Call Monitor
PersistentSort

DWORD value specifying how the Client’s Call Monitor displays newly 
arriving calls, after the view has been sorted by clicking on a column 
header. A setting of 1 turns on persistent sorting, so that newly arriving 
calls appear in the correct place according to the sort order. A setting of 
0 turns off persistent sorting, so that new calls always appear on the 
bottom row. After a call appears on the bottom row, you can click a 
column header to sort the new call correctly with the others.

Note that turning on persistent sorting can result in slower Client 
performance.

Default is 0 (persistent sorting off) on installation. 

..\Client\Logon
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HKLM\SOFTWARE\Artisoft\TeleVantage\Client\SecBridge

HKLM\SOFTWARE\Artisoft\TeleVantage\Client\Server

HKLM\SOFTWARE\Artisoft\TeleVantage\Client\TSP

..\Client\SecBridge
MaxTraceFileSize

DWORD value specifying the maximum size (in bytes) of the SecBridge 
log file.

Default is 1 mb.

TracePath

STRING value specifying the path at which SecBridge log files are 
created.

Default is Program Files/Common Files/<Company><Product Name> 
/Logs

OutputToTraceFileOn

DWORD value specifying whether tracing should go to a file on disk.

Default is 1 (yes)

MaxRevisions

DWORD value specifying the number of log file revisions.

Default is 5.

..\Client\Server
Pingtimeout

DWORD value specifying the ping time-out duration. If this is not set to 
0, users who log on to the Terminal Server remotely will need 
administrator permissions to run the Client (see “Installing the Client on 
Microsoft Terminal Server” in Installing TeleVantage). 

Default is 5000 milliseconds.

..\Client\TSP
HangUpCalls

DWORD value specifying whether or not the current user can hang up 
calls in a TAPI client application that is using the TeleVantage TAPI 
Service Provider (“TSP”). This setting is important for GoldMine users. 

Default is 1 (Clients can hang up calls using TAPI functions). A setting 
of 0 will prevent Clients from hanging up calls via TAPI.
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ServerPingInterval

DWORD value specifying how often the TAPI Service Provider 
validates the connection to the TeleVantage Server. If the connection is 
lost, the TSP tries to reconnect.

If the Server is restarted, there is a maximum delay of about 10 minutes 
before the CMA, for example, will start popups again for incoming calls.

Default is 10 minutes.

TraceMaxRevisions

DWORD value specifying the maximum number of backup log files that 
will be generated on this machine before the TeleVantage TAPI Service 
Provider (“TSP”) starts overwriting the oldest files. 

Default is 10 log files. 

TraceToFile

DWORD value specifying whether or not the TSP will log activity for 
this user to a disk file. 

Default is 1 (TSP will log). 

TraceDirectory

STRING value specifying the path to the TSP log file folder. 

Default is the \Logs subdirectory of the TeleVantage Client install 
folder. 

TraceLevel

DWORD value specifying a number used to limit logging output from 
the TSP. The higher it is, the more events will be logged. 

Default is 10 events. 

..\Client\TSP
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HKLM\SOFTWARE\Artisoft\TeleVantage\Client\TSP\Logon

..\Client\TSP\Logon
Address

STRING value specifying the station ID that the TAPI Service Provider 
(“TSP”) will monitor for incoming calls. TAPI client applications are 
notified of all calls to this station. 

The user can set and change this value using the TeleVantage TAPI 
Configuration Wizard.

No default. Must be set before the TSP can run.

Server

STRING value specifying the name of the TeleVantage Server computer 
to which the TSP will call. May be either a NetBios name (for example, 
“TeleVantage”) or an IP Address (for example, “123.12.76.102”). 

The user can set and change this value using the TeleVantage TAPI 
Configuration Wizard.

No default. Must be set before the TSP can run.
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TeleVantage Server language locale settings__________________
TeleVantage currently uses the following locale codes:

EN00 U.S. English
EN10 U.K. English
ES00 Latin American Spanish

HKLM\SOFTWARE\Artisoft\TeleVantage\Server\TUI

Locale definitions
Each installed locale code has its own set of registry entries, as follows:

HKLM\SOFTWARE\Artisoft\TeleVantage\Server\TUI\<LocaleCode>

..\Server\TUI
DefaultLocaleCode

STRING value specifying the default locale code. 

Default value is determined during installation. 

..\Server\TUI
Description

STRING value specifying the language description for this locale code. 

Defaults are: EN00 =“US English”, EN10 = “UK English”, ES00 = 
“Latin American Spanish”. 

LocaleDLL

STRING value specifying the DLL to use for this locale code. 

Defaults are: EN00 = “TVLEN00.DLL”, EN10 = “TVLEN10.DLL”, 
ES00 = “TVLES00.DLL”. 

SentenceFile

STRING value specifying the sentence file for this locale code. 

Defaults are: EN00 = “TVLEN00.INI”, EN10 = “TVLEN10.INI”, 
ES00 = “TVLES00.INI”. 

VapFile

STRING value specifying the system voice file for this locale code. 

Defaults are: EN00 = “TVLEN00.VAP”, EN10 = “TVLEN10.VAP”, 
ES00 = “TVLES00.VAP”. 
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Defining custom tones ____________________________________
Custom tones can be defined for incoming fax detection and disconnect detection. You can 
define one incoming fax tone and up to ten different disconnect tones under the following 
Windows NT registry keys:

HKLM\SOFTWARE\Artisoft\TeleVantage\Server\ToneDefinitions
\IncomingFaxTone 

HKLM\SOFTWARE\Artisoft\TeleVantage\Server\ToneDefinitions
\DisconnectTone<n> 

where <n> is a digit from 1 through 9 (for example, \DisconnectTone1, \DisconnectTone2, 
and so forth).

Custom trunk disconnect detection tones are used in installations where a PBX sits between the 
central office and TeleVantage, and where the PBX provides a tone to indicate trunk hangup. 
By default, defines a DisconnectTone1 as a fast busy tone. 

After you enter custom tones, you must restart the TeleVantage Server. At startup, TeleVantage 
will read the definitions for all custom tones and define them to the Dialogic drivers. 

Each custom tone is defined by the DWORD values of the keys listed in the following table.

Custom Tone Keys
Key Description

freq1 First frequency (in Hz) for the tone

freq1dev Allowable deviation for the first frequency (in Hz)

freq2 Second frequency (in Hz) for the tone

freq2dev Allowable deviation for the second frequency (in Hz)

cadence 1 = cadenced tone, 0 = noncadenced tone

minrep Number of repetitions for the cadence (that is, the number of 
times that the on/off signal is repeated)

dualtone 1 = dualtone, 0 = single tone

cadenceon Length of time for which the cadence is “on” (in 10ms units)

cadenceon_dev Allowable deviation for “on” time (in 10ms units)

cadenceoff Length of time for which the cadence is “off” (in 10ms units)

cadenceoff_dev Allowable deviation for “off” time (in 10ms units)

leadingedge 1 = tone detection on leading edge, 0 = on trailing edge
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Example: Defining a disconnect tone
The keys in the next table are DWORD values that define the default disconnect tone for 
TeleVantage. The tone has the following characteristics:

Q A Dual Tone Frequency with a first frequency of 450Hz – 510 Hz (that is, 480 +/- 30) 
and a second frequency of 580ms – 660ms (that is, 620 +/- 40)

Q On and off times are both between 200ms – 300ms (that is, 250ms +/- 50ms)

Q Cadence must repeat 2 times

Q Cadence begins on the leading edge of the tone 

Disabling Dialogic devices_________________________________
By default TeleVantage allocates and opens all Dialogic devices that are present on the Server 
for itself. If you do not want TeleVantage to allocate all of the available devices, use the 
procedure described later in this section to disable the Dialogic devices. 

You might need to disable Dialogic devices for any of the following reasons: 

Q Disable devices to allow non-TeleVantage applications to run on the TeleVantage 
Server. For example, you may have another CT application installed on the TeleVantage 
Server that must own some Dialogic devices. You would identify the specific Dialogic 
devices and channels required by the CT application, and then disable those devices. 
When TeleVantage opens Dialogic devices at startup, it will ignore the disabled devices, 
making them available to the CT application. 

Note:You do not need to reserve devices when developing an IVR Plug-in, which will 
automatically share TeleVantage’s Dialogic resources as needed. 

Custom Tone Keys
Key DWORD Description

freq1 480 First frequency (in Hz) for the tone

freq1dev 30 Allowable deviation for first frequency (in Hz)

freq2 620 Second frequency (in Hz) for the tone

freq2dev 40 Allowable deviation for second frequency (in Hz)

cadence 1 1 = cadenced tone, 0 = noncadenced tone

minrep 2 Number of repetitions for the cadence

dualtone 1 1 = dualtone, 0 = single tone

cadenceon 25 Time for which cadence is “on” (in 10ms units)

cadenceon_dev 5 Allowable deviation for “on” time (in 10ms units)

cadenceoff 25 Time for which cadence is “off” (in 10ms units)

cadenceoff_dev 5 Allowable deviation for “off” time (in 10ms units)

leadingedge 1 Tone detection: 1 = leading edge, 0 = trailing edge
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Q Disable devices to connect a fractional T1 or E1 line to TeleVantage. For example, 
you may have a T1 line with 12 channels instead of 24. To connect this T1 line to 
TeleVantage, you still connect it to a Dialogic card with 24 channels, but you disable 
half of the channels. When TeleVantage starts, it will see 12 instead of 24 trunks, which 
will match the fractional T1 line. You must be sure to disable the correct half, for 
example, trunks 1-12 or trunks 13-24, whichever matches the fraction of the T1 line you 
have.

Q Disable devices to ignore several trunks on a telephony board and use its voice 
processors only. For example, you may want to support a 1T1-by-24-station 
configuration in the minimum number of slots. The best way would be to install a 
D480SC-2T1 card that supports two T1 lines and 48 voice processors in one slot, and an 
MSI240 board to support 24 stations in a second slot. You would install the 2T1 line card 
even though you only have one T1 line because the D480SC-2T1 card has 24 extra voice 
processors that you can use to provide dial tone and voice prompts for the 24 stations. 
Installing a D240SC-T1 card and a D240SC card for the voice processors would require 
more slots. For this configuration, you would disable the network resources for the 
second T1 line on the D480SC-2T1 card. TeleVantage will not see them when starting 
up, but it will see all the voice processors. 

To disable Dialogic devices in the Windows registry

1. Using the conventions described in “Dialogic device names” on page A-18, determine 
the device names for the Dialogic devices you want to disable.

2. Run Regedit.

3. Create the following key (if it does not already exist): 

HKLM\SOFTWARE\Artisoft\TeleVantage\Server\Settings

4. Create a string value under Settings named DisableDevices.

5. Set the contents of DisableDevices to a comma-separated list of the device names you 
are disabling.

For example, to disable the third and fourth channels on the first telephony board in a 
system, set the contents of DisableDevices as follows:

DXXXB1C3,DXXXB1C4

To disable all the channels on a board, set DisableDevices to the board name without 
any channel, for example:

DXXXB1

6. Save the changes to the registry. 

Note: If you add or remove Dialogic boards, you must update the DisableDevices list.
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Disabling Dialogic conferencing resources
By default, TeleVantage may utilize any Dialogic board in the system to perform conference 
calls. Some boards support more parties in a conference than others, and if a conference call 
grows too big for the board currently handling it, TeleVantage will automatically switch to a 
higher-capacity board. By altering registry settings, you can disable the conferencing resources 
of individual Dialogic boards so that they are never used for conference calls by TeleVantage. 
One reason to do this would be to keep a board’s conferencing resources free for use by another 
application, while still enabling its station resources to be used by TeleVantage.

To see how many conference call parties a given Dialogic board can support, see Installing 
TeleVantage.

To disable a Dialogic board’s conference resources in the Windows registry

1. Run Regedit.

2. Create the following key (if it does not already exist): 

HKLM\SOFTWARE\Artisoft\TeleVantage\Server\Settings\DisableDevices

3. Create a string value under DisableDevices for the board whose conference resources 
you want to disable. The values are as follows:

Changing conference board priority
When a conference call is created, TeleVantage chooses which telephony board handles the 
conference based on a priority setting. The available board with the lowest priority number gets 
chosen first. If the number of participants in the conference exceeds the capabilities of the 
current board, the conference is moved to a board that supports the increased requirements, if 
one is available. See Installing TeleVantage for more information regarding telephony boards 
and their conference capabilities. If multiple boards in the system meet the conference 
requirements, then TeleVantage chooses the board based the following priority order:

1. Dialogic MSI boards - 100

2. Dialogic DMV boards and DISI boards - 200  

3. Toshiba Strata boards - 300

The lower a board’s priority number is, the more often it will be used for conference calls. By 
altering the registry you can change these priorities. 

Board Value where

MSI station boards /MSIConfBn n is the board 
number

DMV/2400/A
DI/HI station boards

DCBConfBnDy n and y are the 
board number
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To change the order in which TeleVantage selects boards for conferencing

1. Run Regedit.

2. For each board whose conference priority you want to change, add a DWORD value 
to the following setting:

HKLM\Software\Artisoft\Televantage\Server\<boardName>\ConfPriority

Name the value as follows, where n is the board number:

3. Set the value to the priority number you want.

Note: The priority between Dialogic DMV and DISI boards depends on which physical PCI slots 
they are installed in, and the board’s ID. If you want to have TeleVantage distinguish these boards 
based on priority, make sure they are arranged in correct order in your PCI slots. For example, to 
have TeleVantage use a DISI board before a DMV, make sure that the DISI board is installed in 
a PCI slot with a lower number than the slot which holds the DMV board. You can also set the 
board’s priority through the registry, as described in this section.

Dialogic device names
Dialogic system software creates standard names for devices and channels within devices. 
These names are used to open the devices to receive device handles, which are used in all 
subsequent Dialogic driver functions.

Dialogic telephony board device names
A Dialogic telephony board device name has the form DXXXBnCn, where Bn is the board 
number and Cn is the channel number. For example, Channel 1 on Board 1 would be named 
DXXXB1C1. If multiple telephony boards have been installed, the board number 1 is assigned 
to the Dialogic telephony board that was installed in the TeleVantage Server with the lowest 
board ID. (For information about setting Dialogic board IDs, see Installing TeleVantage.) The 
board number is then incremented by 1 for every four voice ports. The channel number is 
assigned sequentially starting with 1 each time the board number changes and incremented by 
1 for each voice channel. Whenever all the devices on one Dialogic telephony board have been 
named, the board-numbering sequence continues on the Dialogic telephony board that was 
installed with the next lowest board ID. 

Board Value

Dialogic MSI boards /MSIBoardn

Dialogic DMV and DISI boards /DCBBoardn

Toshiba Strata boards /DKTBoardn
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For example, if you installed a Dialogic D/80SC-4LS in the TeleVantage Server with the board 
ID set to 0 and a D/41ESC with the board ID set to 1, the devices on these boards would have 
the names shown in the following table.

If you assigned the lower board ID to the D/41ESC board, the devices on the same boards would 
have the names shown in the following table.

Board Board ID Channel

D/80SC-4LS 0 DXXXB1C1 - LSI/VOX

DXXXB1C2 - LSI/VOX

DXXXB1C3 - LSI/VOX

DXXXB1C4 - LSI/VOX

DXXXB2C1 - VOX

DXXXB2C2 - VOX

DXXXB2C3 - VOX

DXXXB2C4 - VOX

D/41ESC 1 DXXXB3C1 - LSI/VOX

DXXXB3C2 - LSI/VOX

DXXXB3C3 - LSI/VOX

DXXXB3C4 - LSI/VOX

Board Board ID Channel

D/41ESC 0 DXXXB1C1 - LSI/VOX

DXXXB1C2 - LSI/VOX

DXXXB1C3 - LSI/VOX

DXXXB1C4 - LSI/VOX

D/80SC-4LS 1 DXXXB2C1 - LSI/VOX

DXXXB2C2 - LSI/VOX

DXXXB2C3 - LSI/VOX

DXXXB2C4 - LSI/VOX

DXXXB3C1 - VOX

DXXXB3C2 - VOX

DXXXB3C3 - VOX

DXXXB3C4 - VOX
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Dialogic modular station interface (MSI) device names
The device name for a Dialogic modular station interface has the form MSIBnCn, where Bn is 
the board number and Cn is the channel number. For example, Channel 1 on Board 1 would be 
named MSIB1C1. The board number is assigned sequentially starting with 1 and is incremented 
by 1 for each board. Board number 1 is assigned to the MSI board installed in the TeleVantage 
Server with the lowest board ID. Board number 2 is assigned to the MSI station board installed 
with the next lowest board ID, and so on. (For information about setting Dialogic board IDs, see 
Installing TeleVantage.) The channel number is assigned sequentially starting with 1 on each 
board, incremented by 1 for each channel.

For example, if a TeleVantage Server had a single MSI/80SC Dialogic MSI board installed, the 
MSI devices would have the names shown in the following table. 

For more information, see the Device Name Assignment technical bulletin on the Dialogic 
support site at:

http://support.dialogic.com/tnotes/tnbyos/winnt/tn188.htm

Dialogic Internet telephony board device names
You can disable Dialogic Internet telephony boards to make them available for 
non-TeleVantage use, but you cannot disable individual channels on the boards. Board names 
use the form DM3Boardn, where n is the board number. The board number is assigned 
sequentially starting with zero and is incremented by 1 for each board.

Board Channel

MSI/80SC MSIB1C1

MSIB1C2

MSIB1C3

MSIB1C4

MSIB1C5

MSIB1C6

MSIB1C7

MSIB1C8
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Dialogic telephony board settings___________________________
Dialogic telephony board settings consist of VoiceBoard keys, which apply to all channels for 
a specified board number, and VoiceBoard Line keys, which apply to individual channels on the 
board. 

VoiceBoard settings
VoiceBoard keys are located under:

HKLM\SOFTWARE\Artisoft\TeleVantage\Server\VoiceBoard<n> 

where <n> is the Dialogic board number (see “Dialogic telephony board device names” on 
page A-18 for an explanation of board numbering conventions).

..\Server\VoiceBoard<n> 
Key Default Description

DXBD_FLASHCHR & Flash Character. Character that causes a hook 
flash when detected.

DXBD_FLASHTM 50 Flash Time. Length of time onhook during 
flash.

DXBD_MAXPDOFF 50 Maximum Pulse Digit Off. Maximum time 
loop current may be off before the existing loop 
pulse digit is considered invalid and reception 
is re-initialized.

DXBD_MAXSLOFF 25 Maximum Silence Off. Maximum time for 
silence being off, during audio pulse detection.

DXBD_MINIPD 25 Minimum Loop Interpulse Detection. 
Minimum time between loop pulse digits 
during loop pulse detection.

DXBD_MINISL 25 Minimum Interdigit Silence. Minimum time 
for silence to be on between pulse digits for 
audio pulse detection.

DXBD_MINLCOFF 40 Minimum Loop Current Off. Minimum time 
before loop current drop message is sent.

DXBD_MINPDOFF 2 Minimum Pulse Detection Off. Minimum 
break interval for valid loop pulse detection.

DXBD_MINPDON 2 Minimum Pulse Detection On. Minimum 
make interval for valid loop pulse detection.

DXBD_MINSLOFF 2 Minimum Silence Off. Minimum time for 
silence to be off for valid audio pulse detection.

DXBD_MINSLON 1 Minimum Silence On. Minimum time for 
silence to be on for valid audio pulse detection.
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DXBD_MINTIOF 5 Minimum DTI Off. Minimum time required 
between ring-received events.

DXBD_MINTION 5 Minimum DTI On. Minimum time required for 
rings received event.

DXBD_OFFHDLY 50 Off-hook Delay. Period after off-hook, during 
which no events are generated (no DTMF digits 
detected during this time).

DXBD_PAUSETM 200 Pause Time. Delay caused by a comma in the 
dialing string. Value indicates the number of 10 
millisecond units. 

DXBD_P_BK 6 Pulse Dial Break. Duration of pulse dial 
off-hook interval.

DXBD_P_IDD 100 Pulse Interdigit Delay. Time between digits in 
pulse dialing.

DXBD_P_MK 4 Pulse Dial Make. Duration of pulse dial 
off-hook interval.

DXBD_R_EDGE 2 Ring Edge. Detection of ring edge: 
1- Beginning of ring 
2 - End of ring

DXBD_R_IRD 80 Inter-ring Delay. Maximum time to wait for the 
next ring (100ms units). Distinguishes between 
calls. Set to 1 for T-1.

DXBD_R_OFF 5 Ring-off interval. Minimum time for ring not to 
be present before qualifying as “not ringing” 
(100 ms units). 

DXBD_R_ON  3 Ring-on Interval. Minimum time ring must be 
present to qualify as a ring (100ms units).

DXBD_S_BNC 4 Silence and Non-silence Debounce. Length 
of a changed state before Call Status Transition 
message is generated.

DXBD_TTDATA 10 Duration of DTMF digits for dialing. Value 
indicates the number of 10 millisecond units. 

DXBD_MFMINON 0 Minimum MF On. The duration to be added to 
the standard MF tone duration before the tone is 
detected. The minimum detection duration is 
65ms for KP tones and 40ms for all other tones. 
This parameters affects all the channels on the 
board (10ms units).

..\Server\VoiceBoard<n> 
Key Default Description
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VoiceBoard channel settings
Channel-level settings are controlled by the VoiceBoard Line registry keys, which are located 
under:

HKLM\SOFTWARE\Artisoft\TeleVantage\Server\VoiceBoard<n1>\Line<n2> 

where <n1> is the Dialogic board number and <n2> is the channel number (see “Dialogic 
telephony board device names” on page A-18 for an explanation of board and channel 
numbering conventions).

DXBD_MFTONE 6 MF Minimum Tone Duration. The duration of a 
dialed MF tone. This parameter affects all the 
channels on the board. Max value 10 (10ms 
units).

DXBD_MFDELAY 6 MF Interdigit Delay. The length of silence 
period between tones during MF dialing. This 
parameter affects all the channels on the board 
(10ms units).

DXBD_MFLKPTONE 10 MF length of LKP Tone. The length of the LKP 
tone during MF dialing. This parameter affects 
all the channels on the specified board. Max 
value 15 (10ms units).

DXBD_T_IDD 5 DTMF Interdigit Delay. Time between digits in 
DTMF dialing.

DXBD_MINOFFHKTM 250 Minimum Off-hook Time. Specified in 10ms 
units.

..\Server\VoiceBoard<n> 
Key Default Description

..\Server\VoiceBoard<n1>\Line<n2> 
DXCH_ADSIALERT_AMPL

DWORD value that specifies the volume of the ADSI alert tone, which 
is the first Caller ID beep when sending Caller ID with call waiting. The 
Dialogic default is -13, which is louder than the TeleVantage setting.

TeleVantage default is -23.

DXCH_D_FLAGS

DWORD value for DTMF detection edge select. 

Default is 0.
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DXCH_DTINITSET

DWORD value that specifies the DTMF digits on which to initiate play 
on. You can OR values of different DTMF digits to form the bit mask. 
Legal values are as follows:

Value Digit Value Digit
-DM_1  1 -DM_9  9
-DM_2  2 -DM_0  0
-DM_3  3 -DM_S  *
-DM_4  4 -DM_P  &
-DM_5  5 -DM_A  a
-DM_6  6 -DM_B  b
-DM_7  7 -DM_C  c
-DM_8  8 -DM_D  d

Default is 0.

DXCH_DTMFTLK

DWORD value for DTMF Talk. Sets the minimum time for DTMF to be 
present during playback to be considered valid. Increasing the value 
provides more immunity to talkoff/playoff. Set to -1 to disable.

Default is 5.

DXCH_DTMFDEB

DWORD value for DTMF debounce time. Maximum length of time in 
which DTMF can be absent and then come back on again and still be 
considered the same DTMF tone.

Default is 0.

DXCH_MFMODE

DWORD value for MF Mode. A word-length bit mask that selects the 
minimum length of KP tones to be detected. Possible values: 

Q 0 - detect KP tone > 40ms 

Q 2 - detect KP tone > 65ms 

Q Greater than 2 - KP tone returned to application during MF 
detection. Ensures only standard length KP tones (100ms) are 
detected. If set to 0 any KP tone greater than 40ms will be detected.

Default is 2.

..\Server\VoiceBoard<n1>\Line<n2> 
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E1 and T1 board settings
In the following lists, Board<n> refers to a Dialogic board number. See “Dialogic telephony 
board device names” on page A-18 for an explanation of board numbering conventions.

HKLM\SOFTWARE\Artisoft\TeleVantage\Server\DTIBoard<n>\GlobalCall

DXCH_MAXRWINK

DWORD value for Maximum Loop Current for wink. Maximum time 
loop current needs to be on before recognizing a wink (10ms units)

Default is 20.

DXCH_MINRWINK

DWORD value for Minimum Loop Current for wink. Minimum time 
loop current needs to be on before recognizing a wink (10ms units)

Default is 10.

DXCH_WINKDLY

DWORD value for Wink Delay. The delay after a ring is received before 
issuing a wink (10ms units)

Default is 15.

DXCH_RINGCNT

DWORD value for Ring Count. Number of rings to wait before 
returning a ring event.

Default is 4.

DXCH_WINKLEN

DWORD value for Wink Length. The duration of a wink in the off-hook 
state (10ms units). 

Default is 15.

..\Server\VoiceBoard<n1>\Line<n2> 

..\Server\DTIBoard<n>\GlobalCall 
CIDName...

The CIDName settings allow you to customize how your system receives 
Calling Name Identification on PRI lines. See the next section, 
“Configuring Calling Name Identification on PRI boards.” 
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DumpCallInfo

DWORD value specifying whether or not to include raw call-event 
information elements from E1 and T1 trunks (ISDN PRI, robbed-bit, 
CAS) in the TeleVantage Server log (Tvlogxxx.txt). 

Default is 0, which suppresses the information element logging. Set to 1 
to include the information elements in the log. 

HandleProgressInd

DWORD value specifying whether TeleVantage uses IE-based audio 
connection on ISDN trunks. Add for each PRI board in your system. 
When this feature is turned on, audio is connected on IEs of 1 and 8 on 
PROCEEDING, SETUP_ACK, and ALERTING. 

When set to 0, this feature is turned off. Audio connects on all ISDN calls 
regardless of Progress IEs.

When set to 1, this feature is turned on. Audio connects on ISDN calls 
only with the IEs described above.

Default is 0.

InProtocol and OutProtocol

These values define the CAS protocol on E1 boards. For details, see 
“Manually entering E1 CAS protocols” in Installing TeleVantage. 

DNISLength

DWORD value specifying the number of expected DNIS (DDI) digits (in 
milliseconds) to be received by the TeleVantage Server before 
attempting to process the inbound call. 

No default, but the TeleVantage Server attempts to get the DNIS 9 digit 
string upon notification of an inbound call.

DNISWaitTime

DWORD value specifying the expected DNIS (DDI) time (in 
milliseconds) that the TeleVantage Server will wait for digits to be 
received before attempting to process the inbound call. 

Default is 2000 milliseconds (2 seconds) after it receives the notification 
of an inbound call.

..\Server\DTIBoard<n>\GlobalCall 
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Configuring Calling Name Identification on PRI boards
Depending on your ISDN provider, Calling Name Identification is delivered in an Information 
Element (IE) either when the incoming call is offered (in the SETUP message), or on a 
subsequent FACILITY message. 

This information is controlled via the registry values described below.  The default values 
represent commonly-used settings, but you may need to customize the defaults based on how 
your provider delivers Calling Name Identification.

Add the following for each PRI board in your system, under:

HKEY_LOCAL_MACHINE\SOFTWARE\Artisoft\TeleVantage\Server\DTIBoard1\
GlobalCall

Q CIDNameOnSetup (DWORD). Message that contains the calling name field. When set 
to 0, calling name is delivered in the FACILITY message. When set to 1 (the default), 
calling name is delivered in the SETUP message.

Q CIDNameIE (DWORD). IE in which the calling name field is delivered. default is 28 
(0x1C).

Q CIDNameOffset (DWORD). Offset within the IE where the calling name field begins. 
Default is 14 (0x0E).

Q CIDNameLength (DWORD). Length of the calling name field within the IE. Default is 
15 (0x0F).

Q CIDNameTimeout (DWORD). Used only when CIDNameOnSetup = 0. Maximum 
length of time TeleVantage waits for the FACILITY message to arrive. The default, 
2000, specifies a 2-second wait.

The following is a sample IE taken from a TeleVantage Server log that conforms to the default 
CIDNameIE, CIDNameOffset, and CIDNameLength values described above. The IE is 
displayed in hexadecimal and ASCII: 

IE: 0x1C: 9F 8B 01 00|A1 17 02 01|01 02 01 00|80 0F 52 4F|42 42 49 4E|53 20 45 4E|47 49 4E 45|45    
"....!.........ROBBINS ENGINEE"

OverlappedDNIS

DWORD value specifying how DNIS digits are delivered on your 
system. Normally, DNIS digits are delivered completely on the SETUP 
message. Some European switches deliver DNIS digits one at a time 
after the SETUP message (overlapped digits). 

Set to 0 (the default) if DNIS digits are delivered completely on the 
SETUP message. 

Set to 1 if DNIS digits are delivered as overlapped digits.

..\Server\DTIBoard<n>\GlobalCall 
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BRI board settings
HKLM\SOFTWARE\Artisoft\TeleVantage\Server\BRIBoard<n>\ISDN

..\Server\BRIBoard<n>\ISDN 
DumpCallInfo

DWORD value specifying whether or not to include raw call-event 
information elements from BRI trunks in the TeleVantage Server log 
(Tvlogxxx.txt). 

Default is 0, which suppresses the information element logging. Set to 1 
to include the information elements in the log. 

DNISWaitTime

DWORD value specifying the expected DNIS (DDI) time (in 
milliseconds) that the TeleVantage Server will wait for digits to be 
received before attempting to process the inbound call. 

Default is 2000 milliseconds (2 seconds) after it receives the notification 
of an inbound call.

HandleProgressID

DWORD value specifying whether TeleVantage uses IE-based audio 
connection on ISDN trunks. Add for each BRI board in your system. 
When this feature is turned on, audio is connected on IEs of 1 and 8 on 
PROCEEDING, SETUP_ACK, and ALERTING. 

When set to 0, this feature is turned off. Audio connects on all ISDN calls 
regardless of Progress IEs.

When set to 1, this feature is turned on. Audio connects on ISDN calls 
only with the IEs described above.

Default is 0.

OverlappedDNIS

DWORD value specifying how DNIS digits are delivered on your 
system. Normally, DNIS digits are delivered completely on the SETUP 
message. Some European switches deliver DNIS digits one at a time 
after the SETUP message (overlapped digits). 

Set to 0 (the default) if DNIS digits are delivered completely on the 
SETUP message. 

Set to 1 if DNIS digits are delivered as overlapped digits.
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ISDN Megacom service settings
These settings enable you to make outbound international calls using ISDN Megacom service. 
The first setting is required, and the last two settings are optional. 

For each outbound call, TeleVantage checks the dial string to see if it is prefixed with the 
number specified in InternationalPrefix. 

If it does not contain the international prefix, the call proceeds like a normal domestic call, and 
no further steps occur.

If it does contain the international prefix, TeleVantage strips the prefix from the dial string, and 
then checks whether InternationalType and InternationalPlan are present. If they are, 
TeleVantage uses them to override the called number and calling number call parameters.

HKLM\SOFTWARE\Artisoft\TeleVantage\Server\DTIBoard<n>\GlobalCall\
MakeCall

PointToPoint

DWORD value specifying whether the board uses point-to-point 
protocol. 

To use point-to-point protocol, set to 1. You must also change the 
firmware file for the board (see Installing TeleVantage).

Default is 0 (Multipoint protocol)

..\Server\BRIBoard<n>\ISDN 

..\DTIBoard<n>\GlobalCall\MakeCall
InternationalPrefix

STRING value for your international dialing prefix. For example, 
InternationalPrefix=“011”.

Default is “011”.

InternationalType

DWORD value used to override the called number call parameter. 

Default is 1, INTL_NUMBER.

InternationalPlan

DWORD value used to override the calling number call parameter. 

Default is 1, ISDN_NUMB_PLAN.
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MSI station board settings
HKLM\SOFTWARE\Artisoft\TeleVantage\Server\MSIBoard<n>

..\Server\MSIBoard<n> 
CID_FSK_FORMAT

DWORD value specifying the format used by MSI board <n> to send 
Caller ID information to CLASS phones. 

Valid settings are:

Q 0 - SDMF (Single Data Message Format) sends the date, time, and 
10-digit Caller ID number.

Q 1 - MDMF (Multiple Data Message Format) sends the date, time, 
10-digit Caller ID number, and 15-digit caller name.

Q 2 - UK_MDMF (UK Multiple Data Message Format) sends the 
date, time, 18-digit Caller ID number, and 20-digit caller name.

Default is 1 (MDMF format).

MSG_DBONTM

DWORD specifying the duration (50 ms units) that stations on MSI 
board<n> must be on-hook before a hangup is detected. This value 
should usually be equal to MSG_MAXFLASH + 1. 

Default is 21 (1050 milliseconds). 

MSG_DBOFFTM

DWORD specifying the duration (50 ms units) that stations on MSI 
board<n> must be off-hook before an off-hook transition is detected. The 
valid range is 2 - 20. 

Default is 3 (1050 milliseconds). 

MSG_MAXFLASH

DWORD specifying the maximum length of time (in 50 ms. units) for 
stations on MSI board <n> to be on-hook before a hook flash is detected. 

Default is 20 (1000 milliseconds). 

MSG_MINFLASH

DWORD specifying the minimum length of time (in 50 ms. units) for 
stations on MSI board <n> to be on-hook before a hook flash is detected. 

Default is 6 (300 milliseconds). 
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Using the TeleVantage Advanced Settings Editor ______________
The TeleVantage Advanced Settings Editor is a utility that you can use to view and alter settings 
for both the Server and individual users. The TeleVantage Server uses a database to store 
numerous settings. Other TeleVantage settings are stored in the Windows registry of each 
machine. You must have Administrator permissions to run the TeleVantage Advanced Settings 
Editor. 

Use this utility with extreme caution, preferably under the direction of your TeleVantage 
provider. 

To run the TeleVantage Advanced Settings Editor, start the Administrator and choose Tools > 
Advanced Settings Editor.

Viewing current values
The main window of the program displays a list of all available settings.

Q In the User Name drop-down list, select a TeleVantage user. In the Location column, 
“User” refers to the user specified here. 

Q Name indicates the path and name of the key. 

VMWI_FSK_FORMAT

DWORD specifying the format used by MSI board <n> to send visual 
message waiting indication to CLASS phones. Valid settings are:

Q 0 - SDMF (Single Data Message Format)

Q 1 - MDMF (Multiple Data Message Format)

Default is 0 (SDMF format). 

..\Server\MSIBoard<n> 
APPENDIX A. TELEVANTAGE CONFIGURATION SETTINGS A-31



Q Value indicates the current value of this key. You can change the value by 
double-clicking the item and entering a new value in the Edit Setting dialog box, as 
described in the next section, “Changing key values.” 

Q Default indicates the TeleVantage default value for this key. 

Q Location indicates where the key value will be stored. “User” and “Server” keys are 
stored in a database on the TeleVantage Server. “Registry” keys are stored in the 
Windows Registry of the machine on which you are running the TeleVantage Settings 
program. 

Q Type indicates whether the value is Boolean, Long, or String. 

Changing key values
When you double-click on a key listed in the main window, the Edit Setting dialog box opens.

Q Name displays the name of the key. 

Q Value allows you to change the value of the key by typing a new value and clicking OK. 

Q Default displays the default value. 

Q Location displays the location of the key. 

Q Type displays the type of value for this key (Boolean, Long, or String).

Q Description displays a description of the key. 
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Modifying other supported TeleVantage settings
Artisoft support is available for the settings described in this section. These settings are stored 
either as Registry keys on the current computer or as System items on the Server database. 
Support is not available for other settings except when your TeleVantage provider has 
specifically instructed you to alter them.

Registry keys on the current computer
audio\temp file dir

STRING value that specifies the directory in which to store temporary 
files. 

Default value is “” (empty string). 

audio\VolumePercentage

DWORD value that specifies the percentage to increase the current wave 
volume on playback or recordings or greetings. 

Default value is 35 (increase volume by 35%). 

Call Monitor\Hold Conference Parties

DWORD value that specifies whether or not external conference parties 
may be put on hold. 

Default value is 1 (true). A value of 0 would specify that parties may not 
be put on hold. 

Database\Connectiontimeout

DWORD value that specifies the amount of time (in seconds) to wait 
before timing out when connecting to the database. 

Default value is 15 seconds. 

Device Monitor\RefreshInterval

DWORD value that specifies the interval (in minutes) between Device 
Monitor application refresh cycles. 

Default value is 5 minutes. 

System database settings
ACD\NoAnswerTime

DWORD value that specifies how long to wait after an agent in a call 
center queue fails to answer a call before offering that agent another call. 

Default value is 30 seconds. 
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Server\ACDWrapupTime

DWORD value specifying the number of milliseconds (for ACD group) 
between when an agent hangs up a call and when the oldest waiting caller 
is notified that the agent became available. 

Default is 4000 milliseconds.

Server\BufferDirCleanupThreshold

DWORD value specifying the threshold age (in days) of old files that the 
Server automatically deletes from the buffer directory. The Server will 
delete files as old or older than this setting. Note that many buffer files 
are created by workstation applications such as the Client, so the 
threshold should be kept long enough so that workstation applications 
will be stopped and restarted, ensuring that the remaining files are really 
unused.

Default value is 10 days.

Server\CPAConnectDelay

DWORD value that specifies the delay in milliseconds after call progress 
analysis returns the connected result before marking an outbound call as 
connected. Increasing this value may help discriminate between 
abandoned and connected calls. 

Default value is 2000 millseconds. 

Server\AllowCallsWithoutUsers

DWORD value that specifies whether or not to allow conference calls 
with no users (that is, all parties have left the conference) and external 
transfers of external calls. 

Default value is 1 (true). A value of 0 would prevent conference calls 
with no users and external transfers of external calls. 

Server\AllowGatewayUserLogin

DWORD value. If this value is non-zero, the system will allow Gateway 
users to log in from an auto attendant or internal dial tone. Gateway users 
inherit the permissions of their IP Gateway and usually have the ability 
to dial external numbers while logged in on a trunk.

Default value is 1.

Server\AudioControlRingtimeout

DWORD value that specifies the maximum time (in milliseconds) that 
the TVAudio Control will spend attempting to connect before returning 
with a time-out. 

Default value is 30000 milliseconds. 

System database settings
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Server\CheckRecipientCallForSetting

DWORD value. Check both callee and recipient “call for” setting. The 
callee is the person whom the call is for. The recipient is the person who 
answers the phone, or, to be more precise, the person who most recently 
logged in at that station. Note that these can be different people. 

Default value is 1 (yes). With this setting (or if the setting is not present), 
“call for” will be announced if either the callee or the recipient has “call 
for” turned on. Can be set to 0 (no.)

Server\DefaultGreetingSize

DWORD value that specifies default size (in minutes) for greeting space. 

Default value is 10 minutes. 

Server\DefaultMailboxSize

DWORD value that specifies default size for a new mailbox. 

Default value is 20. 

Server\Dial911AtDialtone

DWORD value that specifies whether the emergency number can be 
dialed at the internal dial tone.

Default value is 0 (no). Can be set to 1 (yes).

Server\DirectCallsUseFaxTarget

DWORD value that determines whether incoming faxes on DID calls are 
diverted to the Send faxes to extension for the trunk. When enabled, 
faxes are diverted, but all trunks on the span must use the same fax target. 
When disabled, DID calls are always routed to the user whose DID 
number is being dialed, even when they are fax calls.

Default value is 0 (disabled). Can be set to 1 (enabled).

Server\DropMonitorsAfterTransferComplete

DWORD value specifying whether parties supervising a call are 
disconnected when the call is transferred to another party or parked and 
unparked by another party. Supervisors are call center agents who have 
used the Coach or Monitor command on another agent’s call.

The default is 1 (supervisors are disconnected on transfers).

Server\E911RingDuration

DWORD value that specifies the number of milliseconds to ring E-911 
stations before dialing out of trunk.

Default value is 4000 millseconds (4 seconds).

System database settings
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Server\ExternalCallOfferingDelay

DWORD value specifying the wait (in milliseconds) before TeleVantage 
starts call offering on a trunk for routing lists and call forwarding. This 
setting applies to normal PSTN calls (analog, RB T1, and ISDN). For IP 
calls where a positive indication of connection is received, use 
ExternalCallOfferingDelayConnected.

Default is 8000 milliseconds. 

Server\ExternalCallOfferingDelayConnected

DWORD value specifying the wait (in milliseconds) before TeleVantage 
starts call offering on a trunk for routing lists and call forwarding. This 
setting applies to IP calls where a positive indication of connection is 
received. For normal PSTN calls (analog, RB T1, and ISDN), use 
ExternalCallOfferingDelay. 

Default is 100 milliseconds. 

Server\InternalDialtoneTrunkFirsttimeout

DWORD value that specifies the dial tone duration (in milliseconds) 
before the trunk goes to reorder when a user is logged in remotely. 

Default value is 180000 milliseconds. 

Server\InternalDialtoneTrunkSecondtimeout

DWORD value that specifies the dial tone duration (in milliseconds) 
after a remote party hangs up before the station goes to reorder when a 
user is logged in remotely. 

Default value is 180000 milliseconds. 

Server\InternalDialtoneStationFirsttimeout

DWORD value that specifies the dial tone duration (in milliseconds) 
before the station goes to reorder. 

Default value is 25000 milliseconds. 

Server\InternalDialtoneStationSecondtimeout

DWORD value that specifies the dial tone duration (in milliseconds) 
after a remote party hangs up before the station goes to reorder. If there 
is a PBX behind TeleVantage that uses the reorder tone as a disconnect 
tone, you may want to decrease this value. 

Default value is 5000 milliseconds. 

System database settings
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Server\IPVoiceTitleMaxSilence

Sometimes voice titles for IP calls are cut off. This is because latency 
causes extra silence at the start of the call. This setting allows you to 
change the Maximum duration of silence allowed in milliseconds.

Default is 2000

Server\LongIdleTime

DWORD value that specifies the minimum duration (in seconds) of a 
function call or IVR Plug-in before a Windows NT event is generated. 

Default value is 21600 seconds. 

Server\MaxAutoAttendantLoops

DWORD value that specifies the maximum number of auto attendants to 
which a call will be routed without the caller pressing a key. 

Default value is 3. 

Server\MaxRingDuration

DWORD value that specifies the maximum ring duration (in 
milliseconds) for internal and external calls. The maximium possible 
value is 999000. Note that for live Operator systems you might want to 
use the maximum value, to help prevent Operator calls from continuing 
down the Operator’s routing list.

Default value is 120000 milliseconds. 

Server\MinimumMessage

DWORD value that specifies the minimum duration (in milliseconds) for 
voice mail messages. Messages shorter than this are discarded. 

Default value is 2000 milliseconds. 

Server\MinRingDuration

DWORD value that specifies the minimum ring duration (in 
milliseconds) for internal and external calls. The minimum possible 
value is 1000.

Default value is 5000 milliseconds. 

Server\MinRingDurationForExternal

DWORD value that specifies the minimum ring duration (in 
milliseconds) for external calls. 

Default value is 12000 milliseconds. 

System database settings
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Server\MinRingDurationForExternalCallOffering

DWORD value that specifies the minimum ring duration (in 
milliseconds) for external calls using call offering in routing lists. 

Default value is 12000 milliseconds. 

Server\MinRingDurationForExternalPadding

DWORD value that specifies the extra time (in millseconds) that the 
system adds to ring durations for external calls in routing lists.

Default value is 3000 millseconds.

Server\MSDEFullPercentage

DWORD value specifying the maximum percentage of MSDE database 
size allowed, after which the Server will stop logging call data.

Default is 90.

Server\MSDECriticalLimitPercentage

DWORD value specifying the critical limit on the MSDE database size 
(as a percentage), at which the phone system raises an NT event.

Default is 80.

Server\PageRequestTimeout

DWORD value specifying how much time (in milliseconds) the Server 
allots, when a user makes a page, to take all paged Cybiolink and Aastra 
Powertouch phones offhook. (No delay occurs for Strata phones.) At the 
end of the allotted time the page connection is made with however many 
phones were successfully taken offhook. Note that if the time is too short, 
some paged phones will not be taken offhook and will not receive the 
page.

Default is 10,000 milliseconds.

Server\PageTimeout

DWORD value specifying how much time (in milliseconds) a page can 
last, following the beep that signals connection. At the end of the allotted 
time, the page ends automatically.

Default is 30,000 milliseconds.

Server\PageVoxAllocMaxRetryInterval

DWORD value specifying the length of time TeleVantage waits (in 
milliseconds) to retry taking a phone offhook for a page, after it fails due 
to lack of voice resources.

Default is 2000 milliseconds
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Server\PageVoxAllocRetries

DWORD value specifying the maximum number of attempts to take a 
phone offhook for a page.

Default is 10

Server\PrependVTMessageDuration

DWORD value specifying the length (in seconds) of voice messages 
beyond which TeleVantage does not automatically prepend the caller’s 
voice title. On short messages, the voice title is sometimes wanted to 
identify the caller, while on longer messages it is assumed the 
identification is provided in the message. 

Default is 5.5 seconds.

Server\RefreshVMWI

DWORD value specifying the number of milliseconds to wait before 
refreshing the CLASS phone message waiting lights. 

Default is 5000 milliseconds. 

Server\PresentExtensionBeforeCallerID

DWORD value specifying how callback is performed on voice messages 
that have both an extension and a Caller ID number. This can occur when 
a user calls in from a remote phone, logs in, presses # and dials an 
internal number, and leaves a message. When set to 0, callback dials the 
Caller ID number. When set to 1, callback dials the extension.

Default is 0 (dial Caller ID number)

Server\RequireLoginForTUIOnTrunk

DWORD value specifying whether or not TeleVantage will require a 
user login after pressing ** on a remote phone (trunk ** has the same 
effect as a station flash). 

Default value is 1 (login is required). A value of 0 specifies that login is 
not required. 

Server\RoutingListContinueDelay

DWORD value specifying the time duration a caller has to press # and 
be advanced to the next action in the routing list.

Default value is 15 seconds.

Server\SendDigitsToStationDelay

DWORD value that specifies the delay (in millseconds) before sending 
digits to a station, for example, DID digits.

Default value is 0 milliseconds.
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Server\TrunkAllocationInterval

DWORD value that specifies the amount of time (in milliseconds) that 
dialing services wait before trying to allocate another trunk. This is only 
used when a trunk is not responding. If you decrease this value, you also 
need to decrease WaitLoopCurrenttimeout (see page A-7). 

Default value is 1800 milliseconds. 

Server\TUIIdleTimeout 

DWORD specifying number of milliseconds before the TUI times out. 
Timeout causes a trunk to hang up. When a station times out, the re-order 
tone will play and then the station will be disabled until it is hung up. 

Default is 120000 milliseconds.

Server\TUITransferRingDelay

LONG value specifying the amount of time (in milliseconds) that the 
server waits before ringing the recipient’s phone on call transfers using 
the telephone commands. The delay gives the transferer time to hang up 
when performing a blind transfer. Increasing the ring delay can avoid 
extra ringing of the recipient’s phone that may cause confusion.

Default value is 5000 milliseconds.

Server\UISupportIdleTimeout

DWORD specifying the time in milliseconds before a station goes to 
dialtone after the Client plays or records audio.

Default is 120000 milliseconds.

Server\VoxLowEventInterval

Minimum Time interval in milliseconds for generating Event logs when 
a low priority voice resource cannot be allocated. A low priority voice 
resource is a voice resource used for VMWI and paging.

Default value is -1 (Ignore).

Server\VoxLowBorrowedMinFreeAbsolute

The minimum number of voice resources the system should maintain 
before allocating a borrowed voice resource for a low priority task. A low 
priority task is a VMWI or paging task.

Default value is -1 (Ignore).
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Server\VoxLowBorrowedMinFreePercentage

The minimum percentage of voice resources the system should maintain 
before allocating a borrowed voice resource for a low priority task. A low 
priority task is a VMWI or paging task. A setting of -1 means the 
parameter is ignored.

Default value is 100 (Don’t allocate any).

Server\VoxLowSharedMinFreeAbsolute

The minimum number of voice resources the system should maintain 
before allocating a shared voice resource for a low priority task. A low 
priority task is a VMWI or paging task.

Default value is -1 (Ignore).

Server\VoxLowSharedMinFreePercentage

The minimum percentage of voice resources the system should maintain 
before allocating a shared voice resource for a low priority task. A low 
priority task is a VMWI or paging task. A setting of -1 means the 
parameter is ignored.

Default value is 50.

Server\VoxLowMaxInstances

The maximum number of voice resources that can be allocated 
simultaneously in the system for low priority tasks at any point of time. 
A low priority task is a VMWI or paging task.

Default value is -1 (Ignore).

Server\VoxSysCallRecEventInterval

Minimum time interval in milliseconds for generating Event logs when 
a voice resource cannot be allocated for System Call Recording. A 
setting of -1 means the parameter is ignored.

Default value is 900000 (15 minutes).

Server\VoxSysCallRecBorrowedMinFreeAbsolute

The minimum number of voice resources the system should maintain 
before allocating a borrowed voice resource for System Call Recording.

Default value is -1 (Ignore).

Server\VoxSysCallRecBorrowedMinFreePercentage

The minimum percentage of voice resources the system should maintain 
before allocating a borrowed voice resource for System Call Recording. 
A setting of -1 means the parameter is ignored.

Default value is 100 (Don’t allocate any).
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Server\VoxSysCallRecSharedMinFreeAbsolute

The minimum number of voice resources the system should maintain 
before allocating a shared voice resource for System Call Recording.

Default value is -1 (Ignore).

Server\VoxSysCallRecSharedMinFreePercentage

The minimum percentage of voice resources the system should maintain 
before allocating a shared voice resource for a System Call Recording. A 
setting of -1 means the parameter is ignored.

Default value is 10.

Server\VoxSysCallRecMaxInstances

The maximum number of voice resources that can be allocated 
simultaneously in the system for System Call Recording at any point of 
time.

Default value is -1 (Ignore).

System\MinAdminBuild

DWORD value that specifies minimum build version number of the 
Administrator program that is allowed to log on to the Server. 

Default value is 0. 

System\MinClientBuild

DWORD value that specifies minimum build version number of the 
Client that is allowed to log on to the Server. 

Default value is 0. 

System\MinDevMonBuild

DWORD value that specifies minimum build version number of the 
Device Monitor that is allowed to log on to the Server. 

Default value is 0. 
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APPENDIX B

COMMAND LINE OPTIONS

Starting TeleVantage from the command line
You can use optional command line arguments to log on to the TeleVantage Administrator or 
Client using the Run command of the Start menu, from within an application, or from a Desktop 
shortcut such as:

"C:\Program Files\TeleVantage\Test Admin\TVAdmin.exe" /Server=TVTest 
/station=17

Use the command line options shown in this section when logging on.

Command line options
/Server=<Server name>

Name of the TeleVantage Server on your network that you want to log 
on to. Useful for running a Client or Administrator against a test Server.

If you do not use this option, TeleVantage logs you in using the name of 
the TeleVantage Server stored in the Windows NT /2000 registry, set 
when you install TeleVantage.

/station=<station number>

Station ID assigned for this session.

If you do not use this option, TeleVantage logs you on using the station 
number stored in the Windows NT/2000 registry, set when you install 
TeleVantage.

/allowmultiple

Allows more than one Administrator or Client to run simultaneously on 
a machine. If you do not use this option, TeleVantage allows one 
instance of the Administrator or Client to run on a machine.

/user=<user name>

User name under which you want to log on.

If you do not use this option, the Administrator or Client prompts you for 
your user name at startup.

/password=<password>

Password for the user account you use to log on.

If you do not use this option, the Administrator or Client prompts you for 
your password at startup.



/backup

Administrator only. Performs an immediate online backup of the 
TeleVantage database using the current System Settings, and then exits 
the Administrator when the backup is complete. See “Backing up 
TeleVantage” on page 11-17.

/sentence

Administrator only. Enables the Tools menu selection Test Sentences, 
which allows you to listen to system prompts in context over your 
telephone. See “Testing system prompts” on page 12-10.

Command line options
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About toll fraud __________________________________________
Businesses using any phone system, not just TeleVantage, are vulnerable to loss of money from 
unauthorized people "hacking" into their phone system. Hackers make hundreds of outbound 
long distance or international calls that cost businesses around the world millions of dollars 
every year.  TeleVantage contains several features and options that can dramatically increase the 
security of your system against toll fraud.

Typical toll fraud strategies
While hackers committing toll fraud try a variety of techniques to gain access to a system, it is 
important to note that 99% of the time access is gained through insecure (easy-to-guess) 
passwords. The Administrator’s System Settings provide several options for enforcing 
harder-to-guess passwords. See “The Security tab” on page 3-15.

The following are the most common methods of attempted toll fraud:

Q Calling the main auto attendant, pressing #, logging in as the Administrator, pressing # 
for dial tone and placing outbound calls

Q Attempting to log on at every extension (101, 102, etc.) until an extension with an easy 
password is found.  Once found, the hacker will change call forwarding to the external 
number they want to dial (for example, an international number or the number of another 
hacked PBX), and then make calls to the external number as needed.  By calling through 
multiple hacked PBXs, Caller ID and traces will be unable to track down the hacker's 
identity.

Q Calling random users and telling them they are a representative from the phone company 
and need their voice mailbox password to track down a problem with the phone system.  
Users should be told to never give out their passwords, and if they have reason to believe 
someone else has it, to change it immediately to something secure.

Identifying Toll Fraud______________________________________
The following methods will help you tell whether your system has been targeted by toll fraud 
hackers:

Q Check your Administrator's call log daily for multiple logon attempts.  A failed logon 
attempt will show as "logon - Abandoned".   A successful fraudulent logon will typically 
show many long distance or international calls placed afterwards from that extension. 

Note: You can have TeleVantage automatically hang up on callers and lock out 
accounts after multiple failed logon attempts. See “The Security tab” on page 3-15.

Q Check your phone bills carefully for international numbers or long distance numbers you 
do not recognize.

Q Watch your device monitor for sudden bursts where every line is busy with people trying 
to logon.
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Protecting your system against toll fraud_____________________
The following are a variety of ways to secure your phone system.  While practicing all of these 
strategies will keep your phone system very secure, by far the most important strategy is to just 
improve the security of passwords.

Password security
The Security tab in System Settings (see “The Security tab” on page 3-15) gives you several 
options for making user passwords more secure. For maximum security you should choose all 
of the following options:

Q Set a minimum password length. Passwords should be at least 5 digits long, preferably 7.

Q Prevent passwords from including the user’s extension.

Q Prevent passwords from including easy-to-guess elements like same-digit strings (111) 
or consecutive-digit strings (123).

Q Regularly force password change. 

Changing the Admin and Operator passwords
TeleVantage’s two default users, the Admin and Operator, have easy-to-guess passwords. 
Immediately after installing TeleVantage, you should change the passwords on those accounts 
to something more secure, by editing those users in the Users view. Reminder messages in the 
Administrator will warn you if you leave the extensions as is.

Identifying users with security-risk passwords
The Administrator has a built-in Security Analysis report that analyzes your system for potential 
security risks. To run the Security Analysis report, choose Tools > Analyze Security. The report 
appears on-screen. 

Use the report to determine which users in your system have passwords that make your system 
vulnerable. If you have implemented the security options described in this section, few users 
should appear in the list. Those who do might have old passwords that have not yet been 
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changed, either because they have not yet logged in and been forced to change their passwords, 
or because they are exempt from forced password change. Talk to those users about making their 
passwords more secure.

User permissions
Disallow security-risk permissions for all users except those individuals who really need them. 
You can change permissions for individual users by editing the user account (see “The Security 
tab” on page 6-38), or for many users at once by editing the User's Role (see “Managing roles” 
on page 6-46).

Security-risk permissions which should be disallowed are:

Q Place external calls when logged on via a trunk (under the Standard permission group)

Q Log on via trunk (Standard)

Q Log on via IP trunk (Standard)

Q Log on via station (Standard)

Q Forward or route calls to external numbers (Standard)

Q Return calls when logged on via a trunk (Standard)

Q Select a specific trunk for outbound call (Administration)

Setting up dialing restrictions
A good way to prevent unauthorized outbound calling is to place restrictions on users' dialing 
permissions. You can change permissions for individual users by editing the user account (see 
“The Security tab” on page 6-38), or for many users at once by editing the User's Role (see 
“Managing roles” on page 6-46).

Some dialing restrictions to consider:

Q Disallow access to any number dialed during toll fraud.  To find a list of numbers, search 
your call logs for frequent calls to international locations.

Q Disallow dialing 011 and 00 to block all international calls (00 dials the international 
operator).  To permit some international calls you can do the following:

Q Enable 011 for those individuals who are authorized to make international calls.  
Those individuals can then dial any country.

Q Enable country codes for those foreign countries that are appropriate for users to 
call.  To do so, enable 011xxx where xxx is the desired country code.

The full list of country codes can be found in your phone book.  The list is maintained 
by the ITU (International Telecommunication Union), a division of the United Nations.  
The ITU web site is <http://www.itu.int> and the most recently published list of country 
codes is available at <http://www.itu.int/itudoc/itu-t/ob-lists/icc/e212_685.html> (this 
list is valid as of June 2000, and some additional country codes have been assigned since 
then).
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Q Disallow dialing sequences that call for-pay services like 1900 or 1976, 976, etc.  For 
information on additional numbers that should be blocked, see this website: 
<http://www.lincmad.com/telesleaze.html>.

Q Disallow dialing certain international North American area codes if desired, such as 
those in the Caribbean. For example, disallowing 1242 blocks calls to the Bahamas.

The full list of North American area codes can be found in your phone book or at the 
web site for the North American Numbering Plan Administration 
<http://www.nanpa.com>.  For the numerical list of area codes, see 

<http://docs.nanpa.com/cgi-bin/npa_reports/nanpa?function=list_npa_geo_number>

Making account logon more secure
There are several ways to prevent hackers from even getting to the account logon choice of your 
auto attendant.   Some methods make it difficult for your own users to use the system, so you 
need to judge how far you want to go to prevent toll fraud at the expense of phone system ease 
of use.  Please note that these options do not make your system secure by themselves, as they 
only slow down hackers.  The only way to do that is to make sure your user passwords are secure 
and change often.  

Auto attendant security options include the following:

Q In your main auto attendant, change the default "#" for user logon to something else. 
Ideally, give your remote users a phone number routed to a special auto attendant that 
permits remote logon, while your main auto attendant does not.  For DID systems, where 
you can’t control the specific trunk used on inbound calls, give your remote users a DID 
number instead that routes them to the special auto attendant.

Q Do not permit logon in your main auto attendant that is assigned to every trunk.  Instead, 
create a unique auto attendant on a different trunk each week that permits logon.  Publish 
the trunk’s phone number to your users as it changes.

Securing your phone system database 
Toll fraud typically involves "hacking" over phone lines instead of data hacking.  However, the 
TeleVantage database runs on a Windows server on your network and contains all permission 
settings and can be hacked at that level.  It is always wise to keep your corporate network secure 
from unauthorized external access. This safeguards your database against tampering by network 
and computer hackers.  Some ways to do this include:

Q Use standard firewall technology to secure access to your network.  If desired, allow 
access to specific protocols and ports, such as those for HTTP or H.323 (VoIP).

Q For extra security, host the TeleVantage Web Services on a separate server from the 
TeleVantage Server and database.
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Reacting to toll fraud attempts ______________________________
If your phone system has been the target of toll fraud attempts, you can do the following:

Q Report Caller ID numbers and called numbers of fraudulent calls to your long distance 
carrier.  Sometimes carriers can block certain numbers from calling you.  

Q Report excessive toll fraud to your local FBI office.  Note, however, that the FBI does 
not usually get involved with toll fraud unless losses are substantial.

You can also use the information from previous toll fraud attempts to make your system even 
more secure. For example, you can add any numbers being called during toll fraud to the list of 
numbers prevented with dialing permissions.  If fraudulent calls have been made to a particular 
few countries that are not otherwise called, disallow dialing those country codes (011xxx). 

Using Caller ID to prevent fraudulent calls
If you know the Caller ID from which fraudulent calls originate, you can prevent calls from 
those numbers. To do so:

1. Create a user called “Fraud Detector.” Create it with a secure password, a station ID 
of 0, and use permissions to prevent it from making any external calls.

2. Log on to the Client as the “Fraud Detector” user.

3. Create a routing list called “Normal.” Delete the “Call me where I am” action.  Change 
the final action to “Transfer to an extension” and select your main Auto Attendant. 
Uncheck the greeting from playing.   Make this the default and active routing list.

4. Create a second routing list called “Fraud Call.” Delete the “Call me where I am” 
action.  Change the final action to “Hang up.”

5. Create a contact named “Fraudulent person.” Edit the phone numbers of the 
“Fraudulent person” contact and add any numbers of known fraudulent callers. 

6. Create a call rule so that when the contact "Fraudulent person" calls that they are 
handled by the "Fraud Call" routing list which hangs up on them.  

7. Assign every trunk to call the Fraud Detector user, instead of your auto attendant.

Subsequent calls from the known fraudulent numbers will be automatically hung up on, and will 
appear in the Call Log as being from “Fraud Detector.” Other calls will be handled as normal. 
As new fraudulent numbers are detected, you can associate the Caller ID with “Fraudulent 
person.”
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APPENDIX D

IP GATEWAY CONFIGURATION 
WORKSHEET

This appendix provides a worksheet to help you create a unified dialing plan before connecting 
TeleVantage Servers over IP Gateway connections. By using this worksheet, you can avoid 
conflicts between connected Servers, such as overlapping extensions or auto attendant numbers. 
You can also plan consistent access codes for dialing services. 

For complete information about IP Gateways, see Chapter 13, “Configuring Internet Telephony 
Support.” 

Two worksheets are presented, an illustrated sample and a blank worksheet that you can copy 
and use.



IP Gateway Configuration Worksheet
Server 1 Server 2

Name 1HZ�<RUN� &KLFDJR

Contact 7RP�5DQG������������� $P\�/XP�������������

Internet Span Address ����������� �����������

Extensions begin with � �

Auto attendants begin with �� ��

IP Gateways

To Server 1 To Server 2

On Server 1
N/A

Name: &KLFDJR
Local Server 1 extension: ���
Local Server 1 password: ����

On Server 2 Name: 1HZ�<RUN
Local Server 2 extension: ���
Local Server 2 password: ����

N/A

Internet-to-Centrex/PBX Extension Service: Internal Dial Tone

To Server 1 To Server 2

From Server 1
N/A

Svr 1 access code: ��
Uses IP Gateway: &KLFDJR

From Server 2 Svr 2 access code: ��
Uses IP Gateway: 1HZ�<RUN

N/A

Other Internet Dialing Services

Name Type From Server
Access 
Code

To Server
Access 
Code

IP Gateway

%HOO�$WODQWLF�
DQDORJ

R�,3�WR�3KRQH�
R�,3�WR�&HQWUH[

&KLFDJR �� 1HZ�<RUN � 1HZ�<RUN

%HOO�$WODQWLF
&HQWUH[

R�,3�WR�3KRQH�
R�,3�WR�&HQWUH[

&KLFDJR �� 1HZ�<RUN � 1HZ�<RUN

R�,3�WR�3KRQH�
R�,3�WR�&HQWUH[

R�,3�WR�3KRQH�
R�,3�WR�&HQWUH[

�

�



IP Gateway Configuration Worksheet
Server 1 Server 2

Name

Contact 

Internet Span Address

Extensions begin with

Auto attendants begin with

IP Gateways

To Server 1 To Server 2

On Server 1
N/A

Name:
Local Server 1 extension:
Local Server 1 password:

On Server 2 Name:
Local Server 2 extension:
Local Server 2 password:

N/A

Internet-to-Centrex/PBX Extension Service: Internal Dial Tone

To Server 1 To Server 2

From Server 1
N/A

Svr 1 access code: 
Uses IP Gateway: 

From Server 2 Svr 2 access code: 
Uses IP Gateway: 

N/A

Name Type From Server
Access 
Code

To Server
Access 
Code

IP Gateway

R�,3�WR�3KRQH�
R�,3�WR�&HQWUH[

R�,3�WR�3KRQH�
R�,3�WR�&HQWUH[

R�,3�WR�3KRQH�
R�,3�WR�&HQWUH[

R�,3�WR�3KRQH�
R�,3�WR�&HQWUH[
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About using IP phones with TeleVantage _____________________
TeleVantage supports the use of the following Voice-over-IP phones:

Q Polycom IP phones (see the next section)

Q Intel PBX-IP Media Gateway phones, also known as PBX-IP Media Gateway phones 
(see “Using an Intel PBX-IP Media Gateway with TeleVantage” on page E-22).

Using a Polycom IP phone with TeleVantage __________________
This section describes using a Polycom IP phone with TeleVantage.

Introduction
Polycom IP phones are supported by TeleVantage to provide handset functionality using the 
H.323 standard over an IP trunk. Polycom IP phones can be used in two ways:

Q Internally. You can use a Polycom phone as an internal station, enabling single-wire 
connection to a workstation (one network wire for the PC and the phone).

Q Remotely. Using a Polycom phone at a remote location, you can automatically log onto 
the TeleVantage Server over the Internet and place calls as if you were at an internal 
station.

Note:When using a Polycom phone over the Internet instead of on a LAN, the quality is 
not guaranteed. Internet traffic is susceptible to greater delay and packet loss, both of 
which affect voice audio quality.

Requirements
To use a Polycom IP phone with TeleVantage, your TeleVantage system must have the 
following:

Q An IPLink board for Internet telephony installed on the TeleVantage Server computer. 
See Installing TeleVantage.

Q An IP dialing service. See Administering TeleVantage.

Q Network access to the Internet, if you plan to use a Polycom IP phone remotely.

Q If you are using a SoundPoint IP 400 phone, the bootrom version of your phone should 
be 1.1.1. The version does not matter for SoundPoint IP 500 phones.

Overview of TeleVantage - Polycom IP phone integration
To use a Polycom IP phone with your TeleVantage system, you must complete the following 
tasks. Each task is discussed in detail in this document.

1. Connect your Polycom phone to the network or Internet. See “Connecting the 
Polycom IP phone” on page E-3.

2. Configure an FTP server that the phone can access by network. When the phone is 
plugged in, it downloads several files from the FTP server to configure itself. The files 
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contain information about how the phone logs in to the TeleVantage Server via PLAR, 
the IP address of the TeleVantage IP trunk, how the keys on the phone are 
programmed, and other phone configuration details. See “Configuring an FTP Server” 
on page E-4.

3. Edit the configuration files on the FTP server for each Polycom IP phone on the 
network. These files are in XML format.

4. Using the TeleVantage Administrator, create users who will use the Polycom IP 
phones. Using the TeleVantage Client, forward calls for each user to the Polycom IP 
phone. See “Configuring users for the Polycom IP phones” on page E-8.

5. Configure the Polycom IP phone using its on-screen commands. See “Configuring the 
Polycom IP phone” on page E-9.

What is PLAR?
PLAR, or Private Line Automatic Ringdown, is a technique that ties two telephony devices 
together, such that when one handset is lifted, the other device automatically rings. This is the 
way that the Polycom IP phones communicate with TeleVantage. When the Polycom IP phone 
goes off hook, it automatically connects to the TeleVantage Server via an IP trunk, then logs in 
as an individual user. When you hear dial tone, you are actually hearing TeleVantage dial tone; 
you are subject to any dialing restrictions of that user, and any calls that you make from that 
point are entered into the Call Log of that user.

Configuring the Polycom IP phone requires that you specify the TeleVantage IP trunk, and the 
user extension and password to log in. This is the role of the configuration files and other setup 
steps. There are other features of the Polycom IP phones that are not utilized by TeleVantage; 
they are not addressed in this document.

Connecting the Polycom IP phone
You can connect a Polycom IP phone either internally (on the same network as the TeleVantage 
Server) or externally.

Connecting a Polycom phone internally
To connect a Polycom phone to TeleVantage internally, simply connect it to the network that 
the TeleVantage Server is on.

If you are using the TeleVantage Client, connect the Polycom phone as follows:

1. Run the network wire to the LAN port on the Polycom phone.

2. Connect the PC port on the Polycom phone with your PC’s network card. 

The Polycom phone contains a network hub that enables it to work with the network and your 
PC. In this manner your phone and PC communicate with the TeleVantage Server over the same 
wire.
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Connecting a Polycom phone remotely
To use a Polycom phone at a remote location, connect the LAN port of the Polycom phone to a 
network that has access to the Internet.

Configuring an FTP Server
To use a Polycom phone with TeleVantage, you must configure an FTP server on your network. 
When the phone boots up, it logs in to the FTP server and reads information from configuration 
files that enables it to connect to TeleVantage.

The following files must be present on the FTP server: 

Q <MACid>.cfg

Q <UserFile>.cfg

Q <ServerIP>.cfg

Q Func.cfg

Q Ipmid.cfg

Q Hmx.ld

These files are described in detail below in the section “About the configuration files.” 

Location of the configuration files on the FTP server
The <MAC>id.cfg file must be in the default directory of the FTP server. Each phone on your 
network must have a separate <MACid>.cfg file. 

The other configuration files are listed in the <MACid.cfg> file. You can rename them or move 
them into other directories. 

Security for the configuration files
The configuration files include all of the settings for the Polycom IP phone. Some of the 
information required is a TeleVantage user login (including password), so the accessibility of 
this information must be carefully considered to minimize the security risk to your system. 

One alternative is to create subdirectories from the FTP root for each of the Polycom IP phone 
users; each user would only be able to read the root directory and their subdirectory, so it would 
not be possible to see other users' login information. Since some of the files (including Func.cfg, 
Ipmid.cfg, and Hmx.ld) are shared across all users, these files would need to be accessible to all 
users, or duplicated in all user subdirectories.

Note: The user account on the FTP server should have "write" access to the TeleVantage 
Server so the phone can upload log files that are useful in troubleshooting problems.
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About the configuration files
The following files are supplied on the TeleVantage Drivers CD in the \Polycom directory.

Important: Do not use Wordpad to edit the XML files, as Notepad can reformat the files. Use 
an XML editor such as XML Wordpad (available from msdn.microsoft.com).

Q <MACid>.cfg. The first file read by the Polycom phone when rebooted or plugged in. It 
contains the list of other configuration files which provide specific configuration 
information for the phone. (For instructions on rebooting the phone, see “Configuring 
the Polycom IP phone” on page E-9). The name of the file should be the 12-digit MAC 
address of the phone. The phone's MAC address is on a sticker on the back of the phone, 
or you can read the "ENet" field while pressing and holding the button beneath the 
"About" softkey on the phone's LCD screen. When the phone boots up, if it does not find 
a file with its MAC address, it will read a file named 000000000000.cfg. 

Hint: When debugging a configuration file, add a file named 000000000000.cfg to your 
FTP server for the phone to read. You may have incorrectly named your file, and the 
phone will default to this file if it does not find one with its own MAC address.

After reading this file, the Polycom IP phone reads from the files listed in the field 
CONFIG_FILES in the order listed.  

Note:If the same setting is contained in more than one configuration file, the setting that 
the phone downloads first will take effect. The order that the phone downloads the files is 
determined in <MACid>.cfg.

Q <UserFile>.cfg. Defines specific settings for the user, like extension and password so 
they can log into the server.  This file is unique per user.

The settings include the Display name for the user (20 characters maximum), and the 
user's extension and password.  This file should be protected and only accessible by the 
user (and the FTP system Administrator) since it contains the user's extension and 
password. 

Q <ServerIP>.cfg. Defines the IP address for the TeleVantage IP trunk and key mappings 
for the feature buttons on the phone.  This file will be the same for all users who are using 
ports on the same IP board in the TeleVantage Server.

Q Func.cfg. Defines protocol parameters for the phone.  This file is common to all users 
and shouldn't be modified. Artisoft does not provide support for modified versions of 
this file.

Q Ipmid.cfg. Defines codecs, tones and other basic parameters of the phone. Also specifies 
the SNTP server for obtaining the correct time, and the GMT offset. This file must be 
the same for all users. 

Q Hmx.ld. This Polycom file loads the basic operation of the phone.  It's a binary file and 
can't be modified.
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Editing the configuration files
You must make the following edits to the configuration files on the FTP server. The .cfg files 
are in XML format, and should be edited using an XML editor or basic text editor (do not use 
Wordpad, because it reformats the file). You can download an XML editor called XML Notepad 
from msdn.microsoft.com.

Example of an XML editor

Note: These configuration file edits specify the TeleVantage IP trunk, the user extension, and 
the password that enable you to log in when you pick up the phone. Other features of the Polycom 
IP phones that are not utilized by TeleVantage are not addressed in this document.

For more information on configuration files, see “Sample Configuration Files” on page E-17.

To edit the configuration files

1. Edit <UserFile>.cfg to use information specific to the phone's user.

a. In the "Features" folder, edit the "plar.log.string" field to contain the login string for 
this user. The login string for a user with extension 202 and password 202 would 
be:"*202*202*".

b. In the "GENDESC" folder, edit the "genDesc.name" string to reflect the name of 
user. This name will appear on the LCD screen of the Polycom IP phone when it is 
idle. It will also be transmitted as caller ID when the Polycom IP phone is used to 
call another user on the TeleVantage Server.

c. In the "GENDESC" folder, edit the "genDesc.E164addr" field to be the 
TeleVantage extension for the user. This will also appear on the LCD screen of the 
Polycom IP phone.

d. Rename this file to reflect information about the user (for example, User202.cfg).

2. Edit <ServerIP>.cfg to contain the IP address that the user will use to access the 
IPLink board in your TeleVantage Server.

a. In the FEATURES folder, edit the feature.plar.address field to be the IP address of 
your IP trunk. Use the IP address of the Dialogic DM3 IPLink board, or, if you are 
using an IPLink board which does not have its own network interface card on it, the 
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IP address of your TeleVantage Server. Your network administrator can tell you the 
IP address of the Server or boards.

b. Rename this file to describe your IP address (e.g., TVIP2.cfg).

Notes

QIf you have more than one IP board in a TeleVantage server, you may need more 
than one of these files, each specifying the IP address of a different IPLink board. 
You need one file for each non-DM/IP040-LSI board and another file to cover all 
DM/IP040-LSI boards. (All DM/IP040 boards share the TeleVantage Server’s 
single IP address.) You determine which user uses which board by having their 
<MACid>.cfg file point to the appropriate <ServerIP>.cfg file. Each <MACid>.cfg 
file can point to only one <ServerIP>.cfg file.

QDo not change the settings listed  in the VoipProt.server.address field. Entering the 
address of your IP board will result in the IP stack crashing on the Server.

3. Edit <MACid>.cfg to specify the configuration files to be used by the phone. This file 
will specify the name and subdirectory where the other configuration files can be 
found.

a. In the CONFIG_FILES field, list the four other configuration files, including the 
<UserFile>.cfg file with the user’s login string, and the <ServerIP>.cfg file with the 
IP board to be used. If some of these files are in a subdirectory on the FTP server, 
you can specify that in the file name (for example, "/User202/User202.cfg"). 

Note:The order of the files in this list is significant: if more than one field with the 
same name is encountered in different files, the first value will take effect and the 
subsequent values will be discarded. Put the customized files at the front of the list 
so that if later updates are made to the downloaded files, any duplicate fields will not 
affect the custom fields you have set.

b. The APP_FILE_PATH should show the binary application file (hmx.ld). If this file 
is moved to a subdirectory on the FTP server, edit this field to specify.

c. Rename this file to be the 12-digit MAC address of the phone (found on a sticker 
on the back of the phone), or to 000000000000.cfg as a default.

These are the only files that you need to edit. However, if you need to change the codec used by 
the phones when communicating over IP to TeleVantage, or modify the feature key mappings 
on the phone, you will need to edit other configuration settings. See “Sample Configuration 
Files” on page E-17 for samples of each of the configuration files.

Note: Supported codecs are G.711 ALaw and MuLaw, and G.723.1. Do not use G729, as it is 
not supported.
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Configuring multiple Polycom IP phones
If you are using several Polycom IP phones on your TeleVantage Server, be aware of the 
following considerations:

Q Ratio of IP phones to IP boards. It may not be necessary to have an IP port for each 
Polycom IP phone installed on your system. The IP trunk will only be in use while the 
user is actually on the phone (on a call, checking their voicemail, etc). If your IP phone 
users are on the phone frequently—for example, if they are sales or support 
agents—then it may be necessary to have a dedicated or 1-to-1 relationship between IP 
ports and IP phones. However, for other users, a lower ratio of IP trunks to IP 
phones—such as 1-to-3 or even 1-to-4—may be acceptable.

Note that you need one TeleVantage IP Port license per IP port, not per IP phone.

Important:If a user takes their Polycom IP phone off hook at a time when there are no 
available IP trunks, they will hear a delay in dial tone until there is an available trunk. There 
is no way to signal to the phone that there are no IP trunks available; the user will hear 
silence. Be sure to carefully consider the ratio of IP phones to IP trunks in the TeleVantage 
Server.

Q Configuring multiple DM3 IPLink boards in your TeleVantage Server. If your 
TeleVantage Server includes multiple DM3 IPLink boards which have their own 
on-board network interfaces, remember that each one of the boards has a unique IP 
address. Therefore, you will have multiple <ServerIP>.cfg files each containing a 
different PLAR IP address. 

Remember to carefully distinguish which phones will use which IP board. Make sure a 
phone’s <MACid>.cfg file references the <ServerIP>.cfg file for the IP board you intend 
the phone to use. 

Configuring users for the Polycom IP phones
Before a user can use a Polycom IP phone with TeleVantage, you must configure that user’s 
account as follows:

1. In the Administrator, edit the user’s account to use the Polycom phone. See 
“Configuring a user to use an IP phone with TeleVantage” on page E-24.

2. If the user will be placing calls from their Polycom IP phone to numbers external to 
the TeleVantage Server, make sure their user permissions include being able to place 
calls while logged into a trunk. In the TeleVantage Administrator, edit the user by 
double-clicking them in the Users view, and click the Permissions tab. Select the 
setting Place external calls when logged in via a trunk (in the “Standard” category), 
then click “Allow” for the setting. You can also set up a role where “Allow" is the 
default for this setting.

3. Edit Ipmid.cfg to change the SNTP (time server) and the GMT offset parameters, as 
follows:

In the TCPAPP field, edit the tcpIpApp.sntp.address field and enter a valid time 
server IP address. Also edit the tcpIpApp.sntp.gmtOffset field to reflect the proper 
GMT offset for your time zone. This value is listed in seconds.
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Notes about configuring TeleVantage
Q An Internet span must be configured in the Trunks view of the Administrator.

Q An Internet dialing service must be configured with the correct codecs (G.711, G.723) 
for calls to be forwarded to the Polycom phone when the extension is called. In general, 
G.711 is needed for the transmission quality that a phone user expects.

Q The TeleVantage Server must be set to log internal calls for the IP calls to be logged by 
the Server.  This is set in the Administrator, under System Settings.

Configuring the Polycom IP phone
The configuration of the Polycom phone can only be done when rebooting the phone, or when 
it is first plugged in. To reboot the phone, hold down the buttons labeled Volume-, Volume +, 
Hold and Voicemail at the same time for several seconds. These are buttons 8, 10, 11, and 12 on 
the diagram on page E-13. 

Note: For TeleVantage, these buttons may be labeled Volume -, Volume +, Take, and 
Available.

Just before the phone reboots, press the "Setup" softkey button to enter the setup screens. Use 
the arrow buttons on the top right hand corner of the phone to move between fields. To save your 
changes to the settings, you must press the Save button before moving to the next field.

When alphanumeric fields (such as FTP login and FTP password) are highlighted, you will see 
two additional softkeys on the screen which allow you to switch between alphabetic and 
numeric characters. To enter a lower case letter, hit the "a->A" key, then use the number keypad 
to enter the letters beneath each number. To enter an "a", hit the 2 key once; to enter a "b", hit 
the 2 key twice, etc. To enter an upper case letter, hit the "a->A" softkey once again. To enter a 
number, hit the "->123" softkey. Use the left and right arrow keys to move within a field.

To save your changes to the settings, you must press the Save button before moving to the next 
field.
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Set the following configuration for the Polycom phone:

Setting Value Comments

DHCP Client <Enabled/Disabled>

If DHCP is disabled, the 
phone uses a fixed IP 
address from the Phone IP 
Addr field below. If DHCP is 
enabled, the phone receives 
information from the DHCP 
server in the format 
specified below. Disabling 
DCHP is recommended for 
use with TeleVantage so 
calls can easily be 
forwarded to your Polycom 
IP phone.

DHCP Timeout <30>

Number of seconds the 
phone waits for secondary 
DHCP offer messages 
before selecting an offer.

DHCP Boot 
Server

<default/override>

When set to "Default", the 
phone will look for vendor 
specific option number 66 
(string type) in the response 
sent from the DHCP server. 
The DHCP server must be 
configured to send the boot 
server address in option 66, 
for example, "192.168.0.1".

When set to "Override", the 
phone will look for the 
vendor specific option 
number specified by "DHCP 
Boot Srv Opt", of type 
"DHCP Boot Srv Type", in 
the response sent from the 
DHCP server. This generally 
should not be required 
unless the default Boot 
Server option is in use for 
another purpose on the 
network.
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DHCP Boot Svr 
Opt

<128-254>

Specifies vendor specific 
option number for the 
response sent from the 
DHCP server (if DHCP is 
enabled and DHCP Boot 
Server set to "Override").

DHCP Boot Svr 
Type

<IP Address/String>

Specifies vendor specific 
option type for the response 
sent from the DHCP server 
(if DHCP is enabled and 
DHCP Boot Server set to 
"Override").

Phone IP Addr <192.168.1.135>
Fixed IP address assigned 
to the phone (if DHCP is 
disabled).

Subnet Mask <255.255.255.0>
Subnet mask of the network 
(if DHCP is disabled).

IP Gateway

IP address of the IP 
Gateway. Used when SNTP 
is obtained from a remote 
server.

FTP Server IP <192.168.1.136>
IP address of the FTP 
server.

FTP User <IPPhoneAccess>

User account to access the 
FTP server for the 
configuration files. Using 
“anonymous” is not 
recommended for security 
reasons.

FTP Password <IPPhonePassword>
Password for the FTP user 
account.

SNTP Address <192.168.1.136>

IP address of the time 
server. This setting enables 
the Polycom IP phone to  
display the correct time (if 
DHCP is disabled).

Setting Value Comments
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Using the Polycom IP phone
The Polycom SoundPoint IP 400 and SoundPoint IP 500 phones have several features that are 
valuable to TeleVantage users. The LCD screen, in addition to editing configuration settings, 
also provides line appearances and soft keys. When an incoming call is received from 
TeleVantage, the screen shows the contact name if the call is recognized as a contact, or Caller 
ID information. 

To brighten or darken the contrast on the LCD screen, simultaneously hold down the +, -, and 0 
keys (buttons 12, 13, and 14 on the diagram on page E-13) for several seconds. A slider will 
appear with a light and dark square on either end; when it does, lift off the keys and then use + 
and - to darken and lighten the contrast.

Important: When using a Polycom phone, you will not be able to use the call handling 
commands in the TeleVantage Client or Web Client. You can still use the TeleVantage telephone 
commands. See “Using the Call Monitor with a Polycom IP Phone” on page E-21 for information 
on configuring remote stations if you would like to use your TeleVantage Client for call control with 
a Polycom IP phone.

These phones also include a number of feature keys preprogrammed for TeleVantage features. 
Your Polycom IP phone may come with keycaps that show functions that do not apply to the 
TeleVantage version of the phone. You may want to replace these keycaps with then blank 
keycaps that should have also been included with the phone. If you received no blank keycaps, 
contact the reseller where you purchased the phone to acquire them.

GMT Offset <-5>

Offset in hours from 
Greenwich Mean Time (if 
DHCP is disabled).You can 
find your GMT offset by 
looking at the time zone 
settings on your computer. 
For the eastern United 
States, the GMT offset is -5.

Setting Value Comments
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The key mappings for TeleVantage are shown beside each key on the following diagram. The 
table below shows the functions of all of the key. Some of the keys have been mapped to 
TeleVantage telephone commands; the telephone command key sequence is also listed. Check 
the diagram carefully for the number corresponding to each key.

 

Key 
number Function Description

Telephone 
commands
equivalent

1-6
Screen setup 
keys

Move around and 
edit setup screens.

N/A

7 Do Not Disturb
Sets the user’s 
Personal Status to 
Do Not Disturb

612

8 Available
Sets the user’s 
Personal Status to 
Available

611

9 Flash Flash hook key <Flash> or **
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10 Take

Press this key before 
the Line keys to 
toggle between calls 
on the phone (Note 
that this will put the 
call on local hold, but 
not TeleVantage 
hold.)

N/A

11-12 Volume keys
Adjusts the volume 
on the phone 
handset or speaker

N/A

13-24 Digit keys
Act as regular DTMF 
digit keys

N/A

25-28 Soft keys

Take the function of 
the softkey on the 
screen directly 
above each key

N/A

29 Transfer
Transfer the active 
call 

<Flash> 1

30 Unhold
Remove the active 
call from 
TeleVantage hold

<Flash> 4

31 Hold
Place the active call 
on TeleVantage hold

<Flash> 7

32 Voicemail
Access the user’s 
voicemail

<Flash>

33-35 Line keys
Use with the "Take" 
button (button 9) to 
toggle between calls.

N/A

36 Park

Place the active call 
on TeleVantage Park 
(Unpark by hitting 
*92)

*66

37 Directory
Hear the 
TeleVantage user 
directory

*93

Key 
number Function Description

Telephone 
commands
equivalent
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Issues for users of Polycom IP phones
Q Password change. Polycom IP phone users must alert an administrator when they 

change their password. The administrator must modify the plar.login.string entry in the 
user’s <UserFile>.cfg file to reflect the new password, or the Polycom IP phone will not 
be able to automatically login when the handset is taken off hook. If the login fails, users 
will hear the auto attendant greeting for the IP trunk, rather than dial tone.

Q Phone hold versus TeleVantage hold. When juggling multiple calls on the Polycom 
IP phone, a user may use key 10 (labeled "Hold") and the Line keys to switch between 
calls. This will place the inactive call on phone hold. In this state, they will not hear 
music on hold, and the TeleVantage Call Monitor will not reflect that they are on hold. 

Q Using the TeleVantage Client. Polycom IP phone users can use the TeleVantage Client 
or web client and will see their calls in the Call Monitor. However, unless they are 
configured as remote users as described in Appendix D, they will NOT be able to grab 
calls from the Call Monitor or use their Polycom IP phones as an audio device (e.g, to 
hear their voicemail, record greetings or voice titles, etc.) from the Client. 

Instead, the audio for the TeleVantage Client or web client must use the speakers of the 
local PC. To record audio prompts, use the Telephone Commands.

Q Message indicating lamp. The red message indicating lamp on the Polycom IP phone 
does not light if you have TeleVantage voicemail messages. Further, the text on the 
screen of the Polycom IP phone rotates between your user description (set in the 
gendesc.name field of the <UserFile>.cfg) and “No Messages,” even if you do have 
unheard voicemail messages in your TeleVantage Inbox.

Issues for Administrators of Polycom IP phones
Q Firewall issues. Standard firewalls should work with the Polycom Soundpoint IP 

phones. The ports in use by the phones must remain open. If you are using a NAT 
firewall, make sure it is VoIP-enabled; not all NAT firewalls are capable of handling the 
IP addresses that are embedded in the payload of some VoIP packets.

Q Network security risk. As with any IP device, connecting the Polycom Soundpoint IP 
telephone to a TeleVantage server through a firewall requires that ports be opened on the 
firewall. Specifically, the Soundpoint IP telephone uses H.323, RTP, FTP and SNTP, 
and the associated ports must be opened. This may pose additional security risks, which 
may be minimized by opening these ports only to the TeleVantage, FTP and NTP servers 

38-40
Phone mode 
keys

Toggle the phone’s 
audio between 
handset, speaker, 
and headset mode

N/A

Key 
number Function Description

Telephone 
commands
equivalent
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and by taking other security precautions such as applying operating system and server 
software security patches.

Q QoS issues. The Polycom Soundpoint IP phones have been tested thoroughly and 
provide outstanding levels of audio quality. However, when used on the open internet, 
this audio quality cannot be guaranteed. 

Q Security of the FTP files on the server. You must protect the files from anonymous 
access or the security of your TeleVantage system could be compromised.  One method 
is to have separate FTP user accounts (with passwords) per phone.  The FTP user will 
only have the ability to see the one folder with the Polycom phone settings, so the other 
accounts would be protected.

The individual user .cfg files should have some level of user permission. You should 
allow only the individual user and the FTP server administrator to open the files, because 
they contain extensions and passwords.  

Q Access. The FTP server can only be accessed by IP address from the phone and can’t be 
accessed by server name.

Q Fixed IP address. A fixed IP address is recommended for the Polycom phone. You can 
choose to use a DHCP server to provide an IP address for a Polycom phone instead, but 
then the IP address of the phone can change every time it is booted, meaning that call 
forwarding in the TeleVantage Client would have to change every time to match it.  If 
the Polycom phone is only used for calls from the phone to the TeleVantage Server, and 
not for incoming calls from TeleVantage to the phone, this is not an issue and DHCP can 
be used without problem.

Q SNTP server access. Access to an SNTP server is required for Polycom phones to 
display the date and time correctly.  

Contacting Polycom
For assistance in configuring your Polycom IP phone with TeleVantage, contact your 
TeleVantage Reseller. Authorized TeleVantage Solution Providers can contact Artisoft 
TeleVantage technical support.

For more information about Polycom IP phones, contact Polycom using the following 
information:

Polycom Headquarters 
1565 Barber Lane 
Milpitas, CA 95035 
USA 

1.800.POLYCOM ext. 6973 
or 408.526.9000 ext. 6973

sales@polycom.com
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Sample Configuration Files
This section contains sample configuration files.

<MACid>.cfg
This master configuration file should be renamed to reflect the 12-digit MAC address of your 
Polycom IP phone. (Find the MAC address on a label on the back of the phone, or by reading 
the ENet field visible while pressing and holding the "About" softkey button). If the phone does 
not find a file that matches its MAC address, it will look for a file called 000000000000.cfg.

You will have one such file for each Polycom IP phone, and it must reside in the default 
directory of the FTP server for the phone’s specified FTP login. This file references in the 
CONFIG_FILES field the actual filenames for the user’s configuration files. Subdirectories may 
be specified for the configuration files (for example, IPUser1/IPUser1.cfg). The maximum 
length of the string that makes up this value is 511 characters, including commas and white 
space. This file also defines the location of the hmx.ld file in the APP_FILE_PATH field, which 
can also include path information and is restricted to 127 characters.

<UserFile>.cfg 
This file should be renamed to represent the user (and the name should match the 
CONFIG_FILES field of the <MACid>.cfg file). The sample download file is called 
IPUser202.cfg.

You will have one such file for each Polycom IP phone, which references in the plar.log.string 
the login string for that user, "*<extension>*<password>*".

The genDesc.name field will be the string that shows in the phone’s LCD screen. It is also used 
as Caller ID when you call into a TeleVantage server, so internal users will see this string in the 
Number field of their Call Monitor (along with the phone’s IP address). The genDesc.E164addr 
field is the address of the phone; enter the TeleVantage extension of the user. This will also show 
on the LCD screen of the IP phone after the name, for example, "IPUser (202)".

Field Value

APP_FILE_PATH hmx.ld

CONFIG_FILES
IPUser202.cfg, TVIP1.cfg, 
func.cfg, ipmid.cfg

Folder Field Value

GENDESC

gendesc.name IP User

genDesc.E164addr 202

Feature

plar.log.string *202*202*
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<ServerIP>.cfg
This file should be renamed to represent the IP trunk (and the name should match the 
CONFIG_FILES field of the <MACid>.cfg file). The sample download file is called TVIP1.cfg.

You will have one such file for each separate IP trunk IP address (for example, if you had two 
DM3 IP boards with their own IP addresses, you would have 2 files). Each file references in the 
feature.plar.address field the IP address for that IP board.

Note: If you would like to remap some of the function keys on the Polycom IP phones, use the 
key map fields. Remapped keys are not supported by Artisoft.

Ipmid.cfg
The ipmid.cfg file contains many settings for the Polycom IP phone. It is recommended that you 
do not modify this file, except for changing the SNTP address and GMT offset. The only settings 
that may need to be modified are the CODECS fields (under the VOICE folder); the order 
should match the order of codecs used by TeleVantage. G.711 and G.723 are the codecs 
supported by TeleVantage and the Polycom IP phones. Use G.711 is a higher quality 
transmission but will utilize more bandwidth on your network; G.723 is a lower bandwidth, 
lower quality codec. 

Note: Do not use codec G.729. It is not supported.

Folder Field Value

MAPS

key.map.37 1,*93

key.map.36 1,*66

key.map.32 1,**

key.map.31 1,**7

key.map.30 1,*4

key.map.29 1,**1

key.map.9 1,**

key.map.8 1,**611

key.map.7 1,**612

FEATURES

feature.plar.address 192.168.1.100

feature.autoanswer 0
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This file also contains settings which specify the level of logging that is done by the phone. The 
phone maintains information about its functioning and can upload this information to the FTP 
server to assist when diagnosing problems. Artisoft or Polycom Technical Support may direct 
you to modify the level of logging provided by the phone when troubleshooting; only modify 
these settings under the direction of Artisoft or Polycom Technical Support.

Func.cfg
The func.cfg file contains a small number of VoIP protocol parameters. It is never necessary to 
modify this file for use with TeleVantage.

Troubleshooting the Polycom IP phone with TeleVantage
If you are having difficulty configuring your Polycom IP phone with TeleVantage, review the 
following steps carefully.

First, check to see if an IPLink board has failed. If it has, a notification has been added to the 
Windows Server Event Log.

If your IPLink boards are functioning, check to see if TeleVantage can place a call to the 
Polycom IP phone (either by dialing the IP address directly from a station phone, or by 
forwarding a user to the IP phone and dialing the user’s extension).

If not:

Q Ping the phone. Make sure you can ping the phone from a machine on the network. An 
easy way to see the IP address of the phone is to press and hold the "Setup" softkey 
button.

Folder Field Value

VOICE

    CODECS

voice.audioProfile.1.rt
pPayload

G711Mu

voice.audioProfile.1.p
ayloadSize

160

voice.audioProfile.2.rt
pPayload

G711A

voice.audioProfile.2.p
ayloadSize

160

voice.audioProfile.3.rt
pPayload

G723

voice.audioProfile.3.p
ayloadSize

1
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Q Check the IP address and subnet mask. Make sure the IP address and subnet mask 
information in the Polycom IP phone setup screens are correct.

Q Use a valid IP trunk address. Make sure the <ServerIP>.cfg file references a legitimate 
IP trunk. Remember that some Dialogic DM3 IPLink boards have their own NIC 
interfaces, and therefore their own IP addresses. The DM/IP0821A-T1 and 
DM/IP2431A-T1 are examples of boards with an onboard NIC; this is signified by the 
"1" (not "0") in the last digit of the model number. The DM/IP040-LSI does not have an 
onboard NIC.

If you are using a board with its own NIC interface, use the IP address of the board, not 
of the TeleVantage Server itself. 

Q Ensure a supported codec is in use. Only G.711 and G.723 are codecs that can be used 
with TeleVantage and the Polycom IP phones. G.729a/b or other codecs are not 
supported.

If you can place a call to the phone, but not place a call from or hear dial tone on the phone, or 
if you hear a quick burst of dial tone but then silence, the PLAR login is not working for some 
reason. Do the following:

Q Verify the login string. Make sure the login string specified in the <UserFile>.cfg file 
is a valid one, and using the correct password. To test, dial the login string from a station 
phone (using # characters instead of *) and make sure you log in as the correct user.

Q Recheck the MAC address. Make sure the <MACid>.cfg file is named with the proper 
MAC address. An easy way to confirm the MAC address is to press and hold the "Setup" 
softkey button (and read the ENet address). It may also be on a sticker on the back of the 
phone.

Copy the <MACid>.cfg file with the name 000000000000.cfg. This will be read by 
default by any phone when it does not find a file with its MAC address.

Update the timestamp on the <MACid>.cfg file to force it to be reread when the phone 
is rebooted.

Q Confirm the name and accessibility of each of the files on the FTP server. Make sure 
the <MACid>.cfg references the correct files, and that the files exist in the directory 
named in this file.

Make sure that the files can all be accessed via FTP with the FTP user and password you 
specified on the Polycom IP phone setup screen. Test this with an FTP utility (for 
example, typing FTP at a command prompt). 

To test your user privileges, change the login screen to temporarily use the administrator 
login and password. (This user should have access to all files.)

If you are using subdirectories to store the configuration files, make sure all 
subdirectories referenced in the <MACid>.cfg file are accessible.

Q Validate the file formatting. If you have used Wordpad or another text editor to edit 
your configuration files, they may have lost their formatting. Make sure they can be read 
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by an XML editor such as XML Notepad (downloadable from msn.Microsoft.com). If 
not, start again with fresh configuration files.

Once the phone is working, but the phone user experiences a subsequent loss of dial tone:

Q Confirm there is an available IP trunk. If IP phone users share IP trunks on the 
TeleVantage Server, there may be no IP trunks available at the time they are trying to 
make a call. This can be confirmed by observing the state of the IP trunks in the 
TeleVantage Device Monitor.

Q Check the network. You may be experiencing a network problem. Make sure you can 
ping the IP address of the IPLink board or TeleVantage Server.

Q Check the H.323 stack. If users see "Disconnected" in the LCD screen of the Polycom 
IP phone, there may be a problem with the IPLink board or it’s H.323 stack. Check the 
Windows server event log to verify errors. The IPLink board or TeleVantage Server may 
need to be restarted.

Using the Call Monitor with a Polycom IP Phone
Normally users of Polycom IP phones cannot use the Call Monitor commands on their calls.  For 
example, a Polycom IP phone user cannot transfer a call with the Client.  Instead they must use 
the telephone commands or feature buttons on the phone to transfer or manage calls.

For a workaround that enables Polycom phone users to use Call Monitor commands, see 
Appendix F.
APPENDIX E. USING AN IP PHONE WITH TELEVANTAGE E-21



Using an Intel PBX-IP Media Gateway with TeleVantage _________
TeleVantage supports the Intel PBX-IP Media Gateway, a device that connects to your LAN and 
enables up to 8 digital IP phones. TeleVantage supports both the 2-wire and 4-wire versions of 
the Gateway, enabling you to use either 2-wire or 4-wire Avaya digital phones. The following 
digital phones are supported:

Q Avaya 4406D+

Q Avaya 4412D+

Q Avaya 4425D+

Configuring a Gateway for use with TeleVantage is a two-step process, as follows:

1. Install the Gateway device on your LAN and attach up to 8 digital IP phones. Refer to 
your Intel PBX-IP Media Gateway documentation for instructions. Make a note of the 
Gateway device’s IP address.

2. Configure the Gateway device for use with TeleVantage. See the next section for 
instructions.

3. Edit each Gateway phone user in the Administrator and configure their accounts to use 
the Gateway phone. See “Configuring a PBX-IP Media Gateway phone user in 
TeleVantage” on page E-23.

Configuring the PBX-IP Media Gateway device for use with 
TeleVantage

To use a PBX-IP Media Gateway phone with TeleVantage, you must configure it through the 
Gateway device as follows:

1. The first step is to add a temporary route to the PC that you are using to access the 
Gateway. From the Windows Start menu choose Start > Run, type cmd in the Run 
dialog box, and click OK. When the DOS window appears, type the following 
command:

route add 10.12.13.74 <PC Adapter IP>

For example, if your PC's IP address is 198.1.3.25, then the command executed would 
be:

route add 10.12.13.74 198.1.3.25

2. Point your web browser to the IP address of the Gateway device on your LAN. By 
default it is:

http://10.12.13.74

3. At the logon page, enter a valid username and password. By default the username is 
admin and the password is IpodAdmin (both are case-sensitive).

4. Select IP on the navigation bar to go to the IP page. Make sure that Subnet Mask is set 
to the correct Subnet Mask for your TeleVantage Server.  The Default Network 
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Gateway Address setting is not necessary, and can be set to 0.0.0.0 unless the PBX-IP 
Media Gateway device will be connecting to another subnet.

5. Select System on the navigation bar to go to the System page. From the Operating 
Mode drop-down list select "H.323 Driving." Under PBX Type select "Magix." Make 
sure that PCM Coding is set to "uLaw."

6. Select Phone on the navigation bar to go to the Phone page.  Assign the appropriate 
phone set types and Gateway extensions to the ports of the Gateway device. Because 
the Gateway extension displays on the phone,  it’s best to assign a Gateway extension 
that matches the TeleVantage extension of the Gateway phone’s user. For example, if 
Rob Smith’s Gateway phone is attached to Port 1, and his TeleVantage extension is 
215, then assign Port 1 a Gateway extension of 215. 

7. Select H.323 on the navigation bar to go to the H.323 page. Make sure that Gatekeeper 
Mode is set to "Proxy." In the Proxy IP Address field, enter the IP address of the 
TeleVantage Server’s Internet telephony board.

8. Select Import/Export on the navigation bar to go to the Import/Export page.  Click 
Export Settings and export the settings to a configuration text file.

9. Leaving the Import/Export page open in the browser window, open the exported 
configuration text file in a text editor such as Microsoft Notepad. Make the following 
changes there (do not enter the periods at the end of the following lines):

Q Find the line "; External Call Control Mode Login Sequence".  For all ports 
set "telPhdExtSeqLogin" to *.

Q Find the line "; External Call Control Mode Transfer Sequence".  For all ports 
set "telPhdExtSeqTrans" to **1.

Q Find the line "; External Call Control Mode Conference Sequence".  For all 
ports set "telPhdExtSeqConf" to **.

Q Find the line "; External Call Control Mode Redial Sequence".  For all ports 
set "telPhdExtSeqRedial" to *66.

When your edits are complete, save the modified file.

10. On the Import/Export page, click Browse, select the saved file, then click Import 
Settings.

Configuring a PBX-IP Media Gateway phone user in TeleVantage
To complete the configuration for a user’s PBX-IP Media Gateway phone, you must configure 
that user’s account to use the phone. See “Configuring a user to use an IP phone with 
TeleVantage” on page E-24.
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Using a PBX-IP Media Gateway phone with TeleVantage
Once the PBX-IP Media Gateway is properly configured as described in the previous sections, 
a Gateway phone user can use his or her phone as follows:

Q The user can pick up the phone to place a call or use the TeleVantage telephone 
commands, as with any phone. The dial tone that sounds is TeleVantage’s internal dial 
tone.

Q Incoming calls are routed by TeleVantage to the user’s Gateway phone.

Q Pressing the Hold button on the Gateway phone during an active call puts the other party 
on standard TeleVantage hold, with the appropriate music-on-hold.

Q The message-waiting light on the Gateway phone lights up when there are unheard voice 
messages in the user's Inbox.

Dialing a PBX-IP Media Gateway phone directly
In addition to dialing a PBX-IP Media Gateway phone user’s extension at a dial tone or an auto 
attendant, callers can dial the user’s Gateway phone directly by dialing the following:

<the PBX-IP Media Gateway device’s IP address> * <the PBX-IP Media Gateway phone’s 
extension>.

For example, if the Gateway device’s IP address is 222.99.14.96, and the Gateway extension of 
the user’s phone is 123, callers would dial 222*99*14*96*123.

Configuring a user to use an IP phone with TeleVantage_________
To enable a TeleVantage user to use an IP phone with TeleVantage, you must configure that 
user’s account as follows:

1. In the Administrator, double-click the user in the Users view to open the User dialog 
box for that account.

2. On the General tab, make sure that the user has a Station ID of 0.

3. Click the Phone tab. 

4. Check Using a VoIP Phone.

5. Under Ring phone for, specify how long incoming calls ring the IP phone before 
proceeding to the next step on the user’s routing list.

6. Under Phone Type, select the user’s type of IP phone.

7. Under Call Using, select an Internet dialing service to be used when placing outbound 
calls from the phone. For instructions on creating an Internet dialing service, see 
“Adding a dialing service” on page 8-8.
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8. Under Address, enter the IP address as follows:

Q For Polycom phone users, enter the IP address of the Polycom phone.

Q For Intel IP-PBX Media Gateway phones, enter the IP address of the Gateway 
device, followed by a forward slash ( / ), followed by the Gateway extension of the 
Gateway phone’s port.  For example, if the Gateway device has an IP address of 
222.99.14.96, and the user’s phone is attached to Port 1 of the Gateway device, and 
Port 1 has an extension of 101 in the Gateway configuration, then you would enter 
222.99.14.96/101 in Address.

For instructions on defining Gateway extensions see “Configuring the PBX-IP 
Media Gateway device for use with TeleVantage” on page E-22.

9. Click OK.
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APPENDIX F

APPENDIX F

USING A REMOTE PHONE WITH THE 
CALL MONITOR

TeleVantage supports the Call Monitor commands with a TeleVantage station, not a remote 
phone. For example, a remote user can not transfer a call with the Client. Instead he or she must 
use the telephone commands (with ** instead of Flash) to transfer or manage calls. 

This appendix describes a workaround so that administrators can configure a "virtual remote 
station" that allows a remote user to use the Call Monitor in conjunction with their remote 
phone. The remote user can then use any Call Monitor command, and the remote phone at his 
or her desk will respond appropriately. For example, the remote user can be a full-fledged agent 
or supervisor in a TeleVantage call center, able to perform Call Monitor actions such as Monitor, 
Coach, and Join.

The remote phone can be a standard analog phone, Polycom IP phone, cell phone, or any other 
type of phone.

Setting up a virtual station _________________________________
The following procedure creates a virtual station for a user.  In this example the user is named 
Jane Stevens.

1. Create a placeholder user with a Station ID of 0, at an unoccupied extension.  Name 
the user "Virtual User" or something similar.

2. Configure the Virtual User to forward calls to the remote phone.  Leave the forwarding 
options for "Prompt recipient to accept/decline call" unchecked.  Instead, if you want 
call screening, turn that option on in Jane Stevens’ account in step 4.

3. Take the station wire from an unassigned station port (for example station ID 10) and 
instead of connecting it to a phone, connect it to an inbound analog trunk port on the 
TeleVantage Server.  Configure that trunk to route all calls directly to the Virtual 
User's extension. Configure it also to answer calls after one ring instead of the default 
of two.



4. Edit Jane Stevens’ user account to use the rewired station ID (in this example, station 
ID 10). If you want call screening, turn on the appropriate options in the Client by 
choosing Tools > Options, Incoming Calls tab.

Jane Stevens can now use the Call Monitor with her remote phone by logging in to the Client 
using Station ID 10. When she chooses a command in the Call Monitor (for example, Coach), 
TeleVantage rings her station ID (70), which passes the call to an inbound trunk, then to the 
Virtual User, then out to Jane’s remote phone via call forwarding. Her remote phone rings, and 
she can pick it up to complete the Coach command.

If she needs to change the phone number where she is working, she simply changes the call 
forwarding number for the Virtual User.

Disadvantages to using a virtual station
The virtual station setup has the following disadvantages:

Q While a normal forwarded call consumes 1 trunk port, you need 1 additional station and 
trunk port for every simultaneous remote user who wants to manage calls using the Call 
Monitor.

Q When the remote user chooses a Call Monitor command, there is a delay before the 
remote phone rings (because TeleVantage must answer the incoming call from the 
station port, then call the external user). 

Q Caller ID is not displayed on incoming calls.  You can learn who is calling by looking 
at the Call Monitor, or over the phone using the call screening options you may have 
enabled in step 4 (above). 

Q To use Call Monitor commands on an outbound call, the user must place the call using 
the Client rather than dialing it on the phone.  Outbound calls dialed on the phone cannot 
be managed with Call Monitor commands.
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Overview________________________________________________
The TeleVantage SMDR (Station Message Detail Recording) Service lets you send real-time 
call data from TeleVantage to a third-party application. Third-party applications might be 
anything from a printer that prints a line for each call, to call accounting software that generates 
detailed reports.

TeleVantage sends out the information for each call as soon as the call is ended.  The 
information is sent as text in any of the following supported SMDR formats:

Q Lucent/Avaya Definity. The standard SMDR format for Lucent’s Definity switch, which 
is supported by most SMDR vendors. TeleVantage uses Lucent’s "Enhanced Printer" 
SMDR data format.  For details on the data stream sent, see “Avaya Lucent Definity 
SMDR format” on page F-9.

Q Toshiba CTX. The format for Toshiba's CTX100 and CTX670 switch. For details on the 
data stream sent, see “Toshiba CTX SMDR format” on page F-10.

Q TeleVantage fixed-width. TeleVantage’s own format that outputs all call information 
that appears in the Administrator’s Call Log. The information is formatted in 
fixed-width columns.

Q TeleVantage CSV. TeleVantage’s own format that outputs all call information that 
appears in the Administrator’s Call Log. The information is formatted as a 
comma-separated string. The data stream is the same as when cutting and pasting a Call 
Log entry.

The SMDR Service is a Microsoft Windows Service that runs behind the scenes. It does not 
require that a user be logged into the PC.

You can configure settings for the SMDR Service using the TeleVantage SMDR Service 
Manager. See “Configuring the SMDR service” on page F-3.

Output connection options
The TeleVantage SMDR Service can send call information from the TeleVantage Server on the 
following connection methods:

Q COM port. This is the standard way in which PBXs send SMDR data. To use this 
method, plug one end of a serial cable into the appropriate COM port on the TeleVantage 
Server computer, and connect the other end to the COM port of the PC or device that 
requires SMDR data.

Q TCP/IP Socket. The data stream is broadcast over the network from the IP address of the 
TeleVantage Server. Any computer on the network (or Internet) would be able to receive 
the data. By default the TeleVantage TCP/IP port 1000, but you can change this to any 
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port. Certain TCP/IP ports are not recommended, like 23.  For a list of ports to avoid, see 
“TCPI/IP ports to avoid” on page F-5.

Note: Only one device can listen to the TCP/IP port at a time.

Q Text File. The data is written to text file anywhere on the network that gets constantly 
updated.  You can have TeleVantage automatically back the file up at midnight.  When 
using this method, the best format to use is TeleVantage CSV.

Installing the SMDR service ________________________________
To use the SMDR service, install it on the TeleVantage Server computer. The SMDR service 
requires that the TeleVantage Client also be installed on the same PC. For instructions on 
installing the Client, see Installing TeleVantage.

Note: You can install the SMDR service without shutting down the TeleVantage Server. 
However, it is recommended that you perform the installation during off-peak hours in case a 
Server restart is needed.

To install the SMDR service

1. Insert the TeleVantage master CD in the CD drive on the TeleVantage Server 
computer.

2. Run the file \SMDR\Setup.exe on the TeleVantage master CD.

3. Follow the instructions in the SMDR Service Setup window.

Configuring the SMDR service _____________________________
To configure settings for the SMDR service, including the data format and connection type, run 
the TeleVantage SMDR Service Manager on the TeleVantage Server computer. To start it, 
choose Start > Programs > Artisoft TeleVantage Server > TeleVantage SMDR Manager.
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Important: To change any configuration setting, you must either stop or pause the SMDR 
Service.

Starting, pausing, and stopping the service
Click the buttons in the Service section to Start, Pause and Stop the SMDR Service. You must 
either stop or pause the service to change configuration settings.

Q Stopping the service. While the service is stopped, TeleVantage calls that complete are 
not reported.

Q Pausing the service. While the service is paused, TeleVantage calls that complete are 
stored in a buffer. When you click Continue, they are reported.

Starting the SMDR service automatically on restart
Check Auto-start the service to have Microsoft Windows automatically start the service 
whenever the PC is started, regardless of whether anyone has logged in or not.

Choosing the SMDR format
To select the format for data sent by the SMDR Service, use the SMDR Format drop-down list. 
For a list of supported formats, see “Overview” on page F-2.

Selecting the output connection type
In the Output section, check whichever of the following methods you are using to connect the 
TeleVantage Server with your third-party SMDR application:

Q Serial connection. Check to enable connection through a serial cable running from a 
COM port on the TeleVantage Server computer to an SMDR device.

Q COM port. Select which COM port on the TeleVantage Server computer to use. For 
information on selecting a COM port, see your Windows documentation. Note that 
COM port 1 is often used for the Dialogic BCP panel’s Watchdog mode on a 
TeleVantage Server, so it might not be free to use.

Q TCP/IP Socket. Check to enable broadcasting of SMDR data on your network or the 
Internet.

Q Port. Enter the number of the TCP/IP port on which to broadcast SMDR data. For 
a list of port numbers to avoid, see “TCPI/IP ports to avoid” on page F-5.
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Q Text file. Check to have the SMDR Service write call data to a text file in the location of 
your choice. Click Settings to set file location and archiving options in the Text File 
Output Settings dialog box.

You can set the following text file options:

Q Click  to specify a new location or filename for the file.

Q Check Archive Log Daily to have TeleVantage automatically begin writing to a 
new file every midnight, leaving the previous day’s file as an archive. The 
filenames are numbered sequentially. Click  to specify the location for the 
archive files.

TCPI/IP ports to avoid_____________________________________
When choosing a TCP/IP port on which to broadcast SMDR information using a TCP/IP Socket 
connection, avoid the following port numbers:

For more information, see the following website:

www.ietf.org/rfc/rfc1700.txt?number=1700

Port Traditional use

TCP25 SMTP

TCP20,TCP21 FTP 

TCP80 HTTP

TCP110 POP3

TCP119 NNTP

TCP389 LDAP
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TeleVantage fixed-width SMDR format________________________
The following table shows the data stream for the TeleVantage fixed-width SMDR format:

Position Description Width in characters

1 Direction.

Q 0 - Inbound

Q 1 - Outbound

1

2 From Name.
Name of the person who originated the 
call. On incoming calls, "Unknown" 
appears unless the caller has been 
identified as a global contact. On outgoing 
calls, the name of the user who placed the 
call.

15

3 To Name.
Name of the party who received the call. 
On incoming calls, this is the name of the 
user who took the call. On outgoing calls, 
"Unknown" appears unless the person has 
been identified as a global contact.

15

4 Answered By.
Name of the user who answered an 
incoming call. Useful for analyzing data for 
call centers.

15

5 Number.
Phone number of the caller or the person 
you called. For incoming calls, the Caller 
ID information that came in with the call, if 
available. For a call to or from another 
TeleVantage user, this field contains <NA>.

30

6 From Number.
Number the call came from. For incoming 
calls, the caller’s extension or external 
phone number. For outgoing calls, the 
extension of the user who placed the call.

15

7 To Number.
Number the call was placed to. For 
incoming calls, the extension of the user 
who was called. For outgoing calls, the 
external number or extension that was 
called.

15
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8 Callback Number.
If a caller enters a callback number, it 
appears with the prefix "Callback:" 

15

9 DID.
The DID of the incoming call.

10

10 Start Time.
Date and time when the call started.

17

11 Wait Time.
On incoming calls, the length of time from 
when the caller selected an extension to 
when the user picked up. On outgoing 
calls, Wait Time is always 00:00.

8

12 Duration.
Length of the call, after the two parties are 
connected.

8

13 Result.
How the caller’s wait ended:

Q 0 - Abandoned. The caller hung up 
before call was answered.

Q 1 - Connected. The caller was 
connected to a party. 

Q 2 - To voice mail. The caller went to 
voice mail, but did not necessarily 
leave a message.

Q 3 - Blind transfer. A blind transfer 
sent the caller to another party. 

Q 4 - Supervised transfer. A 
supervised transfer sent the caller to 
another party.

1

14 Account Code.
The Account code for this call

10

15 Message.

Q 0 - no message

Q 1 - the caller left a voice message.

1

Position Description Width in characters
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16 From Device.
On incoming calls, the trunk or extension 
from which the call originated. On outgoing 
calls, your station number.

11

17 To Device.
On incoming calls, your station number. On 
outgoing calls, the trunk used for the call. If 
an incoming call was transferred, To 
Device shows the last station that took the 
call.

11

18 Parties.
Number of people who took part in the call, 
including the caller, the called party, 
anyone to whom the call was transferred, 
and any conference call participants.

2

19 Dial String.
Digits that TeleVantage actually dialed over 
the trunk, which may be different than the 
digits TeleVantage displays in a contact’s 
phone number. For example, a dial string 
may contain an international or 
long-distance access code, least cost 
routing information, or a dialing prefix or 
suffix.

15

20 From Type.
Type of incoming call: Phone, Centrex, or 
Internet.

1

21 From Code.
Access code of the dialing service that will 
be used to return this call. Only applicable 
to calls coming in from remote TeleVantage 
Servers over an Internet trunk.

1

22 From Rules.

Q 0 - No rules

Q 1 - TeleVantages dialing rules will be 
applied when returning this call.

1

23 To Type.
Type of outgoing call: Phone, Centrex, or 
Internet.

1

Position Description Width in characters
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Avaya Lucent Definity SMDR format_________________________
The following table shows the data stream for the Avaya Lucent Definity SMDR format:

24 To Code.
Access code used to dial an outbound call.

5

25 To Rules.
If checked, dialing rules were used to 
make an outbound call.

1

26 Custom Data.
Custom data, if any, associated with the 
call. For most systems this will be blank.

30

Position Description Width in characters

Position Description

1-4 Time of day (HHMM)

5 Space

6 Duration - hours

7-8 Duration - minutes

9 Duration - tenths of minutes

10 Space

11 Condition Code

"9" - Inbound

"7" - Outbound

"0" - Internal

12 Space

13-15 Dialing Service

16 Space

17-19 TAC Trunk Access

Inbound:  Blank 

Outbound: Trunk Number

20 Space

21-35 Digits Dialed
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Toshiba CTX SMDR format _________________________________
The following table shows the data stream for the Toshiba CTX SMDR format:

36 Space

37-41 Station Number

Inbound:  Trunk Number

Outbound: Extension

42 Space

43-57 Account Code

58 Space

59-82
Ignored in TeleVantage implementation of 
this format

83 Carriage Return

84 Line Feed

Position Description

Position Description

LINE 1 Basic Call Information

1 Record Type
• "B" - Abandoned
• "N" - Normal Inbound/Outbound Call

2 Blank

3-5 "001" - Record Number

6 Blank

7-12 Node ID (Ignored in our implementation)

13 Blank

14-22 Origin Information
• Inbound:  "T001" + Trunk # (000-999)
• Outbound: "DN" + Extension Number
• Internal: "DN" + Extension Number

23 Blank
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24-32 Termination Information
• Inbound:  "DN" + Extension Number
• Outbound: "T001" + Trunk # (000-999)
• Internal: "DN" + Extension Number

33 Blank

34-47 Time Stamp (MM/DD HH:NN:SS)

48 Blank

49-58 Call Duration (HH:NN:SS + ".o")

59 Blank

59 Blank

60-91 Number Dialed

92 Carriage Return

93 Line Feed

LINE 2 CallerID and DID

1 Blank

2 "&"

3-19 CallerID

20 Blank

21-39 Blank (Ignored in our implementation)

40-46 DNIS/DID

47-62 Blank (Ignored in our implementation)

63 Carriage Return

64 Line Feed

LINE 3 Account Code 
(optional, will not appear if no account code)

1 Record Type
• "B" - Abandoned
• "N" - Normal Inbound/Outbound Call

2 Blank

3-5 "002" - Record Number

6-47 Mirror of Line 1

Position Description
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48-59 Blank

60-91 Account Code

92 Carriage Return

93 Line Feed

Position Description
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INDEX
Numerics
911. See enhanced 911

A
access codes

for dialing services, 8-7

special, 3-11

updating phone numbers after changing, 8-7

using 0, 8-7

account codes
described, 10-6

examples, 10-6

how users enter, 10-7

in Call Log, 10-12

setting for a user, 10-10

text file of valid codes, 10-10

Adjust Station IDs, 2-5

Admin user, 6-2

Administrators role, 6-46

Advanced Settings Editor, A-31

allocating space
for SQL Server database, 3-8

for voice files and greetings, 3-9, 6-15

analog trunks, 5-9

archiving the Call Log, 11-14

audio controls, 2-10

audio controls, using, 2-10

audio recordings
changing file format, 2-10

creating, 2-10

file formats, 2-10

VOX files, 2-10

WAV files, 2-10
auto attendants
about, 9-4

actions, 9-9

and DID, 9-2

creating, 9-7

creating menu choices for callers, 9-8

default, 9-5

defining menu choices for, 9-8

example, 9-4

routing calls, 9-2

routing calls to, 9-2

scheduled actions, 9-14

scheduling transfers and greetings, 9-13

setting up, 9-6

using, 9-4

what caller hears, 9-5

Auto Attendants view, 9-6

Avaya, E-22

B
backing up

and restoring, 11-18

moving backup file, 3-10

TeleVantage database, 11-17

blocked numbers, 6-53

BRI, adding a digital span, 5-17

business hours, defining, 3-3

C
call forwarding

and voice mail, 6-29

to a mobile phone, 6-29

to another extension, 6-29

turning off, 6-29

turning on, 6-28



call handling
fax routing, setting up, 5-6

multiple users at one station, 6-14

outbound calls, 8-1

on a trunk, 5-4

routing, 5-4

routing inbound calls, 5-4

Call Log
archiving, 11-14, 11-15

display options, 6-11

exporting, 11-13

logging internal calls, 3-8

result codes for exported, 11-14

Call Log view, 2-4, 11-10

call routing
about, 9-2

flowchart
for Administrator, 9-3

for Client, 9-3

to a single ACD workgroup, 9-2

to an auto attendant, 9-2

to groups, 9-2

trunk directly to a user, 9-2

call screening, setting up, 6-26

callbacks
setting default access codes for, 8-8

working with international numbers, 5-13

caller ID
handling international numbers, 5-13

setting outbound for the system, 3-6

setting outbound for user, 6-42

calling name on ISDN PRI, A-27

calls
entering account codes for, 10-7

recording, 4-2

CAS, adding a digital span, 5-16

Centrex/PBX transfer, 6-30

changing
default Server, 2-2

station ID, 2-2

channel settings, A-23
INDEX-2
Client
audio controls, 2-10

call routing flowchart, 9-3

modifying user settings from Administrator, 6-44

permissions, setting, 6-38

codecs for Internet transmissions, 5-27

columns, customizing, 2-9

commands
shortcut menu, 2-7

using in views, 2-7

using toolbar, 2-7

companies. See organizations.

COMPANY, A-2

configuring the Administrator for the first time, 1-4

confirmation menu, voice mail, 3-6

converting audio recordings to new file format, 2-10

CSV files, for system prompts, 12-3, 12-4

custom data
overview, 9-18

defining variables for, 9-19

setting values for, 9-20

custom tones
for disconnect detection, A-14

for fax detection, A-14

D
Default Auto Attendant, 9-5

defaults
0 for extension of Operator user, 8-7

access codes
viewing in the Administrator, 8-8

viewing in the Client, 8-8

access codes for callbacks, 8-8

Administrator password, 2-2

auto attendant, 9-5

database size, 3-9

dialing time-outs, 3-12

deleting users, 6-45

Device Monitor view, 2-4, 11-2
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dial-by-name directory
and default auto attendant, 9-5

creating settings for, 3-17

defining special access codes for, 3-11

listing user in, 6-30

on a remote Server, 13-8

dialing exceptions
importing and exporting, 8-17

overview, 8-15

dialing services
about, 8-2

adding, 8-4, 8-8, 8-17

and access codes, 8-7

avoiding dialing ambiguities, 8-6

choosing names for, 8-6

deleting, 8-5

disabling while creating, 8-6

for IP Gateways, 13-13

identifying trunks allocated by, 8-12

permissions, example of, 8-18

Phone Number dialing service, using a prefix and 
suffix, 8-10

types, 8-2

types supported, 8-2

using to test trunks, 8-4

Dialing Services view, 8-4

dialing time-outs, 3-12

Dialogic devices
disabling, A-15

names for, A-14

DID, sending digits to stations, 14-4

digit collection
about, 5-5

setting up on analog trunk, 5-11

digital spans
overview, 5-9

adding, 5-17

Direct Inward Dialing (DID)
assigning number to a user, 6-14, 7-5

routing calls to auto attendants, 9-2
disabling
dialing services while creating them, 8-6

Dialogic devices, A-15

digital spans, 11-6

record of in Maintenance Log view, 11-26

disconnect tones, A-14

disk space, allocating for users, 3-9

display phones, changing format from MDMF to 
SDMF, 5-30

documentation, 1-5

E
E1 and T1 board settings, A-25

E1, adding a digital span, 5-16

Edit All Client Settings command, 6-44

e-mail
notifications of new voice messages, 6-18

receiving Event Log notifications, 3-20

synchronization with Microsoft Exchange, 3-18

emergency dialing services, 3-13

English language prompts, 3-6

enhanced 911, 3-13

entering account codes for a call, 10-7

errors and warnings, 11-19

Event Log
messages, 11-19

notifications, 3-20

T1 alarms, 11-22

viewing, 11-19

Exchange Server. see Microsoft Exchange Server

expiration of passwords, 3-16

exporting
Call Log, 11-13

Phone Number dialing service dialing 
exceptions, 8-17

system prompt files, 12-3, 12-4, 12-5

voice files, 2-11

exporting and importing dialing exceptions, 8-17
INDEX-3



extensions
and station ID, 6-13

assigning, 6-10

assigning to workgroups, 7-5

starting number, 6-11

F
fax

integrating server, 14-4

routing calls to, 9-2

fax detection, A-14

file formats
for voice files, 2-10

VOX, 2-10

WAV, 2-10

files
.VAP, 12-6

.VOX, 12-6

allocating space for, 6-15

change encoding format, 12-5

changing format, 2-10

companies that can record new files, 12-7

converting formats, 2-10, 12-3

exporting and importing system prompts, 12-5

for documentation, 1-6

importing and exporting, 2-11

moving, 3-10

playing over phone or computer, 2-11

prompts, 12-6

script for vendors, 12-7

sentence file, 12-6

Test Sentences dialog box, 12-10

testing, 12-8

voice, 2-10

folders, working with, 2-9

follow-me call forwarding, 6-30

forwarding
and voice mail, 6-29

follow-me, 6-30

to a mobile phone, 6-29
INDEX-4
forwarding (cont’d.)
to another extension, 6-29

turning off, 6-29

turning on, 6-28

G
Gateway users, 13-14

greetings
creating, 2-10

scheduling in an auto attendant, 9-13

group conversation lines, blocking, 6-53

H
H.323 terminals, 13-3

handling
multiple users at one station, 6-14

outbound calls, 8-1

hands-free answering
changing beep for, 6-42

enabling, 6-41

Help, where to find, 1-5

hold audio, 3-5

hold music
for a user, 6-30

for an auto attendant, 9-16

for the system, 3-5

holiday schedules, 3-3

holidays, defining, 3-3

hotline, creating, 5-31

hours, defining business hours, 3-3

hunt group, 5-4

I
importing

Phone Number dialing service dialing 
exceptions, 8-17

voice files, 2-11
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inbound call routing, 9-2

auto attendant, 9-4

extensions, 9-17

inbound PRI calling name identification, A-27

inbound-only, configuring, 5-4

integrating third-party devices, 14-4

Intel PBX-IP Media Gateway, E-22

intercom and page settings, A-38

internal calls, logging, 3-8

international caller ID, 5-13

Internet span, adding, 5-25

Internet telephony, 13-2

Internet telephony board device names, A-20

Internet, enabling calls over, 8-3

Internet, using to connect to Servers, 13-8

IP Gateways
Configuration Worksheet

worksheet, configuring IP Gateways, D-1

creating, 13-10

dialing services for, 13-13

overview, 13-8

IP Gateways view, 13-11

IP network
codecs for, 5-26

using to connect two Servers, 13-8

IP phones, with TeleVantage, E-2

ISDN
adding a digital span, 5-16

inbound calling name on PRI, A-27

ISDN BRI, adding a digital span, 5-17

items
copying and pasting into the Problem Report 

Wizard, 2-9

creating, 2-8

creating a new item based on an existing item, 2-8

in views, 2-7

using commands on, 2-7

IVR Plug-ins
licensing, 14-11

view, 2-4
L
language

installing additional, 12-3

of system prompts, 3-6

licenses
configuring a system without, 1-5

in system settings, 3-2

lockout, 3-16

logging internal calls, 3-8

logging on
options, B-1

password, 2-2

to Administrator, 2-2

using command line arguments, B-1

M
mailbox permissions, with Microsoft Exchange, 3-18

Maintenance Log view, 11-26

MDMF display phone format, 5-30

menu choices, 9-8

message waiting light, 5-30

messages, moving voice files to regain space, 3-10

Microsoft Exchange, synchronizing with 
TeleVantage, 3-18

Microsoft NetMeeting
about, 13-3

calling DID number from, 13-6

calling TeleVantage Server from, 13-6

placing calls to
from TeleVantage Client, 13-3

from TeleVantage phone, 13-4

mobile phones, issues with forwarded calls, 6-29

moving
TeleVantage Server to another machine, 11-19

voice files, 3-10

MSI device names, A-20

multiple companies. See organizations.

multiple users, 6-14
INDEX-5



music-on-hold
for a user, 6-30

for an auto attendant, 9-16

for the system, 3-5

N
NetMeeting. see Microsoft NetMeeting

new install, configuring, 1-4

notifications
scheduling, 6-21

setting, 6-18

setting business hours, 3-3

numbers, blocking specific, 6-53

O
offhook auto-dialing, 5-31

Operator user, 6-2

options, setting for user, 6-9

Organizations
associating users with, 6-43

defining, 10-3

with auto attendants, 10-4

overview, 10-2

outbound caller ID
for system, 3-6

for user, 6-42

outbound-only, configuring, 5-4

P
page and intercom settings, A-38

password
Administrator default, 2-2

expiration, 3-16

restricting user choice, 3-15

security, C-3

when logging on, 2-2

PBX, customizing trunk disconnect tones, A-14

PBX-IP Media Gateway, E-22

permissions, 6-38
INDEX-6
Phone Dialer, 13-7

phones
adding, 5-30

changing format from MDMF to SDMF, 5-30

supported by TeleVantage, 5-30

playing system prompts, 12-4

Polycom IP phone, E-2

prefix and suffix
in Phone number dialing service, 8-10

PRI boards, and inbound calling name, A-27

problems, reporting to technical support, 11-27

Q
Queues view, 2-4

R
recording

system calls, 4-2

system prompts, 12-8

recordings
changing file format, 2-10

creating, 2-10

ringback tone, 12-12

voice file formats, 2-10

VOX files, 2-10

WAV files, 2-10

registry settings
changing in Windows NT/2000, 3-2

custom tones, A-14

Server settings
ACDWrapupTime, A-34

AllowCallsWithoutUsers, A-34

AllowGatewayUserLogin, A-34

AnalogMinTrunkOnhookTime, A-3

AudioControlRingtimeout, A-34

BCPComPort, A-3

BufferDirCleanupThreshold, A-34

CheckRecipientCallForSetting, A-35

COMPANY, A-2

CPAConnectDelay, A-34
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registry settings (cont’d.)
Server settings (cont’d.)

DbCacheInterval, A-3

DefaultGreetingSize, A-35

DefaultLocaleCode, A-13

DefaultMailboxSize, A-35

Description, A-13

Dial911AtDialTone, A-35

DirectCallsUseFaxTarget, A-35

DisableDevices, A-3

DropMonitorsAfterTransferComplete, A-35

E911RingDuration, A-35

EmptySentItemsFolder, A-4

EnableIPLogin’,, A-4

ExternalCallOfferingDelay, A-36

ExternalCallOfferingDelayConnected, A-36

InterbalDialtoneTrunkFirsttimeout, A-36

InternalDialtoneStationFirsttimeout, A-36

InternalDialtoneStationSecondtimeout, A-36

InternalDialtoneTrunkSecondtimeout, A-36

IPVoiceTitleMaxSilence, A-37

LocaleDLL, A-13

LockoutResetInterval, A-3

LogHours, A-4

LogPath, A-4

LongIdleTime, A-37

MaxAutoAttendantLoops, A-37

MaxNonSilence, A-4

MaxRingDuration, A-37

MinAdminBuild, A-42

MinClientBuild, A-42

MinDevMonBuild, A-42

MinDiskFreeSpace, A-4

MinimumMessages, A-37

MinRingDuration, A-37

MinRingDurationForExternalCallOffering, A-3

8

MinRingDurationForExternalPadding, A-38

MonitorInterval, A-4

MonitorRestart, A-5

Monitortimeout, A-5

MSDECriticalLimitPercentage, A-38
registry settings (cont’d.)
Server settings (cont’d.)

MSDEFullPercentage, A-38

NoAnswerTime, A-33

NumLogs, A-5

PageRequestTimeout, A-38

PageTimeout, A-38

PageVoxAllocMaxRetryInterval, A-38

PartyCustomDataMax, A-5

PrependVTMessageDuration, A-39

PresentExtensionBeforeCallerID, A-39

Q931DefaultSourceName, A-5

RefreshVMWI, A-39

RequireLoginForTUIOnTrunk, A-39

RoutingListContinueDelay, A-39

SendDigitsToStationDelay, A-39

SendDisplayOnAnswerCall, A-6

SentenceFile, A-13

TruncateRecordings, A-6

TrunkAllocationInterval, A-40

TUIIdleTimeout, A-40

TUITransferRingDelay, A-40

UISupportIdleTimeout, A-40

UnknownCallerName, A-6

UseConferencesForEchoCancellation, A-6

UseDedicatedVoiceDevices, A-7

UserVoxPath, A-7

VapFile, A-13

VoxHighEventInterval, A-7

VoxLowBorrowedMinFreeAbsolute, A-40

VoxLowBorrowedMinFreePercentage, A-41

VoxLowEventInterval, A-40

VoxLowMaxInstances, A-41

VoxLowSharedMinFreeAbsolute, A-41

VoxLowSharedMinFreePercentage, A-41

VoxSysCallRecBorrowedMinFreeAbsolute, A-

41

VoxSysCallRecBorrowedMinFreePercentage,
A-41

VoxSysCallRecEventInterval, A-41

VoxSysCallRecMaxInstances, A-42

VoxSysCallRecSharedMinFreeAbsolute, A-42
INDEX-7



registry saettings (cont’d.)
Server settings (cont’d.)

VoxSysCallRecSharedMinFreePercentage, A-4

2

WaitLoopCurrenttime-out, A-7

voice board settings
CID_FSK_FORMAT, A-30

CIDName, A-25

DNISLength, A-26

DNISWaitTime, A-26, A-28

DumpCallInfo, A-26, A-28

DXCH_ADSIALERT_AMPL, A-23

DXCH_D_FLAGS, A-23

DXCH_DTINITSET, A-24

DXCH_DTMFDEB, A-24

DXCH_DTMFTLK, A-24

DXCH_MAXRWINK, A-25

DXCH_MFMODE, A-24

DXCH_MINRWINK, A-25

DXCH_RINGCNT, A-25

DXCH_WINKDLY, A-25

DXCH_WINKLEN, A-25

HandleProgressID, A-28

HandleProgressInd, A-26

InProtocol and Outprotocol, A-26

InternationalPlan, A-29

InternationalPrefix, A-29

InternationalType, A-29

MSG_DBOFFTM, A-30

MSG_DBONTM, A-30

MSG_MAXFLASH, A-30

MSG_MINFLASH, A-30

OverlappedDNIS, A-27, A-28

PointToPoint, A-29

VMWI_FSK_FORMAT, A-31

workstation settings
Address, A-8, A-12

audioemp file dir, A-33

AutoLogon, A-8

Connectiontimeout, A-33

Database, A-9

HangUpCalls, A-10
INDEX-8
registry settings (cont’d.)
workstation settings (cont’d.)

History, A-9

Hold Conference Parties, A-33

MaxTraceFileSize, A-10

OutputToTraceFileOn, A-10

PersistentSort, A-9

Pingtimeout, A-10

RedrawMode, A-8

RefreshInterval, A-33

Server, A-9, A-12

ServerPingInterval, A-11

ShowStatusBarServerInfo, A-8

TraceDirectory, A-11

TraceLevel, A-11

TraceMaxRevisions, A-11

TracePath, A-10

TraceToFile, A-11

Username, A-9

VolumePercentage, A-33

remote stations, creating virtual, E-1

reporting problems, 11-27

restoring TeleVantage database, 11-18

right-click menus, using, 2-7

ringback tone, rerecording, 12-12

Robbed Bit T1
adding a digital, 5-14

signaling
configuring, 5-14

template for, 5-15

roles
Administrators role, 6-2

Users role, 6-2

routing calls
directly to auto attendants, 9-2

to call centers, 9-2

to fax machine, 9-2

routing services
adding, 8-26

adding new routing variables, 8-30

defining a new number for a routing rule, 8-32
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routing services (cont’d.)
defining patterns, 8-30

defining stop rules, 8-29

using for least cost routing, 8-22

using for long-distance calls over an IP 
gateway, 8-22

routing variables
adding new, 8-30

example, 8-30

S
schedule entry

for auto attendant, 9-14

for notifications, 6-23

schedules, setting business hours, 3-3

scheduling transfers and greetings, 9-13

SDMF, changing display phone format to, 5-30

security
overview, C-1

for passwords, C-3

system settings for, 3-15

Server
moving to another machine, 11-19

shutting down, 11-16

settings
audio output

over your computer speakers, 2-11

over your phone, 2-11

confirmation menu before voice mail, 3-6

database space, 3-8, 11-15

dialing service permissions, 8-18

dialing time-outs, 3-11

disk space, 3-9, 11-15

e-mail synchronization, Microsoft Exchange, 3-18

generating tones, 3-5

in the status bar, 2-11

recipient of Windows Event Log Notifications, 3-20

special access codes, 3-11

viewing database and disk usage, 3-8

workgroup extension, 7-5
shortcut menu, 2-7

shutting down TeleVantage Server, 11-16

SMDR service, F-1

Spanish language prompts, 3-6

special access codes, 8-8

SQL Server database
allocating space, 3-8

restoring, 11-18

starting the Administrator, 2-2

station ID
adjusting all, 2-5

and extensions, 6-13

assigning to a user, 6-11

stations
adding, 5-30

automatic offhook dialing, 5-31

automatically resetting after non-default logins, 6-43

monitoring activity, 11-3

restarting with Device Monitor, 11-9

sending DID digits to, 14-4

starting number, 6-11

stations, virtual remote, E-1

stop rules, defining in routing services, 8-29

support, technical, 1-5

synchronization with Microsoft Exchange, 3-18

system call recording, 4-2

system prompts
changing encoding format of files, 12-3, 12-5

choosing a language for a user, 6-15

controlling display of, 12-3

customizing, 12-2

editing, 12-4

exporting text for CSV files, 12-3, 12-4

importing and exporting audio files for, 12-3, 12-5

managing, 12-3

playing, 12-4

recording, 12-8

testing, 12-10

translating, 12-5

System Prompts view, 2-4, 12-2
INDEX-9



system settings
allocating disk space, 11-15

archiving the Call Log, 11-15

business hours, 3-3

changing Windows NT/2000 registry settings, 3-2

confirmation menu before voice mail, 3-6

database space, 11-15

dialing time-outs, 3-11

dialog box, 3-2

e-mail synchronization, Microsoft Exchange, 3-18

generating tones using software, 3-5

hold audio, 3-5

language for prompts, 3-5

licenses, 3-2

logging internal calls, 3-8

overview, 3-2

Server configuration, 3-5

special access codes, 3-11

viewing database and disk usage, 3-8

Windows Event Log Notifications, 3-5

System Settings dialog box
Call Log tab, 3-7

Dialing tab, 3-11

Emergency tab, 3-13

General tab, 3-5

Other tab, 3-17

Storage tab, 3-8

tabs in, 3-2

T
T1 alarms, 11-22

technical support, 1-5

telephone receiver, using computer speakers for, 2-11

TeleVantage
additional phones with, 5-30

backing up database, 11-17

Internet telephony, 13-2

monitoring system, 11-2

phones, supported by, 5-30

restoring database, 11-18

trunks, supported, 5-2
INDEX-10
TeleVantage Administrator
connecting servers over the internet, 13-8

H.323 terminals, 13-3

Microsoft NetMeeting, using, 13-3

Web site "Call Us" link, 13-7

TeleVantage Advanced Settings Editor, A-31

TeleVantage database
backing up, 11-17

restoring, 11-18

TeleVantage Server registry settings, A-2

TeleVantage Workstation applications registry 
settings, A-7

terminated hunt group, 5-4

third-party devices
integrating, 14-4

sending DID digits to, 14-4

tie-lines. see IP Gateways

toll fraud, C-1

tones for disconnect detection, A-14

tones for fax detection, A-14

toolbar, 2-7

Toshiba phones, 3-6

transfer, between two Centrex/PBXs, 6-30

translating system prompts, 12-5

trunks
adding, 5-2

analog, adding, 5-9

ANI/DID, 5-5

changing system settings when adding, 3-2

configuring signaling on, 5-14

customizing disconnect tones, A-14

deleting, 5-3

digit collection, setting up, 5-11

digital, 5-9

identifying those allocated by dialing services, 8-12

Internet, 5-9

Internet span, adding, 5-25

number of, 5-9

restarting with Device Monitor, 11-9

Robbed Bit T1, 5-14
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trunks (cont’d.)
routing to a user, 9-2

setting defaults for, 5-29

setting properties for, 5-9

types supported, 5-2

Trunks view, 2-3, 5-7

TVConvert.exe, 12-3, 12-5

U
U.K. English language prompts, 3-6

U.S. English language prompts, 3-6

updating access codes, 8-7

users
account code modes, 10-10

adding, 6-7, 6-10

Admin, 6-2

changing system settings when adding, 3-2

clearing lockout, 6-40

configuring to use an IP phone, E-24

deleting, 6-45

managing, 6-1, 7-1

modifying Client settings from Administrator, 6-44

Operator, 6-2

ringing multiple users simultaneously, 9-2

roles, 6-2

routing trunks directly to, 9-2

setting options, 6-9

Users role, 6-46

Users view, 6-5

V
VAP file, 12-6

variables. See custom data variables.

view bar, 2-7

viewing Windows Event Log, 11-19

views
customizing columns in, 2-9

deleting, 2-9

Maintenance Log, 11-26
views (cont’d.)
using commands in, 2-7

working with, 2-7

visual message waiting indicator, 5-30

voice board device names, A-18

voice board settings, A-21

voice files
allocating space for, 3-9

converting, 12-3, 12-5

importing and exporting, 2-11

moving, 3-10

supported formats, 2-10
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